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感

CFD 是进行传热、传质、动量传遍及燃烧、多相流和化学反应研究的核心和重要技

术 ， 广泛应用于航天设计、 rt革设计、生物医学工业、化工处理工业、涡轮机设计、 半

导体世计、 HAVC&R 等诸多工程领域.

流体分析的理论方法和实验方法存在较大的局限， 发展得相当缓慢 ， 而随着计算机

技术的高速发展. CFO 技术开始作为主要的流体分析方法， 井在执国得到了飞速的监

展 . CFD 方法具有成本低和能模拟较复杂或较理想过程等优点. 经过一定考核的 CFD

软件可以拓宽实验研究的范围，减少成本昂贵的实验工作量. 在给定的垂数下用计算机

时现卑进行一次数值模拟相当于进行一次数值实验，历史上也曾有过首先由 CFO 数值模

拟盎现新现盘而后由实验予以证实的例于 . CFD 软件-般都能推出多种优化的物理模

型 ， 如定常和非定常流动、层流、 董流、 不可压缩和可压缩流动、传热、化学反应等.

对每一种物理问题的流动特点，部有适合它的数值解法， 用户可对显式或隐式差分格式

进行选搏，以期在计算速度、稳定性和精度等方面达到最佳. CFO 软件之间可以方便地

进行数值交换 ， 井果用统一的前、后处理工具，这就省却了科研工作者在计算机数据衔

接方法、蝙程、前后处理等方面投λ的重复、低效的劳动 ， 而可以将主要精力和智盟用

于物理问题本身的探置上.

自从 1 98 1 年英国 CHAM 公司首先推出求解流动与传热问题的商业软件 PHOENICS

以章，迅速在国际软件产业中形成了通称为 CFO 软件的产业市场. 到今天， 全世拌至少

已有 so 企种这样的流动与传热问题的商业软件， 在促进 CFD 技术应用于工业实际中起

了很大的作用 . 在 CFO 软件中 . FLlJENT 软件是目前国内外使用最多、最流行的商业软

件之一. FLlJENT 的软件设计基于 "CFD 计算机软件群的概意"针对每一种流动的物

理问题的特点，采用适合于宫的数值解法在计算速度、稳定性和精度等各方面达到是

佳.

FLlJENT 软件包含有结构化及非结构化网格两个版本. 在结构化网格版本中有适体

坐标的前处理软件 ， 同时也可以纳入 I-OEAS. PAT民AN、 ANSYS 和 ICEMCFD 等著名

生成网格的软件所产生的网格. 速度与压力稿告采用同位网格上的 SIMPLEC 算法 . 对

流项差分格式纳λ了一阶迎风、中心差分且 QlJlCK 等格式 . FLlJENT 软件可用来模拟

从不可压缩到高度可压缩范围内的重杂流动. 由于采用了多种求解方法和事重网格加速

收敛技术， 因而 FLlJENT 能达到最佳的收敛速度和求解精度. 员活的非结构化网格和基

于解的自适应网将技术且成熟的物理模型 ， 使 FLUENT 在转披与漏流、传热与相变、化

学反应与燃烧、多相流、旋转机械、动/变形罔格、噪声、 材料加工、燃料电池等方面有

广泛应用.

本书作者从理论、工程实例卦析、模型世置、计算方法等各个方面系统阐述了

FLlJENT 在流悻分析且仿真领域的运用 ， 书中 1 2 章依次介绍T计算流体力学理论、流

悻流动分析概述、前处理网格生成、揣流模型、传热分析、非定常流动问题、$相流模

型、 转动模型、组分输运与化学反应模型、流动分析后处理、 UOF 使用且偏写、典型工

程JI;例等内睿 . 书中配备了算例立件及屏录，能够较快地帮助读者学生井熟悉 FLlJENT

的撮作流程，掌握 FLUENT 的相关模型去解决实际工程问题.



谨祝本书与您分享的 FLUENT 流体分析与仿真技术能够帮助你在 CFD 研究领域有深入

的拓展!

兰ιd号
全国首届教学名师

问海大学流体力学教授

河晦大学水力学且流体力学中心主任

教育部高校力学教学指导委员告委员

2010 年 2 月于南京
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提于本书

内容和特点

计算流体力学是计算流体动力学的简称，英文名为 Computational Fluid Dynamics (缩写

为 CFDl . 它是基于离散化的数值计算方法， 利用电子计算机对流体相对于不同固体边界的

内外流场进行数值模拟和分析的学科，属于流体力学的 个卦直. 由于流悻流动的直杂性，
理论分析尚无法束得详细的解析解，计算流体力学正是弥补此不足而于 20 世纪 60 年代发展

起来的，并相应地形成了各种做值解法， 主要包括有限差分法、有限元法和有限悻积法.

随着计算机技术的高速发展，关于计算流体力学数值计算的软件也垣渐兴起，自 198 1

年以来 ， 出现了如 PHOE阳CS 、 CFX、 STAR-CD、 FlDAP 、 FL四川 等多个商用 CFD 软

件. 这些商用软件在工程界正发挥着越来越大的作用. 其中. FLUENT 是 CFD 软件中相对

成熟和运用最为广泛的商业软件. 官基于有限体积法对计算区域进行离散，用户可以根据实

际情况选择相应的算法对离散后的控制方程组进行求解.

FLUENT 是一个用于模拟和分析复杂几何区域内的流体流动与传热现草的专用软件，
它提供了灵活的网梅特性，可以支持多种同格，且以用户界面直好而著称，所以对初学者来

说非常喜品上手. FLUENT 的软件世计基于 CFD 软件群的思想，从用户需求角度出发，针

对各种复杂流动的物理现聋，采用不同的离散格式和数值方法，在特定领域内使计算速度、

稳定性和精度等方面达到最佳组合，从而高效率地解快各个领域盟杂流动问题的计算.

FLUENT 软件的不断完善与重新，使得其不仅作为一个研究工具 ， 而且还作为世计工

具在水利工程、土木工程、石油工程、天然气工程、环场工程、食品工程、海洋结构工程等

领域发挥着巨大的作用.

正是因为 FLUENT 在流悻工程模拟计算中发挥着重要的作用，流悻分析与设计的相关

行业人员且科技工作者对于学习 FLUENT 的热情都很高，所以作者结告自身的敏学且工作
经验， 蝙写了这本 FLUENT 流体分析且仿真，本书在编写的过程中突出了以下特点.

(1) 直观品懂 z 圭书以图解实例的形式介绍基础知识和实例操作，所有的实例操

作过程都有图片介绍 ， 直观品懂，使用户能够在最短的时间内藐取知识.

(2) 实用性z 全书采用了基础知识介绍和实例操作相结合的方法 ， 互相补充，书

本上的实例大多来源于生产实例，井且从用户的角度出发进行了简化和政

迹 ， 同时在各内容关键处给予了有益的提示和指导 ， 使用户在学完本书后能
够快速地将知识应用于生产实践.

(勾结构捕晰，讲解详尽=圭书采用基础知识一实训实例-综合实例的循序渐进

的讲解方法， 一步步地提高用户的 FLUENT 流悻分析方法， 而且每个知识点

和实例都做丁尽可能详细的讲解， 使用户学习起来轻松自如.

(4) 多媒体示范·本书的配套光盘中提供了所菁实例的视频操作，用户可以在观

看视频的过程中增强对知识点的理解.

本书共升为 12 章，依次介绍了计算流悻力学理论、流体流功分听概述、前处理网幡生

成、揣流模型、传热分析、非定常流动问题、多相流模型、转动模型、组分输运与化学反应

模型、流动分析后处理、 UDF 使用及编写、典型工程实例等内容.



- ~ I 章计算ìt体力学理论.介绍施体力学的一些基本理论.计算施体力学的

基本方程且 FLUENT 的计算原理.

• 第 2 章施体施动企析概述.介绍施体施动分析的皮晨，捞且 CFD 的概念、

CFD 软件及施动分析的应用咽域，重点介绍 CFD 壮件中适用最为广适的
FLUENT 辑件及其功能、运行方量和用户界面，井配有简单实例 .

• 第 3 j在前处理网掉生成.介绍网格生成的方浩2< GAMBIT 软件的用户界面，
详细讲解 J GA1咀IT 的操作步噩，井配有实例.

• 第 4 章瑞施模型. 介绍常用的精ìt模型，时且利用 FLUENT 进行瑞班班动模
拟的操作过程，井配有;t，倒.

• 第 5 章传热分析.介绍情熟的各种方洼和应用咽埠，因且利用 FLUENT 进行
传格分析的操作过程，并配有实例

第 6 掌非定市班动问题.介绍非定市革动问题的概幸 ， 1;(2<如何在 FLUENT

中进行非定睛施勒问题的计算，并配有实例.

• 第 7 章多相撞模型.介绍常见的几种多相撞模型 VOF 模型、 Mixture 模
型和 Euler 模型，1;(且 FLUENT 中多相雄模型的计算过程 ， 并配有实例.

• 第 8 章转动模型.介绍 FLUENT 中用于模掘带动和变形区域的施体温动问题

的动#寺1民模型、滑稽网格模型且动网格模型，井配有;t，例.
· 第 9 章组分输远与化学且应模型. 介绍利用 FLUENT 卓解组分输远与化学且

应问题，并配有实例.

· 第 10 章施动分析后处理.针时施动分析后址理的帽耍，介绍利用 FLUENT

及 Tecplot 进行模掘结果后处理的操作过程，井配有;t，倒 .

• 第 II 章 UDF 使用及编写.介绍 UDF 的基础知识， UDF 茸且 UDF 的解释与

编译，并配布要例讲解 UDF 的基本使用方浩.
• 第 12 j位典型工程实例.结合石油天然气、环境、机械等工程咽域的典型问题

进行 FLUENT 施体分析且齿真的介绍，并配有;t，例.

光盘说明

本书配套 1 张多媒体 DVD 光盘， 主要内容介绍如下.

1 本书是基于 FLUENT 6.3.26 版本进行写作的，读者需要且不低于土述版本打

开文件.

2 克盘上的主件是只埃主件，因此，需要将尤盘土的源主件1制 j~ 电脑硬盘

尘，取消主件的"只读"属性，方能进行修改.

3. Ch'立件臭，其中·号代在某个数丰 ， 与本书的章时血，其中的又件是谊章中

使用到的主件，包括本书中所有操作实制的结果主件，时应主中的)t.(U_".J .
4. Ch-主件史中的 AVI 主件夹用于存址本书所有操作lI;倒的操作录像，时且立中

的兑("'''J . 直接且去需要播放的主件即可吼琦.
西南石油大学朱红钩编写了书中第 3-12 章，井对全书进行了统稿. 西南石油大学样元

华教授蝙写了第 1 -2 章，进行7全书的悻改与完善，井在编写过程中提供了全面的技术支

持和克卦的指导. 香港中文大学副龙汉博士对本书进行了校对和完菩. 另外， 本书还得到了

2 



人民邮电出版社的大力支持， 在此-井致以深深的谢意 ' 同时也非常愿谢仿真科技论坛、工

程流体网、流体中文网的广大网直的帮助和支持.

限于编写水平 ， 且时间仓促，书中难免有疏漏之处，望广大读者给予指正. 读者可通过

电于邮件 s叩uticky@ 1 26.com 或者 reader.toptech@gmail.com 与我们交流，不胜感谢!

最红钧

2010 年 2 月于成都
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第 1 章

计算流体力学理论

计算流体力学是计算流体动力学的简称，是基于离散化的数值计算方法，利用电子计算

机时流体相对于不同阳仲边界的内外流场进行数值模拟和分析的学科， 属于流体力学的一个

分支. 由于流体流动的直杂性， 理论分析无法求得详细的解析解，计算流体力学正是为弥补

此不足而于 20 世纪 60 年代发展起辈的，井相应地形成了各种数值解法，主要包括有限差分

法、有限元法和有限体积法• Mi体力学运动偏微分方程有椭圆型、抛物型、双曲型和混合型

之分， 计算流体力学很大程度上就是针对不同性质的偏微分方程采用并发展了相应的数值解

法.

随着计算机技术的高速发展 ， 关于计算流体力学数值计算的软件也逐渐兴起 ， 其中

FLUENT 是 CFD 软件中相对成熟和运用最为广泛的商业软件. 它基于有限体积法对计算区

属进行离散，用户可以根据实际情况选择相应的算法对离散后的控制方程组进行束解.

本章主要介绍流体力学的一些基本理论、计算流体力学的基本万程且 FLUENT 的计算

原理， 帮助读者熟悉相关的基础理论与慨章，了解 FLUENT 的基本原理，从而为进一步学

习 FLUENT 的实际操作世置、做值计算运行、结果分析与整理打下基础.

要点

• 计算班体力学理论基础 .
• 计算施体力学基本方程.

• FLUENT 掩体分析基本原理.

1.1 流体力学基本理论

流体是指在任何微小切应力作用下都舍发生连续不断变形的物质， 这种连续革断的变形

韩为班动. 流体与固体的区别在于，当施加一定外力时 ， 团体也要发生变雕，但变形量达到

一定程度时其内部的变形抗力就会阻止固体继续变形 ， 因此，固体能承呈压力、拉力、切

力，不呈现流动性， 而流体不能在最受剪切力的同时，使自己保持静止的状态.



流体力学就是以流体为研究对聋，研究其平衡、运动时宏观物理量〈具高大量流体骨子

统计平均特性〉的变化规律 ， 且流体与固体之间相互作用的力学特点的一门学科. 计算流体

力学则主要利用数值计算方法来完成流体力学的研究任卦， 属于流体力学的分直.在利用计

算流体力学方法进行流体流动的数值仿真之前 ， 应首先了解流体力学相关的基本理论.

1.1.1 研究对象

流体由分于组成，卦于之间有间距、平连续. 由于我们研究的是平衡、运动时流体宏观

物理量的变化规律且流体与团体之间的相互作用力 ， 若通过研究分子运动来研究流体的运动

是极其复杂且无此必要的.

-、流体质点

流体力学研究的对革是流体宏观物理置， 因此研究的最小单元不是分于， 而是具有确定

统ii 平均特性且体积很小的 〈流体微团〉流悻质点. 它具有 "量现小"、 "微观大"的性质.

用一杯水打比方，流体质点的尺寸相对于杯子的特征~度 L 或 D 都小得事，但是相对

于-个分于的长度来讲卫大得多.

二、 连罐介质模型

连续介质模型是将流体舰为没有空隙的由流体质点充满毡'所占据的整个空间的一种连续

严 |介质， 且其所有的物理量郁是空间坐标和时间的连续函数的一种假设模型.

言 E | 把流体看作连续介质的单元体， 则阳宏观流体的各种物理量都是空间坐标和时间的连
被:1 1 续国撇， 这样就可以引用连续函数的解析方法来研究流体平衡和运动状态下有关物理#数之

耀在 |间的数量关革.
分

;| 啤当所研肌程实际尺寸与分子的自由行程为叫相近的山时抗不能应用途鳞介咐

'‘ l 如稀薄气体.
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1.1.2 j荒体的物理性质

流体具有惯性、压缩性、膨胀性、粘性和表面张力特性等物理性质， 其中粘性是其区别

于固体的-个重要的物理性质.

一、 惯性

惯性是物质保持原有运动状态的特性， 即使流体在平交外力作用时， 也具有保持原有运

动状态的属性. 质量是流体惯性大小的量度 ， 质量越大， 惯性越大. 单位体积流体所具有的

质量称为密度，表达式如下:

ρ= lim 旦
AV.....O .6.V 

式中ρ 为流体苗度 (k肘n勺 ， m 为流体质量 (kg ) ， V为流体体积 (m勺.

二、 压缩性

(1 . )) 

流体的压缩性是指温度不变的矗件下 ， 流体体积和曹皮随所受压力的变化而变化的性



质. 可用体伊压缩'"来度量压缩性的大小，即压强增大一个单位值时，流悼体积的相对减小

值，理达式如下

β dV I V 
一一一一 (1 -2 ) 
a伊

式中 p 为体积压缩率 ( Pa-勺 ， p 为所受的外部压强 ( Pa) . 

三、 膨胀性

流体的膨胀性为压强不变时 ， 体积随温度而变化的性质. 与压缩性类似， 用温度变化

l K 时体权的相对变化来农示膨胀性的大.1)' I 表达式如下

dV I V 
α= 一一一 (1 -3 ) 

áT 
式中 ι为体胀系数 ( K 勺 ， T为流体温度 ( K ) .

四 、 粘性

粘性是流体区别于固体的一个重要性质 ， 它是指流体在运动状态下具有抵抗剪切变形的

能力. 体现为流体搅动时， 流体层内部出现内摩擦力 ， 阻碍质点做相对运动. 此内摩擦力卫

称为切应力，其大小可由牛顿内摩擦定律计算得出

du 
， =μ dy (1-4 ) 

式中 z 为切应力 ( Pa ) ， p 为流体动力粘度(Pa-s ) ， di旷dy 为速度梯度 ( 5.1) .

i主撞 z 速度柑度实质J:.Jt i.血体运动时的剪切史形角速度，即就体的切811与剪切变形1制造皮"'-"'.也
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表征流体粘性的物理量称为粘度，分为动力粘度μ 与运动粘度 U 两种，表达式如下:

τ 
μ = 一一一一­

du /吵
(1 -5 ) 

υ= 丘
p 

式中。为运动粘度 (m2/s) .
流体粘性的本质量由流动流体的内聚力和分子动量交换引起的.一般在相同辈件下，液

体的粘度要大于气体粘度，井随着温度和压强的变化而变化. 随着温度的升高，所有液体的

粘度都减小，而气体的粘度增大. 这是由于液体分子问距较小，相互吸引力即内聚力较大，

粘性主要由内聚力造成. 随着温度升高，分于间距增大，内聚力减小， 从而使液体粘度减

小. 气体分子间距大，内提力很小 ， 粘性主要是气体分子动量交换的结果. 温度升高时， 气

体卦于运动加快，卦于的动量变换遮串加剧， 切应力随之增加，从而造成粘度的增加.

(1 -6 ) 

五、 表面张力特性

液体表面由于分子引力〈分于间的内聚力〉不均衡而产生的沿表面作用于任一界线上的

张力，称为表面张力. 如自由表面上， 气体卦于内聚力与液体分于内聚力有显著莹剔，使液
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体卦于有向内部收缩倾向，这 性质称为表面张力特性.

细营插λ液体时 ， 表面张力会使营中的液体自动上升或下降一个高度，这就是由于表面

张力作用而导致的毛细现草.当液体与团体壁面接触时，若固体壁面吸附力大于液体内罪

力 ， ~rJ液体与固体壁面的接融面有扩大的趋势，称为漫润现草〈如水 l ， 反之韩为不浸润现

靠(如水银l.

由于表面张力很小， 一般情况下可以想略军计， 但在液体中模拟气泡运动时衙噩考虑表

面张力的作用.

1.1 .3 流体的分类

根据流体的压缩性、帖性等物理性质可以对流体进行下面 3 种分类.

-、可压缩流体与不可压缩流体

根据流体压缩性的大小 ， 可以将流体分为可压缩流体与不可压缩流体. 曹度随压强变化

较大且不可舰为常数的流体，称为可压缩流体，Jji.立 ， 密度随压强变化很小且可视为常数的

流体， 称为不可压缩流体.

除了水击现靠外般液流运动均可视为不可压缩流体进行分析计算 . 低速气体

( v<5归由〉也可舰为不可压缩流体，这是由于低速气体的压力和温度在整个流动过程中变

化很小， 它的重度和密度变化也很小， 可近似看成常数. 而高速气流则需考虑西应变化的影

响，作为可压缩流体来处理.

二、 理想流体与实际流体

根据是否考虑流体的粘性，把流体分为理想流体与实际流体两类.在理论研究的初期 ，

学者们通常将流伴着作挫有粘性，即理坦l流体来"J虑， 大大简化了问姐. 而我们现在进行流

体运动仿真时通常需要寺虑流体的粘性，即当成实际流体处理 ， 这样的模拟结果更贴近实

际.

三、 牛顿流体与非牛顿流体

根据流体是否满足牛顿内摩擦定律， 可以把流体分为牛顿流体与非牛顿流体.

符合牛顿内摩擦定律 ， 切应力与速度梯度成正比的流体为牛顿流体. 切应力与速度梯度

不符合线性分布， 不满足牛顿内摩擦定律的流体为非牛顿流体，其卫可分为塑性流体、假塑

性流体与膨胀性流体 3 种 ， 如图 1- 1 所示.

塑伎翻‘你, 
0111俭'‘体

牛..‘体

• 膨胀性流体

o 理想流体 tr 
陋 1-1 iI‘变剑"



塑性流体， 如袖糖、稀润滑脂簿， 官们受力后不能立刻变形 ， 必须施加足以破耳其结掏

性的力才能发生剪切变吊，即流动. 因此该类流体存在屈服tlJ应力马，只有克服屈服切应力

后 ， 才能开始流动. 其tlJ应力与速度楝度满足如下关罩.

du 
T = TO 忖丐 ( 1.71 

武巾 '。 为屈服切应力 C Pa ) .

假盟性流体， 如高分子榕液、事L化液等，粘度随遮!l!梯度的增大而减'1、 ， 其切应力与速

度骨，度的关系如下

r = k(艺)" ， n < 1 ( 1.8) 

式中 k 为树皮革致， 取决于流体性质 n 为流变指数， 无因~ .

膨胀性流体，如淀粉糊、石灰班等，其粘度随速度梯度的增大而增大，其切应力与迫皮

梯度的关系如下

h哈" 的 l (J .9) 

1.1 .4作用于流体上的力

无论是平衡还是运动状革的流体都受到各种力的作用. 作用在流体隔离体上的力，技Jt

*现形式可以升为质量力和表面力两种.

-、 质量力

作用在流体每一质点上 ， 且与所作用流体的质盘成正比的力为质量力. 单位质量流体所

量的质量力为单位质量力，它是 个矢嚣， 形式如下=

• 
→ 户γ

f = 二一 =λi+λJ+λk
m 

式中下标 X， Y、 z 表示 x、 y、 z 三个方向 . [为单位质量力(m/s勺.
最常见的质最为有重力和惯性力两种.

( 1) 篮力 .

G=mg ( 1. 1)) 

式中 G 为重力 (N) ， m 为质量 ( kg) . g 为重力加速度 ( m/s勺 . 若 z 轴铅直向上，则单

位质量重力的 3 个分力为þ= /y - 0 , /z - - g . 

(2) 直线惯性力 .

(J .1 0) 

I =-ma ( 1.12 ) 

式中 1 :为直线惯性力 (N) ， a 为且线加速度 ( mls2 ) . 单位质量直线惯性力为 fx- - Qu . 

'
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h'" - 0 9 , f: = - On . 

。)离心惯性力.

R=mω'r (1 - 13) 

式中 R 为离心惯性力 (N ) . ω 为角速度 ( S 勺 . 若3句 x可平面的旋转加速运动， 其 3 个

方向的单位质量离心惯性力为k= ω性. [，~ ω弘 f， ~ O. 

二、 靠西力

作用在流体表面上， 井与受作用流悻表面积成正比的力称为表面力. 表而力可分为垂直

于作用丽的压力和平行于作用面的切力，如回 1-2 所示.

l压力 P.

jF' . "; 
+τ一一切为F.

压力的
.
嘲
叫
F
C
m
z
4灌
体
八
万
衍
且
仿
真

实
用
数
徨

翻，-， 翻‘你徽闭上下寝面所受两种褒画为示鑫困

静止流体只受到压力作用，而单位面积上的压力称为压强， 对流体内部一点而言 ， 压强

大小与方向无关.

理想流体运动时只受到压力作用 ， 而实际运动的流体既受到压力作用 ， 也置到切力作

用.

通过上述分析可知流体受质量力和农丽力两类力的共同作用，在一般运动中，这些力都

有可能存在. 但在一些特例中，可能只存在其中几个. 因此，正确升析作用在流体上的力是

研究流体平衡和运动规律的基础.

1 . 1 . 5 流体流动的描述

流件运动是由无敌质点构成的连续介质的流动，描述流体运动的方法有拉格朗臼法和欧

拉法两种 .

-、 拉格朗日法

拉格朗日法把流体质点作为研究对聋， 着眼于观察质点的流动情况. 通过研究每个质点

的位置、压强、流速碍物理量随时间的变化规律， 综合流场中所有流体质点，得到整个流场

流体的运动规律. 以初始坐标 a、 b、 c 作为标记区别不同质点，且1) r 时刻质点位置坐标可最

示为 :

r = r(a.b.c,t) 

式中 a、 b、 c 为初始时刻质点的坐标. r 为时间 (，).

由此可得流速为·

(1 -14 ) 
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ár ðr怡， b， c， t)
IJ =一=一

dl ðl 

质点加速度为。

_ dü ð' r(a， b， c ， 。
一一回 dl ðl ' 

(1 -1 5) 

(1 -1 6) 

二、 欧拉法

欧拉搓着眼于整个流场中各空间点流动#数随时间的变化， 研究流体压强、流速等物理

量在空间点上的分布规律， 综合流场中的所有点 ， 便可得到整个梳场流动#触的变化规律.

用欧拉法描述的流场内各处流速分布可表示为

ü = ü(x, y , z ,/) 

若用 B 代表其他物理置， 则密度、压强等物理置可表示为

B = B(x, y , z ,/) 

式中 x、 y、 z 为流场中空间点的位置坐标， 称为欧控变数.

将物理量随时间的变化率称为质点随件导数， 其表达式为-

dB(x, y ,z ,t) òB dt , òB dx , òB 吵白 òBdz òB òB òB ι òB 
一一一一一=一，…一­dl òldl ' iJx dl ' òydl òz dl òl 町t ðx . _y 司y , . , òz 

若引入晗曹顿做什算于2

ð ð , ð 
V = g + j--+ k一-

ðx 句y ô险

(1 -1 7) 

( 1-18 ) 

I! 

( 1-20) 

。

-
h

uz

成

+
写

。
一
@
哺

勺
式

ιh

达

B

一
仿
制

uz

敬

=Ah )

4 

V

随

有

f

以

则
户

。

所

( 1-2 t> 

dB ðB __ _， ~ 
-一一 +(ü ， V)B

dl ðl 

由质点随体导数公式可得加速度的表达式为 :

dü ðü 
a =一=一+(ü ' V)ü 

dl ðl 

可见加速度由两项组成 ， 其中吾称为时变加速度 (或当地加速度) ， 即表示梳动过程中

( 1-22) 

(1 -23) 

#配件质点由于速度随时间变化而引起的加速度 (17 .V)Ü 称为迁移加速度(Iæ位变加速度)，
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即表示搅动过程中流体质点由于速度随位置变化而引起的加遮皮.

由于研究流体运动常需要从整个流场角度分析流速、压强分布且变化规律，因此欧拉法

运用E为广泛.

嘲
川r
cm
z
4
流
体
分
街
且
仿
真

实
用
被
撞

1 . 1 . 6 流体流动的分类

根据流体流动过程中物理属性的变化且流体的结构、流态等，可以将流悻流动进行下面

几种分类.

-、 定常流动与非定常流动

按ii\l动要章是否随时间变化可以将流体流动分为定常流动与非定常流动. 定常流动〈卫

称稳定VIi或恒定流〉是指流场中任一空间点上各运动要章均不随时间变化的流动，而非定常

流动 (卫称非稳定流或非恒定流)中至少有一个运动要量要随时间变化. 因此， 可用时变加

速度来判别定常流或非定常流. 若手。，可认为作定常流动:苦苦.，，则为非定常流动 .

二、均匀流与非均匀流

均匀流是指沿流动方向流场中各点的流速(包括大小与方向)均相同的流动，而非均匀

流是指流场中相应点的流速大小和方向只要有一个沿程改变的流动. 因此， 可用迁移加速度

来判别均匀流或非均匀流.若 (ü . V)ü = O ，如等直径直管中的流体流动 ， 可近似为均匀流

动·若(ü . V)ü 雾。，如收缩臂、扩张管、弯管内的流体流动为非均匀流动 ， 如图 1-3 所示.

是二

(., ( b) 

刚川 '曹冕的.，.划勾搅动

《ε》

三、 渐变流与想辈流

非均匀流卫可以分为渐变流与急变流，渐变流是指非均匀流中流动沿程变化缓慢，因加

速度产生的惯性 〈离心)力很小 ， 相时于重力可以扭略不计的流动， 因此渐变流可近似为均

匀流求解问题. 而:，;;变流是指流动沿程急剧改变的非均匀流动 ， 其流线间夹角很大或曲率半

径较小或二者荣而有立，因而惯性力不能担略.

四 、 层流与满流

若流体质点E不捧混，有矗不紊地作萌序的成层流动，这种流动状态称为层流. 丘之，

流体质点相互播混，作无序的随机运动.此时的流动状态称为端流 〈章流) . 对于涮流而

言，其局部速度、压力等物理置在时间和空间中都可能发生不规则的脉动.

假据雷诺数的大小可以判别流体作层流或精流流动.帘诺数的表达式如下.

Re=旦
U 

( 1-24) 
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式中 Re 为雷诺数 • I 为特征-1':度 ( m ) .

对于圆管内流动 ， 特征仕度 l 可取为圆营管径 d. 其临界宙诺数通常为 2创圃，即

R斗<2蛐为层流， 否则为前流.

对于非圆曹流动 ， 特征-1':度 l 取为当量直径白， 临界雷诺数根据实际问题而定，如正方障

和正三角形的临界雷诺数仍可近似取为 2田泪。， 而偏，[..环空缝隙仅为 1 000. 其巾 d"表示如下2

( 1-25 ) dlf = 4二f
z 

式中 A 为过流断面面积 (m勺.X 为湿周 (m ) .

五 、 高旋流与无旋流

流体具有连续变形的性质，因此，除了可表现出刚体质点运动的平移与旋转抖，还可以

表现出变形运动.按照流体辙团运动是否存在旋转，可以将流动分为无旋流动和有旋流动 ，

假据为旋转角速度m是否等于罕.其表达式如下

-ml--
计
算
流
体
力
学
理
论

( 1-26 ) 

k 

。

oz 

l
a

一@

t 

。
一
伽

l
-2 

-s 

u z 

若亘 = 0 ， 则为无旋流动 ， 否则为有旋流动.

大、 内部流动与外部流动

根据流体所在的流动空间区域， 可以将流动分为内部流动和外部流动 ， 如图 1 -4 所示.

内部流动是指在 定结构的限制空间内的流动 ， 如管道和渠道内的流动.外部流动是指流体

从物体外侧绕过的流动，如圆柱绕流等.

u y u x 

(b)汽享外部绩榄(，)侧门内部班动

内外部流功示鑫圄因 ，~

气体动力学基础1.1.7 

流体包括气体， 而气体具有明显的可压缩性， 即在流动过程中其密度是变量， 需要充分

考虑其压缩性对流动的罪响 ， 气体动力学正是以可压缩气体流动规律为研究对靠的. 下面简

单介绍一些重要的气体动力学的基础知识.

9 



• 

热量交换，也没有能量交换 ， 简称无能挺的绝热过程 ， 其去等于常数• k 为

卡门罩数， 对于空气而吉 ， k=1.4 . 

二、 声速与马静鼓

( 1 ) 声班 是细微弱压力扰动波在可压缩介质中的传播速度. 在实际气流中，由

于气体具有可压缩性 ， 某一扰动不能在 鹏间传遍整个流场，而是以被面的

形式适渐向前推进.如阁 1-5 所示， 在等直营的左瑞放一活塞，以速度 ν 向右

轻微推动 d 时刻， 此时活蛊先压缩与活率面直接接触的蹲一层气体， 该层气

体进而压缩邻居，邻层再压缩下一邻层， 从而在直营中一直传播下去， 形成

一道微弱的压缩披.被丽为未扰动和己扰动区域的分界面 ， 称为被盐 ， 被面

向前传播的速度就是声遮.

p+ dp! p 

' c v 

ρ+dρt ρ 

回 ， ., 幢弱压力雄传捕

由于波面左侧气体已被压缩，而右侧气体来瞌压缩 ， 所以被面左右的压强分别为 p+dp

和 p. 苗度分别是 p+dp 和 ρ. 取动坐标罩在披头上， 则右侧气体速度为-<0. 左侧气体擅度为

""" . 建立连续性方程与动量方程=

pA(-c) = (ρ +dp)(v - c)A 0-30. ) 

'1· 
计
算
流
体
力
学
理
论

(p +dp)A - pA = ρqJ-c-(ν -c)] 

考虑微弱扰动的 dμρ<< 1 ，联立上式解得z

0-30 b ) 

在 0 -31) 

因微弱压力扰动波传播过程可视为绝执无摩阻的等熔过程， 所以z

c =JZ=JEF ( 1-32 ) 

式( 1-32 ) 即为气体的声速公式.声速 c 的物理意义为表征气体可压缩的难品程度， 压

缩性越大，声速越小.

洼，障 公式 ， - J耳环对气体、液体均适用 . 对反体 由体"'~l量 K _呻悼，可知 c - .[ii言.

(2) 马鹉数 为某处气流速度 v与该处声速 c 的比值， 记作 Ma. 其表达式如下g

11 



ν 
Ma=- ( 1-33) 

C 

A勿为气体动力学中十分重要的一个无量纲物理害数，可衡盘气体压缩性的大小 ， Ma 

越大，可压缩性Ii响就越大 • Ma> l 的气流为超)U遮气流 • Ma< 1 的气流为低声速气流 ，

Ma= 1 的气流为严遮气流.

三、 滞止#数

将流动的气体等悄地滞止到储气箱内，使其变为静止的气体， 此时相应的运动参数称为

滞止垂数. 滞止垂数用下标 "0" 表示，如 p，、 p， 、 r， .

为分析滞止垂数，珑们就需要创造等精过程井使气流速度降为零.参照毕托管原理，世

置流动方向上的驻点，如图 1-6 所示: 气流到达驻点(滞止点〉时，流速降为军:由于滞止

点前的流动流程技炬，热变换来不及发生，且气体间的摩擦阻力可扭略不计，故可以视为无

摩阻的绝热流动，即等娟流功 .

p
c
m
Z
」
『
班
体
分
伤
及
仿
真

实
用
数
程

" \二±

-'-一·

• 
p ， ρ ，T p , ' ρ 。，

阳 '.6 滑止过-，"，1.

建立该过程的能量方程如下z

kRT v' kρT 
-一一-+-=-一~ ( 1-34 ) 
k-l 2 k- l 
为了求精止温度，我们可将式 ( 1-34 ) 表示为与原温度的比值， 井表示为马赫数的函

数=

T.. • k-l v' . k - l v' . k - l.. , 
4 = l + = l +一一.:.，. = 1 +一-MG
T 2 kRT 2 c' 2 

( 1.35) 

又由等煽过程方程JL = comf 和状态方程p伊 = RT，
ρ 

可得

PO =(生)'
P P 

Po I ToH~l 
1'0 = (0)• 1 
P ' T 

U-36 a) 

U-36 b) 
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Po ， To 土
一 =(士)
P I 

因此， 其他滞止垂数的函数为

PO ' 1 . k - l .1.1"_2 土
1'0 = (1 +一~Ma' )
p 2 

PO ' 1 . k - l 土且= (1 +一~Ma2 )H
p 2 

(1 -36 c ) 

( 1-37 a) 

0-37 b ) 

i k - l 。 i
二Q.= (') 一 = (1 + ~ _ • Ma' ) 
C I L 

= φ巳Ma' )-击= 1.04561 
当 Ma==0.3 时，空气的 ρ 2 密度变化不足 5%. 而时于 20"C的空气

(1 -37 c) 

来说 • Ma = ν /c= ν / 343< 0.3. 即v<103.2m1s. 可见，低速气流的密度变化较小.

常温下空气的运动速度v=û-48m/s 时 ， Ma<O.l 4 . 其密度变化不大于 1%。因此， 当空

气的速度回5伽时s 时， 可视作不可压缩流体.

1 .2计算流体力学基本方程

流体流动要遵循物理守恒定律，这些定律主要包括质量守恒定律、动量守恒定律、能量

守恒定律.如果流动涉及不同组分的混合或相互作用，还要遵守组分守恒定律. 在实际计算

时， 还要考虑不同的流态 ， 如油流要遵守附加的揣流输运方程.

计算流体力学的基本方程是这些守恒定律的描述. 下面详细介绍这些基本守恒定律时应

的控制方程，高关揣流的附加控制方程将在第 4 章中介绍.

1.2.1 流体力学的连续性方程

连续性方程即质量守恒方程， 任何流动问题都必须满足质盘守恒定律. 按照质量守恒定

律，单位时间内流出控制体的流体昂质量之且和应等于同时间间隔控制体内因密度变化而减

少的质量，由此可导出流体流动连续性方程的微分形式如下:

。ρ 画。(阳J . ð(pu, ) . ð(阳~:) f\ 

一------~ ~一- .. ðl ðx ðy ðz 
( 1-38 ) 

式中 ， U" , uy ' Uz 分别为 x、 y、 z 三个方向的速度分量 ( m/s). t 为时间〈时， ρ 为密度

( kg/m勺.

, 
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引入哈雷顿微分算于=

ð "ð . ð 
'í1=; -一 + j ":;;- + k 

ðx 司y ðz 

则式(t .38 ) 可表示为

( 1.39 ) 

为式形程方性

0

2

续

=

式

。

连

、
l

J

形
=

-
u
h
m

、

B
I
EF
Z

扣

L
V
剧

-

m

m

v

响
曲
础

+

-F

i
m
圆

、
伊一为
表

P
F

于

B

-t

或

E

-5

时

( 1-40 ) 

(t -4 1l 

旦旦 +pu， +旦旦旦2+旦旦ι2+旦旦Lo
ðtr ðr rðB a泣

上面给出的是遇用的 般形式的连续性方程· 若对于恒定流，丝 = 0 ， 其形式变为
d t 

(t-42 ) 

旦PUJ +旦旦，) +旦旦斗 =0
ðx 句I ðz 

若为不可压缩流动.p 为常数，则有

00 00 , 00 
一-- ;r + __ Y + .:..::.:.!.. = 0 
ðx 司y ðz 

其柱坐标罩形式为

U. 00. 00. 00. 
-ι+-" +-'二+--' = u 
r ðr rao ðz 

(t-43 ) 

(t-44 ) 

(t-45 ) 

1 .2.2流体力学的动量方程

动量方程的本质是满足牛顿第二定律.该宣撑可描述为=对于一给定的流体徽元，其动

量对时间的变化率等于外界作用在该微元体上的各种力立和. 伍据这一定律 ， 可导出 X， Y 

和 z 三个方向的动量方程如下.

旦旦. ) +V"(PU.~)=-?> +生旦+生旦+生旦+ρ儿 (1-46 a ) 
飞 } ðx ðx 司y ê泣



ð( pu. 1 _ I 司、。叨 ðL ðL ðr 
」-iL+V lmwu i =-4+一旦+一旦+一旦+pj，

ðl 飞 '1 0- ax 司y ðz , -, 

ð(pu,) . ~ ( _. ~\ ðp. ðr~ . ðr" . ðr. 
二二L三.L+\7， ( pu， u ) 二一+一~+一一+一旦+ρ'1:

ðl 飞 I ðz ax 司y ðz 

式中 ， p 为流体微元体上的压强 ( Pa ) ， t~... 马、 'u 等是因分于粘性作用而产生的作用

• 在微元体表面上的粘性应力 宵的分量 ( Pa l ， j;、 J;、 j; 为 3 个方向的单位质量力(m!s勺，若
质量力只量重力 ， 且 z轴垂直向上， 则j;~j;~ O ， j; ~-g. 

有广义内摩擦定律〈本构方程) ，

(1-46 bl 

(1-46 c) 

…­
~V= 2υμ 亏苦?+ λ川\7 .u 

~V俨=斗2υμ号+川

~V= 2υμ专+λ川v叫二

(00. 00_ ì 
T = τ=ul-'ι+-ιI 

q .P ~ t 司y iJx) 

r ð!ι 00. ì 
T = τ = ul-'+-' 1 

u u '\ðz iJx) 

(00. 00. ì 
， -=τ = μ1 --' +-' 1 
庐 q '\ðz 0-) 

( 1-47 a ) 

(1-47 b) 

(1 -47 cl 

(1-47 d ) 

(J-47 e) 

(1-47 f) 

式中， μ 为动力粘度 ( Pa.s) ， À 为第二粘度 (Pa"s) I 通常取为 213 . ~IJ式(1 -46 l 化

为.

呼斗ι+闯叫\7(归阳风川， ü)=二

i刷}丁2:l+\7'(町)十(顺风)+气

呼ιv(mzA)=-2叫gradu，)吨 .

(1-48 a ) 

(1 .48 b) 

( 1-48c ) 

式中 ， S，町、 SIlY ~ Soø 为广且源项， SIlr=Ph+S~. SII}':pJ;.+岛 I SIJJfl'""PÞ+Sz . 其中品、 S，.. Sz 

为

-m
l
·-
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斗(合)4々)+;(μ昔比(川) (J-49 时

斗(今)4(专)+;(命)+;(，lv~) (J -49 b) 

sa=;(合)4(合)4(μ刮过(，lv~) (J -49 c ) 

对于粘性为常数的不可压缩流体$，、 Sy' Sz 通常取为 o.

动量方程在实际应用中有许多表达形式，其中比较常见的有如下几种.

( 1 ) 可压缩粘性流体的动量方程.

ρ生=ρ1.+鱼+立{+缸半+鱼+也)]}dt ' "0 ðx ðxlÎ ðx 3\ðx 0' ê泣

+;[μ(专+号)]+;[μ(去+去)]
< I-SOa)

敏程实用 P EZ • R 生=附鱼斗[2~ -作+鱼+~ )]} d 司Y 0' 1' 1 0' 3\ðx 0' ê泣

+;[μ(苦+去)]叫作+到]
(J .50 b) 

生听鱼斗[2坠~(也+~+~ )]} dl ' '' Z é泣 ðz l' l ê泣 31 ðx 司y ê险

+;[μ(苦合)]+;H号+到]
< 1-50 c) 

(2) 常粘性流体的动量方程.

p2 =pJ-graφ+fsm巾 +μ'v'豆 ‘ (J -5 1) 

(3) 常密度粘性流体的动量守恒方程.

du y r (J -52 ) ρ一 = pJ -gradp +μIV~ U 
dt 
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(4) 无粘性流体的动量守恒方程.

ρ二 = pJ-gra咱p
d 

(5) 静力学方程.

ρJ=gr缸斗。

(J -53 ) 

(J -54) 

1 .2 _3 流体力学的能量方程

能量守恒定律是包含有热交换的流动系统必须满足的基本定律，其本质是热力学第一定

律. 依据能量守恒定律， 微元体中能量的增加率等于进入嗷元体的净热流通量加上质量力与

表面力对微元体所做的功，可得其表达式为 2

2于Lv{~(川)J=V[k'ffV叩，jJj+<ff ~)]吨 ( 1-5日
E=h 旦+E:

式中 ， E 为流体微团的且能 O!kg) ， 包含内能、动舵和势能主和， ρ 2 , h 为

鸟= J C，川T
始 O!kg) , hJ 为组分 J 的始 O!kg)，定义为 '. 其中 T，..r298.15K; k~ff为有效热

传导系数 (W/(m'K)) ， k'ff =如鸟 ， k， 为涮流热传导系数，根据所用的柑流模型来确定斗为

组分J 的扩散通量 S，为包括了化学反应热且其他用户定义的体积热源项.

芷章爪管能量方程是流动 传热问题的基本方程，但对于不可压缩流动，是拿然交接很 J.可以忽略时1 可

不考怠能量方程.

1.2 .4 流体力学基本方程的初始及边界条件

初始条件和边界条件是控制方程有确定解的前提，控制方程与相应的初始矗件和边界矗

件构成对一个物理过程完整的数字描述. 现有的 CFD 软件都提供了现成的各种类型的边界

是件，这里筒单介绍一下有关的初始条件和边界条件.

-、初始提件

初始条件是所研究对靠在过程开始时刻各个求解变量的空间分布情况，顾名思义，就是

计算初始时刻给定的声数. 如 t == '0时各变量的函数分布为。

U",== u", (x,y.z.t(l) = uxO (x‘,y.z) 

Uy= uy (x，yι.z.tl)) = U，.州.(x‘，y.z

u屿. = uz(x，y，z，时 = u:o (xJ!,z) 

p = p(x,y,z,/o} =户。 (x，y.z)

(1 -56 a) 

(J -56 b ) 

Cl .56 c) 

(J -56 d) 
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ρ = p(x，yι'0) = po(x,y,z) ( 1-56 e) 

T= T(x,y,z.lo) = To(x,y,z) 0-56 f) 
对于非定常问题，必须给定初始盎件，而对于定常问题，不需要初始盎件.

二、边界晕件

边界条件是在求解区域的地界上所求解的变量或其导数随地点和时间的变化规律. 对于

任何问题， 都必须给定边界条件. 例如 ， 流体限于固体壁面包裹的空间内流动，不能有穿过

固壁的速度分量 在自由液面上，大气压强认为是常数 在流体与外界无热恃导的边界上，

流体与边界之间无温差等.

通常流体边界可升为流固交界面和流流〈液液、液气〉交接面.

(1 )流固交界面边界条件.

流体在管内流动时的管壁，飞机、船舶在空气且水中运动时的气固或液固交界丽，河水

在岸边且向床的液固交界面部属于流固交界面.

对于粘性流体，流体将粘附于固体表面，满足无滑移边界条件，即，

叫F= vls ( 1-57 ) 

式中，叫F是流体速度 (m!s ) . 叫s是固体壁面相应点的速度 (mfs )0 

对于理想流体，流体可沿界面滑移，即有速度的切向分量，但不能脱离异面，即.

v..I,.. = v..ls (1 -58 ) 

式中， v..l，..为流体的法向速度分量 ( m!，剖 ， v..ls 为固体壁面相应点的法向速度分量 (m!s) .

(2) 液液交界面边界条件.

密度不同的两种液体的交界面，如油水，属于液液交界面. 对于此类分界面两侧的液体

应满足

T1 = T2 

0 -59 a) 

( 1-59b) 

( 1-59 c) 

Vl = ν2 

的去1， = μ， :1, ( 1-59 d ) 

(1-5ge) 

(3) 液气交界面边界条件.

;水与大气的接触面，自由液面即是液气交界面. 自由液面的运动学条件为 z

ðF -
一一+u.VF=O
ðl 

式中. F代表自由液面上的所有物理变量.

当不考虑表面张力时 ， 自由液面压强应满足z

( 1-60) 

p =pa 

式中 • Po 为大气压强， 一个标准大气压为 10 1 .325kPa .

( 1-6)) 
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1.3 FLUENT 原理

计算流体力学数学模型是一系列的偏微分方程组， 要得到解析解相当困难，目前均采用

量值方法得到满足实际需要的近似解. 其基本思路是对流体区域进行离散化，通过一定的原

则建立离散区域节点上的代数万程，求解代数万程以获得所求解变量的近似解 . 现有计算流

体力学求解计算中用得段辜的数值方法有 有限差分法、有限元法和有限悼积法 ， FLUENT 

所景闸的是有限体权法，其对流场运代求解的方法主要有 SIMPLE 算法、 SIMPLEC 算法和

PISO 算法等. 下面针对 FLUENT 所果用的数值计算方法进行逐-介绍 • 
• 

1 .3 . 1 有限体积法

有限悻帜法 〈简称 FVM ) ， 卫称有限容积法，最近年来盎展非常迅速的一种离散化方

法，其特点是计算效率高. 目前在 CFD 领域得到了广泛的应用，大事数商用 CFD 软件都采

用了这种方法， 如 FLUENT、 STAR.CD、 CFX 等.

有限体积法将所计算的区域划分成一系列控制体积 ， 每个控制体积都有-个节点作代

囊， 通过将使制万程对控制体权作积分来导出离散方程. 在积分的过程中 ， 需要对控制体积

界面上的被求函数本身 〈对流通量〉且其一阶导数〈扩散通量)的构成做出假定，这就形成

了不同的格式. 由于扩散项事是采用相当于二阶精度的线性插值，因而格式的区别主要体现

在刑流项上.

用有限体权法导出的离散方程可以保证具有守恒特性， 而且离散方程草数的物理意义明

确，是目前流动与传热问题的数值计算中应用最广泛的 种方法.

1 . 3 .2 流体区域离散

在对特定问题进行数值计算前，首先要将计算区域离散化，即对空间上连续的计算区域

进行划分，把其划分为事个于区域， 井确定每个区域的节点 ， 从而生成阿格. 然后，将控制

方程在同格上离 l血，即将偏微分格式的控制方程转化为各个节点上的代数万程组.

-、 计算区域的离做

有限体积法的区域离散实质上是把计算的区域划分为许多个互不重叠的于区域， 井确定

每个于区域的节点位置且该节点所代表的控制体积.

区域离散后的几何要置主要有 4 种z

• 节点( node)，需要卓解的未知物理量的几何位置，

• 控制体积( control volume)，应用控制方程或守恒定律的最小几何单位，
• 界面( face )，在节点相应控制体扭曲史界面，

• 网格钱( 8rid line )，连接相邻两节点而形成的幽盟章.

在离散的过程中 ， 将一个控制体积上的物理量定义井存储在节点上.一维与二维问题的

高限体权法计算同格如回 1.7 所示， 图中括出了节点、控制悻积、界面与同格线.
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(b 】 二锥问题的有限体积法计算附棉

因 )-7 有限你以培计算同恪

计算区域离散的网格高两类 结构化同格和非结构化网格 ， 结构化网格的节点排列有

序，即当给出了-个节点编号后，立即可以得出其相邻节点的编号 ， 所有内部节点周罔的网

格数目相同 非结构化网格的内部节点以一种不规则的方式布置在流场中 ， 各节点周罔的网

格数目不尽相同 ， 其网格生成直杂， 但却有极大的适应性.共于结构化网格与非结构化网格

的详细介绍见第 3 章.

二、 控制]方程的离做

• 控制方程的通用形式为

旦旦ø) + d(叫卢，ø) ~ d叫rgradø)+S (I -62 ) 
ðt 

式中， ;为广义变量 ， 可以为速度、温度或陆度等一些待束的物理量 r 为相应于，的

广义扩散系数 s为广义源项.

一蛙抱在对班一扩散问题的离散方在为

ap仇 = aw仇 +aE化 +b (1 -63) 

其中
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(pu) 
Q..'" I~"， A.，.+ 一-::-'-'- .4，.

(叫，
(pu) 

E. =7二.!..，- A '"一....!.!...A(ðx). --. 2 

a EJH+工L4 Sp AYzvaJ巴LA -l2LAw-sp Av , (ðx). --. . (ðx). 

b '" Sc .ð.V 

式中， A 为控制体职界面的面权 åV是控制体积的体积.

. 蛙晴在对革 扩散问题的离散方在为:

a,Ø, '"' 0，.[/，仇 +( 1 - f);:]叫[J，化 +(1- f);:]仇

十苦-(1 - f)[ D.斗]- (1 -牛引+(1-川
其中 z

Q, =0: + I (oe +0...)+ f(ι -几) - JS,åV 

a__ ::::: D___ +车
• 2 

Q _ = D.-主• , 2 

• åV 
a二 =p /'J 

• 二盘'睡在时施 扩散问题的高散方程为

o pøp = 0 ... 仇 +a，仇 +aN化 +asØs +h

其中

。， =0: +oc +Q... +as +o/'i +(F.-凡)+(F. ι ) - S，åV

a..= D..+ m阻 (0，几)

气 = D， +m缸 (0， ι)

气 =D， +m阻(0，1';)

句 = DJm皿 (0， -ι)

。 . åV
a卢 = P~ !lJ 

b = Sc !J. V +0; +ø; 

(1-64) 

(I-6S ) 

( 1-67 ) 

(1 -68 ) 

• 三雄"睡在对施 扩散问题的计算E峰在 XOy 和 xoz 平面上挂Ii如固 1 -8 所

示 ， 其离散方在为

a，饨= 0...; .. +of:佐 +aN化+吨ø， +冉冉 +aBØB+b ( 1-69 ) 



其中

。， = a; +aE+aJas+aN+(ι - 凡)+(凡 F，)+(F， 凡 ) - S，âV

a." =， D，，， +max(O， 几)

α.= D.+max(O，-F，) 

a， = D.+m皿 (O，F，)

气 = D~+m副(0，凡)

Qr= Dr+ m皿 (O， F，)

0 8 = DB +max(O,- F8 ) 

" " ð. V 
a』 =ρPE

b = Scð.V +a! +ø: 

( 1-70 ) 
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因 '~8 三锥问腿的有限体狈法计算网格

三、常用的离做格式

使用有限体积法建立离散方程时，重要的一步是将控制体积界面上的物理盘及其导数通

过节点，物理盘插值求出 . 引λ插值方式的目的是为了建立离散方程，不同的插值方式对应于
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• 

不同的高散结果，因此，插值方式常称为离散格式. 有限体积法常用的离散格式有 中心盖

骨格式、 一阶迎风格式、混合格式、指数格式、乘方格式、 二阶迎风格式、 QUICK格式.

各种离散格式对一维、稳态、无源项的对流扩散问题离散可得·

a，仇 =awø.. +aEØE 

而高阶问题可得=

(1 -7 1) 

a，叽 = a"，仇 +a_ø_+ aE先 +a"世曰 (1 -72) 

式中 ， a，取值取决于问题的阶数，对于一阶问题 . op = a...+ O,!+ (F.- F...). 对于二阶问

题 I Qp"" a...+ QE+ a.....+ QEE + (F.- F .. ). 其中 a.、 a..、町、 a"取决于所使用的离散格式，

如表 1-1 所示• 

褒1- 1 不同离做格式下来Ø: Q"" a，.，.、.，、 .u的计算公式

黯触格式 嚣颤..' .... 赢幢 IJI;_ IJU 

中心'应分幡式 afDJfi 
2 

a =DJfi ! -~. 2 

一阶"'风幡式 。.. : D..+max(O，几) Q, = D. + max(O,-F,) 

混合格式 川剧[几 (ι斗).01 a, = max[ -F,,( o. -%-).0] 
• 

衔1Ii幡式
几 exp(几 /0.) a~= F. 0 " :: c- exp( F. I D. )- 1 exp(几 1 0.)- 1

'障方幡式
Q.. :s D.. max [矶(l-O'iP，Il' ] Qt: = D. max [叶。'i乓Il']

+max(凡，0] +ffiw< [- F" OJ 

3 _ 3 ,. , _ 
Q,. = D", +2"aF.. +"2a F. a. =D，一(l -a) F， -~(I-α)凡2 ' ,. 2 

二阶迎风'各式

a z--aFW 
- 2 

1 
am = E(1 - a)Ft 

6 
。. = 0ι胃 +-BaMWF山~ +ga..F, 

3 _ 6 
aE=De --8αeF'--8 (1maJF; 

QUICK 格式
3 、 1 

+E(1 -ι)凡 -~(I-a. )凡
8 

。"才aλ ri(MJR 

对于任何一种离散格式，用户郁希望其既具再稳定性，卫具有校高的精度，同时卫能适

应于不同的流动形式， 但是实际上这种理想的离散格式是不存在的.下面时离散格式进行粗

略的对比，方便用户实际计算时选用，如表 1-2 所示.

• 
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褒 ， -， 常见'‘徽铺式的笆'量对比

离触格式 得
-

盔'
-

定

-
2

a

-
三

nu
-
pa 

位

-
也

定

守
幢

幢.
件

雀
'

精度温室量'"童

中心缝分恼式 在不发生'医萄的，数施阳内，可以旅得极准确的创报

凰然可以获得.，观上可岱雯的解， 但当 P.'院校大"， I贸扩'院组严重.
为暴兔此阀'题。'"霄"翩蕾计算同格

当 P.~ 2 时，性"与巾。"分幡式相同当 P，> 2 剧性..与阶迎风
格式栩阙

主要i4用于元"颂的财源扩徽陶11. 对有非"'.段..项的场合 当 P. '除
骏商时有领大诲'自

与指数格式相同

精度缺-"迎风格式高，但仍有'自扩散问题

可以磁少"..霞说犁 MIl锁商应用领广泛. 但主要闸于六面修强

四'"'"网幡

佳能与 QU1CK 怖式创间， 只是不存在稳定性~lIJ

-阶边风格王军 ..对.. 定

混合格式 '也刑拖延

俯徽棉式 翻~，晴稳定

癫刀'鲁式

二阶边风格式

.. 对a定

绝对梅定

QUICK 格式 每件@应 p. S 813

改造的 QUICK 格式 锦州确定
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1 ， 3 ， 3 流场迭代求解方法

流场计算的基本过程是在空间上用有限体积法或其他类似方法将计算区域离散成许多小

的体积单元， 在每个体积单元上对离敞后的控制方程组进行求解. 上面已经I.I!立了与控制方

程栩应的离散方程 ， 即代数方程组. 但是 ， 除了如已知遮IJt场求温度场这类简单的问题之

外，所生成的离散方程不能直接用来束解，还必须肘离散方程进行某种调整， 井且对各未知

量〈压力、速度、 温度等〉 的求解顺序且方式进行特殊处理. 流场数倪材算是针对常规解法

存在的主要问题进行改普而形成的-罩列方法集，其本质是对离散后的控制方程进行草解，

可分为分离式解法和辅音式解法两大类 ， 如图 1-9 所示.

「涡 ，，-，缸嗣数
「非展始变靠拢 4
l 、嗣量--i鹰Il法

分离"法1
r压力修正法

‘巅'自变量法 才，原压力泊松方E

、人为压缩法
流楠f<饱解法

r 所有变量会场联立求解

唰台解法 4 部分变量全场联立求解

I 局部地区所有".金Ió联主求'再

阔卜' 施桶f<值计算方法的分!Il

分离式解法不直撞解联立方程组， 而是顺序地、逐个地求解各变量代数方程组.

依据是否直接求解原始变量， 分离式解法可分为非阪始变量法和原始变量法.

涡置一速度法和涡量 流画敏法是两种典型的非原始变量法. 涡量-速度法不直接求解

流场的原始变量 p. 而是束解旋度e和速度 U. 嗣量 流函数法平直接求解原始变量 u 和

p. 而是求解旋度e和流函数 ~.
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常用的原始变量法有压力悻正法、解压力泊松方程法和人为压缩法.解压力泊松万理法

需要采用对方程取散度等方法将动量方程转变为泊松方程， 然后求解泊船方程.人为压缩法

主要是受可压气体可以通过联立束"速度分量和密度的方法来求解的启发，引λ人为压缩性

和人为状态万程，以此对不可压缩流体的连续性方程施加干扰.目前工程上使用最广泛的模

场计算方法是压力佳正法.其实质是法代法. 压力修正法有很多实现方式，其中 ， 压力嘱告

方程组的半隐式方法 (SIMPLE 算法)应用最为广泛，也是各商用 CFD 软件曹遍采用的方

法.

辅音式解法则同时求解离散化的控制方程组， 联立求解各变量.偶合式解法可以分为所

有变噩噩场联立求解(隐式解法L 部分变量整场联立草解〈显隐式解法〉、在用郁地区〈如

个单元上)对所有变盟联立革解(显式解法).且体而吉，辆吉式解法计算效率1匠、内存
消挺大.

下面详细介绍几种数值计算常用的流场送代求解方法.

-、 SIMPLE 算法

SIMPLE 算法基于交钳间格，所谓交错同格是指将速度分量和!压力在不同的网格罩统上

离散，如压力、温度和密度等在正常的网格节点上存储和计算 ， 而将速度的分量分别在铺位

后的网格上存储和计算，铺位后罔格的中心位于原控制体积的界面上.二维流动计算的交铺

同格如图 1- 1 0 所示， 有 3 毫不同的间格系统. 时于三维问题，则有 4 套网格系统，在此不

再详述.

N 

• 
- E 

n 

E 

s 

《川主鲤制.... ( b ) 11. 徨制体职 ( e) "，但刷体.，

阁 1-10 二维温动计算的交输网幡

SIMPLE 算法由 Patankar 与 Spalding 于 1 972 年提出，是一种主要用于求解不可压缩流

场的数也方法〈也可用于瑞解可压流动).它的核心是采用"猜测一悻正"的过程，在交错

罔格的基础上来计算压力场，从而达到求解动量方程的目的. 其基本思路可描述如下:对于

给定的压力场(它可以是假定的值，或是上一次运代计算所得到的结占世)，求解离散Jf>式的

动量方程，得出速度场，因'J.J压力场是假定的或不精确的，由此得到的速度场一般不满足连

续性方程，因此，必须时给定的压力场加以告iE，修正的原则是:与修正后的压力场相应的

速度场能满足这一遮代层次上的连续性方程. 据此原则，我们把由动量方程的离散吊式所规

定的压力与速度的关罩代人连续方程的离散格式， 从而得到压力悻正方程，由压力佳正万程

得出压力修正值.接着，根据悻正后的压力场，求得新的速度场 然后撞查速度场是否收

敛:若不收敛，用佳正后的压力值作给定的压力场，开始下一层次的计算.如此反宜， 直到
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获得收敛的解.

在上述束解过程中 ， 如何藐得压力悻正值(即如何构造压力佳正万程) ， 以且如何根据

压力悻正值确定 "正确" 的速度〈即如何构造速度悻E方程)，是 SlMPLE 算法的两个关键

问题.

( 1 ) 速度悻正方程.

针对直角坐标革下的二维层流稳态问题进行介绍 ， 设有初始的猜测压力场 p\ ~IJ动量

方程的离散方程可借助该压力场得以求解 ， 从而求出相应的速度分量 U. 和 uy· .

动量方程的离散万程为 2

Q/.J" Id,J = L a，础U，.". +(PI-I,.J - PJ ,.J ).4;,J +鸟J (\ -73 时

鸟儿I，) = L,Q..bUYM + (PI,J-t- PI ,J }A1,j +bl,j ( 1 ~73 的

式中 ， A 为控制体积的鼻而面积，对于二维问题，即为曲或句 b 为动量万程的源

项.

将狮测压力场代人得

O/,JU' XI.J = 1:o,."u'.... +(P'J-I.J - p'1.J )A;,.I +鸟.J ( 1-74 a ) 

鸟儿I，} = :LQ,eu'yoob +(//.J-1 - P'I,J )A1.J + bJ,j ( 1-74 b ) 

定义.正的压力值p 为正确压力场p 与猜测的压力场p.之差， 有z

有"' u x u 值正悻度速

P

且

+
定

p 
=
样

n
y
习
叼

(\-75) 

-U_ = u +u 
" -- .r: 

( 1-76 . ) 

u.. = u__ + u y -- )1 (\-76 b ) 

将正确的压力场 p 代人动量离散方程，得到正确的速度场. 将式 (\ -73) 减去式 ( 1-

7时 ， 井假定源项 b 不变 ， 有:

OI.J (uJ</.J - U'''I.I ) = LOItb (uw-u卢)+ [(hv - P" -'J ) - (p" , - p'" , )],4", 

o,.A U' , .) - u'yfJ = LQ,. (u川 -u'，.. )+[(p，川 p山)-(p" ， - P" J )]A" I 

引λ压力悻正值和速度悻正值. ~IJ式 (\ -77 ) 化为

a/.Ju~，J = I， a""u皿 + (P~- I ，.J - p~，.J )心

a， 州，1 = ~>.础u')'fIb +(P~ ，.J - I - p~.J ) 

(\-77.) 

(\ -77 b ) 

(\-78.) 

( 1-78 b) 

由上式， 可以通过压力悻正值敢出速度修正值. 式中表明，任一点上速度的佳正值由两



部分组成， 一部分是与该速度在同一方向上的相邻两节点问压力悻正矗立茬L 这是t:
佳正值的直接动力，另一部分是由邻点速度的悻正值所引起的，这卫百U榄树回鹰在丹柳f
正值对所讨论位置上速度改进的间接黠响.

为简化武门-78) 的求解过程，可引入如下近似处理， 即略去方程响市艇攫修革值糟
的 La..，，'... 和 1>....，.. .该近似是 SI岛{PLE 算法的重要特征，于是有z

U~I.J = dl.J (P~-l，J - P~ ，J ) <I . 79 a) 

U~.J = d /.} (P~.J-l - P~.J ) (I -79b) 

其中-

~ A," 
叫J - 一

叫J

( 1-80a) 

dω=宇
"' .1 

( 1-80b) 

UyI.} =与川d{ ，j (P~，J-l - p~ .J ) 

( 1-81 a) 

( 1-82a) 

(1 -82 b ) 

将式。-79) 所示的速度悻正值代人式( 1-76)，有:

Ux{,J = Uxi./ +d;,J (P川的，)

对于 U;<;+I ，) 和 u川川'存在类似的表达式为 z

U..;+I.J = U"j+l卢d川 J(p~.J - P~+I.J )

U川]= u川仆d， μ1 (p~.J - P~ ，J+I ) 
其中:

J A,.I.J 
U i • 1.J "'-一­

叫."

(1 . 83 a) 

d" , "生ι/.;.1 
- I.j.l 

( 1-83 b ) 

式( 1-81)和式 ( 1-82) 表明，如果已知压力佳正值，便可时猜测的速度场作出相应的

速度佳正，从而得到正确的速度场.
。)压力悻正方程.

在速度修正方程的推导中，只考虑了动量方程，其实，如前所述，速度场还受到连续性

方程的约束.这里针对二维稳态问题进行分析，其连续性方程为

式形散离下如足满程方性续连积体企
巾控量标

心
的

L

示

阳
@
所

a-

H 

+

' 
川
于
帕

(1 -84 ) 
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[(时Lé -(PU.A)，J+[(四PAL-1 (时)，.J =0 ( 1-85) 

J+1 

标量锺制体狈} +I 

J 

J 

J-1 

1-1 f 1 1+1 1+1 

。

) ] ) 
刀
ω
』

J

、
叶
冉

冉
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F

沪

剧
院
恬
+

岛

鲁

b

(
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J 
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J
叫
矶

酣
吨
川

嗨
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凡

的

J

U

EL[ -u

J 

t
J

』
川

,,, 自

I

ρ

船

J
H
L
r

帽
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)

刊
有

n
u

川

则

'

N

n
n

u
U
H
n
凹
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L
z
e
咆

-
υ

因

1

J

P

(
冉

­

r
t
"

'

t
飞

"
F

ZJFF 

似
叫
川

值

υ
·

州

度
·
」

h
L

速
占

川

的
代
码

确

A

川

正

U川
二
月

辑
w
f
u
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( 1-86 ) 

该式可简记为=

a/,JPt,J = QI+I,J PJ+I,J + a/_1 ，J PI_υ +a'.J刊Pt ，J+l +a1 ,J_IPJ,J_1 +b"J 

其中:

a川 =(ρd4)，川J

ad u= (pdAL J 

a山 = (pdA)",., 
Q' ,J-l =(pdA)I., 

() -87 ) 

() -88 ) 

OJ ,J = 01+1 ,J +01-1.1 +o/，Jφ1+ 01，)_1 

b; .J = (阳;A) 'é- (阳I~ 'A) i+I .J+(PU)" A) I.} - (阳JA丸。l

式( 1-87 ) 为连续性方程的离散方程，也是压力佳正值的离散方程. 方程中的源项是由

于不正确的速度场所导致的"连续性"丰平衡量. 通过求解式( 1-871.可得到空间所有位

置的压力悻正值.

式( 1-88 ) 中的密度是标量控制体积界面上的密度值，需要通过插值得到. 无论采用何

种插值方法，对于主界面所属的两个控制体积， 必须采用同样的密度值.

为了求解式 ()-871.还必须对压力修正值的边界条件进行说明 . 由于压力修正方程是

动量方程和连续性方程的派生物，不是基本方程，故其边界条件也与动量方程的边界矗件有

关. 在一般的流场计算中，动量方程的边界条件有两类z 一种是已知边界上的压力;另一种
是己知精边界法向的速度分量. 若为第一种边界， 知边界压力 p 可以令fzF，则压力佳

正值 p应为军 若为第二种边界，如边界上的法向速度，在网格世计时令控制体积的界面与

边界一致， 这样，控制体积界面上的速度就为已知矗件了 .

。) SIMPLE 算法的计算 ， 如图 1 - 1 2 所示.



开始

'夏~-个温度分布， 用于计算笛次选代时的动量禽触方f'iN'的票数和僧'民项

-.飞 鸟…<... . 马.，

11\1-个愿为桶，即'食定压力销涮值 p

P 

闹翻'当菌遗'"蝠剥压力场，计算动'‘

离融方ti'l'的泵'院和僧'世项

a、 b

w. . ， 求'再动量高傲方祖

-. .、-，'

「
仁
们
俨

吗~ II'，U. LQ..u 皿 +(p'叫 p" .J ) A.... 吨J

Q/JIl 川J. LQ......... +(p.山 P υ )AJJ +b，.I

$.2，恨'回速度，求"压力修正方'望

" '.J P' .J • ølo'.J p/ ， 'J φ Q'.IJP;. ，J -+ QIJ" P;.J" + Q' .J" P' .J-I + b;J 

令 p..p. 11....... 
，，" 鸟，._ ，. 0

P 

lÞa) , .正压力与速度

Pu .. P' .J + P' .J 

""" - ..~... +ιvω P;J ) 
" " J . ...../ +d'.J (p;J-I - P;.J ) 

p、-. ‘'r ,. " 

$a 4，求.. 所有其他的离散化'自握方刷

。'J.J'I.J • (1，.，.1"叫 .u.

否

1111- 12 SIMPLE 算楼温程圈
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二、 SIMPLEC 算法

SIMPLEC 是英芷 SIMPLE consisent 的缩写，章为协调一致的 SIMPLE 算法. 它是

SIMPLE 的改造算法之一， 由 Van Doonnal 和Raithby 提出 .

在 SIMPLE 算法中 ， 为求解的方便，略去了速度佳正万程中的 I:Q...:"项，从而把速度的

佳正完全归结于压差项的直接作用. 这 作法虽然井不~响收敛解的值，但加置了悻正值 p

的负担，使得整个速度场运代收敛速度降低. 实际上， 当我们在略去I:"'...:" 时 ， 犯了一个

"不协调一致"的错误. 为了能略去。剧呻而同时卫能使方程基本协调，试在 U.J 方程

<t -78 ) 的等号两端同时减去 I>.....~.... .有 z

(a,.., - ~;a...) u~ ，J = ~>...( u卢 - U;，J )+(P~-I .J - p~，J )~.J ( 1-89 ) 

可以预期，叫，v与其邻点的佳正值 U.，. 具有相同的数量级，因而略去LQ.. (.... - .;.. )所产生

的~响远比在方程<t-78) 中不计 LQ..II:'" 所产生的lIi响要小得多 . 于是有2

u~i.J = d,.J (p;-1.J - P;,J) <t -90) 

其中 g

J A" J 
叫..，= 飞"

…" "'1.1 ~"'M 

同理，有e

u山 = dl./ (P;.J-I - P; ,J ) 

<t -9 1l 

<t -92) 

4月式公篝
IT 

R咱
岛

丛
γ
"
咱

A
-

-

剧

一
冉
正

--
悻

中

J

出

其
矿

叫
得

( 1-93) 

UxJ,.J = Uxl ,J " +dj,J (p;-I.J - P; ,J ) <t -94. ) 

UyI,J = Uμ川dJ./ (P;';-I - P;,J) <t -94 b ) 

式 ( 1-94 ) 与式 <t -8 1l 形式上-致， 但军数 d 的计算公式不一样.这里需要用式<t -

91l和式<t-93 )计算.

这就是 SIMPLEC 算法， 它与 SIMPLE 算法的计算步骤相同，只是速度悻正方程中的系

数项 d 的计算公式有所I8: JlIJ .

由于 SIMPLEC 算法没有忽略L""':"项，所以得到的压力悻正值 p一般比校告适. 因

此， 可不对p进行欠松弛处理. SIMPLEC 算法的流程图如图 1-口 所示.



IHit-个..J!纱布 m予计算首次选代时的动量离散方包中的票'由1<"指敛囔

", ", "，.… 《马马.】

镶边←个压力编."偷定压力摘翻值i

• P 

报..当筒遮J!蝠"压力编计算耐量禽

方疆中的系'段"稽'配项

a、 b

/tI. .， 求解动.离散方程

翩川、 ~. 

Di ,lI/ ' .,1 ., L D..."'_ +(P' ,-,,1 - p'， ，1 )ι吨J

D,,J" ' ,,,J" L " ... u',... +(p山 号 p" ，I )A，川b"
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Q，~P;~ .. D,.uP;.U +Qt-UP;-U +Qt，l.，P，~.， +Q，~_，P;~... +b;~ 

侈.3， .ìE压力与迫J!

Plj = PIJ + PIJ 

"",," ....，1 φι(凯......- p;.J )

""，J- "，..，J '叫Ap;.J'" - 凯~ )
d，~ ， dJ，J 与 SIMPLE有区别

.. p" . p. ","-",> 
""". ",. ,.. ,. " 

p , "" ",., ,. . 

/tI. 4，求解所有其他的商徽化'自运方程

D,,I; ,,1 .. Q"，，1伤 ".，1 +D,....,I;;-I.,I +钊.，1.，;;.，1.， +Q/~-，;;.，I-， 叶u

否

回1-13 SIMPU元，事推翻lðlOl
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三、 PISO 算法

P1S0 算法是 Pressure lmplicit 明白 Splitting of Operators 的缩写 ， 意为压力的隐式算于分

割算法， 于 1986 年由 lssa 提出， 起初是针时非稳态可压流动的无选代计算所建立的 种压

力速度计算程序， 后来在稳态问题的士在代计算中也较广泛地使用了该算法.

SIMPLE 算法和 SlMPLEC 算法是两步算法，即一步预测和一步修正，而 PISO 算法增

加了一个悻正步，在完成了第 步悻正后寻求第二次改进值， 目的是使它们更好地同时满足

动量方程和连续性方程. 由于 P1S0 算法使用了预测一修正 再佳正 3 个步骤，从而加快了

单个迭代步的收敛速度，其 3 个步骤介绍如下.

(1) 预测步.

利用猜测的压力场p\ 求解动量离散方程， 得到速度分量 u， •、 u，飞

(2) 第一悻正步.

引λ对 SIMPLE 算法的第一个修正步， 给出一个速度场 ( u".. ， uy.. ) ， 使其满足连续

性方程. 此处的悻正公式与 SIMPLE 算法中的式 0.79 ) 完全一致，但考虑到 PISO 算法还

有第二个佳正步，因此使用不同的记法

p = p + p 0 .95 a) 

.. . 
Ux = U" + uJt 

0.95 b) 

.. . 
U" = uy +uy ( 1-95 c) 

这组公式用于定义悻正后的速度 u;·和 u;.

uL =umJ+dtJ(pj lJ-p;J) ( 1-96a) 

u;J= u民川 dt ，j (P~，J- I - P~ .J ) 0.96 b ) 

将式 0.96) 代λ连续性方程( 1.8日， 产生与式( 1.87 ) 具有相同罩数与源项的压力修

正方程. 求解该方程，产生第一个压力修正值 p . 一旦压力修正值己知，可通过万程 o

96 ) 获得速度分量 u"..和 uy··.

。)第二悻正步.

为强化 SIMPLE 算法的计算. P1S0 算法要进行第二步佳正. ux--和 Uy ••的动量离散方
程是g

ahJUL=ZaJL+(p:;J -p:;)4J 吨 J ( 1-97 a) 

a叫:J = ZhuL+(p:;4 p:;)AIYbI J 0.97 b ) 

再次求解动量方程，得出两次悻正的速度场=



auuJI;= Za"已 + (p;二 - p;:') A,,.I +b,.) (\ .98 a ) 

冉 ju;;=Za地U二 +(p二 - p;7 )A，川hl.J (J .98 b) 

遣. 修￡步中的求和项是用速度分量 U~..和 11， " 来计算的 • 

• 

将式(J .98 ) 减去式( 1.97 ) ， 得 z

L， Q.. (U':- uλ ) 
，J = udJ +一一τ一一一+d，，J (P;.I.J - P;.J ) 

"," 
( 1-99a) 

La.. (心 -u;" )
J生2号千二丘i叫 j (P;,J- I - P;,J ) (\ .99 b ) 

其中 2

p = p +p 

将 (\.99 ) 式代λ连续性方程 (\ .85 ) . 得到二次压力佳正方程z

a，JP，J= aMJPMJ +ar1JP， teJ+ aMJ;J州 +Qt.J-IP;.J- i + b;.J 

其中

Ol+l ,J = (ρdA)川，J

a'.',1 = (pdAL 
QI.J+l = (ρdA)川

Q/,J-I = (州)' ，J
I.J = QJ付.J +QI-1,J +0，.1州 + Q' .J- I

ι扣叫=(宁) ，"二La.. 叫(u心L 弘ω价)卜-仔) .. 川I+ I .JL
+( 子钊)，ι (队u〈心仇;;L;Lb - G b ) - (子) ',i .,La... (u;:" - u;") 

*解万程 (J.101 ) ， 就可以得到二次压力佳E值 p ， 从而得到二次修正的压力场z

( 卜100 )

(J .101l 

( 1. 102) 

……. p = p + p = p +p+p ( 1.103) 

最后，求解万程。.99 ) ， 得到二次幢正的速度场.

在麟;t;问题的非选代计算中 ， 压力场 p...与速度场〈uz--- ， uy---〉被认为是准确的. 时

于稳杏流动的法代计算 ， PISO 算法的实施过程如阁 1-14 所示.
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步. ‘ 求'帽二次压力修正方位

。IJP，.J 鑫 Q"'JP， .，-， + 鸟 ，-，p，-，-， φ句.J，' Pu.' + Q,.J-'P'.J" +同J

步.5 ， ..正压力与速度

… . p = p +p+p 

11, 0 - 1/" 1/> _ ", . ι-HF出机哨> 1
令 p'''p . 11,' - .., . 

1/" 11如 p， ", . 

〈 叫: AF轧d" ， (，;~~_ p;~ )

p…、 11， " .、 .. ,... 

令 1/. ... ..屿， -，…·悔， p…'p

步...求解所有其他的离散化输运方程

何.J;;.J '" (J， . l，.J矶 υ + 11' ，.....惋.'J + Q' .I> oÎlJ" + QJ.J. '; '.J " + 鸟J

否
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PISO 算法要两次求解压力悻正方程. 因此，它需要额外的存储空间来计算二次压力悻

正方程中的源项. 尽管该方法涉且校辜的计算，但对比发现，它的计算速度很快，且体效率

比较高 . FLUENT 的用户手册推荐，时于酣事问题 . PISO 算法有明显的优势.而时于跑事

问题，可能造 SIMPLE 或 SIMPLEC 算法更告适.

SlMPLE 算法是 SIMPLE 罩列算法的基础. 目前在各种 CFD 软件中均提供了这种算

法. SlMPLE 的各种改造算法主要是提高了计算的收敛性，从而缩短计算时间.

在 SIMPLE 算法中，压力悻正值p能够很好地满足速度悻正的要求，但对压力佳正不是

很理想. SlMPLEC 和 PISO 算法草体上计算量要高出 SIMPLE 算法 3例也左右，收敛速度校

‘ SIMPLE 算法快 300.!e--5肝L 但对于不同类型的问题而言，每种算法有各自的优势. 一般而

言，动量方程与标量方程如躲不是偶合在一起的 ， 用 PISO 算法能够较好地收敛， 且体现出

较高的计算效率. 而在动量方程与标量方程捐告非常密切时 . SIMPLEC 挥捷的效果可能更

好些.

1 .4本章小结

本章主要讲述了计算流体力学的基本理论、基本方程且 FLUENT 软件所涉且到的数值

计算方法，包括区域的离傲、法代求解方法等. 通过本章基本理论知识的讲述，帮助读者了

解计算流体力学的求解思路，掌握 CFD 计算方法且 FLUENT 原理，为后接 FLUENT fl<1使

用打下基础.

! /t 
'y""幸

> 在你的粘性是E刷子固体的主要性质之一.

> 计算流体力学的连续性方在.动量方程和能量方租是最主要的基本万

租-
> FLUENT 基于有限体租法，埠场迭代卓解的方法主要有 SIMPLE 耳法、

SIMPLEC 算法和 PISO 耳法等.
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第 2

流体流动分析概述

任何流体运动都必须遵循质量守恒定律、动量守恒定律和能量守恒定律. 这些基本定律

可用数学方程组来描述，如欧拉方程、 N-S 方程等. 建立这些描述流体流动方程的方法为理

论分析方法， 它是最早的流体流动分析法. 然而 ， 此万法往往要束时计算时靠进行抽血租简

化，才能得出理论解 ， 所以时于直杂流动问题很难得到精确解: 借助物理模型进行流体流动

相关物理#数的实验盘测是后来发展而成的实验研究方法， 然而， 此方法卫过分依赖于实验

耳镜，且常受到模型尺寸和入到因嚣的lI'响，得出的结果与实际存在一定的差距 采用撒值

计算方法. 通过计算机求解控制流体流动的数学万程， 进而研究流体的运动规律，这就是近

年来发展如火如荼的计算流体动力学方法.

本章主要介绍流悻流动卦析的发展，涉且 CFD 的概盒、 CFD 软件且流动分析的应用领

域，重点介绍 CFD 软件中运用且为广泛的 FLUENT 软件. 通过 FLUENT 软件的功能、运

行方法、用户界面且一个简单实例的演示，帮助读者在了解第 1 章的计算流体动力学基本理

论的基础之上，掌握 FLUENT 软件的基本操作，井学合分析简单流体流动问题.

• CFD 的概企且相关应用杜

件.

• 施动分析的应用嚼蜡.
• FL山NT 杜仲版本且运行方
浩.

本章案例

二撞三通管内班体的班动分析.

• FLUENT 与其他壮件的最据史
换.

• FLUENT 的用户界面及其操作.
• FLUENT 入门操作实例.

, -.-...--.--------- --------- --..--. -r …_.".--.-." 牛牛牛 - - • _ . •• .… …… 、. . __._ _ ..._-_..... . ._ -_...... .
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2 .1 流动分析的发展

早期对流体流动现且(lJ分析主要依靠理论分析研究，但由于万程未知数的个数，曹大于方

程数，需要对计算对且进行抽血和简化.l&使理论分析发展缓慢 随后 ， 人们转向于重验研

究， 然而诸事流动问题相当直杂， 涉及的扑在耳境因素颇多，且所建立的模型往往涉且到变

态比尺， 故实验结果存在较大的误差 随着计算机技束的高速发展，人们开始利用计算机进

行直杂搅动问题的解挥，且在水利、航运、海洋、食品、环境、流体机械且相关流体工程领

域己有成功应用. 这种利用计算机技术进行流动问题敬值草解的方法就是计算流体动力学方

‘ 法， 现已有相关剖算流体动力学商业软件问世， 过去只能揣在验手段得到的某些结果，现在
已完全可以借助数值模拟来准确夜取.

2.1.1 CFD 的提出

计算流体动力学 (Computational Fluid Oynamics. 简称 CFD ) 是述立在经典流体动力学

与数值计算方法基础之上的一门新型独立学科， 其基本定且是通过计算机进行数也时算和阻

惶显示， 分析包括流体流动和1热传导等相关物理现聋的系统. 它嫌有理论性和实践性的双重

特占 . ll!立了许多理陆和方法， 为现代科学中件事宜杂流动与传热问题提供了有效的计算技

术.

CFD 方法与传统的理论卦析方法、实验量测方法组成了研究流体流动问题的完整体

系. 理论分析方法的优点在于所得结果具有曾植性， 各种黠响因章清晰可见， 是指导实验研

究和验证新的数值计算方法的理论基础， 但是，它往往要求对计算对革进行抽草草"简化， 才

能得出理论解. 对于非线性情况， 只有少数流动才能给出解析解. 实验测量方法是理论分析

和数值万法的基础. 1t重要性不可低估，然而，实验往往受到模型尺寸、流场扰功、人为因

章和测量精度的限制 ， 且还捕投入相对校辜的经费、人力和物力 . CFD 万法很好地克服了

理论分析与实验研究的弱点，在计算机上实现一个特定的计算 ， 且可以形草地再现流动情

景.

利用 CFD 进行流动1同li-it热现盘分析的基本思想是用一系列有限个离散点上的变量值的

集含章代瞥空间域上连续的物理量的场，如速度场和1压力场:然后 ， 按照一定的方式ll!立这

些商做点上变盘之间关系的代撒方程组，通过求解代数万程组藐得楠变量的近似值. 官;可以

看作是在流动基本方程控制下对流动的数值模拟. 通过这种数值模拟，我们可以得到椒mz

杂问题的流场内各个位置上的基本物理量的分布 ， 以且这些物理:!!:随时间的变化情况， 确定

被涡分布特性、 空化特性且脱流区等. 还可据此;\'/:出相关的其他物理置， 如旋转式流体机械

的转短、才〈力损失和效率帘. 此夕←， 它与 CAD 联合，还可以进行结帕优化世计等.

CFD 具有适应性强、 应用面广的优点. 由于流体问题的控制方报一般是非线性的 ， 自

变量多，计算域的几何形状和1边界条件直杂，很难求得解析解 ， 只有用 CFD 方法才有可能

求得满足工程需要的数值解. 另外. CFD 方法不受物理模型和实验模型的限制， 有钱有

时，有校辜的旦活性， 能给出详细和完整的数值计算结果， 很容品模拟特殊尺寸、商温、有

毒、品燃等真实条件和实验中只能接近而无法达到的理想条件. 然而. CFD 也存在一定的

局限， 其数值解法是-种离散近似计算方法， 依赖于物理上合理、数学上适用，适合于在计
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算机上进行计算的离散的有限数学模型 ， 且战终结果不能提供任何形式的解析表达式，只是

有限数量离散点上的数值解， 井有一定的计算误差.此外 . CFD 软件的应用很大程度上依

赖于经验和技巧.

CFO 方法依赖于系统的流体动力学知识和较深入的数理基础，虽然商用 CFD 软件减轻

了用户在这方面的压力，但是学习和草握 CFD 还不是一件容易的事， 需要读者在熟悉 CFO

基本理论的基础之上掌握相关软件的模拟功能，在不断的练习和实战中且结经验和技巧.

2.1.2 CFD 软件简介

CF口的应用与计算机技术的发展密切相关. CFD 软件应早于 20 世纪 70 年代诞生于美

国，但近十年才真正得到较广泛的应用.

为了完成 CFO 计算，早期需要用户自己编写计算程序，但由于 CFO 的E杂性及剖算机

软硬件的事样性，使得用户各自的应用程序往往缺王通用性，而 CFD 本身卫有其鲜明的系

统性与规律性， 因此，比较适合于被制成通用的商用软件.

自 1 981 年以章，出现了如 PHOENICS ， CFX 、 STAR-CD、 FIDAP、 FLUENT 等多个商

用 CFO 软件，且随着计算机技术的进一步快速盎展， 这些商用软件在工程领域正发挥着越

来越大的作用.

• PHQENICS 世界上第一个投敢市场的 CFD 商用软件，可H算是 CFO 商用软

件的鼻祖. 这一软件中所乖用的一些基本算浩，如 SIMPLE 方浩、现合格式

等，正是囱谊软件创始人 0.8. Spalding 及其合作者 S 以 Pa田水ar 等所提出
的 1 对 H后开皮的商用牲件有较大的影响 . 近年章. PHüENICS 软件在功盹

上与方娃方面做了较大的改进，包括纳入拼片式%网格及细密网掉嵌入技术，
同位网格且非结构化网格技术，在瑞班模型方面开发了通用的军方程、低

Reynolds k - e模型、 RNG k- E模型等. 应用这一软件可计算大量的实际工

作问题，包括城市市最预测‘叶轮中的就动、营造班动等 .

• CFX: ~主杜件果用有限容和浩‘拼片式快结构化网络，在非正主曲钱坐标(适

体坐标)Ji<上进行离散，变量的布置呆用同位网格方式 . 对流项的离世格式包

括一阶迎风、混合格式、 QU1CK、 CQND1F 、 MUSC1 且高阶理风格式. 压力

与速度的桐合共革乖用 SIMPLE Ji<刑算法 (SIMPLEC ).代盘方程草解的方法
中包括强选代 代世%重同路、 1CCG 、 STQNE 强盹方法及块盹式( B1M ). 

软件可计算不可压缩且可压缩流动.桐告传热 多相班、化学反应"气体燃烧

等问题.

• STAR-CD 软件名称是英语 Simulation of Turbulent Flow in Arbitrary Region 的

描写，连宇样后的 CO 是开皮商 Computational Dynamics Ltd 的简草草.这是基

于有阻W-tJ:茸的一个通用软件. 在同格生成方面.JIl用非结构化同棒，单元的

串串可且有六面体.四面体、三角形截面的幢柱体、金字塔形的锥体且六种形

柱的其他它盖面体.应用这一耻件可时计算艳在与非瞌牵施动.牛顿施体及非
牛锢掩体的施动、多孔介质中的植动、亚音速且超音速施动， 并且这一软件在

汽车工业中的应用十分广泛.
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• 

• FIDAP 这是英语 Fluid Dynamics Analysis Package 的描写，于 1983 年由英国

Fluid Dynamics Intemational Inc 推出，是世界上第一个使用有阻元培 ( FEM )

的 CFD 软件. 可以接量如 I-DEAS 、 PÄπAN. ANSYS 和 ICEMCFD 等著名

生且网榕的教件所产生的网掉. 1;主软件可J;(计算可压缩且不可压缩埠.层班与

精捷、单相与两相施.牛顿班体且非牛顿班体的施动问题.

FLUENT 这一软件囱英国 FLUENT Inc 于 1983 年推出，是盘 PHOEN1CS 软

件之后的第二个投放市捕的基于有限在租洼的软件. 它包告有结构化且非结构

化网格两个版本 在结构化罔掉版本中有适体坐标的前处理软件，同时也可U

纳入 I -DEAS. PATRAN. ANSYS 和 1CEM-CFD 等著名生成网格的杜件所产

生的网格. 速度与压力桐合最用同位网格上的 SIMPLEC 算洼. 对革项量分格

式纳入了一阶迎风、中心量分且 QUlCK 等格式 杜仲佳计算可压缩且不可压

缩施动.告有植于的草草‘燃烧过程 多组分介盾的化学且应过程等问;I!.

所有的商用 CFD 软件均包括 3 个基本环节，分别为前处理、草解和后处理， 与之对应

的程序模快常简称前处理器、求解器、后处理器.

(1) 1市处理辑用于完成mf处理工作.前处理环节是向 CFD 软件输λ所求问题的相

关数据 ， 该过程一般是借助于求解器相对应的对话框等图形界面来完成的.

用户需要定义所求问题的儿何计算区域， 井将计算区域如l卦成$个互不重量

的于区域， 形成由单元组成的间格 然后，时所要研究的物理和化学现革进

行抽且 ， 选择相应的控制方程.最后，定义流体的物性#数和初边界矗件.

目前， 商用 CFD 软件数值计算时， 超过 50%的时间花在几何区域的定义剌计

算网路的生成上，我们可以使用 CFD 软件自身的前处理器来生成几何模型 ，

也可以借助其他商用 CFD 或 CAD/CAE 软件提供的几何模型.

连慧『在前处理阶段生成计算网格时，关键是要把握好计算精度与计算成本之间的平衡.

(2) 求解器的核心是数值束解Jr.法 . 常用的数值求解万蛊包指有限量分、有限

元、谱方法和高限体积法等. 总体而言， 这些方法的求解过程大致相间 ， 都

是首先借助简单函数来近似恃求醉的流萌变置 ， 然后将近似关革代入连续型

的控制方程中 ， 形成离散万程钮 ， 最后求解代数万程组. 各种数值求解方案

的主要区别在于流动变量植近似的方式且相应的离散化过程.

(3) 后处理器帮助用户对流体计算结果进行观察和1分析 ， 包括计算区域的几何模

型且同格显示、速度矢置四、各物理量的等值线图/舌阁、 XY 散点图、植于轨

迹阁等. 借助后处理功能，还可以动事模拟流动效果，直观地了解 CFD 0'1计

算结果.

2 . 1 . 3 流动分析的应用领域

随着 CFD 的不断监展， 所有涉且流体流动、热交换、分子输运等现草的问题，儿乎都

可以通过计算流体力学的方法进行分析和楼拟. CFD 平仅作为一个研究工具，而且还作为

世计工具在水利工程、土木工程、石油工程、天然气工程、环境工程、食品工程、海洋结构
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工程、工业园制造等领域芷挥作用. 典型的应用场合且相关的工程问题包括

• 水轮机、风机和章等班体机械内部的班体班动，

· 石油 天然气的地下事进开乖且储运，

• 飞机和航天飞机等飞行器的设计，

• 汽车撞蝇外形坤性能的 ti响 ，
• 棋水草及河口潮施计算，
• 施体机械的结构设计与位化，

• 风靠荷对大替 高层建筑物艳定性且结构性盹的 ti响 ，
• 温室且室内的空气施动且耳境分析，

• 电于元器件的冷却;
• 换热器性能分析且换热器片形扰的选取，

• 坷班中肯染铀的扩散，
汽车尾气对街道环境的污挠，

• 食品中细菌的运晤.
对这些问题的处理， 过去主要借助于基本的理论分析和1大量的物理模型实验，而现在大

多采用 CFD 的方式加以分析和解决. CFD 技术现已发展到完全可以分析三维粘性揣流血榄

涡运动等复杂问题的程度.

CFD 的束解过程包括了建立控制方程、确定边界条件与初始条件、划分计算同冉、建

立离散方程、离散初始矗件和边界矗件、给定求解控制#数、求解离散方程、判断解的收敛

性、显示和输出计算结果等步现. 为丁便于用户将主要的精力集中在基本的物理原理上， 目

前已经有很多优秀的 CFD 商用软件投λ使用.

2.2 FLUENT 软件简介
FLUENT 是目前处于世界领先地位的商业 CFD 软件包之一，在流悻建棋中被广泛来

用，最初由 FLUENT Inc 于 1983 年开始发行. 丑剧年 2 月 ANSYS lnc 收购 FLUENT Jnc 后

成为全球最大的 CAE 软件公司 .

FLUENT 是一个用于模拟和分析复杂儿何区域内的流体流动与传热现聋的专用软件，

它提供了只活的同格特性， 可以支持多种罔格. 用户可以自由选择使用非结构化或者结构化

网棉来划分复杂的集合区域，如钊对二维问题支持三角形同格或四边形网格 针对三锥问题

支持四面体、六面体、梭锥、模形、$面体同格:同时也直持泊青同格. 用户也可以利用

FLUENT提供的同格自适应特性在求解过程中根据所获得的计算结果来优化同格.

FLUENT 以用户界面友好而著称，所以对初学者来说非常容品上手. FLUENT 的软件

世计基于 CFD 软件群的思想， 从用户需求角度出发，针对各种复杂流动的物理现聋，采用

不同的离散格式和数值方法 ， 在特定领域内使计算速度、稳定性和精度等方面达到最佳组

合 ， 从而商效地解决各个领域的直杂流动计算问题.

FLUENT 的基本程序结构如图 2- 1 所示， 一般包括以下几个部分.
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FLUENT .f'Hf结构网

FLUENT，进行模拟计算的卓解嚣，

prePDF，用于模拟 PDF 燃烧过程，

GAMBIT，建立几何模型及网格生血，

Tgrid，用于从现有的边界网棉生成体网棒，

• Fi l ters ， 转换其他程序生成的网棒，用于 FLUENT 的计算.

可以接口的程序包括 ANSYS ， I-DEAS 、 NASTRAN、 PATRAN 等.

回，.，

• 
• 
• 
• 

-m2·· 

FLUENT 软件功能2.2.1 

FLUENT 的功能与特点介绍如下.

完全非结构化网格 . FLUENT 软件采用基于完全非结构化网格的有限体积

法， 而且具有基于网将节点和l网格单元的梯度算法， 网格类型较多 ， 如图 2-2

所示.

( 1) 

口
…叩

二罐阙倏g

r , , , , 

k呻k企~

六面体

阁2-2 FLUENT 的同幡形状

Trian&l~ 
三角形

三维网将l

prum OCW吨，
三破怯..幌形

P')'I'WIIid 
m搜艘

T ..... 叠~
四面体

(2) 定常J非定常流动模拟. 可以模拟定常与非直常流动，且新增快速非定常模拟

功能.

先进的动/变形罔格技?在 . 主要解决边界运动问题，用户只需指定初始同格和

41 
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运动壁面的边界提件 ， 余下的网格变化完全由解算器自动生成. 网格变形方

式有 3 种 : 弹簧压缩武、动态铺层式且局部网格重划式 ， 其局部网将重划式

是 FLUENT 所独有的 ， 且用途广泛， 可用于非结构罔格、变形较大问题以且

物体运动规律事先不知道而完全由流动所产生的力所决定的问题 . FLUENT 

解算器包括 NEKTON、 FlDAP ， POLYFLOW、 I CEPAK 且 MIXSIM .

(4) 11'网格支持功能 . FLUENT 具有强大的网格支持功能， 支持界面不连续的网

格、混合网格、动/变形罔格以及滑移网格等.需要强调的是， FLUENT 还拥

有多种基于解的阿格自适应、动$自适应技术以且动网格与网格动态自适应

相结合的技术.

(5) 多种数值算法. FLUENT 采用有限体积法，提供T非辆古隐式算法、捐告显

示算法、辑合隐式算法 3 种数值算法， 是目前商用软件中量多的.

(6) 丰富先进的物理模型.

· 用户利用 FLUENT 可以精确地模拟无枯班、层捷、瑞班 . 瑞施模型包括

Spalart-AlImaras 模型、 k - cu 模型坦、 k -E模型坦 雷诺应力模型、大揭模

拟模型以且最新的分离涡模拙模型且 V2F 模型菁 . 另外，用户还可~根据菁

要自己定制卓埠'"瑞施模型. 有关瑞施模型的详细介绍见第 4 章.

• FL山NT提住了牛顿施件非牛顿革体的I!值计算模型.

• 告有强制/自然/理合对班的古书传导，固体J施体的热情导‘辐射等模型.
• 包告了多种化学反应且耀最模型，可 l且完成化学组分的混合/反应计算.

· 包告自囱表面雄模型、欧拉多相撞模型、混合$相撞模型 颗粒相模型，空武

两相班模型及理革汽模型等 .

• 可以模拟培化/瞌固，嚣itl冷摄相变模型 .
• 提供了非均质串连性、惯性阻抗、固体热情导，$孔介质模型.

· 告有风扇 散热器、以棉史换器为对血的集中#盘棋型.

• 基于精细渣场衅算的预测施体噪声的声学模型.
• 告有磁掩体模块，可用于模拟电磁场和导电施体之俐的相互作用问题.

• 舍有连辑纤维幌址，可用于模拟纤维和气体埠动之间的动量 . 质量~2I.热史换
问题.

(7) 其他独有的特点.

• 可以方便设置惯性或非惯性坐标革 童歌基准坐标单、滑移网格~2I.动静翼相

直作用模型化后的撞撞界面.

• 内部集咸丰富的物性#世世据库，告有大量的材料可候选用，此外，用户还可

时方便地自定义材料.

• 具有高挂率的井行计算功能，提供多种自动/手动分E算法，内置 MPI 并行机

制可大幅提高并行撞事.

• 拥有友好的用户界面，并提供了二在开皮接口 (UDF ), 

· 告有后处理和世据输出功能，可对计算结果进行处理，生且可视化的围!I>且相

应的幽虽报最等.



2.2.2 UNIX 版本运行方法

在 UNJx l\统下，可在命令行启动 FLUENT 的适当版本， 如 FLUENT 2d 为三维单精度

版本. FLUENT 2dd 为二维双精度版本，其余的 3d 、 3dd 对应了三维单精度和三维双精度版

本.
也可以在 FLUENT 控制台窗口的 "Version> " 提示符后输入挝、 2dd、 3d 或 3dd 启动相

应的版本. 还可以在图吊用户界面中执行'" File " → " Run" 命令 ， 从而选择合适的版本。

2.2.3 Windows 版本运行方法

FLUENT 最初只主持 UNJX 操作系统，面向高端用户 . 随着 Windows 系统的普及，

FLUENT 也开始支持 Windows 系统， 但是其前处理软件 GAMBJT 仍然需要在 UNIX 类型的
操作系统下才能正常运行，所以要在 Windows 系统下运行 FLUENT 必须圭援 个模拟

UNJX 环境的软件一一Exceed o

按照 Exceed→GAMBJT→FLUENT 的安装顺序置装完之后，就可以在 Windows 窗口中

运行 FLUENT 丁，其运行方法有 3 种.

( 1 ) 直接利用桌面快捷方式，双击 FLUENT 6.3 .26 快捷图标，在弹出的 FLUENT

Version 时话框中选择需要用到的二维/三维单精度/双精度解算体，单击 R_ I 
按钮， 即启功了 FLUENT，如图 2-3 所示.

回回-

E EF 
1"一-

• 
nUlnt 
6. 3. 26 

Wo'c 阳市币-'lOB ::J 

巳E 二主」
因2-3 FLUENT 的直很启动图示

(2) 单击开始菜单中的"运行飞在命令提示符中输入 "FLUENT"，按!Enter I键 ，
弹出 FLUENT Version 对话框，其余同上.

(3) 单击开始菜单中的所有程序，选择.. FLUENT Inc Products n - .. FLUENT 

6.3.26" • "FLUENT 6.3 .26"，即弹出 fLUENT Version 对话框，其余同上.

2.2.4并行计算运行方法

FLUENT 支持井行计算，能够方便地对井行配置进行检查和悔改. 在 FLUENT 井行计

算中， 需要将网格和数据分割成多个更小的于部分，然后将每个于网格分配给对应的一个计

算进程，每个计算进程分别再为一个计算节点. 每个计算进程求解一个特定的于部分， 井在

相互之间的接口处进行信息交换. 于同格个数可以是计算节点的整数倍，比如将 1 个罔格分

割成 8 个子同格，可运行在 1 、 2 、 4 ， 8 个计算节点上进行计算.
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并行计算运行íiír需要进行网络通信配置，然后才能启动井行讨算环境. 在 Windows 系

统中，单击"开始"按钮， 在"运行"对话框中输入 " FLUENT 2d-ro.3.26-a飞剧动

FLUENT 井行计算，如l阁 2-4 所示.

| 副i r?'rx' 

白 如坐在摆出带h叫. t 11 iIJltCJ.ß 

打开也):-匾'回-噩噩噩 、，

1 '"己c::::!!巳匮"" .. 1
丽24

阁2.' 启动 'lUENT 并行计算

2.2.5 FLUENT 的文件类型

FLUENT 的输入、输出主件类型较多，其中输入文件包括 Grid 、 Case、 Data 、 Profile 、

Scheme 且 Jouma l ， 输出的文件有 Case ‘ Data、 Profile. Jouma] 及 Transcript . FLUENT 还

可以保存对话框的布同且阁形窗口的硬拷贝 ， 使用各种可舰化且后处理工具可以输出数据.

FLUENT 中的主要主件类型如表 2- 1 所示.
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表'-1

文件在路

。而 〈例幡立停》

eu. ( 鑫侧文件》

"'" ( 罐罐文件》

柿l)filc (泊界俏凰文件〉

Jω~J(日志文件》

Transcript ( 酬本文件》

11.侃。，， (便悄贝文件》

Export (.出文件， 1 

Sc:hemc (源文件》

InlC1'JXl 1仙~ (斜l镰叉'非》

FlueDl ( 配置文件》

CJdayolll ( 界画布局文，非》

FLUENT 中的主要文件类型

后..
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用户州克

用户"元:

取自爬子输出格式

取决于.Il\格式

m 

111户指定

。院刨

cxlayout 

玄'牛肉'

包含所有节点的坐标及节点闸的..攘俯息.-t'舍"界条件、'‘础.""

衷..."
也保同梅、lIJ界象侨、求解"世班吻"险.锥….. '"户界面刷回
到医碎囔flCJftiA
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细注lIJ界区披上的模动..件，以A刷地界的运动..，晨，非

记绿用户.入泣的各种.."

U己绿金郁输入.&. tllf:J.Q. 

将图形'窗口中的内容硬"贝·山沟 T1Ff . Pl口刷1 BMP t5格式的图形
文件

将敛'自输出到 AVS. DataExplom 、 Ens i仙\ ， FAST‘ FIELDVIEW、 I
DEAS , NASTRAN, PATRAN'& T，町阳等第三Ji CA凶CAE 歇件

定刷 FLUENT 的界面撞'两 FLUENT 的运行

不嗣同幡求解时的'专镰文件 FL四'"允许用户用两种阙ttim脏袋..网
间题中间通过 lnlapol.ti侧 文件交钱'血.. 

包含 "阮~通宵写成的司'句!附于 FLUENT越行蛇.".徨制­
FLUENT 启动时，要导，然惊文件.将找刽笆 ..，.它

N:7f.当前对面明."图形窗口的布局
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FLUENT 的操作界面2.3 

FLUENT 的操作鼻而有两种:圆形界面 (GUJ)和文本界面<TUJ)，控制包括菜单、

按钮的图形界面和些端{/in程序.

图形用户界面2.3.1 

FLUENT fl<J圈吊用户界面由菜单、对话框且图形窗口组成 ， 如回 2-5 所示. 刚启动

FLUENT 时只显示控制台窗口 ， 即阁 2-5 所示最底层的窗口 . 当用户从此窗口盎出某些与同

格或阁惶有关的命令时， FLUENT 就会打开新的窗口 ， 如图 2-5 左下10所示的回血窗口 . 此

外，许多命令在执行过程中郁金弹出而敏或对话框， 如国 2-5
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FLUENT 的图形用户界面

FLUENT 的菜单程如国 2-6 所示，是技运行的步骤顺序有层次地以菜单的方式组织在一

起的_ m户既可以从控制台窗口顶端的菜单栏中选择所需的命令 ， 也可以从窗口中的命令行

输入信息. 菜单中提供了控制台中的大部分命令，菜单的使用方法很简单， 执行 〈 鼠标左键

单击〉菜单中的某个命令即可弹出相应的肘话框. 如图 2-7 所示，执行 Define 菜单中的

Operaling Conditions 命令 ， 将弹出 Operating Conditìons (操作环境〉对话框.
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FLUENT 的对话框可以简单地分为两种 ， 一种用于完成筒单的输入/输出任务 ， 如警

告、错误和询问，如图 2-8 所示. 这种对话框是临时窗口，出现时要对其进行响应. 如信息

提示植告诉我们需要知道的信息，单击一旦」按钮关闭:卫如警告对话框用于警告某些潜在

问题，井询问是否继续当前的操作.
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FLUENT 的另-种对话植用于处理复杂的输入任舟 ， 使用这种对话框更惶是填充-个

衰格.这种时话框都是独一无二的，而且使用各种类型的输入控制组成表格. 在对话框的控

制下输入数据后， 需要应用所改变的世置，或者取消所改变的世置.

应用所改变的设置之后立刻关闭对话框，这种时话框有两个战钮。单击-丘且董钮应用

世置井关闭对话框:单击二M~I 按钮关闭对话框而且不做任何改变， 如图 2-9 所示.

应用所改变的设置之后仍然不关闭对话框，这时可以做更辜的设置.后处理和J 自适应网

格中经常舍出现这样的对话框， 如阁 2- 10 所示. 且E旦除钮表示应用设置不关闭对话框，这
一按钮经常也有其他的名称，比如后处理过程中该按钮的名字是 Display . 自适应网格中这

个按钮名字是 Adapt. 旦旦二按钮玻示关闭对话框 • • 
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对话框中的 "剖， 除钮用于显示如何使用肘话框的信息. 对话框中的各种类型输入控制

如衰 2-2 所示.
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圆形显示窗口如困 2-11 所示， 可以通过显示选项对话框〈见困 2-1 2) 来控制圆形显示

的属性，也可以打开另一个显示窗口. 鼠标掠键对话但可以用于设定鼠标在阁形显示田口单

击时所执行的操作. 当为图形显示处理数据时要取消显示操作可以按国巳键， 已经开始
画阁的话就无法取消操作了 .
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回2-12 阁'"显示窗口 回归3 显示这项对;0躯

2.3.2 文本用户界面

FLUENT 控制台窗口是一文本界面 ， 用户可借助此拌面输入各种命令、数据和表达

式. FLUENT 也利用这个窗口显示倍4且，从而达到用户与 FLUENT 交互的目的. 简要诅明

的菇，文本界面使用了一种叫做 Scheme 的辅程语吉对用户输λ的命令和现达式进行管理­

Scheme 是 L1SP 语言的一种， 简单易竿，尤其是其茸功能非常有用.

文本界面中的命令行提示符位于巅下面一行， 刚一启动 FLUENT 时，显示为">气 用

户可在此提示符下输入各种命令或 Scheme 表达式， 直接按 IEnter ，键可显示当前菜单应放下
的所有的. 如在根目录下直接技 IËnter ~键，则显示菜单桂相对应的同名命令， 如图 2- 1 3
所示.

>

.d.ptl 
dpUne/ 
.1军plio.ll l

"‘量t

file/ 
,,.ldJ 
p.nlldl 
plotl 

,."p.,.t/ 
501" 1'/ 
事 .，. fac l"

‘11"., 
> 

阳2- 14 文本界面啡'菜单在相对应网名命φ的显示

在命令行提示符下， 用户除了可以输λFLUENT命令外 ， 还可以输入由 Scheme 函数组
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成的具有复杂功能的 Scheme表达式. 详细信息请#阅 FLUENT 用户手册.

2.3 . 3 图形控制及鼠标使用

执行 Display 和 Plot 菜单中的相关命令可进行图形显示内喜的选择和属性的世置. 执行

Display-Contours 由令可显示压力、速度等物理量的云图〈瑶等值线圈h 执行 Display→

Options 命令可进行阁形由口的显示属性的佳改. 右键单击图形窗口左上角 ， 弹出-个对ili

框，让用户直制或打印图11' . 要改变图形窗口的背景色或同格颜鱼 ， 可直接在命令行输λ

• display/seúco l肘，然后输λ要改变颜色的对直名称以实现颜色的改变.

执行 d;叩lay→mouse bottons 由令 ， 可调整鼠标按键的定义. 默认自由植标按键功能是z

按住左键拖动为移动阁形. 按住中键拖动为缩版图形，拉住右键拖动为执行用户预定义的操

作.

【实例 2-1 】 二维三通管内流体的流动分析

本实例通过对简单二继三通管内流体梳动问题的分析， 介绍运用 FLUENT 进行数值仿

真计算的基本步骤 ， 帮助读者罩绕地认知 FLUENT 的操作流程.

一、 实例概述

在实际输水、输油、 输气管路工程中， 经常会遇到分直或交叉的管路 ， 三通管就是其中

最为常见的一种. 阁 2- 1 4 所示为水平放置的输水管路中的三通臂 ， 干管为 1∞mm 的钢管 ，

曹段中间位置接入 50mm 的主管 ， 干青水流方向为水平方向从左至右 ， 流速 2m/s o 直营的

水流速度为 1 m/5 . JIl么 ， 主管水流汇入后对于管水流产生多大的"响 ， 交汇后在下游的流

动情况如何 ， 这些是我们需要解快的实际问题. 下面我们就用 FLUENT 来进行管内流场的

模拟.

" 
10m 

叫

=::> I 100川

乡0=\ I ~m 

阁2 归 三遇"几何攘型筒图

思路分析

由于管路水平肢置， 所以可暂不考虑重力方向的雕响 ， 于是可以把问题简化为二维问

题， 即研究水平截面上三油管内水流的流动现草.

通过本实例的演示过程， 读者将学习到

• 前处理杜仲 GAMBIT;
• 点 、 辑、面的蛙制，
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• 网格的划企，
• 边界提型的定义，

• 网榕的输出，
• 二撞单精度解算嚣的选择，

• 尉料的定义，
• 边界虽据的定义，

• 控制#敬的世置，
• 选代步撞的世置，
• 收散的判断，

• 田形的后处理.

(U<.II )一#见附带光盘" Ch2\rmsl.msh ，.、" Ch2\nn叫"、咱

"Ch2飞m响、s剖l 衍呐"、" Ch2\rms 1.cas旷"、 "Ch2\rms l . dat "• 

(....u )一剧附带光盘 "Ch2\AVI\rmsl.avi"
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模型建立

双去 GAMBIT 的桌面快捷万式，弹出 GAMBIT 启动时话柜，如围 2- 15 所

示. 耻认的工作目录是 C 飞Documents and Settings\Adminis阳t肘，用户可U通

过 - 1按钮选择合适的工作目录，如 F 飞，gambît working , ~;，(方使计算结果的

存址与查看.单击E豆3接扭，即启动丁 GAMBIT.
|且山川"刑'川 旦巨 .

W础吨』阳.，. jC.'Ð院_.....恤--二l

S......Jd 3 
• 句也圃，

,‘ • 3 2 I 
G..hi ‘ 
2. 3. Lð 

E "" .. 
W啦。.叫fF阴阳啕 ~ l~iI 
阁2-]6 GA岛但IT 启动对话幅

埠'但 。 GAM81T 的工作目 录巍好全为美始或在外舍，即工作文件央委用英语咸拼音命名，否则将血 oc现.....，

不便τ次调用 .

2. H fi" -~ -Ir'"，在 cre耐 R回I Vertex 峭的川、叶林输入栏中输入
(0, 0.05，的，单击 .旦旦」接扭生成第一个占，随后接同样方法帷次建立点

(0 , -0.05 , 0). ， ~_( IO ， -0.05 , 0) 点 (10 ， 0.05 , 0)，点( 4.975 , -0.05 , 

0) 点( 4.975 , -5 , 0 ) ，占 (5.025 ， -5 , 0) ，点( 5.025 , -0.05 , 0) , ,/i 

(5.025 , 0.05，川和启 (4.975 ， 0.05，川等 9 个点，如圄 2-16 所示，这样就克
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成丁本制儿何模型的基础点蜡制.
阳

s, .~， • ' -.... 
M 

Il.,. ， 主l
二_ ..J

缸"'可一­
'1" lõ øs 
<1'一--

r. fii可--­
'1" þî __ 

" Iõ"---
• -~ 

. ， .... 飞__ I _ -.1 , 

阁2- 11 基础点的绘制

3. ...,t.[i" - íi'f→F， 在。因te Straight Edge 阳中选择点 I (Vertix.l) 与点
2 (Vertix .2)，建立这两也间的蝇段，然后住次建立点 l 与点 10. 点 9 与占

1 0、点 4 与点 9、点 2 乌点 5、在 5 与最 10、占、 8 与事、趴在 5 与点 8. .*. 3 

与点 8. 存、 3 与 ，P，.、 4、但 5 与我 6、占、 6 与在 7 正点 7 与点 8 之间的战段，共

1 3 串战段， 如圈 2. 1 7 所示.

" 

匾噩噩EEEE--圄
·由r一一一一一-到

阳·刷 、，四

1工二二兰r-二1
圆圈 u 
=旦星星二Z

回2-111 娼的绘制

4. ...,t.[i" - íi'f呵厅， 在 Create Fa四 from Wireframe 峭的国ges 黄色输入拉
中选取由要围成面的战段， 单击 - I按钮生成几何00 . 本倒共生成 4 个

几何函，分别由战段 I ( edge. I ) . 蝇段 2 战段 5 蝇段 6 组成， 战段 3、战

段 6、蝇段 7、钱段 8 组成， 或段 4、或段 7‘蝇段 9. 战段 10 姐且和战段

8. 战段 11 、战段 1 2、蝇段 1 3 组成，如固 2.18 所示
li~ 

坤.rr .!l -呻1
蝴a
啕3

·甸.. 
啕S
呻.
帽，
啕._. 
帽 .. 

由

'阳.- ... --. 
• 

..I _r.. If"一一- .!l

J叩甲 U .!J 
..I--r一-.!l
T.__. _ .. J 

_ \1 rr--
-旦J_旦旦'_L二旦巳」

蝠.，

.MI 

二旦.=J E豆3
1112-19 丽的给割
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啊

!I;~ 

连慧z 此处原本可以生求 l 个面，这里生成 4 个"，，t为了下步网格划分时提供方使{划分时不同函1;要采

用不同的划分尺寸).

至此，已完成了本酬的几何模型的建立.

三、 网楠划分

三号虑到水流近壁丽粘性效应， 首先需要绘制边界层网格.

1. u li" -Itif - r臣，畔m Creale Bound町Layer 恤，在臼ges .e.输入
栏中i&取民 2. 视圄司pj牵线会出现一个红色的箭头，代在着边界品生岚的方

向 . 然后，选中 ) , ) 的边界品生成方式，并设直第一个点距壁画距离为

o∞1m . 进步曾比例因子为 1.2.边界层为 4 层. 最后，单去-旦旦-.J按钮即
蜡制克且耳品问格.

2 按照同样的方法生成线段 3 线段 4‘线段 5. 线段 8、纯段 9 的边.!r-层网

掉，如围 2- 1 9 所示.

E 雪| 阁2 划生成的边界阴阳大回
吨 3 . .t.r百-[F呵|歹，在 Mesh Ed阴阳的剧ges 黄色输入栏中选中圄 2-2。
在 | 所示的 6根蝇，边排 lnterval Size 分段方式， 并在左侧输入栏中输入 0. 1 .
星 4 按照同样的万法. ，夺战段 1. 蝇段 3、线段 8、线段 10 和纯11 1 2 哥 5 牵线段

匾~;J. Interval Size 为 0.0 1 划分，划分出采的蝇网格如圄 2-2 1 所示.

-.,." 
·咽'
叩·
呻?

tdge.e …, .. 
1<1",12 

」且-=.J

由

→四-，
呻E

一呻'
‘一..申4
叩门

协.d-…·

.., 

E三3

蝇- ~一-.!I

'陆-皿-国

主主一一二茎4.-…… 
伽_.响 -1

"'" 主旦旦旦旦.=J
丘~ .阳翩翩"
回 F 

-τD' 

白山叫

101 .豆豆!....=.l
句- . 蛐.

J…-呻._-… -J里且J _ I c暨

图2-2] 线网'鲁划分



、 回2-22 划分饰的线附幡

5 单击I百-陌→I亩， 打开 M田h Fac白面板， 的巳坦克制同格划分的面
1. 画 2 . i1 3 和i1 4 ， 运用 Quad 单ι与 Map 方法时这 4 个面进行划分， 其

网持生成情况如圄 2-22 所示. 由于遵捕的是由战到面的网持生成顺序.所以

Mesh Faces 时话柜中 Interva l S ize 左恻输入拦的默认值 1 不常是政， 直接单击

一旦旦-.J接扭即可.

回2-23 生成的面向格

面同格~分好后， 需要定义边界类型-

6 单击r.-→睛， 在 Spe呻 Boundary Typ白面担中将战段 1 和蝇段 12 走义为
追庄人口 (VELOCITY lNLET)， 名非为 inl 与 in2，将线段 1 0 ;t:iè为自由tI:

啤 ( OUTFLQW ) ， ，也非为。时， 如圄 2-23 所示.
』- ,-
J .., I " EloctTY … 

> 

‘~..侧."ω

'-' 
，_.10[啤川. 1"'-[1

回2-24 地界突噩定又

边界类型定义完后，需要将网格文件输出.
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7 执行 File - Export → Mesh 命令，弹

也会，圄 2.24 所示的网格文件输也对

话框，在又件且中输入 nnsl .msh ， 并

迫中 Export 2- D (X-Y) Mesh ， 在示

输出的约二维模型同格主件.

四、 草解计算

!I 
...- 圳"刷刷响1ft I n.U[ffT 5.c 

阳_: 1}MI..'h 一

'时呻"~m

-主二l

旦旦旦」 -1 

回2.]S 同幡输出

1. :rJ.击是ó1尘的 FLUENT 6.3.26 快徒

圄样，在妹出的 FLUENT Vers ion 时话柜中选择 2d (二单单柑庄)计算器，单

击口E按钮启动 FLUENT.
2 执行 File→Read→Case 命令，该入划分奸的网格主件 "rmsl .msh" ，如圄 2-

25 所示.

"".‘ 
c... I hh 

....阳明

I.'olo. Ot,,_ .-...... 
b". f ,l. 

，.~ 

Z…且

四 • ." …叫

-~， .., 
隙2-26 诲入划份蟹的阀'‘文件

读入网格文件之后 . FLUENT 控制台窗口会自动显示网格立件的基本属性，包括节点

数、而放、1)\元数等网路信息.如图 2-26 所示 . 同格读λ后，带要进行检查 ， 执行

Grid→Check 命令， 控制自窗口即显示网路的质量信息， 包括尺寸范田、最小同格体积、届

大问格体积、最小网格面积、届大网格面积等信息， 如阁 2-27 所示. 若检测成功，最后一

行会出现 "Done" 语句，者位测不成功，则需要查悄问题所在，修改完善网棉.
• ==Hi _...,. 

th!EI a协，. ~.. 崎向~ ...~ ....' 局..'~' a; .. 崎 &1" ....' 1...... 抽
， …·吗叮"i\tb唱快....."'. ，.....-.---→←←一←一{一

..， 四.

..川·时 ， ..... ..-.
" .1时叫，_......._ .

'剧，."I·e·" · ·1" '"·. ，ω­" .. ...刷刷息， . ， .，.. ,‘..,.- • 
MH .1... t......... ...... __ I 

r G!o ..._110.....1 "110.'_ I 

u . ..." ...... .....由、‘.'- .... ".. -，叫"抽"".. ç_. 磊

阳川时，

隐 .....tI..…………问·‘..四…l
J-c.....川剧 c.) • -s 嗣_.-.....恻 - . . ....嗣

"'幅山U>l Lcs
"， .1- 剧-，耐 1 : . . ...11'. 翩
翩01_ ..，嗣同1 : ， ..酣---
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…山..... ,,," , . …帽....1_ .... "'U ''') 1 山附帽
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罔2-21 阙格也盒，u网2-21 阀'售谶入后的窗口，.，.



遣军·若出现最.1 体/面积为 Ut的价况，证明同格划分出现~体积， 需要返回到 GAMßlT 中进行修改，

直到读入网格丈件时显示元错

3 执行口rid→Scale 命令，弹出 Scale Grid 

时话框，如圈 2-28 所示 . 在谅时话柜

中 ，用户可以重嘶走义网格的尺寸

(GAMBIT 中耻认单位为 m ).还可d查

看网格又件的~万向的尺寸跑回 .

解算前最关键的一步是计算条件的定义 ， 由

执行 Define_Models→Solver 命今， 弹

出 Solver 对话桩，如圄 2-29 所示. 迫里

用户可.~选择压力品或啻皮革 隐式或显式 走带或非走常哥基本模型， 本

制为默认选择，不做改动，直接单去一旦监扭.
本倒水 )1.. 速度为 ] -2mJs ，营 内为 瑞流流动， 故执行

Define叶Models→Viscous 命今，在佯出的 Viscous Model 对话握中边排 k­

epsilon[2 eqn] ( k - E )模型 • k - & 模型分为标准( Stand...d ). 重组

(阳G )、可实现( Realiz.able) 3 种，本制选为#准 k -&模型 ， 如圄 2-30 所 | 事
示. 时话柜右恻的模型事缸 (Mode\ Constans) 命的数值不做主动 1 取为默认 I i拿

| 动"佳，单击~按钮，关闭 Viscous Model 时话桩 分 2

h 
述

Define 菜单完成相关命令操作.

4 

5 
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附2.31 捕却也极盛怠"对洒"医

6 执行 Deflne→Materials 命令，在 Materia!s 对话柜中走义流动的材料， 如围 L

31 所示 . FLUENT默认的材料为空气 (创刊， 本倒要用到水，需要从 FLUENT

自带的材料欲据库中调刑，具体操作万法为 单去 Materia l s 对话植右侧的

AuenIO."b"e 接扭， 在伴出的 Fluenl Datab国e Materials 时话柜中，选择



列在中所需要的材料 水，单去 waler-l iquid[h2o<I>] ， 即合在下万的

Properti目中出现相应物理属性的数据 ， 如密度为 998 .2kg/m3 ，比热在为

4 182j/ ( kgX ) 等，如围 2-3 2 所示单击二旦L按钮，即将数据库中的材料拷

贝 j'l 当前工程中 . 然后 ， 在 Materia l s 时话括中的 Fluent Fluid Materials 下拉多'1

在中就存在丁空气和水两种材料， 本例选择水. 最后， 顺序单去五旦旦旦到
和=三EE卫按钮， :Æ:A材料的是义
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因2.33 Flue川Database Material，对访报

注意 若 FLUENT 自带的材料数据库中找不到所需材料时!用户可以拳击坐立E坐丛旦旦旦斗制旦进行

材料的自定义-

7 执行 Define→Operating Condit ions 命令，弹出 Operating Conditions 对话框，

如困 2-33 所示. 其中操作ßil圣耻认为一个大气压，操作压强的事考住直耻认
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为雁，在 ( 0 . 0 ). 本事倒不做改动， 选为默认事歇. 由于本制的三通管为水乎

址置，不需要考虑重力的作用， 址不用时 Gravity 做任何设置， 单击~安

钮，是间 Operating CondîtÎons 对话框即可.

8 接下来是键的-步走且耳欲据的定义，执行 Define→Boundary Conditions... . 

今，弹出如围 2-34 所示的 Boundary Conditions 对话植. 左边的 Zone 为持走义

的边耳名样，右边则为时应的边界是型 本倒需要定义的主要有 " nuid飞

飞旧 "、 气n2" 和 "out" 4 个边界杏件 • 

• 
~.‘-品酌'

』

·.-a随-M ., 
•• 回
叫

"。

一一」 王E过 ßE~

筐12.1 12 12i.t.回帽II1II……町萄

悟出旦旦旦l r叫

胁，cllCO: Pr~.. ...e l.KaIMII 

X川归

Y ImI [i 

一~ !c_到~

罔2.)5 Bωn但"C~、d泊。阳对踊但阳2-34 Opmtilli COI'叫i tion! 对幡根

· 选择 fluid . 其提型 Type 为 fluid . 单击」兰L按钮， 在回 2-35 所幸的 Fluid 对

话框中的 Material Name 的下拉列表中选择 water-liquid . 单击」巳」按钮.
• 选择 in l， 其提型 ηpe 为 vel时ity- inlet . 单击i主』幢钮， 在回 2-36 所幸的

Veloc町 Inlet 对话握中的 Veloc町 Specificat ion Melhod 中选择

.. Magnitude,Normal 10 Bounda可"表示速度进口方向垂直于入口边界.在

Velocity Magnitude ( mls )中输入 2 . 表示进口速度为 2m!趴在 Turbulence 中
可~进行浦施#酷的世置，本例选择 Specifi四tion Mehod 中的 Intens ity and 

Hydraulic Diamelcr ， 在 Turbulent Jntensity 中输入 1 ， Hydraulic Diameter 中输

入 O. lm ; 最后单击」巳」按钮完成速度进口 in 1 的设置.
? .. ……………-电 III~川，川1 咳

主主d....""U"..4 
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-_.幅.....- 才

3 
3 

町.­
U帽....z...

S…τ.~. 
flI<C~ V.阳.
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T叫M…IIvI'4 Ji

响曲曲时时间fï.i

3 
-旦」 旦到旦旦J陶.

阳2-36 F luid 虫'凶假 回2-37 Vdoçity I nkt别说倔

• in2 的设置同 in !， 1!别仅在于 Velocity Magnitude (m/s) 中输入 2 和 Hydraulic

'
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Dìameter 中输入 O.05m .

· 选撑 。ut . 其英型 Type 为 outflow . 单击」丘』按钮，在回 2.37 所幸的

OUltlow 对话框的 Flow Rate Weighting 中输入 1 .最幸进入的水均从读出口撞

出 .
EltMhM……………·咽司

A_'"幌仙' 1'

~岳国~
因2-)& Outllow 对活但

9 执行 Solve - Control - Solution 命令， 弹出 Solution Contro J s 时话桩，如圄 Z

38 所示. 埃者可;A.Jt需要计算的方程、定义方程的柑跑回于以，!\，方程解弃的

算法 ， 本倒均为默认世直.

阳..时叫叫

I~ 一一
恤-申

主 阳…'f叫"
--阿"'".问

T咕.~，叫阿瓦，-

._~啕--阿....百二E

JJ 
「
且1
J
1
4
3

1112-39 so 町 惆c..，衍刨，对话枢

10 接下来， 时流场进行初始也. 执行 Solve -0 lnitialize -0 Initialize 命今，在弹出

的如国 2-39 所示的 Solution Initia lÎzation 时话框中选择 all-zones . 时全区域初

步合化，顺序单去J旦J， 旦旦l 旦旦旦棚.
Iö~"川川山

Z雷 同胞 'd洲阳 Cell Ze..e 
r ....... 脚

1,,111.1 V.IMU 

广一 " 唰Plc....... 1P..c.叩

""呻叫h

y"叫~I I'

Y叫"叫"M啊阳句 1，."111_"'"
二j

...!!!'J 旦旦 旦旦1 ，.旦j 旦旦j

回2-40 SoIution IIIÎtializatîon对访但

11 相曲也后， 执行 Solve -0 Monitors -0 Residua! 命令，在弹出的 Residua l



Monìtors 时话柜中选中 Plot. ~;.t打开战呈曲蝇田，如固 2-40 所示. 在时话框

下方的 Criterìa 中可且输入各#数的收虽柑庄要求 ， FLUENT 耻认值为

0.001 . 

12 克成上述步骤的设直后，还需要是义迭代事数. 执行 Solve- Iterate 命令，

在弹出的如圄 2-4 1 所示的 lterate 对话植中设置 Number of Iterations 为 10咽，

单去旦旦旦按钮即可开始解l!-.
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阁2-4 1 I毫臼id....Moo由剿，对'"锹 圄2-4 2 I l1:rate对运"

解算过程中 ， 控制台窗口合实时显示计算步的基本信息，包括 x 与 y 方向的速度、 k 和

ε 的收敛情况. 本例在计算到 70 步后，即达到了收敛 ， 此时窗口中会出现 U solutìon Îs 

converged" 的提示语旬，如图 2-42 所示，

--吧空空….… -50理
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回2-43 M S。川盼。 "α~""萨'"她示俯凰

啕--
咱

叩-
咱 …. . . . … 

" ..‘· 叫"白.

网，... 魏.，幽饵圈

计算完后，可以通过 Display 菜单进行圆形结果的显示. 执行 Display-Contours 由

令，弹出如图 2-44所示的 Contours 对话框 . Optìons 选择栏中保持 Fìlled 未选中， 则显示的

为等值线圈，如图 2-45 所示的压强等值线圄. 若 Fìlled 选中 ， 则显示的为云圈，如图 2-46

所示的边皮去图 . Contours of 下拉列表中可以选择显示何种物理#数的等值线图或云固，

如图 2.47 所示.

这嚣z 用户可以丰剧.需要;.;，排需要显示的物理事欲的"值钱困Ji.云图 .
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13 执行 Display- Vectors 命令， 弹出如圄 2-48 所示的 Vectors 时，舌框，其界li7

与 Contours 对刷刷础，本例iiI Scale 为 2 . 单击应iii!ù按钮，显示如圄

2-49 所示的速度矢量固 .

… 句则…
r 
. _.民…·
. 也.~咽
r '"'"_k ... 
r…w刷

仲叫
lim阵a.m_"'tt y .iMm ~13 

• 
且 『 23 当 n 

嘈'" 号 2 E 2 

白白.-.-
Z甲.-
『

一.--甲 ~_I 

‘-
一
一.-
E 

'唰.-
『

白甲甲.._-- '由-··幽.-幽

丁
V.lodly '"画面 寸

4户'" p甘-一

「一一

M帽

罔2-"，9 V，剧骂~对齿'医 回2 到边Il'晨...

60 



14 陪丁用y 可按需选择要显示的圆形外，还可时进行计算报告的显示.执行

Report -0 Fluxes 命令，得出如国 2-50 所示的 Fluxe Rep。同时话枢，选中进.

出口边鼻，单去E豆画国按钮，克成进、出口质量埠量的计算，结革且
Results . 可见进、出口质量流量相且 -1.1制409 x I肘，满足丁蜻庄要

卓.
叫，.，.""，..， 叫.

r. .…阳A.'e
俨 Total HnlT.，..，k.阳
F 阳d翩翩mω.IT..u阳阳幅

' 
O_....，. N._"-帽

「一一一 .型」
泞，阳"c.15

阴2-51 Flu，，~ Report 对愤恨

15 计算茸的结革需要保再为 case 和 data 主件，执，.ft File- Write 吗 Case&Data... I ~ 
命令，在佯出的主件保存时话柜中将结果文件命名为 nnsLcas ， case 文件悻存 |面

的同时也保存T 削主件 nnsLd创器，
分 2

睛 iU-还可以制叩或 d.~ 文件， 执行 Wrile-+C由或 Writ.叩刷命令啊， 制阳和 |如

d.~ 文件同时保存 I '述

16 最后，执行 Fî le→ Exit 命令，安全退出 FLUENT. 若不按此法，持生A碎片主

件.

2.4本章小结

本意主要讲述了流功分析的发展. FLUENT 软件的功能、界面、运行方法等 ， 井列咕

了一个简单的实例 . 通过入门引例的介绍，帮助读者认识 FLUENT 的操作界丽，了解

FLUENT fl'J求解过程 ， 为后续利用 FLUENT 解决实际工程问题打下基础.

/t 
v"晕

>> CFD 的植企且且用明域.

>> FLUENT 杜仲的功能正操作捍面.
> 利用 FLUENT解决简单流动问题的操作过程.



第 3 章

前处理网格生成

在运行 FLUENT 进行计算前，需要借助于前处理软件完成模拟对靠的儿何模型建立与

同格划分. 目前，可用于 FLUENT 前处理同格生成的软件有 GAMBIT 、 ICEM-CFD 、

Gridgen 等 ， 其中 GAMBIT 是面向 CFD 的专业前处理软件 ， 具有较为全面的几何IJ!模和网

格划分功能，可以直接进行点、钱、面、体的模型建立且边界店、线、面、体的罔格却l卦 ，

也可以从其他 CAD/CAE 软件导人儿何模型和网棉.

在实际仿真计算工作中，大约有 80%的时间是花费在网格划分上的 ， 可以说网棉划分

能力的高低是决定工作效率的主要因置之一. 鉴于此，本章主要介绍间格生成的方法且

GAMBIT 软件的使用 ， 通过本章!k例的学习 ， 帮助读者了解 GAMBlT 的操作步骤且学舍利

用其对些模拟对靠进行模型的悲立与同格的划分， 从而在一定程度上提高网格划卦效率.

• 网格生成的基本原理且方量.
• GAMBIT 操作界面及操作方
浩.

• GAMB IT 几何建模.
• GAMBIT 网掉划分方浩 .

• GAMB IT 边界定义方浩.
• GAMBIT 与 CAD 杜仲的世据
史换 .

本章案例

• 二蛙埋地输班营与周围环境传热的模型建立与网格划分.
• 三蛙幽面喷管班动的幢型建立与网掉划分.

b
n
几
r
H
S
L

…ι
(
(白
)

v
u
m

叫
-

E 

一-…-. ~一 !、._----------------------------------‘--_........................…'…....._..... --_.. _._.. _.- -_. -_. -- _., 



3.1 网格生成方法

CF口 的本质量对控制方程在计算区域上进行离散 ， 主要为点离散(如有限差卦法)或

区域离散〈如有限元法与有限体积法l . 从而使控制方程转变虫在各同格点就于区域上定义

的代数万程组，然后用线性代数的方法进行选代求解. 因此， 网格生成是后续运代束解的前

提，也是整个计算过程中关键的一步 ， 当物体外形直杂程度较大时 ， 同幡生成技求将起到至

关重要的作用.

l FLUENT 可以导人进行后续计算的网格有二维的三角形和四边形网楠， 三维的四面悻

网格、大固体同楠、金字培型罔格、棋型同棉，以且由上述网格类型构成的混合型同棉. 按

其生成方法可分为两大类 结构化同格和1非结构化网格. 下丽详细介绍结构化间格、非结构

化网格且结合两者优势的混合同格生成方法.

3 . 1 . 1 结构化网恪

较早的网格划分方法主要为结构化网楠. 从严格意义上讲，结构化网格是指网格区域内

所有的内部点都具有相同的毗邻单元，即网格体系中节点排列有序、相邻点间的关军明确.

结构化同格可以用直角坐标草或圆柱〈球}坐标罩下的坐标值表示出其同格的位置 {X . y , 

。且大小. 其优点主要体现为 I !Z

• 在昂实现E峰的边鼻掘合，适于流体和表面应力量中等方面的计算章 ，
• 网格生成的速度快格3

• 网格生成的质量好盖意
• I!:据结构简单，

• 对曲面盘空间的制告太多数最用"'1!:1t革样串插值的方浩得到 .IK峰光滑，与
实际的模型亘在昂接近

现有的结构化同格的生成方法基本上可分为以下 4 大提.

( 1 ) 代数生成方法，挂在得知l边界上规定的同格节点位置或附加的一些#带点位

置的基础上， 用插值方法确定所有其他同格节点的位置. 具有灵活方便、计

算速度快的突出优点 ， 但对于直杂的几何区域往往难以找到古远的插值函数

进行同格生成.

(2) 保角变换方活s 是指通过已知点的两条任意曲线间的央角大小和l方向不变的

变换，同梅生成采用保角变换方法可以生成完全正交的贴体同格，计算时间

也相对较少 ， 但仅局限于二维网格的生成， 且通常对物体形状有一定的限

制.

(J) 偏微分方程方法·是利用求解偏微分方程的边值问题来确定计算区域内网路

点的分布情况， 其适应性相对校好，且生成的网格质量较好. 运用椭囚型方

程生成的网梅往往比较光树，变化较为均匀 ， 且调和函数的极佳性质保证了

网路生成时物理空间和剖 n空间之间的一-MJsY.关革 . 该方法的幌点是生成

较密罔梅时所幡时间较长.
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(4) 变分原理方法=是利用某个目标函数(泛函数〉取极值 ， 来达到生成网棉所

希望满足的整求.由于可以比较方便地将网怖划分的要求用某个变分原理来

表示 ， 然后再导出和!该变分原理相应的偏微分方胆 ， 即欧拉方程 ， 该方法常

用于生成自适应罔格.

虽然结构化网路可以方便准确地处理边界聋件， 计算精度较高， 井且可以来用许多高效

隐武算法和多重网格法，计算效率也较高. 然而，它的主要缺点是适用范闺比较窄，对求解

区域相对复杂的情况，网路生成较难， 甚至难以实现， 因此在使用上受到限制.

3. 1 .2 非结构化网格

为了弥补结构化同格不能略解决任意形状和任意连通区域的罔将划分的融欠 ， 20 世纪

四年代革人们提出了采用非结构化网怖的技术手段 ， 现已成为研究的热点之一. 与结构化

同格不同的是，非结构化同棉是指网格区域内的内部点不具有相同的毗邻单元， 即与网棉划

分区域内的不同内点相连的网格数目不间，同格单元和节点彼此没有目1寇的规律可循，其节

点分布完全是任嚣的. 从定义上可以帮出，结构化同格租非结构化同格有相1illi:叠的部分，

即非结构化同格中可能会包吉布结构化网格的部分.

非结构化网格却l卦技本假世任何空间区域都可以瞌四面体(三维)i&三角形〈二维)单

元所填满，即任何空间区域都可以被囚丽体或三角形为单元的网格所划分. 它有两种类型·

宏观非结构化网格和I微观非结构化网将. 宏观非结构化网格是先将空间区域划分成许多小

块，每个小块用结构化阿格划分， 再将每个小块网棉!II非结构化同格连撞， 古井成且体的同

棉. 它在一定程度上可以解决复杂边界问题，但块网路拓扑的形成往往需要大量的人工处

理，因而不易形成工程实际所需的通用程序， 且这种网将由于自适应处理常容易导致网棉结

构性的彻成破坏 ， 因而也不适合于作间幡自适应. 微观非结构化同格是完全没有规律的、自

由生成的网格，是一种任意的网路.

非结构化网格的优点为

• 适合于复杂区绒的网格划分. 特别对奇性点的处理很简单，

• 其随机的矗据结构更暑于作网掉自适应.C(便更好地捕在流墙的物理特性，

• 其生成过程平菁求解任何方程，

非结构化同格生成的主要环节

• 如何在计算城内合理分布同特点;

• 如何将网格点有最连接，形成三角形JIi.四面体用棉单元.

、 根据应用领域区分

根据应用的领域，非结构化网将技术可以分为应用于差分法的间格生成技水 ( grid

generation techno logy ) 和应用于有限元方法中的网格生成技术 (mesh generation 

technology ) o 应用于差分法的网路除了摆满足区域的几何形状要求以外，足要满足某些特册

的性质〈如垂直正交，与流线平行正交等)，因而从技术实现上来说更困难一些. 而应用于

有限元方法的同格相对非常自由，生成的同格只需要满足一些I!i状上的要草就可以了 .



二、 根据生成网格方法区分

从生成罔格的方法来区卦，非结构化同格生成技术还可以分为以下 3 种.

(1) 四叉树(八卫树〉方法.该方法的基本思想是先用一个较粗的矩形〈立方

体〉网路覆蓝包古物体的整个计算域 ， 然后按照罔描尺度的要求不断细分矩

形(立方体) ， 即将一个矩形卦为凶()\)个于短形〈立方体) ， 段后将各矩

形〈立方体〉划分为三角形〈四面体) . 例如一个没有边上中间点自由矩形可以

划分为两个三角形 ， 一个没有撞上中间点的立方件可以划分为五个或六个四

面体， 对于流场边界附近被边界j;IJ割的矩形(立万体 ) ， 因l宿考虑各种可能的

情况， 作特殊的划分.

四卫树 (J\丑树)方法是直撞将矩形〈立方体〉划分为三角形(四团体) ， 因此这种方

以且邻近单元间的相交性和相睿性判断等问题 ， 所以同格生成的

不足之处是同格质量较差.特别是在流场边界附近，瞌切割的矩形〈立方体〉的

"由此而划分的三角形〈四面悻〉的品质难以保证. 尽管如此 ， 四叉树

〉作为一种数据结构已被广泛应用于阵丽推进法和I Oelaunay 方法中，以提高查导

(2) Delaunay 方法. 此方法首先是在区域内分布节点，然后采用适当的准则将点

连接成四面体单元， 生成空间网格. 量为常用的准则为球形准则，即一个四

面体的外接回内不包含其他点. 该法的优点是万使、速度快，网格的尺寸比

较喜且控制，但官需要判断物而边界井进行额外处理，对边界的恢复比较困

难，很可能造成网格生成的失败.

(3) 阵而推进方法. 该方法首先生成背景罔格，自是用户自定义的一个包国所感

兴趣区域的空间同格 ， 同格内各单元设置为不同的害数来控制单元的形状和

大小. 然后 ， 生成三维物体的表面网格，从而形成初始阵面，初始阵面是将

边界点连接而成的表面同格 ， 边界点由原始数据和背景同幅确定，这里要定

义初始阵而且其法线方向 ， 以确保阵面向区域内部推进. 最后，引人新节

点，推进阵丽 ， 完成空间网格的生成.该方法的优点是人工干预少， 但因空

间点是任意给定的 ， 故网格质量段难控制.

由于非结构化同格的生成技术比较复杂， 随着人们对求解区域复杂性的不断提高， 对非

而现有文献反映，非结构化同格生成技术中只有平

自动生成技术比校成熟，平而四边形罔格的生成技术正在走向成熟. 其他空间任

四边形间格的生成， 三维任意几何形状实体的四面体罔棉和六面体阿格的

得'll!解决的问题还非常事 . 主要的困难是从二维到三维以后，待划分同

植的空间区域非常直杂，除四面体单元以外 ， 很难生成同一种类型的罔楠，需要各种罔格形

式之间的过渡，如金字塔形、五面体彤等. 因此，实际应用时往往将非结构化同格划分技术

的各个方法结合起来. 非结构化网格技术有待解决的棘手问题有

三维网格生成+分耗时，寻求通用、方便 快速 有姓的生成方法是*需解决

的，

• 与高睛度有阻量分格式的结合， 三阶 'j上的高精度格式尚难以应用于非结构化
同格的划分.

第
3

章

前
处
理
同
精
集
成



p
c
m
Z
J『
液
体
分
析
及
仿
真

实
用
数
程

3.1.3 混合网格

为克服结构化同格和非结构化网格各自的融点 ， 混合网格技束应运而生， 它结合了结构

化同格和非结构化网格的优点，己越来越受到重视，其划分方式主要有以下 3 种.

( 1 ) 针对;1;部件或多体组杂外形的混合同格. 此方法是先对事件问题的每一单体

或复杂外形的每一部件生成贴体结构网路，而在体与体、部件与部件之间的
交界区挖出一个洞，洞内由非结构化间格辈填充. 这类混合同格的代表有拉

链网格 (Zipper Grids) 和龙形罔恪 ( Dragon Grids) 等.

(2) 针时勤性计算的混合网格. 该方法是先在物面附近向外划分出儿层有一定压

缩比的结构同棉〈二维〉或半结构阿棉〈三维、 三棱柱〉以模拟边界层，其

余部分用非结构化网格划分. 事实上 ， 在外形不太直杂的情况下，全区域采

用三楼柱网格也是可行的 .

。) 矩形与非结构混合罔格. 矩形同棉不必进行 Jacobian 矩阵计算 ， 具有比贴体

网格直为简单而快捷的优点. 但其不足之处在于不易处理曲面边界，处理不

好就会出现所谓的 "自阶效应飞事实上， 在物而附近来用非结构同格就可以
消除 "台阶效应.. 同时达到模拟茧杂扑形的目的 . 这就形成了矩形/非结构混

合网格 . 为了计算和性问题 ， 亦可在物面附近采用结构〈二维〉或半结构

(三维)同格 ， 然后由非结构网格过波到外场的炬形网格，由此构成矩形/非

结构/半结构混合同棉.

阁 3-1 所示为结构化网格划分技术、 非结构化罔格划分技术与混合同格划分技术对同一

模型的网格划分情况，由阁中可以消晰看到三种方法划分后的不同同格形态.

〈ω 拍胸化网幡

( b ) - 1~销构化网恪 (0)耀合同协

阴3.' 习网划分方法的网将形鑫



遣慧=在同格划分时，应根据实际问题的具体要成1 采用优化的同格划分+段

3 .2 网格生成前处理软件 GAMBIT

GAMBIT 是功能强大且丑活方便的儿何迫模且同格划分工具 ， 可以划分出包吉边界应

等特殊要束的高质量网格. 另外， GAMBI T 还可以实现与 CAD 的衔接， 处理复杂的几何模

型，井能生!Ii.与~个 CFD 软件无缝转攘的高质量网格. 其网格:liJ1分方法的选择实现了完全

曹能化，当埠择一个儿何区域后， GAMßIT 合自动选择撮合远的网格划分算法，使网格划

分过程变得极为睿品，其中专有的问格划分算法可以保证在较为复杂的几何区域中直接划分

出商质量的六面体阿格.

对于 Windows 操作革统，要运行 GAMBIT 软件， 必须直菠 HummingBird .Exc田d 软件

以完成系统的虚拟.

3.2.1 GAMBIT 基本界面

GAMBIT (J<J GUI 界面可以分为菜单栏、现图窗口、命令显示窗口、命令输入窗口、命

令解释田口、操作面板和现阁控制i!iî嵌 7 个部分 ， 如回 3.2 所示.

"仰面'民

慢
罔
窗
口

白白

阳).2 GAMBIT 基本界面

(1) 菜单在z 位于标题栏的下方，包古文件、编辑、时且软件和精助 4 个菜单.

国 3 .3 所示为文件菜单，通过此菜单可完成下列任务.
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旦J !"' !"帽
阳 a西缝工钮

If开1日工础

保存

另"为
圆形编剧与IT印

垣行回事

澜'拿日志
查看文件 1.1 .Q.

"入
9曲

直选 CAD

温幽

阴，.，文件，.尊

• 新建工程草打开已有工程，其识别的文件后理名为 ".dbs. • 

• 将当前工程进行保存量月存为操作，保存后在工作目录舍生成 3 个丈件，后撞

Qpoo 

鱼"-.. 
一~ .. 雪'"' ..二

阳"回

』甲"

响..四.

""'" E刻-‘

, 
, 

陆圃-‘臼!
国

名分别为.. .jou" , .. .tm" 和 "，dbs" • 

• 将当前窗口的图形输出且打印.

• 运行威清除臼忘，后撞4 为... .jou" • 
• 查，.当前文件的相关情息 .

• 导入其他软件生成的几何模型或网掉， 或导出当前模型与阿掉，完成相关的晶

据史换，其导λ. 导出列最如固 3.4 所示，对于 FLUENT 而吉，需要将

GAMB IT 建立好的模型且网格导出为后理4 为 msh 的文件.
旦旦J t-t !If"W ... 
旦回国牛

室"_M 
阳嗣四川

一..-协
'圃'回』

旦旦J te !It睛--".. ---,...-

ι
i
t
 

_M_ 
....雪些二
!-_.-

...-四"旦旦旦工- -RP" 1" AØI ._ 

7 GIII!一--
旦旦-------

-鸭"堕嗣啕

回)-4 GAMßIT 文件蕉触的铮入与窜出列褒

• 重新与 CAD 建立连接.

• 退出当前工程.
图 3.5 所示为蝙辅架单，通过此菜单的操作可以先成如下任务.



1IIIe _._ 
定义际踵阳且.... 帽"文件'ð且,..1..... … '幢幢置

。，由国恒… 赋队..置

U自由 编制

... 由 恢复

圄，.，蝙割，.单

• 编辑标题，即命名当前工程名样.

• 编辑文件惜息，如文件4:.编者情息等 .

• 参撤设置.iJI:置相关参晶的名称.提型lt赋值.
• 查找直静<i:默认的环境世置. 单击固 3-6 所示的窗口，若想改变祖田背景色，

可选中默认参数窗口中的 GRAPHICS . 再从下拉列章中选中 WlNOOWS

BACKGROUND COLOR 项，其右下方的情思窗口显示当前窗口的背景色为

black，此时可时通过键盘删除 black 而输入 while，而后单击左边的旦旦旦l按钮

完成曾改操作，如固 3.7 所示，最后单击最下方的 ""'" 按钮关闭默认

#融窗口 ， 即完成了冉黑色背景改为白色的世置.

• 撒销威性童当前操作步.

1 
MESH 

G町'由

lA8EL 
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咀

GU' 
τ.. .. ，。

• G!;N!;R ‘L 

IM中山
I ADD _ 5ILHl1U!.'T:!'!:5 _ A'f_rACI_ COXsmUCTlOB 1 
~..旧凹'.用'_rACI_CON!mWCTTOII 。
'阳也'"飞LIITDI._COι"" .. 在山e
B~T_LIITDI._V151BLE_AT_COBS1J虹JCrl DII 2 
C倒lI!:CTJVπv二队SlD_COLDI\Jxa 0 
r utL AlJTO IWfIPULATlOII 1 

D..cnptlon 

一Jf 1, ,...1y con. 
If 1, ne.1y 叩
Color to .ru.- .., 
0: AU B也叫·始a
o • .... topoloqí 
'缸11. 1n "up旧 l ì

同

旦旦旦旦J ~
, 

v_ ~ 

旦旦J Ir'IGAM8rr.1ni 

旦旦J I}\GAMBIT百

旦旦斗

旦旦斗

h 

用H 默认'数窗口
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~~ … ‘皿
叩

~ 

蛐

阳

，叫

.~ 

…J旧居啤来SI!+Pl C飞鹏-帽

阻归窒.... 帽-.宫-…… -… … _m 

· 晒"'~no1_ .. ....If"~ f _ ,.1",", .嗣
o ..，0.0.1.叩‘吨 ‘ . ........ n萨一
• -由叫.. ... .."'..町时蝴

_.叫 UI 101\ "由一..­,.,f . ". f肿叫川 同伽­

E ……….自 I •• .瞻

z .. 
i!<'与 圳、it<:

, 
旦旦旦!l I Jl'I-~_' .~. 

~I IF'G明Y 刷

主，"If百_.

-斗

-斗

由

回'-7 设置.，童""窗口".色

，主窟，读者还可以根据实际禽费，对模型~网格的色，目及.Ht边行相应的修改，其操作与修改lf景色相

网，均在默认参数窗口 中克成.

国 3-8 所示为对盈软件菜单， GAMBIT 可为 FLUENT、 ANSYS 、 PüLYFLOW 等主流软

件ll!立模型与网格. 在盐1模 1甜可以首先选择欲连接使用的接口软件， 使得工程处理E具针对

性.

(2) 视图窗口 GAMBIT 可以显示 4 个槐困窗口 ， 如阁 3-9 所示. 通过拖曳圈中

的十字按钮，可以完成各个窗口的缩放，若将十字按钮移至左上、左下、右

上或右下四角，即可恢复到图 3-2 所示的一个视国田口 . 在实际建模过程中，

读者可根据需要选择tj\视图或多舰图窗口显示.

坠旦j
阳-

四，-. 对..软件篡单 陶，-，多，.四窗口



(3) 命令显示窗口 位于视图窗口的左下方，如回 3-1 0 所示. 从该窗口中可以且

时查看到每一步操作的命令且结果，帮助用户明确已执行的操作和且时发现

存在的问题. F …·啕民

, 
阴3-10 命令显示窗口

‘ 

(4) 命令输入窗口 位于整个 GU1 窗口的段下方， 如阁 3- 11 所示. 从 Command

后的输λ栏中用户可以通过键盘输入相关命令，以实现相应的操作.

阳翩翩f
阁}-11 .令输入窗口

(5) 命令解释田口 位于悦阁窗口的右下角 ， 将鼠标先标移至槐图窗口右侧任­

操作面扳或视图控制而阪挂钮上，该窗口郁金实时出现按钮命令的解释，帮

助初学者认识相共操作按组的功能， 如困 3-12 所示.
• • 

_I~ JlllDOW_ UPfU LZI'T 
叩m

1113-12 ..饵'事窗口

(6) 操作丽扳 GAMB1T 的核心部分 ， 通过该面阪上的图标按钮，可以完成绝大

部分建模相同幡划分的工作，如阁 3-口所示 . 而阪的前三个按钮匾晚了

GAMBIT 的整个操作过程， 首先是建立模型 ， 其次是同梅划分 ， 最后定义边

界蛊件类型 ， 关于这三个按钮的详细功能介绍见本书的后而章节 . 第四个按

钮娃用来定义视圈中的坐标罩统的， 一般采用默认的设置.-
阳明i
儿俩惯例格边界慢圃
'固始制划分集型坐标

定义..缝
定又

阳3-13 lt作面'后

(7) 视阁控制面阪 升为上、下两部分， 如图 3-14 所示. 上面一排的回标是视圄

血示与苦的控制按钮 ， lïú 4 个卦虽IJ代表丁图 3-9 中左上、右上、左下、在下 4

个视图 ， AI1 即表示激活全部 4 个视图.当激活相应的槐图阁标时， 下方的 10
个控制按钮才合作用于该视阁.

白白

罔}- 14 l!回校制面扳
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视阁搜制而扳下方常用的功能按姐的功能介绍如下.

• '?al: 全国显示按钮.将视图窗口中的图形捕捉全胃口显示.
. 且 视田显示接钮.可以选择不同的回祖固量单视田显示.
. f:J 坐标革辑按钮. 选择模型的方位坐标.
. 1!!l 显示项目控制按钮. 指定模型是否可见.
. 1!J外现显示接钮.指定模型的外观显示，包括蝇握方式遭最方式和消睡
方式等.

3.2.2 GAMBIT 的鼠标用法

GAMB IT m户鼻而是为三键鼠标设计的. 每个鼠标技键的功能可根据鼠标是在菜单.

表格还是在砚圈窗口上的操作而有所不同. 一些在视图窗口上的鼠标操作是和l键盘同时进行

的 .

一、 菜单和理格上的使用

GAMBIT 菜单和表格的操作相对简便 ， 只要求鼠标左右键而不涉且到任何键盘操作，

其中大部分只甜鼠标左键即可.右键通常是用来打开操作面匾上功能按钮的下拉列衰 ， Jn l 匪l

3- 1 5 所示. 在一些农棉上包含主本窗口，右键还可以打开选项的隐藏菜单.

E旦血出l

旦j二封信旦旦
旦J旦♀11:!J~
E工主l主j三l
D~.呵'

,Q "-1-

。 C'"，lo

<7. i川阳

tn1I Sl.，~ Iìorf_ 

翩翩M嗣

[0 ....... 细』

曰--d'l时....

因3-IS 功能往组的下组列军医

二、视固自口上的使用

在舰阁窗口上，通过鼠标主要完成显示操作、任卦操作和点的创建 3 提操作.

( 1 ) 显示操作.通过阻标 3 个键及键盘上的~键可以完成 GAMBIT 槐圈窗口中
的显示操作，如表 3- 1 所示.



襄3- ' 鼠标完成的显示提作 • 
组遥

两次中..，旨 在当翻覆角直撞显示'民型

(2) 任#操作. 利用 3 个鼠标舷键和l键盘上的坠旦陆可以帮助用户完成 GAMBIT

视图田口的任#操作， 包括选中实体和执行动作.

在 GAMBIT 边模和网路划分时通常要求用户指定一个或更多的实体操作 ， 有两种方法

可用于指定一个实体.

• 在指定表格中的列最框中输入实体名字或从列表中挑选一个.

• 用且栋直接在视困胃口模型中选中实体. 川 t 
当使用鼠标从显示在视剧窗口的模型中选择一个实体时 ， GAMBIT 舍把该实体的名字川 l 

插入当前活动的列表中 . I ~ I 
GA阳T问咛3操作有两种不同的类型， 都用到了回键· 两种选中实体的操作咐

明如衰 3 -2 所示 . 苗 .
精 3

圭 章

R棒111&螃.

一左..单击

中.单击

右..单击

右.剧院备

国蜡

是3-'

'民银协同巅'管

往任-1l向拖动Jt标

"任方向拖动先标

往'理方向精确先"

往*'叫F方向植功先标

先保刻，自移动

'使椅..'"
移动'庭堕

缩...随堕《肉上编小向下..大〉

使..型键精图形窗口中心旋转

放大'震型 保留惧型比例. "簸'民保候..后，显示了放大的帽型

鼠标+键盘完成的任务绩伟
• • 

鼠标111&.在.. 偏远

幽
幽
胁

凰辙Wt llUl fI::

Jt标埠1'11晨'

Jtl量...~圈

子~..口

选中'震壁画'1lI型的几何元'"

在..定樊型的棚'"震惊间切倏

...行动作..作等同于尊击 ，..，二」撞倒

违窟 ~G.键可以同时逸←纽目标，只需拖出一个方雄"-lIlit;t园林 ， A制应园，用且肘

1院，t，被选目标.

。) 点的创始. 利用鼠标在砚回回口中可以进行点的创建， 通常为快捷创lJ!已知

坐标点，其具体操作步骤如下.

打开视围坐标是义工具固的操作面桓.
• 单;j;坐标1民操作按创立J.

• 选择坐标网格显示接钮圃，如固M阳.

. ， . ， .刷 .

rI'，.QJ鱼l旦旦

旦旦i工l坦国三l
--1..J..J判三j

罔)- 16 定义慢回坐标'民集王，毛的撮作面'民

" 

国

,_-



• 在弹出的坐标同格定义面提中.分别世置 X ， Y 轴输入E间范围lk坐标网格的

间距，如圈子17 所示，单击」旦丘且!...l按钮，即可在 XY....rlane 中显示定λ好
的坐标节点值，最后单击E豆口按钮完成坐标网格的定义，井在祖国窗口

中生成了如固 3-1 8 所示的坐标同格.

• 按决序特I百-[言→rr:-.使得当前执行点生成操作 .
• 在坐标网格的适当位置，利用 E画鼠标右键即可创建点，如图 3-1 9 所示.…,_.-

兰兰兰芷芒工土豆
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蛐 E灾})z_ r一

• • , 
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旦旦且J-'!旦i三豆豆3
圄)-]1 坐标同幡定义面" 阻3-19 i割了点创煌后的坐桥同格圈3-[8 ~I&的坐标网格

3.2,3 GAMBIT 几何建模

几何模型建立通常为点→线→面→体的顺序，单击I百按钮，即可弹出如图 3-20 际的
几何建棋工具面版， 通过该回恒的功能按钮可完成 GAMBIT 的建模任卦.

给给始给范

例创制制叉
点地面体组

回3-20 几何应镇工具面扳

、 绘制点

单击在T按钮即弹出如阁 3-21 所示的 Vertex 面板 ， 用户只需在 Create Real Vertex 面板中
输λ点的三维坐标 ， 单击- .，..， 披钮后即可在视图窗口中生成相应的点. 对于 个复杂

的几何模型， 读者可先计算出全部点的坐标， 然后依次通过此方法生成所有的点.

点的生成形式有咐， 鼠标右键单击F按钮，可查看其列茬，如图 3-22 所示.由上至
下依次为根据坐标生成点、在线上生成点、在面上生成点、在体上生成点、由交点生成点、

由质心生成点和投靠生成点，读者可根据实际需要选择相应的点生成方式.
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鹏3-21 、佬~.面扳 回3.22 点生成方式"模

在 、'ertex 面极中还有几个常用的命令，如 M叫臼py 命令 . 单击且J掠钮抓出如阁 3-
23 所示的面撮，!)\击 Yertices 右侧输入栏里高亮黄色显示时，读者可以选取需要移动就坦制

的点，通过平移、旋转、映射等方法完成点的移动或直制.

GAMB1T 中除了应坠鼠标左键单击可以选中对靠外，还可以单击货也输入栏右侧的
向上箭头 ， 在弹出的清单列表里边挥待选对聋，如图 3-24 所示.--主!..:!J Ilrl---主l

+- ，，~J1一一一一

一.，甲、，町、，町、，k*

iEJE 
一

J一一
」旦且.J.....!!!巳L豆豆3

回).23 移动'复制点面'民

二、 绘制结

帖 Geometry ífii f&(r{J第二个树立J，弹出如图 3-25 所示的 Edge 酬，读者可以在
Create Straight Edge 俏货色输入栏中选取需要连接成直线的两点，!)\击r.亘ζl按钮就会在

选择的两点间建立-j挺直线.

除直线外，还有很多其他形式的钱可以被绘制，只需右键时7按钮， ~例如图
3-26 所示的统生成方式Jtl袋 ， 有圆弧、圆、椭圆、倒角、 二汰曲线、样条曲线等.

与 Vertex 面版不同 I Edge 面极中有分离按创下τ，其面原如圈子27 所示，读者可以利
用菌命令将一牵线卦割成两条，卦割万法有坐标点切割、已知点切WoJ和统切割 3 种.

'
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回3-21 线分画面'民阻1.2S 日". 面恒

甘 阳帽

南 ..... 

阁3-26 路生威方式"呢

三 、 绘制面

单击Æ按钮， 可以进行丽的绘制，其面阪如回 3-28 所示. 与直线生成方式类似，由
钱植生成面方法只需读者在 Create Face from Wireframe 的黄包输λ栏中选取欲田成丽的钱

段， 单击-旦旦..J按钮即可.

鼠标右键叫古「按钮同样合弹出其他面生成方式列袋 ， 如固 3-29 所示. 除线框国成
而外 ， 还有三点生成平行四地形丽、 三点生成圆丽、 三点生成椭圆面、多点生成事边形面、

钱扫掠成面、 线旋转成面带.
p
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z
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旦主二」
o ......" .,..... 

。侧'
0<'"腼

'回+ - -叩

J四f_ 1I ..!J 

--甲 「一一一- .!l
....--/1一一一一 主j

σ '"阳
QJ:Jl... ..,-

-"'也」一旦旦....J -
困3-2 8 FIIC~ 菌'民

.. .幌刷刷

目 --

曰-­扭』、』

阳3.29 画垒成方式列搜

注雹=由伐4亘生成.，方法 中所逸取的线段必须是封闭的. 扫林成.，可根据抢走路径，也可根据轮靡曲线生

~扫掠"' -

除了由点→线→面或由点-面的生成方法外， 读者还可以且援绘制面，单击 Face 面舷

上排第二个时霄， 即可弹出矩形生成酬，盹3-30 所示. 在宽、高输λ程中输入相
应的数值，即可生成炬形，其默认的生成方法是以原点为中心的. 读者还可根据需要以其他

方式生成， 只需右键单击矩形生成而板中的立旦旦旦二Jj直制选取相应的生成方式即可.
除可丑接生成矩形抖 ， 还可以生成圆与椭圆 ， 鼠标右键单击用-按钮即弹出如阁 3-3 1

j开示的样式列表. 对于简单规则的平丽，直接生成比从点开始绘制方便得多 ， 大大节约了础

模的时间.
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四 、 结制悻
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回3-3 1 实面"式列襄

立J为体绘制按钮. Jt面刷1阁 3-32 际机制体的方法是由面结合成体，即
Stitch Faces 方法， 只宿在 Sti tch Faces 面板的黄色输入栏内选取要缝合成体的所有丽 ， 单击

-旦旦-.J按钮即可. 除此方法外 ， 还有扫掠成体、旋转成体和在现有拓扑结构上生成体三

种方法， 鼠标右键时百~t阳即可弹出隐藏这三种方法的体生成方式脯， 如圈 3-33 所
刁言 . -

I亩三生IJ♀E1l阜11j垒l

阳-u 囚
圄国- . 勘咱阳回归-

It]JStLtmf .... ，叫一- ' -，叫 白_.-
旬. -桐呻.. 回国 é_her_ 

四 11 í5! Mll'Ofr_ 
.....J-'!!!! 回

四3-32 ~u阳面'眼 圈3-33 ~事生成万式列"

体也可以服绘制，帖「古「按钮弹出六面做成面敏，如酌-34 所示. 在 Wid由 、
Dep由 、 Height 在侧输入栏中输入宜、*、高即生成对应的六面体，默认生成方法仍然是以

原点为中心. 其他直接酬的体方式可用脚右键叫吉按钮，在弹瞅瞅瞅瞅
中选择，如圄 3-35 所示，有圆柱体、楼桂体、棱锥体、台悻、障体等.

一"问 I ~刁
~I: IH 俨川
叩阳 I lL.J,Æ 
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巳豆口 - -
因'-l< 六面体生..面'反

。M

血 肉~.

ð .-
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一回3-3S 集体"式列唆

违:1: 二"建棋立要遏3ι 钱也面的原则，而三，售员在模需利用视图 布尔远耳及 CAD ~1.他编助雄模工

具.
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五、 其他常用操作

除上述点、线、丽、体的建模操作命令外，还有一些常用或共高的命令，如阁 3-36 所

刁言.

，非 旦l 面切割 旦l 阳台础怖

主J '*"割 垒l 四设置

且J lea合制锁叫 王j 删除

10 ,."" 
α)时act J ~ 

巳工LI 交
鹏}-)6 真他现""蓝领巅'乍篝锢说明

• 在面和体的建立过程中，布尔运算是带植用到，主要为取井集、史集和一个面

直体减去另一个面]jt体 3 种方式.

• 与 Split Edge -样，对于面和体也可以进行切割 .
· 对于重合的点、蝇 面常需将其合井 ， ~方便边界提型的定义.

• 若觉得默认的色串不合适时，读者还可民自行设置配色方靠.

• 对错误的或无用的模型，读者可I;(JJ除 . I?).避免现增.

【实例 3- ll 几何建模实例

为演示己讲述的 GAMBIT 点、线、面、体的建模功能，下面用一个实例详细介绍模型

的建立过程.

-、 实例概述

三通管在城镇输水霄网、 输油管网 、 输气管网中均较常见， 着营内流动垂数控制不合理

就接头置装位置不到位 . ~~事局导致营路振动和穿透，所以 ， 模拟三通管内的流动可以较好

地得知相关流动喜数的变化， 为实际世计和查藐提供依据. 回 3-37 所示为三维三通管，曹

径为 8∞mm. 左侧为* 10m 的干臂 ， 在干营中间位置有一* 5m 的横直臂 ， 下面介绍其建

模过程.

1=800 

L1"" lOml D:::800nun 

Li=5m 

回)-)7 三罐三埠瞥锚法

思路分析

本例可以遵循点→线→面→体的边模过程， 也可以直接建立体模型.
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二、 模型建立

下面将结合两种方法建立本例的几何模型，用第一种方法迎立主子管，第二种方法建立

横主管.

l 通过"点 -蝇-.，-体"的建棋过程，

建立主子营.

(1) 打开 GAMBIT ， 单击控制.，品中的点蜡

制接钊亩， 在 Create Real Vertex 画板中
输入坐标点 ( 0.4 ， 0 ， 川，谅，费、为二遇苦

苦壁主-占 ， 如困 3-38 所示.

(2) 特立J按钮，鼠标右键时7接
扭，在制的列在中....，[J>棚，以刚
才蜡制的点 (0.4 ， 0 ， 0) 为源点， 绕 z

抽一圃 ， 生成一串营横截面用线，如圄

3-39 所示.

(3) 单击立J接扭，鼠标右键孕击w接
钮，在 Create Face from Wireframe 5J板中

选择刚才生咸的用蝇. 单去 "'" 接

扭，利用其生成营造槽截函，如圈 3-40

". ，、

E盘且l
F互自旦 i~'1

. 冒雪益型(1.... ... r,. 

』臼...，... Ij:-,,* 1 ..!J 

- ，旦旦二J

所示. 回).38 'I ø撞上航点的经制

1--幽幽·】
岳阳市p' 寸.!J

" 
W-I~' .!J 
呻 1*
" 旦旦一一」

..也.) .. "队， I 

.J _r，田 『一一-.!J

~-甲 II ..!J 
J 国.._(L一一-.!J(J 

"."., . - 、"…

T__. 旦4

也翩 H 
-"且.. L..!!重二~ ， -

嗣)-)9 管...面周线的绘制 阁HO 尘，.例...面

(4) 特立J按钮，鼠才甜键时百按钮，在制的列在中单击I百按钮，忡
横在画作为添.，进行拉仲A体的操作. 如围 3-41 所示，首且在 Sweep Fa田s

.，担中选择法函，在 Path 略挂中选择方向矢量万式 Vector，单去旦旦且按钮，
弹出 Vector Definition i1扭，选中 z 方向为方向矢量，在 Magnitude 中输入

10 ， 在示向 z 方向拉伸 10m，单含两次 "'" 按钮，关闲两个.，扭后即生

且4主仲后的体.
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阁341 面位伸，.成体

2 直接建体，建立横主管 .

单击立业扭， 鼠标右键单击I p 棚， 在制的列在中单击圄柱体[吉蜡制
按钮. 此时 ， 读者雷要在圄 3-42 所示 Create Real Cylinder 1iJ板的Axis

Location 中选择~:.t Y 轴为营轴， 在 Height 中输入 S ， Radiusl 中输λ 0.4 . 国为

是圆柱体，所1<:，1. Radius2 可以不填.XI.认也等于 0.4.单，j; 旦旦」制皇后即

生成横向的圆4主体， 如圄 3-43 所示.
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量意除了可"利用方向失量定义画拉伸成体外 还可以绘制-;}线让'"沿着线拉伸成体，i/;者可根据

需要自由逸捺.

3 下刷刷刷刷z轴正向制 5m，特阳按钮， 在 M叫'Copy Vo\umes 
a; i反黄色输入柜中选取横向圆柱体(即 volume2 )，在 z 方向偏移量的输入栏

内输入 5，如圄 3-44所示. 最后，单击-旦旦」挂扭，即>t.A7#动，如围

3-45 所示.
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回34' 慢肉"桂.."动后的覆嗣蝇示

违章 集体除了可以捺方向移动外，还可以定义旋转轴1 造行一定角度的旋转.

4 至此离二通管模型还呈一步，单去|否接钮，执行体合并命令. 如圄 3-46 所
示，在 Unite Real Yolumes 面提中选取前述两种方法建立峙的体 1 和体 2，单

去"'"接扭后即直成了本制模型的建立，如圄 3-47 所示.
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3.2.4 G 

通过曲

的划分任务

3.2 .4 . 1 边

由于流

将进行特殊

粘性效应明

划分边界层

一般 E

要而世计自

CFD 计算『

-特殊需要

Jii击 队

AMBIT 网格划分

作面板第二个制旦J. 可以完成罔格
其 Mesh 工具面版如!回 348 所示.

界层网格划分

体具有粘性， 精度要求较高时需对计算网

处理， 即进行边界层网格的划分. 近壁面

显血流场#数变化树，度较大的区域都应该

同格.

'AE 前处理软件是根据结构强度分析的帘

' 通常不带血边界屋 ， 因此难以满足
精度要求，而 GAMBJT 很好地满足了这

自h 面板中的第一个核Illflii . 弹出如圄
因3.48 网幡划分工具面'民

349 所示酌

Grow由 facl

#数中任意

Create Boundary Layer 面板 ， 需要在 First row (第一个同格点距边界的距离L

0 ' (网格的比例因于)， Rows (边界层罔棉点数)且 Depth (边界层厚度)囚组

输入 3 组. Trans ition pattem 选项提供了 4种不同的边界层划分形式 {J '1 . 4 

2 、 3 , I 驷 5 ' 1l. -
且I31 …

.-
』

产

' 
4 

」

E 
今之.-­

主r;: 7; 1 x ~ 1 ,-----
‘m -翩

;g丑l

;噩噩l

;量虽|
3:1 

5:1 

遗撞 t!. 考虑实际问趣的粉底要求和配件备件 选择合适的边界展网格划分方式徽问Iti& 1 : 1 即

司



【实悟IJ 3-2】边界层网格划分实1J1J

由于运动流体接近壁面处的速度梯度量大，所以在营输时常需在近壁面进行网格细化，

即划分边界层间格. 对阻 3-50 所示的圆面进行边界层网格划分 ， 在 Create Boundary Layer 

丽板的 First row 桂输入 0.005 ， Growth factor 栏输入 1 .2 ， Rows 栏输入 10. 分别采用四种不

同形式的边界层划分类型， 得出的边界层同格如阁 3-5 1 所示.

/-飞\
.‘ 

Gtj 
• 

/'卢~飞、

f J\ 
弘z...，.. G民

回'.S<I 田面

3:1 5:1 
囱3.5 I 不同形式划分田面的边界息网恪

哑王....)一参川见附带光盘" Ch川山旷咄h川13-叫-
3.tm n 、 u Ch3、13-2-b.dbs " 、.. Ch3\s13-2-b.jou ..、 u Ch3、13-2-b.trn "、

"Ch3、13-2-c.tm"、 "Ch3、J3 -2-c.dbs飞 "Ch3、13-2-c .jou"、 "Ch3、13-2-

d .tm"、 "Ch3、13-2-d.db，"、 "Ch3、13-2-d .jou飞

(I;/U")-iI见附带她 "C川1\s13-2.avi"• 

3.2.4.2线网格划分

且在击I古按钮弹出钱网路划分面板，如图 3-52 所
示 . 读者可在黄色输入栏中选取一是或多韭待划分的线

段，而后在 Ratio 控输λ比例因于，可以单调递增或单调

递减 ， 默认值为 J. 即均匀卦布 . 若同时选中 Double

sided ， 则简要输入两个比例因于， 使得划分出来的阿格

呈现中间密两端疏或中问疏两端密的形式.实际划升时，

通常可基于尺寸 ( lnlerva l size) 就段数 ( lnterval count ) 

将线段卦段. 若需要在己划好的线段土重新划分同格，需

要将 Remove old mesh 选中，以删除先前的网格.

【实例 3-3]，线网格划分实例

对一条 4m 仕的统段进行线网路划分，通过改变

坤. ~ 
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Ratio 比例因于与 lnlerva l COunl 或 Interva l size 划分法 . f.I到不同形式的钱间将形状，如阁

3-53 所示 . 圈子53 ( a ) 租圈子53 ( b ) 所示为改变划分方法得出自由线罔格，基于段数

Interval count t'rCJ划法最简单， 只需读者定义划分为多少段的段数UIJ可，而尺寸 Interval size 

划法需要读者预先估计间格的大小尺寸 ， 作相应计算后得出每段尺寸的大小， 然后输入时应

的数值. 阁 3-53 (c) 和图 3-53 ( d ) 所示为通过改变比例因于划卦出的线同楠 ， 网路分别

呈现为单调递减和单调递增. 回 3-53 ( c ) 租图 3-53 ( f)所示为双比例因于设置íJJ出的网

格，网格分别呈现为两头向中间通增租递减的趋势.
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a 缸n" 、 .. Ch3、13-3-b .dbs " 、 u Ch3\s13-3-b.jou "、 ... Ch3、13-3-b .tm "、

u Ch3\s13-3-c.dbs"、 .Ch3、13-3.-c.jou"、 "Ch3、13-3-c.trn ..、 "Ch3、13-3-

d.dbs " 、 .. Ch3、13-3-d .jou n 、" Cb3飞s I3-3-d .trn " 、 u Ch3、13-3-c.dbs "、

.Ch3、13-3-e.jou"、 "'Ch3、13-3-e.tm "、 "Ch3、13-3 - f.dbs"、 "Ch3、13-3-

r.jou"、 "Ch3、13-3-f.缸n".
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‘ 3 .2.4 .3 面网格~J分

通过 Mesh 面版第三个措d百可完成面网格的划分，其 Mesh Face喝面极如回 3-54 所
刁言.
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回)." 画同籍划分面'民

面板中的 Elements 提供了 3 种面网格划分类型.

• Quad 四边形网格形式.

• Tri 三角形网格形式.

• Quadffri 四边形网棒和三角形网格远合的形式.

面缸中的 Type 中提供了 5 种罔格划卦的方法.

• M叩 ~区域划分为四边形的结构性网格

• Submap 将-个不规则的区域划分为几个舰则的区城，并同时划分为结构性

网格.

• Pave: 将E城划分为非结构性网格.

• Tri Primitive: 掉一个三角形区域划分为 3 个四边形E埠，并同时划分为 四边

iIi网掉.
• Wedge Primitive 在-个模彤的主墙划分为三角形网掉，抽着棋形向排辐射，

划分为四边形同格.

虽然有这么多的网格划骨方法，但井不适用于所有的罔格类型 ， 具悻的适用英型如理

3-3 所示.
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划分方法

面网将划分方法适用的网将集型

;am.噩

"3.3 

Q"", τ，咱 。 ".dlTri

Mop J J 

s，巾"" J 

PIVC J J J 

Tri Primilj~ J 

WedlC Primiliv~ J 

适量z 浪者在进行曲同格划分时定要依据各划分方法适用的公犁，否则将提示同格划分失'良

【实悟j 3-41 面网格JW分实例

对阁 3-55 所示的几个面进行不同形式的面网格划分，读者只椅在 Mesh Faces 面扳中的

Elements 和 Type 进行相应的选择，如图 3-56 所示-
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阳酬 T~ ..1 
E阳 P... ..1 

阳四ε 」旦4

加 .-巳.:!l

-， 二土-"'-'
加-巳~

恻).5S 传划分的儿何国 罔J，" 不同方陪刽份出的面网将

对于四边形面，通常景用的是 Quad 单元与 Map 或 Submap 结合的划分方法.而对于三

角形丽， 来用的方法较多 ， 可以用 Quad 单元与 Pave 或 Tri Primitive 结合的方法，也可以用

QuadfTri 单元与 Map 结合的方法，还可以用 Tri 单元与 Pave 结合的划分方法，读者可根据
实际计算精度与网格疏密要束进行选择.

(UU}一，见附带她..Ch3\s13-4.dbs'"、"句C旧刷刷、15 1叫3

包E一参觑见附附带先姐盘咄川I\sl川叭

3 ，2AA 体网格划分

帕 Mesh 面也肿的第四个按钮厅将弹出体网格划分面辰，如图 3-57 所示.
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与面网格却l卦面扳类似， Mesh Volum田 面握中的 Elements 提供了 3 种体问格划分类型.

Hex 大面体网格形式 .

• HexIWedge 主要目六面体网格形式，在适当位置包告模形网.jj.
TetIHybrid : 主要回四面体网格形式，在适当位置包告六面体、 锥形和模形网格

Type 中提供了 6 种网路划分的方法.

• Map 将体划分为六面体结构化网格

• Submap 将-个不可回幸化的体分割成可固示化区域，并将每个区域划分为

六面体结构化网掉.

• Tet Primitive 持-个告四个制面的体仕割成四个六面体E埠，井持每个E蜡

划分为可回示化网格.

• Cooper 持体按照指定的罩面进行划分.

• TGrid 持体主要划分为四面体网格单元，但在适当的位置可目包告六面体.

锥体和模形单元.

Stairstep 划分为六面悻网棒，并生成一个与原始体租培植近似的平晴的体.

上述方法具体的适用类型如表 3-4 所示.

'促3-4 体网格划分方法适用的网精樊盟

划乡'方法
适用集盟

H .. γ.~叶叭"也dH.><M伺.... 

M" J 

S\lbmap J 

TCI Ptimiti vc d 

C领屑' J J 

TOri~ J 

"';昭雄' J 

，主鑫 体同格*1分J与.，网格-t导 ， -;1'.要依据各划分方法适用的类型 ， 不能混乱妞缸， 否则划出的网格质

量得不到保证.
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I实例 3-5 l 体网格划分实例

对不同的儿何体可来用不同的划分方法，如圆柱体可果用 Hex 单元与 Cooper 结合的方

法，圆古体可采用 HexIWedge 单元与 Cooper 结合的方法，六面体可罪用 Hex 1在元与 M.p

结合的方法，锥古体可来用 Te山iybrid 单元与 TGrid 结合的方法， 四面体可采用 Hex 单元与

Tet Primitive 结合的方法， 读者只需在 Mesh Volumes 面版中的 Elements 和 Type 进行相应的

选择即可，划分出的体网格如I图 3-58 所示.
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… 

(uu)一#见附带她咄h旧d趴 "Ch3\s 13 -5.jou飞 "Ch31s13-5 田"·

巨E一番见阳光盘 "Ch3IAVI\s13-5旷.

3.2.5 GAMBIT 边界定义

在完成了几何应模与网格划分之后. GAMBIT 还要完成的 项任#就是边界定义 ， 主

要升为边界类型定义与介质类型定义.

时r.-按钮，弹出如圄 3-59 所示的边界定义工具面板，共有两个功能按钮，从左到
右卦别为边界类型定义按钮与介质类型定义按钮。

定义边界类型 定义介质集型

回3-59 jJJ.界定义工风面饭

一、 边界类型定义

在图 3-60 所示的 Specify Boundary Types 面板中 ， 读者可以添加、删除或悻改边界类型



的定义，井可在 Name 输入程中输λ区别性较好且使于记忆的名字，这里提供了 22 种流动

进、出口边界典型，其类型列表如图 3-61 所示，被定义边界提型的时且通常为线、面就

组.
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附3~划地界袋盟定义面'反

… 
四H I 地界然型，咱褒

下面介绍儿种常用的边界类型.

• WALL 壁面边鼻，或非为回体壁面，通常用于阻制班体和固体E绒.懂英型

定义后可在 FLUENT 中具体定义其为静止. 运动 晴晤'民弗边界.

• VELOCITY _rNLET 速度λ口边界，谊是型定义后可在 FLUENT 中输入具体

的流动入口速度和#量.

• MASS]LOW_rNLET 质量撞动人口边界，定义后可在 FLUENT 中输入具体

的质量班遣，惶提型适用于可压缩施体，对于本可压缩班体大可平必定义此种

英型.

• PRESSURE_INLET 压力入口边界，读英型定义后可在 FLUENT 中具体输入
入口边界的j/，压、静压等标量.

• OUTFLOW 出口施动边鼻，谊边界用于模拟未知出口速度或压力的情且，假

定了除压力之外的所有埠动变量正培向的棉度为草.不盹用于是且可压缩班动

的边界.

• PRESSURE OUTLET: 压力 出口边界， FLUENT 中可输入具体的出口静压

值，当有回班时，使用压力出口边界代替 OUTFLQW边界往往里事昂收散.

• PRESSUREJARJIELD 压力远描边界，用于模拟无费远处的自由可压施

椅，只适用于可压缩班动.

• SYMMETRY 对称边界，用于研究对卑具有幢幢特征的情况

• AXJS 抽边界，品霸使用在几何外形的中虽是

• INTAKE FAN 进气扇边界，用于模掘外部进气扇， FLUENT 中 霄'耳纷走压
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降、施动方向.周围环境的单压且总温.

• EXHAUST FAN; 排气扇边界，用于模拟外部排气扇， FLUENT 中菁蜡是压

力耻..且周围环境的静压 .

• INLET _ VENT 进风口边界，用于模掘进风口， FLUENT 中 '给是损失>>­

盘、施动方向.周围环境的且压且且 yE.

• OUTLET _ VENT 通风口边鼻，用于模拟通风口. FLUENT 中'蜡定损失革

最.周围环境的静压和静温.

撞撞 边界集型定义时应根据实际的统体流动性质选择合适的边界集型，尤其是区别可巫蝙流动还是不可

2军蝙流动.

Speci印 Boundary Types 面板中的 Show

labels 和 Show colors 可方便读者查看己定义

好的边界，如困 3-62 所示. 对于复杂的儿何

模型，打开标签或色彩可以大大提高边界定义

的效事，井可避免错误定义或重复定义.

二、 介质提型定义

*'专丁U川川川叫"川F川B仙飞飞" 、、υ呐…矗

飞

单击而按钮， 弹削出 s加W阳阳i崎咛 Cω。m删删n旧nti阳m
Types 面极，如圈子63 所示. 对于固体与流体

共存的计算模型， 如流体与固体之间的传热问

题， 需要定且不同区域的介质樊型. 面板中的

Type 选项提供了团体和流体两种类型，如圈 3-64 所示，被定义介质费型的对串通常为面、

体或纽带区域. 其最填加、删除、修改、命名且标签、色彩显示功能等与边界类型定义相

同 ， 在此不再详述.

f / , 
'.' 1.0':11、，、‘", 

图3叫"打开 S怕w 1."和剑-""榈树的...慢图
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3 .2.6 与 CAD 软件的衔接

• 

简单的三维儿何体可以在 GAMBIT 中直接创建，而复杂实体贝IJ 需要借助于其他

CAD/CAE 革统的软件， GAMBIT 允许从主流的 CAD/CAE 罩统如 ProÆNGINEER 、

Ansys、 SolidWo阳、 Patran ~ UG 、 I-DEAS ， CATIA 等导人儿何体和阿格.

GAMBIT 支持的 CAD 软件几何接口如下.

• ACJS 支持 ACIS 各种版本的几何瞌据.

• IGES 可阻导入 IGES 几何量据，并可在读入时自动清理重量的几何单元.
• Pro/E VRML 可制导入 Pro/E软件的 VRML 格式的几何推据.

• DEAS FTL 可阻导入 I-D且S 软件的 FTL 串串式的几何推据.

• CATlA 可J;(导入 CAllA 杜仲的 CATIA V4N5 格式的几何量据.

• 还支持其他 STEP、 SET. Parasolid . Optegra Visulizer 等格式的几何世据.

将 Aut() CAD 绘制好的图形导λGAMBIT 的步骤如下 .

• 首先在 CAD 中 克JI<田形的蛙制 .
• 在命令面缸中单击画按钮，选择图形的轮廓蝇，右击革措 þlnted键.
• 执行某单命令 Fi1e-Export. 选择保存韭型为 ACIS ( . .5a仆，输λ合适的文件

名，如 guan l.sat .

· 再攻选择圄J晤的轮廓住， 在击且按匾曰键.
• 打开 GAMBIT，执行革单命令 File→ Import→ ACIS，输λ文件.:t guan I.sat , 

或JA. Browse 中选取，如困 3-65 所示，即可持 CAD 中娃 .J 的圆形导入到

GAMBIT 中 .

「 豆
国甲鱼阳叫… 1---1 
-民剧而-

甲二 ·四 、..-

.J _C '. "--
-巳J -J 

!113-6S 导入 ACIS 文件

革窟 GAMBJT 只能利用坐标事数边行图形定位， 因此在 CAD 中绘制圈 .j时袅i主意坐标的i牟取(如起始

点"坐标A事局}

【实例 3-6 ) 二维埋地输液管传热模型与网格划分

本实例主要运用 GAMBIT 进行二维几何模型的建立且网格的划分， 其介质类型渺且到

班悻与固体两种.

-、 实例概述

如图 3-66 所示， 对于埋地输液臂 ， 管内具高较高温度的液体流动， 曹外还包裹有保温
居且沥青层，沥青层外为土擅环撞，若要考虑营内液体的温度变化过程，则需要建立整个系
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统的传热模型.

本例的输液曹为 φ426x7mm 铜管，营中心埋深为 1 .5m. 管外保温层厚度 崎mm. 沥青

层厚度 6mm. 由于涉且~J与土攘环捷的传热问题，需要毒虑大地恒温层且管道热力量E响区

的水平边界来划定土攘区域范围 ， 本例中选择土攘垂深 1 0m. 水平方向的热力半径为 8m .

思路分析

由于问题具有对称性， 实际建模时可以只建立一半， 而将中心垂线世置成对称边界. 另

因模型相对直杂，儿何建模时尽量遵循点『线『面的过程， 以避免重合的线就面的存在.

通过本实例的演示过程，读者将学习到2

• 点的旋转创建;
• 圃盟的娃制，

• 蝇的分割 ，
• t呈网榕的单调递减划分，

• 非结构网#划分，

• 现合网格划分，
• 边鼻与介盾是型的是5( .

(uu) .li!.附带先盘. Ch3\sI3-6.msh ". • Ch3\s 13.6.d旷、.. Ch3\s13-6.jou " 、
"Ch3飞513-6位n飞

(uu )-.li!.NHIH'tA 'c…13-6.avi" • 

铜管
:‘ 

H- '伽m

土拽

保温层

液体

回，... 二维埋地."'"传始问题描述

二、 铺型建立

遵循点-线『面的过程建立右半区域的几何模型.

l 管道革蝇.

( 1 ) 点的创建.

以坐标原点为圆心，根据铜管尺寸且保温层、沥青层厚度，计算出 x 方向四弧上的点坐

标分别为营内壁 (0.2 1 3. O. 的，管外壁 ( 0.22. O. 的， 保温层外壁 (0.26. O. 肘，沥青

层外壁 (0.266 . O. 的.

单d百-[百-v. 在 Create Real Vertex 面扳的 x . y、 z 坐标输λ栏中输λ(0. 0, 



的，单击ζ豆画工l按钮生成坐标原点，随后按同样方法桂改建立点 (0.2 1 3 ， 0 ，川、点

(0.22 , 0，的、点 (0.26 ， 0 , 0) 和点 (0.2面， 0，的，如圈 3-67 所示. 单击~按钮，
在 MoveJCopy Verti四s 面板的黄色输入栏中选取 vertex.2- vertex.5四个点，视圈中呈红色显

示，如图 3-68 所示. 然后，选中 Copy 与 Rotate 选项， 在 Angle 栏输λ 9() ， 层在击--.!!应-.J

按钮. 重重点复制步骤， 改变 Angle 为-90，再复制出 4 个点.至此，已经在视图中绘制出

了所有圆弧壁面上的辅助点，如回 3-69 所示.
E 明

t'---?- ,. M • 

1-且皿，."
a惆-

" 
丽画画

-恤' , 
叫Z

~-， 
V叩 e一

ffi丽..

佛，

斗
陶- -

固l~7 矗立x 方向 5 个主要辅助点

,. 

里缸色显示

_a..I..，.阳

"队队的， ，队 .. η

军.为簸'舍"

回l~' 点的旋转创建

• 
拿

G, 

• • 

(;11 •• 

商l~9 生成的，，，.系统辅助点

渣.: GAM81T 中的提份以退时针方向为正，顺时针方甸为负，读者应根据需要输入"-确的旋转角度值.

(2) 域的创建.

单叫百→!亏，在 Create Circ巾 M 面缸中以第一种方式绘制圆弧，选择原点为圆
心， 点 2 和点 6 为圆弧上两点，单击丘豆画主E量钮，建立如圈 3-70 所示的困弧.

依次建立所有的圆弧曲线，井连接y方向管径所在直线，如图 3-7 1 所示.
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回J-70 圃'‘的始制 回 }-71 1õ两位的右辱"<1赢镜几何鲍

。)面的创建.
在 Create Face from Wireframe 面板的田ges 黄色输λ注中选取需要阁成面的钱段， 单击

-旦旦-1按钮生成儿何面， 右半管道系统的几何面如圈 3-72 所示， 共 5 个面.

面 3

面4

捆'-72 生成的右孕WìI'-:缝儿何副

由于建立的管道~统圆心位于坐标原点， 而实际管道中心，埋深为

制好的几何面均作iJ Y 轴负向移动 105m.

面 1

飞、、、.. 圃，

‘ • 
k ‘‘勘" 

w 

1 05m. 因此需要棉绘

3 个国

寝示

"'m 
民
臼

回)-73 移动生剧院的面



，主.: GAMBIT 中儿何尺寸长成单位为 m. 因此在实际创建过程中，需要将尊位均模界A战术

2 土壤E域.

土壤区域的 4 个顶点为(0. O. 的、俑. 0，川、俑. -10 , 0) 和 (8. -10 , 0)，点绘

制后连接成钱，由圈 3-74 所示的 7 j民线围成第 6 个面.
ιu 

tÍ\ 

@ 

⑧ 

面6
⑥ 

"' 01 土搬区峨

⑨ 

⑦ 

回'-7‘绘制好的土坝区‘民

三、 网楠划分

对于事区域几何模型，网格划分通常按照由难到品的顺序，本倒先对管道内液体区域进

行划分，其次是营造各层，屋后是土壤区域.

1 管道革蝇.

(1) 营内液体E域.

在 Mesh Edges 面敏的Edges 黄色输入栏中选中阁 3冉所示的 5 根线，选择 lnterval

Count 分段方式，井在左侧输入栏中输入咽，将每矗线均分为 40 段.

呵'喃

- 旦旦旦立旦旦=-l
丘~ ~--
- F = 

分成"段

时

' …*­
J …… 
回).15 "内液体区峨的钱网输划分

时古→~，打开 Mesh Faces 耐，选中已经完成翩翩分的面 1、酌，运用
。皿单元与 Tri 阳mitive 方法对这两个面进行划分，其间格生成情况如圈子76 所示.由于

-
m
3
事

前
处
理
同
将
生
成
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遵循的是由钱到面的阿格生成顺序，所以 Mesh Faces 面阪中 lnterval Size 左侧输入栏的默认

值为 I ， 不需更改， 直接单击 "'" 按钮即可.

E
÷ 

亏~ 回3-76 管内H集体区榻的面网'鲁划分

川 洼白 面 i、们还可以适用 Pave 法生卓网格，但是生Z祀的网格疏街不「不如文中的生ì'.方法好-

~ I (2) 管道各品.
实 El 沿径向将铜管层分为 4 段，保温层 11 段，沥青层 3 段，半圆弧均分为 80 段，划分好的

理主| 钱同格如1圈 3-77 所示.
握主| 时钢管、保温层、沥青层均果用 Quad 1.在元与 Map 方法进行丽间将划分，绘制出如阁

升 13-78 所示的网格.
扬

在
真

回)_n 'lfil~应战网幡划分

- IT'一一一一一 主l

… 
\主正 吃三

面，

甲…
J…~四J__..... 
._-一=旦旦=旦」

』

} ' 句.. 

楠'遭各 E
因

1且划分为

四地'"蜡 -仰"精

句幅画明. 冒棚旦~

- ._. 
」阳回-*-由

」 阳恤'呻恤圃.~由

回3-71 曾划...貌的嗣同'鲁

2. 土壤E域.

首先， 将代表土填区域的地表面与大地恒温层的两个水平线段用 Interva l Count 方法分

96 



为 60 段，将代表热力量E响区边界的土壤区域右侧垂直线段划分为 80 段.

其次，对 y 轴上管道上部的垂向钱段进行划分，由于越接近曾遇系统的传热敢应越明

显， 因此将该线段进行单调递减划分. 在 Mesh Edges 面扳中选中该钱段，此时， 该线上告

出现一个红色的箭头，此箭头代表了比例因于作用的方向.在Ratio 输λ栏中输入 0.95. 选
择 lnterva l Count 方法. 井输入 40. 将钱段以比例因于为 0.95 单调递减地分为 40 段，如阁

3-79 所示.

再汰，对y 轴上管道下郁的垂向线段进行划分， 该线段仍然采用越撞近管道系统间将越

密的划法. 选中读钱时， 出现了一个向下的红色箭头，因此在Rati。输入栏中应输入一个大
于 1 的值〈若输λ的是小于 1 的值，则划分出来的同格离管道越近反而越疏l. 本例中输λ

的值为1.035 . 运用 lnterval Count 方式将该线段划卦为 75 段.

;洼' 辈出现缸色箭头时.J.标中4t'院去该线，箭头舍/i..向，即 ~a垂直向上的箭头，此时对应的比例因

子应t盒里小于1.

最后，对土横区域进行面网格划分，由于土壤区域为不规则图形， 且各钱段的网棉数不

一，因此采用币， 单元与 Pave 万法进行面网格划分.划分出来的二维埋地输液管作热问题

的同格如阁 3-80 所示.

一
r，~ 

~ 1".， 8 一一-.!l

. -响由旦旦l

-- ，旦二l
.腼…叫

@晴咽..附旦旦i

""" :SUCCI1旦旦4· 注鑫.'"方肉，此
时往下!代褒向市

以 U$ 造"
· 单司旨鼠标哼..可以

切倏谅箭头的方向
zpifE 

面主主
h … ' …"…h . -伽·阳宵伽·

-"'" -- I~旦」
阳)-80 二罐罐地.罐臂俯然问题的阙恪附)." 划分尊测边喊例臼阿精

四、边界定义

模型与网梅绘制完后，需要进行边界的定义， 本例涉且到边界类型与介质类型两类-

1. ;t且边界典型 .

由于模型中的钱段枝事，为精晰定义各线段的边界类型， 可以先关闭阿格显示. 单击

盟如钮，在弹出的如困 3-81 所示的 Speci印刷splay Attributes 面板中将 Mesh 显示选择为
。霄， 单击-豆豆己J按钮即可实现网格显示的关闭.

本倒有 WALL 与 SYMMETRY 两种边界类型• y轴上所奇的钱段均设置为 SYMMETRY

'
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边界 ， 其牵线段除上、下 1 /4 圆中间的那矗水平线外部设置为 WALL 边界 . 为了在

FLUENT 中能略分辨各边界的名称，在 GAMBIT 边界樊型定且时，需要读者输入便于记忆

和识别的名称，如圈 3-82 所示. , 
~-

-.11单且斟斟.::J....1_ ~a---~ 
J嗣同 ~rr---- .!l 
J 陆.. _!~_=..lIr一-~
-- 且.:Jr- 主j
...t - ..!!..:.lJr一到
巾- .!!...:.1 tr一主j
.J C. .,. ..!!...:.l rr---主1

翩翩. 刊"
blao-milJl WALl 
d• mlw WALL 
归~bI町 WALL 
dulchenlhou SYMMETRV 

gw盹U剧、-n. lb l WALL 

..- ... "" 、，­
d皿 叫.~

d一….~
'田 、， 00 . .. 

J…」巳.:J
…町

-"皿_L旦旦!...l-

1113.81 笑佣陶楠显示镰作 因).82 j;忘义"的也界'随凰名称列貌

单击 Show Labels 可以查看定义好的边界类型， 方便读者检查E主义是否正确 ， 以且查找

来定义的钱段， 如阁 3-83 所示.
M 

P 

J 
.四'.啊'附

'-'咀民
'_"_1脚

I~V"S~ .. 阿旺'制 叫队削J.83 窗看己定义的边界费'阻

，主童z 对尘、下 1 14 圄中间的水乎钱不进行边界'巨型是义操作 ， 导入 FLUENT 后舍lR认MJ 内部箴，Ip相

当于不存在.

2 走义介盾是型.

管内高温液体与管道各层且土攘耳撞之间是一个非稳态的传热过程， 所以需要将臂内擅

悻定义为流体，其最区域〈包含铜管、保温层、沥青层且土填}都定义为团体.

在 Specify Continuum Types 面握中 ， 通过 Add 逐个添加各个区域的介质樊型， 井赋回

合适的名柿 ， 选中 Show colors 后如固 3-84 所示.管内液体呈现为绿色， 其余固体区域呈现

为灰色.



五、 网幡输出

执行 File→ Exp。同-M田h 命令，弹出如图 3-85 所示的罔将文件输出面展， 在文件名中

输入 s13-6 .msh ， 井选中巳慕田n .:;-u 飞 ^-， J JV:lQn , -ø:. "J、，国 Il .Jn一隔睛里同帽Arr .

R~~晶.

，幢幢

· 刷 、， .阳"即

. ~帽 、，~…

白 ",. 

"叫 m 

… 且@

…崎 跑'

"M '呵 由
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二三巳~r一一 主l
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肉-啕，~

因3.84 介厦樊型定义

• 

国喃自 ωa，_帽"阳回τ幅

画-= liíi=.- 一
2 创协"翩翩

-.1 ~I 

- .-1 

圄3-8S 网幡.出面'反

【 实例 3-7 1 三维曲面啧管流动模型与网格划分

本实例特运用 AutoCAD 进行二维模型的建立， 然后导人 GAMBIT lJ!立三维模型且划

分网将.

-、 实例概述

流体通过图 3-86 所示的三维曲面啧管，流速、压力等特性#数将发生一定程度的变

化，其变化大小正是喷管世计且安全输送的有力依据. 如高速气体作可压缩流动 ， 通过喷管

后是否达到超音速?再如原油在流动过程中蜡、沥青质等沉积于营壁可能舍形成图示流道，

其对后续流动与沉积的.，响如何?这些都是我们所关注的问题.

本例曹长 山n，在 4.8m 营性处存有-*为 O.72m 的喷营， 流体从左端流λ， 通过喷管

后由右端流出.

「
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回3-86 三'量画面啧"穗砚'震型描述

思路分析

本例管道为一旋转轴对称几何体，可以先绘制二维困形，然后旋转生成三维实体. 由于

本例涉且曲面，而 GAMBIT 的曲面绘制功能稍弱，所以借助 CAD 绘制出基本的二维图

形，然后导λ GAMBIT旋转生成儿何悻.

通过本韭例的演示过程， 读者将学习到 2

• CAD 固形导λGAMBIT;

• 二蛙平面旋转生成体，

• 边界层网格的划分，
• 面网格的划分，
• 体网格的划分，
• 网格质量的量晴.

g王~-.凯见附附带先蛐盘 "C由h旧刷川3\s 13、回l臼3-7.sat盹皿旷a创旷t俨"

包u) 参凯阳见删附带先盘 "咄w叩凶ωω3\S蚓削灿、M胁l口协3-叫"、， "C吃Cωω叫旧胁刷叩\sl咄胁13协3弘川­
"吃Ch旧3飞、M咄，1ωl口3-川-习7 回"飞• 

(....u)一→，凯阳…见酬阳附附带先蛐盘 "Ch… 
二、 穰型建立

1. CAD 蜡围 .

由分析可知 ， 只需在 CAD 中绘制如图 3-87 所示的二维模型，其中啧曹曲线部分用样矗

曲线绘制.需特别指出的是，图形应以坐标原点为起始点，以方便导人 GAMBIT 后较好地

将图形定位.

L 
4,8 严马 4.48 

) 

网).87 CAD 始制的旋转销对称二.回到医

绘制好基本的二维图形之后，通过命令面板中的ßlI按钮，将回扉生成面域， 最后输出

文件名为 s13-7 国1 的 ACIS 类型文件.

2 , GAMBIT 建模.
打开 GAMBIT. 执行 File- Import-ACIS 命令 ， 在弹出的 1m阳rt ACIS File 时话框中幢

λ立件"" ，13-7 国t. 将 CAD 绘制好的阁形导λ~J GAMBIT. 如回 3-88 所示.
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t ..J‘ ‘ -'" 
回).88 导入 OAMBIT 后的二罐回到医显示

单刮百-~， 弹出如图 3-89 所示的 Revolve Fac白 面敏. 在面缸中的 Faces 在侧黄色
输入框中选中画好的面 1. 井在 Angle 输入拦中输入 3曲， 表示将该面旋转一周.

由于 Axis 默认的是以 z 轴为旋转对林轴， 而本倒应为 x 轴， 因此需要尊击 Axis 右侧的

Deflne. 在弹出自由 Vector Oefinition 面扳中 ， 将 Direction 下方的 X 选中 ， 即使 X 右侧的

Positive 按钮里红色显示， 如阁 3-90 所示.

二一
一』 l ~" l旦I

.咽. l可
抽

~卜' .阳... 叮 ~. _. 
"" " '皿....0 .J 同刷刷 以 z 铀.... 1. 为'由"

"W.…h 孙 8年'自

…Qw: ' ~-­
-.t: (W. . , 1) ... …>
" "刷刷 E

闹剧 二旦立旦与J

-石:-j百示=主l
由国:

出
川

剧
m
M

...!!旦J~旦J -
阳3 饲 Vcctor De finil阳面'民刚3-19 Rrvol~ F鹏销商'民

Revolve Faces lf1抵命的 时由 mesh i牟项 农示可以在爆面上纷倒好网格， 连同网格-，毒徒待生成

体.

单击两改-旦旦--1按钮， 关闭 Veclor Definition 和 Revolve Faces 面岖，生成的三维实体

如图 3-9 1 所示.

建..

阴).9 1 始制好的三维幽面啧管流动帽塑

三、 网棉划分

三维实体的问格划分可以以一个而为源而，轴向拉伸生成整个体网棉. 因此选择 X~。

这个面作为源面进行面同棉的划分.

由于考虑到仰的近翩翩翩， 首先需要绘制边界层附. 单击[百冉L
[fF ， 弹出 Create Boundary Layer酬， 在 国p黄包输入栏中选取钱 7 ， 棚中该拙出
现一个虹包的箭盐 ， 代囊墙边界层生成的方向. 然后选中 川 的边界层生成方式， 井设置第

一个点距壁而距离为 O.OO lm ， 边晴比例因于为 1.2，边界层为 4 层. 噩后，单击 "'" I按

钮即绘制完边界应间格， JlII 阁 3-92 所示.
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边界层同格划分好后 ， 下一步将对源面进行而网格划分 ， 本例选取 Quad 网格单元和

Pave 划分方式，在 lnterval Size 输入栏中输入 O. I. 生成如图子93 所示的面同格.

;EWI… 
… 

\
飞
1
i

叫
//
/

\rl 

\ 

/
i
l\ 

帽由一旦~
M叫时 同r-一
白白·酬 1， 1 一

r-一:LJ一--­

- ，一一一一
:LJ 

翩翩 (D) Ii百- 一一

"-一J呻甲呻

\ 申千斗 J

J 飞 'r: 十

'洒-.-民
· 川、"ε ... 3 . 1 、~ $,1 

阳刚阳恤. <1'---

旦旦1''''1 二::J.!I
阳 l' 一一一一

---.1_旦旦J -
回 3-92 Creale BωlIIdaly Layer而'民 因).，日纷倒好的源面网将

愚后一步，将源面网格在刷刷，生成体同格. 此时读者只需执行回→F体网格
划分命令，在 Mesh 、olumes 面握中，选中该实体 ， 以 HexIWedge 网格单元和 Copper 划分

方式进行体同格划分 ， 井在 lnterval Size 输入栏中输入 o. I. 划分好的同格如图 3-94 所示.

f 

/ 
附3-94 绘制好的三锥~面啧智体陶幡

四 J 网格质量的检查

单击视图控制面阪中的旦J按钮， 弹出 Examine Mesh 网格检查面板，读者可以根据此
面板进行网格质量的检查.

面板最上部 Display Type 选择栏中有笛卡尔坐标罩、睹坐标系与质量值范围三个选项，

通常用到的为第一个剧第三个.当选中第一个按钮时 ， 如图 3-95 所示，针对三维问题， 读

者需选择三维网梅单元， 其中包括六面体、四面体、锥体与棋形体四种〈若为二维问题，需

要鼠标单击 3D Element 后选中 20 Element . 包吉四边形与三角形两种网格单元).通过拖虫

Cut Orientation 下方的 x ， y、 z 三条滚动轴，可以检查实体内不同截面的同格. 若选中" , 



或"+"按钮， 表示在选中的截面基础上向jJ，向或正向的所有网格都被显示在视图窗口中.

该面板中还有其他视图控制命令按钮，均起到增强可视性与方便网格检查的作用，在此不做

详述.

过童 读者雷根据实际模型'"-网格划分俯况选择显示的

玛格单元，.$-例中只涉及六 oi体与棋形体两种形

式 ， 故只选择二馆网格单元的第一和第四个按

钮. --
嗣-. I!!3 I f!! I且i且iJ-'!J.-.叫当选中 Examine Mesh 面握中 Range 质量也

范围按钮时，面板如圈子96 所示. 同样选中三

维网格单元的六面体与棋形体按钮，质量类型选

为 Equi Size Skew，表示通过单元大小计算的歪

斜度〈或选择 EquiAngle Skew，表示通过单元

央角计算的歪斜度)，此时会出现绿色的质量值

范围柱状图，柱状的高低代表了该质量值网格所

占的单比重. 质量值为 o 时表示同幡质量最好，

而 1 为网格质量最茬，通常应使同格质量值控制

在 0-0.4范围内 .

通过单击柱状图中表征不同质量值的柱辈，

可以在视图窗口中查看该质量值范围内的同路及间格的具体位置，如图 3-97 所示.

V
ωa
v
z
 

、，

= t口--
T 3 

面

因3-9 5 网将细节检查

，町 、， Sf>M<o . A呻

旦旦4日<1> I <1> /IiJ 
叫， .... 

Ecp;OSa. iII.OW ..... I 
时陶.

-配吨~且」且i旦」
，阳"蜘­
民配--帆

.叫...- ，，-
Lowcr, 0 Up隙r ， 0.1 

• -…,-
……，制<"且'
」阳叩…

Lower, 0.1 Upper< 0.2 

倒3-97 不同质量倪施用的阙幡显示

遣'监 若EquiSize Skew > 0.91 的 网格数占总同格数的比重较多时 i 需要对网格进行重嘶划分，否则计算很

容揭发'比 .
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五、 边界定义

本例只寺察流体在营内的流动，因此平涉及介质类型的定义，只需定义边界类型. 对于

气体通过喷管的流动 ， 可以将而 X-o 定义为压力入口 ， 而 X-1O 定义为压力出口，其余管

ll't为壁而·而对于液体通过该臂的流动 ， 则可以将而 X-o 定义为速度入口 ， 面 X= I O 定义

为出口流动边界，管堕仍为ll'tl町 ， 其定义好的类型列衷曲I阁 3-98 所示.
m ",. 问

.~， 

" 咀。C~_瞅盯

" 由 ""',,0. 
.~， 

据度体槐动 气"槐动

阁'-9雹定义好的..界线蜀州襄

六 、 网格输出

与 【实例 子付 一样，划分好的同棉需要导出为 msh X件， 在困 3-99 所示 ExpOr1 Mesh 

File ~t话框巾 ， 输入文件名为 sI 3-7.msh . 与上例不同的是 ， 此时不用选 Export 2-D ( X-Y ) 

Mesh j1项，表示输出的是三维模型网格文件.

l、J
fII T'fIOt: _ 5 I阳时，明町属

阳帽.: r在市，

" -叫"~.

--.1 

- 1 旦旦」

网'-99 同幡输阳对~棍

3 .3 本章小结

本章主要讲述了前处理软件 GAMBIT 的使用方法和1步骤，包括几何应模、同棉划分、

边界定义等. 通过两个分表代表二维与三维模型的实例讲淫，辅助读者掌握 GAMBIT 的建

模与网路生成方法， 为后续导λ FLUENT 计算打下基础.

/ t 
v晕

l> 灵活运用 GAMBIT 的a我 蝇、，iJ 体遣祺工具可生成理想的几何模型 ­
)> GAMBIT 网格划分要注意网格单止与典型的组合.

> 叶子$!þ"及固体与A体区战共存的问题，要注意定义介质典型 .



第 4 章

浦流模型

油施是自然界广泛存在的流动现犁 ， 在多数工程问题中流体的流动往往处于揣流状态，

如大气、海祥环境的流动 ， 飞行销与船舰的绕流， 叶轮机械、化学反应器、旗反应据中的流

体运动部是泊流. 正是由于揣流特性在工程中占有噩噩的地位 ， 揣时LlMt-n槛研究者高度

重视. 端流流动的核心特征是其在物理上近乎于无穷辜的尺度和数学上强烈的非线性，这使 11' 

得人们无论娃通过观地分析、实验研究还是计算机模拟来彻底队识端流部非常困难. 相比之
下 ， 计算机模拟要盟共可操作性，但情要我们继续探求高精度的计算方法和实用可拙的网棉

生成技术， 在研究附前i~l理的同时 ， 跑立相应的模式 ， 从而进行适当的模拟.

本章不深λ涉且柑流的事II里 ， 主要介绍监展至今常用且重要的涮梳模型，井通过两个实

例介绍如何在 FLUENT 中进行泊流流动的模拟.

本章要点

• 瑞流在动的特征及分提.
. 方程模型.
• k-ε 模型.

~ 本章案例
三角翼绕革分析.

吏扩管内班体施动分析.

• RSM 模型.

• LES 模型.

• 瑞撞撞动实例.

••••••••• • • • •••• 句号 -.._._-- ‘._----_...............__....................__...__.. .-_...__...........__..._--_.. 



4.1 常见的消流模型

雷诺试验表明，当雷诺数 ( Re ) 小于某一临界值时，流动是平滑的 ， 流体质点互不混

静，有条不置地作有序的成层流动 ， 这种流动状态称为层流.当雷诺数大于临界值时，流动

呈无序的混乱状态，这种用部速度、压力等物理量在时间和空间中发生不规则脉动的流体流

动，称为端流.端流中的脉动现靠对工程设计有直接罪响，压力的脉动增大了建筑物上革呈

风载的瞬时载荷 ， 有可能引起建筑物的有害振动 对于水轮机而言，脉动压力最大的负披峰

则增加丁发生空化的可能性.

一般认为，无论揣流运动量5么复杂，非稳态的连续性方程和l N-S 方程对于揣流的瞬时

运动都仍然适用.在连续性万程和 N.S 方程基础之上，人们不断引人新的算法，逐步发展

成了多个揣沈模型，主要有如下 3 类.

• 瑞施输运单盘棋型，即将速度胜动的二阶关联量表示威平均速度梯!t与瑞施枯

性~姓的多在租，模型的任务就是蜡出计算瑞施枯性革量的方法 . 根据建立模型

所需要的世分方在的个世，分为军方在模型、单方程模型和;R方程模型 .

• 直接建立瑞施应力和其他二阶关联量的输远方程.
• 把瑞班分成大尺度满温和小尺度瑞埠，通过求解三维经过修正的 N.S 方程，

得到大涡革的运动特征，而小涡旋运动则最用上述以瑞璋的统计结构为基础对

所有涡进行统计平均的模型. 这种模型称为大涡模拟.

FLUENT 提供的端流模型如图牛1 所示，实际求解中，应根据具体问题的端流特点来决

定. 选择的原则是精度高、省时、筒单通用.
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后面各节详细介绍几类常用的揣流模型且其控制方程.
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4.2 一方程模型

在介绍一方程(单方程〉模型前，首先给出捕流时均的连续性方程与雷诺万程2

ðo ð 
工t:+一(阳， ) ~ O ( 4- 1 ) 
ðt ðx, 

3忡去(pu，UJ )~去云(μ去而]+s 忡 2 )

2(N咱时)刮r去 ρ石]+S 叫
单方程模型在揣流时均的连续性方程与雷诺方程的基础之上， 再建立了一个端动能 k 的

输运方程，将揣动粘度μ，表示成 k 的函数， 从而使方程组封闭. 端动能 k 的输运方程为 g

旦丝且L旦血L主I r uιμ+丘刮1 8兰ι |ι+叫μ l 生坠L+生坠Ll险鱼坠L ρκC
ðt a缸X; a缸!xj [川I . σ川‘‘l缸缸凯J [γ. '1 ð.凯x巧j atx, )atxj • " 1 

从左至右 ， 方程 ( 44 ) 中各项依次为瞬态项、肘流项、扩散项、产生项、耗散项. 由

曹朗特表达式有

Pr=ρ~~ (时〉

式中， 町、 CD、 G为经验常数，的叶 • CI'=O .09 , Co =O.OS.......0.38. 
一方程模型中如何确定'"度比尺 I仍为不易解决的问题， 因此很难得到推广应用.

4.3 k-E 模型

弘e 模型为双方程模型 ， 是在一方程模型的基础之上，再引入了一个关于澜动括散率 e

的方程. 该模型是目前使用最为广泛的揣流模型，卫升为标准 kε 模型、重组化群 k.ε 模型

和可实现 k.ε 模型.

-、 标准 k吃模型

在梢动能 k 方程的基础上，引λ一个柑动挺散率ε 的方程，形成了 k号双方程模型 ， 称

为标准 k.， 模型. 该模型于 1972 年由 Launder 和 Spalding 提出 . 模型中的 E 定义为

ε ~ ~(去)(去) ( 4.6 ) 

于是， 端动粘度μ，可表示成 k 与 ε 的函数z

A=PCME . c 
( 4.7 ) 
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因此， 标准 ιε模型的输运方程为 。

旦出+旦旦ι立I(μ+丘)坐 1 + G. + G. - OE - y" + s‘ (4-8 ) 
ðt ðx, ðx, I \.' 吗 ) i泣"j J • P' ，..帽

主字i噜，L~J(什)去]+CpfMGH2 4吨 叫
其中

ι = μ I鱼+生L1生L
ar'laxJ Eh jaxJ 

G=hstZ 
p =_2... ð，ρ --- -­

p ðT 

凡~ = 2ρsMf

M, =.fk瓦7

a=JrRT 

( 4-10 ) 

式中 ， G， 是由于平均速度梯度引起的漏动能产生 G. 是由于浮力黠响引起的揣动能产

生 Y" 为可压缩泊流脉动膨胀对且的挺散草的影响 C" 、 C挝、 C" 为经验常数， FLUENT 
中默认值为 C1，"" I.44 、 C:.e- 1.92 、 C).<=O.09: 由、 n， 分别为涮动能和1捕副院敝率对应的普朗特

数 ， FL四NT 中默认值为 0'.- 1.0、 t1，，=1.3; Pr，为揣动曹朗特数 ， 默认取 P呐 85: gl 为亚力

加速度在 ， 万向上的分量:β 为热膨胀系数 M为端动马赫数 a 为声速.

标准 k-c 模型中梢动能的输运方程是通过精确方程推导得到的 . 但蜒散率的方段是通过

物理推理且散学上模拟相似原形方程得到的. 该模型假设流动为完全端流， 分于粘性的罪响

可以忽略 ， 因此，标准 k-c 模型只适合完全漏流的搅动过程模拟.

二、 重姐也群 k-ε 模型

11!组化群 k-c 模型 ( RNG k-t: 模型〉是由 Yakhot 和 Orzag 提出的 ， 宫是对瞬时 N-S 方程

用重组化群的数学方法推导出来的模型， 模型中的常数与标准 k-c 模型不同 ， 而且万程中也

出现丁新的函撒或项. 所得到的柑动能和辑散率方程与标准 k-c 模型相似，为。

学呼气[(叫)去l川 ( 4- 11) 

豆子l呼气[(叫)去]+C，， : (G, +C，.G. )-叫-R (牛 12 )



其中 z

|~=H+; 
P. '" PC,. s 

式中， G. 是由于平均速度梯l1f.引起的精动能产生 G. 是由于浮力影响引起的涮动能产

生:均为可压缩泊流脉动膨胀对且的挺散率的lI'响，这些#数与标准 <-e 檀型中的#撞相

同$闽、也分别为指动能事ln散惠的有效曹朗特数的倒数，对于高雷诺数问题 ，

C，.=o.o制5.

重整化群 k-e 模型主要针对的是商宿诺数流动问题，对于低雷诺数问题则需要进行相应

的世置.

( 4- 13) 

三、可实现如ε模型

标准 k-e 模型时时均应变率特别大的情形，有可能导致负的正应力.为使流动符合涮流

的物理定律，需要对正应力进行某种数学约束. 可实现 k-e 模型 ( Rcalizable k.c 模型)正是

基于此提出，其油动fÆ且艇做事输运方程为 2

旦旦令旦旦，.1-主[ rμ + 1i)~ι I+G.+G.-oc- Y" 
ÒI iJx, iJx， l\'σ， ) iJx,j 

旦主Lð(旦1-主[(川UEEL ，rF，，fJLd E - c 
ÒI iJx, iJx, L\" , <7，) iJx， J 户，-- '--lk+ .JL正吁~ k -uη 

其中 z

c, : max(阳.q:S) 
q : (2乌 Eeyn i

E. : .!. f 生L+生L[
, 2 ( ðxJ 晶， ) 

纠呐号
c:一一」

, ，也 + ASU -k I & 

As = .J6 co叶

; =iCOS.' (J6W) 
E"E ,.E .. w= • c 千;.

(马E~ )'"

U旷 :币E， +凸ñ， õ.ρ白

凸，= '乌l， - 2'1句树e吼a 

0，:0， -'1川，

( 4.14 ) 

( 4.1 5) '4·· 
满
漳
穰
型

( 4- 16 ) 
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式中， G. 是由于平均速度梯度引起的端动能产生 马是由于浑力量E响引起的涮动能产

生: YU 为可压缩漏流脉动膨胀时品的挺散率的罪响 C，.、 C，.、 c，.、 C，、 A， 为经验常数，

FLUENT 中默认值为 C\c" l.44、 C~- 1 .9 、 CM=O.09 、 C2- 1.9~ Ao-4.0: 的、 u.分别虫端动能和

涮动耗散旦在对应的普朗特数， FLUENT 中默认值为(1. - 1 .0、 σ'，'"' 1.2 . 
该模型适合的流动类型比较广泛 ， 包括有旋均匀剪切流、自由流、腔道流动、边界层流

动和!有卦离的流动等.

双方程模型中 ， 无论是标准阳模型、剧G Ic-e 模型还是 Realizable Ic-e 模型， 3 个模型
有类似的形式， 即都有精动舵和1娓散串的输运方程，区别在于·

• 计算瑞施枯性曲方培不同，

• 控制晴在扩散的瑞施骨朗特撤不同，

• 耗散事方程中的产生项和 G关系平同.

4.4 RSM 模型

上述介绍的各种双方程模型都采用各向同性的揣流粘度辈计算楠流应力 ， 这些模型很难

模拟出旋转流动且流动方向表丽曲事变化的晕响. 为克服这些融点，布:必要直接对惯诺方程

中的泊流脉动应力建立微分方程式井进行求解.

雷诺应力模型 (RSM 模型} 就是求解雷诺应力张量的各个卦量的输运方程， 具体形式

为2

:, (pu/uj )+去(凶，可)=-去[PU;UjUt +而U/+Ójj，Uj )]

云(μ去可)-朽安+江去)- PP(8,Uß+ 8)u,0) 

叩(付)-2在呐(正'Ca，. + " jU..E Jt-) 

其中

D:. =~r丘ðUjUj 1 
, ðx.l σ• ðx. J 

P, =民号
伤 =ø，户ø，， +ø，.

G" = β丘r" 旦+Z 。T |
俨肝， 16'axJ 。J &dJ

E， 今:， (ρε +YM ) 

( 4-1 7) 

( 4-18) 



式中 ， 左边第二项为时流项 cv: 右边第一项为精流扩散项 D; :在边第二项为卦于扩散

s 右边第三项为应力产生项句: 右边第四项为浮力产生项 Gu' 在边第五项为压力应变

: 右边第六项为挺散项句:右边第七项虫草统旋转产生项 F" 同为揣动能对应的骨朗

• 0 ,-0,82 . 

RSM 模型也属于高雷诺数精流计算模型，在固体壁面附近，由于分子粘性的作用 ， 油

， 霄诺数很小 ， 上述方程不再适用.

LES 模型

描流包宫一系列大大小小的涡团，祸的尺度范国相当宽广. 为了模拟涮流流动，我们且

.11计算网路的只度小到足以卦辨最小涡的运动，然而， 就目前的计算机能力来讲，能够果

用的计算网格的最小尺度仍比最小祸的尺度大许事.由于系统中的动量、质量、 能量且其他

"理量的输运主要由大尺度涡I!i响 ， 因此假世流动的几何和边界条件决定了大涡的特性.而

植动特性主要在大涡中体现，小涡受几何和边界矗件的I!i响枝小 ， 井且各向同性，所以计算

时直接求解大涡，这种方法就是大涡模型 ( LES 模型) .

LES 模型的控制方程是对 N-S 万捏在披数空间或物理空间逃行过滤得到的. 过滤的过

程是去捕比过滤宽度或给定物理直JJf.小的涡庭，从而得到大涡庭的控制方程为 ，

ao 8pu, _ • -"-': U 
ar ax, 

如)+是(ρ'11，11j )言去[.量)吾-告
式中 . T，为亚同格应力 ， τ'IÏ fJII'/丐 fJII'/ " Mj • 

【实例 4-1 ]，三角翼绕流分析

河边中的桥敏、轮船且船桨嘈郁金对正常的水流流动造成一定程度的黠响，若绕梳前后

E盖过大，则喜品使障碍物产生振动， 当振动频率与物体某阶固有频率相当时， 则会使物体

扭曲，甚至断提， 后果不堪设想.因此，正确分析障碍物对来流的E响是工程实际中的一个

重要问题，本例即分析水流端流绕过三角翼时的流场.

( 4- 19 ) 

( 4-20) 

-、实例慨述

三角翼的吊状如图 4-2 所示，水从左边正前方 (0 攻11)) 以速度 Smls 绕过， 分析三角

'对水流正常流动的I!i响 .

',m 

一一一'

• 
• 
• 
/可二\

'lkm 斗
阳‘ 2 三角'‘革能班示.~

'a··· 
满
灌
-
E
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思路分析

由于水流绕过三角翼为外流，因此需要建立三角翼外因流域，横向*度取三角翼任何'j 5 

惰，纵向*度取三角翼高度的 20 倩 .

通过本实例的演示过程，读者将学习到2

• 外班区域的建立，

• 几何面的相减，
• 几何区墙的分块，
• 遇变网格的划分.

• Æ力出 口的定义，
• 参考值世置，

• 设置E力孟晶监视器，

• 计算结果的后业理.

(lfU I!)一#见附带光盘 "Ch4\s14- 1 .msh " 、 咄如制l川bs飞 6咄h制ω14比叫4牛­
"Ch4飞、s I4-I.tm "气、 "Ch4飞\s 1 4- I .ca瞄s"飞、 "Ch4飞、s \问4-1 .dat俨".

(uu)-.m'"带她 "Ch4出町、14- l.avÎ .. 
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二、模型建立

1 启动 GAMBIT . .\'-，!c控制制中的["i""- [古→V-.在Create Real 艳阳翩
的 X. Y、 z 坐标输入柜中输入 (-5. O. 0) . 单去 - I按钮生成第一个

点 . 随后接同样方法住在建立晶( 15. O. 川、点 ( 0 . 3. 川、点( -40. O. 

0). 在 (60 . O. 0)ι但 ( -40. 30 . 0). 舟、 (0 . 30. 0). 点 (60 . 30 . 0). 

哉(-40. -30 . 0) 和点 (60 . -30. 0) 共 10 个且，如国牛3 所示.

曲...... 幽矗-1

• • • "-H ·阳， l1=.11' I 主j
6 '-由 且

• • t . 1 • "' I叫 .: J;õ 
" I叫

• . I~ "p 
且翩 f 
句，， m 』

四.-， 穗场应的始制

2 单击I百- [百-[于了，在 Create Straight Edge 1i1.ti.中选择点 1 ( Vertix. l ) 与启
2 (Vertix.2 ) ， 连接过两点生JIJ.蝇段，然后住次建立点 1 与点 3 点 2 与点 L

?i. I 与最 4 . 在、 2 与省、 5. .?i. 4 与点 6、点 6 与点 7 点 7 与点 8. .~. 5 与启

8 月、 4 与点 9 点 9 与点 IO 点 3 与且 7 且点 5 与.~. \0 间的蝇段，共 1 3 牵

线段，如圄 4-4 所示.



|田-翩翩"幽幽-1
咱 -~ 主l

'阳 叫. - ，叩

'阳 工- ~Ir- .!l 
叩 r一一一一一

|E豆口」旦J -

• 

阳.~ 漉.. 键的绘制

3. .;t..t; [百- fðï -厅，在Create Face from Wireframe 帐刊且需要i'J制
函， 本倒要创建 3 个面 ， 分别由蝇段 2 ( edge.2) 蝇段 4 蝇$i. 6. 蝇段 7 、

蝇段 13 组成，且段 3、蝇段 5、战段 8 蝇段 9、线段 1 3 姐成和战段 1 蝇段

4 践段 5. 战段 10、线段 11 . 蝇段 12 组成，如圄 4-5 所示.

申E

第

4
·
恩

精
液
锁
型

τ，...: + R... ... Vlrtu.ll 

.J _fEe rr-一- .!l

"'"幽甲「一- .!l
Jω.~ II .!.J 
t_anc. 明 d

也皿

因.-， 流峨面的经翩

面域创lJ!完后，下步需要对几何模型进行网格的划卦.

三、 网梅拍l卦

由于水具有粘性，者考虑到其近!\!丽粘性效应 ， 则应该划分边界层网棉，本例不划分边

界层， 而采用递变的网楠划法来达到近壁而网路细划的效果.

1 轴fØ-fF-陋，在 M国h Edges 峭的 臼伊拉输入时刷刷4
( edge.4) ， 设置 Ratio 的节点距离比例为 1.0 1， 选择 Interval S ize 分段方式，

并在左侧输入括中输入 0.2 . 单击-旦旦二」按钮生成谅线的线同格. 按照同样
的方法 ， 将钱段 13 也划分成遇茸的线同格. 而将线段1.钱段 2 . 或段 3、 线

段 5 和线段 1 0 ~~等间距比例(即 Ratio 为川、 S因为 0.2 的方式划分，剩下

民段则不用划分战同格， 得出的蝇网掉如圄 4-6 所示.
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- fl一一---旦
，幅幅恤 ~...I

-- ，巳-=.J
川…叫

田咽'明 -1

-主旦旦旦斗

乎Att- 4
巾.~.

' … * _ . 
.J "'.......1.1… 

-"., I~巳i二圣王3
因.~ 线网稿的划分

单击l百-W-[W. 打开 M目h Faces 拙， 用回+制左键选中已脱
A或同格划分的面). i1 2 和面 3 . 运用。咀d 单元与 Map 方法对这 3 个面进

行画同格划分，保留其他E认设置 ， 单击 .里L.J按钮即可 ， 其同品生A如

圄 4.7 所示.

2 

团今' 面同幡的划分

画画画.幽幽

,- 囚j)acl.3 

… -.. 
τ.".， 

一 」至二J

离岖.. 

r一一
」响W 旦旦

旦旦!..-=..I

句- 11' Io1l1h 
11' RIIIOVI 刷刷仙

..J RlIIOYI _.."" 

.. ..商rI .ill~'

....!I旦...J_旦旦_.L旦旦..J

面同格划分好后， 需要定义边界类型.

3. ...，..r-ï→睛， 在 S阳市 Boun血可 Types i1l&.中刷刷叫段 10 走义为
边庄人口( VELOCITY_阳LET).名称为川，将蝇段 7. 蝇段 8、蝇段 9. 战

段 11 和战段 1 2 走义为压力出口 ( PRESSURE OUT). 名#为 out . 将战段



!.蝇段 2 和战段 3 走义为壁画( WALL)，名非为 bimian . 如回 4.8 所示 • 

• 

，、"阳"
白;

' - .叫
、，由 、- _.

白

..__ .J自由

_ : IT 

'"赋
Z主l ...1 

ED 
罔... 边界'题'目的定义

4 同格'时l分克后，执行 File- Export - Mesh 命令， 将同格输出为 sI4- 1.msh .

四 、 求解计算

l 启动 FLUENT 二，食单柑庄计算器，执行 Fi1e→Read→Case....今，读入划分

峙的同格式件气lιl .msh" • 

2 此行 Grid→Check 命令， 时间格进行桔刑，成功栓嗣后窗口鼻函中最后一行会

出现 "Done" 语句 ， 本制的同格桂删信息如圄牛9 所示.
制._.

_.山.~tl τ

. ' c_.t...h : od. (.) - .，…·帽，…. .…..刷

,…..h: .. 归，.) - ' 1 ….-.…. ，…·阳
..1... Ilatlltlcl 

.1R1_ ...1_ (lII1: ' .2""".帽
……恤)， ，…帽
toUl …《耐): S .U_'帽

roct ...a .latl.tl<:1 
"bl_ 'iOn iOI"U 间，阳rl!.- H2

..d_ 阳iOt".. (1Il'): 0 .:1'''_阳
阳".呵咱.... .f n..... ,.r cUl 
阳叫一 'f factl ,or coll 
Ch'Ckl咱‘huM ，.且 RUrl
Ch'Cklol ..叩叫 ..IU ,or hco 
Ch'Ck1ot f iOCO COll l 
C h.c川崎 trl'V- f ao: n 
Ch f'C kht r且~t-ft~.. "0111 
m川，川剧__u

._.崎 f..o _ .....r 
e~kl"t .I...nt t,,. "... l l t..", 
ClIoKk!"t ..川崎庄".. ，

C JwcU咱 hc. ,dr‘ 
川崎，...1...lc _...1 .. 
CMCU啕叫叫‘
CloKld咱 ..sel... ..n u酣
C.......I咱阳01... ,.... u..t 
c.....l咽 'K' 剧'WM
c.....l咽 ..11 剧阳"
CIilKId咱 u......
阳

回~， 同幡撞测恼"

'4 
••• 
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3. GAMBIT 默认单位为 m，而本制单位为 cm，所以执行 Grid→Scale 命令， 在

俘出的 Scale Grid 对话柜中将 Grid Was Created ln r拉到在选为 cm ， 单去

豆豆U制且要现网格尺寸的民主，如国 4-10 所示.
4. 执行 Define→Models→So\ver 命令，弹出 Solver 时话框，如围 牛 11 所示. 本

制为走常模型，故保持默认，不做改动，直接单去一旦J安缸.
" ,." x 
S归

'一" 帽­
C ,,<' 

h • ..句
俨 阳呻

l 温~Tor.n:l川芭I
" "曹..... 8...~
r" 0-. ",. 8...~ 

~.-
" W 
C~_ 

C ~…M 
F 

So:aIch俑.. 

Grld w.. C.e_d '- I an 丁

旦旦旦旦旦划 、IdodIyr_

~.由C ~_ 

><1'.11 
Y ['-百一一

00...'" ExteI01I 
川I I -M xno叫丁广­

Ylllln 阳1 1 - 1.3 一一 v.融同~了一一一

.向阳 …一. ..…… .…叫
俨~-…_.…~ : (" …… 
俨 u.….C" IlHH

Sc.lc I 旦旦~~旦~ ---.!!旦j 一旦.J I!:!J -'旦j
阳4-10 网恪尺寸'"义 因4-11 Solver 对话倔

1 执行 Define→Models→、 ISCOUS 命令，弹出 ViSCDUS Model 对话框，如圄 牛

1 2 所示 . FLUENT 中默认的为层流模型，因本制为端，血流动，放需做相应的

诅置. 本制边排具有非乎街壁画函盘的标准 k-c 模型，在 Model 选项中选择

k-epsil on[2 eqn] ，在 k-epsi lon Model 选项下选择 Standa时，在 Near-Wall

Treatment 选项下选择 Non-Equilibrium Wal1 Functions，保留其他政认设直，

单去" 且安钮，如圄 4-1 3 所示 .
…-…. 

lIiII翩翩蛐

-, 叫一

F … M 

r一 p , 
♂「S z坠』肉，，.ea，H，•• e·胁叶，M"a企-·"pB悻H.e，E.，·F.·咱叶 11 ..叫 Cl-l:'..... (" ~s.e.. f!Ì喇

~问 号

』呻·胁- -副 H.. .… TQ' "'_"…-C_ 
h r 11<01._ 

d 
~.-τ帽…- 电雯垫赞同，-

•• 呻.….吁，飞
|m j 

趴 害与_.…..

且
n嗣归回国回国-曲唱『

二j

.... 1Ic:1 

r Invladd 
信 画画画B
俨 "-刷降-AII...... [1 e咱叫
r 1t-e,.n.1I (l叫叫
r Mllle,_ 12 町叫
r ~old. s..~.. [s e刺

~ 旦旦~-.!!坐J ~ c_l~ 

圆年13 汹流穰型的设置圄4-12 明优僧，四 M刷.，对面恒

违章 之常流动时，满流模型对话徒然不到 LES 模型 这是因为大涡模型为非定常流动的模4时英型 -
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模型设置完后， 下一步就是定义流体的材料.

6 执行 Define-Materials 命今，在 Malerials 时话柜中走且流动的材料 .

FLUENT 中默认的材料为主气( air ) ， 由于本制为水的绕埠流动，故需要且

FLUENT 自带的材料业据库中调用材料-一水. 读者需要单击 Maleria l s 时话
植右侧的 阳enIO.I.b..e 。 按钮， 在弹出的 Fluenl Dalaba幽 Maleria l s 时话柜

中 ， 利用革动条选择 Fluenl Fluid Materials 列在中的水，单击 waler­

liquid[旧。<1斗，即会在下方的Properties 中也现相应物理属性的数据， 如密度

为何82kgtd， 比热在为 41 82jl (kgX) 手，如圄 4- 14 所示 . 单去旦旦接
扭， 即将敛据库中的水材料拷贝到当前工程中 . 单去旦旦三按钮关闭 Fluenl

Database Materia ls 对话桓.
很 l

声旦旦 阳… .. 

"3 ~ ~ 俨阳时，_.

A 
丑. I 

3..:.主」

"呐阳叮酬问

'" 
队，叫1帽­

严百E丽

j 

~-

可

叫，-- "Z"，
…"嗣同"吗

·司2旦旦

阳… .. 

, 

L ...J 

产 3~Î 

3二斗

3主二J

3且主」

h嗣即可阳回

陌言

句嗣'111 1".."'"
1-..1 

Tk ..... IC.由问阳咐同时
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回到 Maleria l s 对话框，即垂直现在 Fluent Fluid Malerials 下拉列表中存在了空气和水两

'
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种材料，本例选择虫水. 晶后单击 Matcrials 对话框中的豆豆豆豆二卫按钮 ， 完成材料的定
义.

撞..若不考感l!.放应 ， 在 Materials 对话柜的材料属性中找不到比鹅容和导热系数'f元'眼N生， 并不代农

材料4tll的不，协会.

7 执..ft Dcfin• ..Operating Conditions 命令，在 Operating Conditions 时话柜中吐

直工作压强 . FLUENT 中耻认为 latm . 事.y-{主直为原点 (0 ， 0)，且不幸卓

Gravity 作用，本制保持默认世直，单去一旦且安钮-
8 工作压强设直直后，需要定义迫再数据，执行Define_Boundary Conditions 

命今，弹出 Boundary Conditions 时话框，定义如下内容.

• 在左边的 Zone 框中选中 f1uid，单击」主ι蜻钮，在团今 1 5 所幸的 Fluid 对话

框中 Material Name 的下拉列囊中选择 water-liquid. 单击~按钮.
- ' 

…阿…
.. _.... ... 匠~r__ 

「叩h

r问.­r r......自.
E阳叩-1 .申_.由 lM田. 1

|…呻 A
.~" .. ,----
V网F一一一一-

-'-高=;一 主 4

-主」旦旦旦」

困4-1S运动介..定义

• 在左边的 Zone 握中选中 m，单击二丘二按钮，在固 牛16 所示的 Vel田町 In let
对话框中的 Velocity Specifi四lion Me由叫中选择.. Magnitudc.Normal to 

Bounda可"最幸速度进口方向 垂直于入口边界，在 Velocity Magnitude 

(mls) 中输入 5，最幸进口速度为 5m/s; 在 Tu<也ulence 中可剧进行描班参姓

的设置，本例选择 Specification Mehod 中的 Intens 民y and Vis∞sity Ratio，在
Turbulent Intens即 中输入 0. 5 . Turbulent Viscosity Ralio 中输入 5. 单击~

按钮.

--
陶帽唰- 1-1--1阳.... 1- 1-ω1晒 1

啕-~曲-陶-1"咽--…- " 
甲乙工严一百一寸
'一' " -陆画面丽画画面

一…"... 
一…阳，

, 

二二旦旦二旦
回4_16 速度入口设置



· 在左边的 Zone 框中选中。ut. 单击 Set... .在回 4- 17 所萃的 Pressure Outlet 对

话框中选择 Specificat ion Mehod 中的 lntens町 and Viscosity Ratio. 在 8ackf1ow

Turbulent I ntensity 中输λ0.5 ， Backf10w Turbulent Vìscosity Rati。中输入 5 . 其

余保持默认，单击」巳且安钮.

阳响·阳叫1_1 s.edot.1 Df'W 1 脑嗣叫晒 i

6叩阳町'叫「一一一日可一一丁

._....由伽响--1_01 .._"")'一一

"叩MM"__

Y叫翩

加喇呻叫h'l蛐...，.-\11-由- 二才

回睛-，-耐蛐.'IIV"F一一一

..面-，.恤""..VI..... ν阳"可

阳4. 1 7 服 1JtH 口 也置

9 下面对卓解#数进行设直，执行 Solve→ Control - Solution 命令，在 Solution

Controls 对话桓将 Oiscretization 项的 Pressure 设直为 PRESτ"O ! ， Momentum 

设置为 Second Order Upwind ， 保持其他耻认设置，如圄 4-18 所示 ，在企

」巳如钮.

问"'-'
f!!i!!iiiï"霄，酬.iÆ& :1 

T.n..Ic"'_E""咖同志高百z一寸T...-ot1 010..__阿布阿 ::J

阁4. 18 求解控制多数丧置

10. 4桌丁来 ， 时，且场地行相始化， 执行 Solve - ln i tializc 司 In itialize 命令 ， 在

Solution I n i t i a li zat ion 对话柜中选择 m . 时进口相始化， 顺序单击 ，，，斗 、
旦旦j. 旦旦旦按钮，如圄 4-19 所示.

川 朝始化后，执行 Sol ve - Mon itors - R臼idual 命令，在妹出的 Residual

Monitors .ì&中 Plot ， I-;l打开战呈曲线圄 ，如图 4-20 所示 . 对话扭下方的

Criteria 中可且输入各事数的收最精度要卓 . FLUENT X!.认为 0 ∞1.本例将

contmu町吐直为 0.0 1 .

笛'
4
‘
.

·

清
流
模
型



p
c
m
Z
」
『
擅
体
分
伤
及
仿
真

实
用
数
程

120 

-圄-司

F 
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， 阳

叫叫

阳-f"i' : 陆曲·

h咱自 阳白r'"封

r _. '"由主且J旦旦

住空些旦旦丁
-丽画画面……-

·嗣由恒，~­
F 蛐叩

正二 j 

川叫""" 1'.- 一!
v..叫-r一一一 | 

M叫-，-咖阳叩丽百「』

阁‘ 20 ø.~自监愧.，段.

「
「
「

, 每 . .~ 
j 

一旦-.l --""..J旦旦旦l 王旦旦二型"

m‘" 初.，化说.
12 选取作用在三角罩在面的压力革数面积平均值作为监制计算4欠佳的圳据 为

使压力革盘计算丘确，必须设直正确的事考值 . 执行 Report 司 Reference

Values 命令，在 Compute From 下拉列在中选捺，" ， 单击」旦」按粗，如圄 4

2 1 所示.

13. ~在考值设置克后，即可设直压力革量监视器，执行 Solve - Monitors • 
Surface 命令，弹t!: Surface Monitors 对话框，如囤 4-22 所示. 糟如 Surface

Monitors 值为 1 ，单击 P)ol 和 Write ， 单击右侧的卫旦己j接扭，打开 Define
Surface Monitor对话框，如圄 4-23 所示.

国幽回幽幽圄曲-… 凰

阳

h 

阳...0'1.由.

~.同「一一­

h耐住，田写陌?言百一一

悦，.，.... r;--一一­

M阳"' 1"'--一一
气II1II士 冒 川".. 11 ，....间

阶阳阳...........恻"叫「一一一一

T叩，巾阳闸町F

V.I.曲同阿南「一

咧m响附听盲目a

....叫耐 "UIIF一一一

s.....~阳阳「量

1.....Jh~ - 1 f;;I r Jõl r量I lIe friOft 丁丘巳斗
严百了一 r r r r丑F汇了丁'，. "." 

1" r r r 厂封严7丁』工J
Fτ-:;-r j r 广量「一一丁l江J 二

~丘-' l~

阳，--

3 
。‘

阔4-21 .Jt也隙'配 回4-22 监愧'对~棍

14 在 Define Surface Monitor 对话框，选择 Report of 下且J'I在中的 Press町e 和

Pressure Coefficient . 选中 Surla四s 111在中的 bimi酬，将 Report Type 设置为

A，国-Weighted Average. 保留其他耻认设置， 单去-坐J接扭， 如圄 4-23 所

示.退回到 Surface Monitors 时话柜，再次单击」巳J接扭.

• 



..w......_ ..."，. 回3

‘ 刨4-23 J监愧霉，数设置对话'医

J S. Jt成上迫步骤的设置后，可队将 C田ε 主件克保存一次 ， 执行 File→ Write­

Cas, 命令， 将工程主件保存为 sl4- l.c皿.

16 下画即可以开始迭代7 ，执行 SoJve - Iterate 命令，设置 Iterate 对话植中的

Number of Iterations 为 2∞，单击旦旦旦旦按钮开始解耳.

200 步计算完后的娥些曲线与压力系数监视曲线如图 4-24 j阳阻 4-25 所示.尽管从残屋

曲线肴 ， 问题还没有达到世盟的收敛要求，但由压力革数监视曲线可见，压力革故已无明且

波动，可以认为已经收敛.

磨一
iIGI阪 .
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四
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回4-2S lJi力系..监槐曲鳝
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1 7 执行 Disp lay -- Contours 命令，在围4-26 所示的 Conlours 对话柜中选择

Contours of r拉列在中的 p，田sure ， 并在Options 选择栏中的 Filled 前单击

(打勾)，单击医王丑剧里，弹出如圄 4-27 所示的剧量分布云围.

I!I町m 叶tI""， J. ':. c~ 

,­.. _~-

，-叫
‘'相问
俨1"' __. 
r _蛐

自

由

E _. 
E 

M 

•• -4 
甲

『
中---E _. _. 
甲-­中

E兰兰兰=-

回‘ 26 Con ωn对话帽 阁4-27 应强分布云恻

18 同样，选择 Contours of 下扯到在中的 Veloci lY，单击E豆豆1接扭，可弹出如
回 4-28 所示的追庄分布云圄 .

" 
巴'

国
-
M
U
国

砸

、• . ". 
1114+28 边度多'布云罔

19 除7可副显示云围之外，还可耐利用 Plot 革单显示做我回 . 执行 PI。俨 XY

Plot 命令，绊出如圄 4-29 所示的 Solution XY Plot 对话框. 在谅时话握中的

Y Axis Function r .f.主 IIJ;在中选中 p，白sure 和Pressure Coefficienl ，并选 中

Surfaces 列在中的 bimi阻，保持 Plot Direction 中的 X 值约!. Y 值为 0，即建

立以 x 万向的长庄为 x 轴，压力革扯为 y 轴的曲线. 单去cPiõ!"l按钮即弹出
如圄 4-30 所示的在面压力月在数傲占国 .

回国…翩翩 -g_v_. 
"…… r 'A, 
「吨.~
r 

回4-29 XY 幽键设.. 对话很



幽幽型国幽幽 嗣呵
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___.____.....M"-. 
-嗣同

阁4.30 三角翼褒面压力系'由分布回

20 最后，将计算结果保存为 case 和 data 文件. 执行 File→ Write - Case&Data 

命令，保存 sI4-1 .cas 和 sI4-1.dat . 执行 File-> Exit 命令，安全迫出 FLUENT .

【实骨IJ 4-2 l 突扩管内流体流动分析

在实际工程的臂迥输送中 ， 经常去遇到突扩或突缩管的悄况， 当甜L体经过这样的突然扩
张或突然收缩的营造时 ， 流动将与管ll!发生分离 ， 井形成被涡 ， 从而造成了压强的损失，消

耗了管输的能量.

-、 实例慨述

圄 4-3 1 所示为水平放置的突然扩张管道， 内部流体为水. 管道且最为 4.5m. 前端细曹

长 1. 5m . 细管半径为 O.2m ， 后蝙粗曹长 3m . 相管半径为 O.4m . 由于管t是相台阶高度的比

值为 1 5. 因此可以认为出口已经是充分盎展的流动. 水流由左端流λ，速度为 5cmls. 那么

经过突扩管后流速变为事少?压强又是如何变化的?下面我们针对这一问题进行模拟计算.

第
4

事思

浦
液
模
型

D、….

←上L→护 '" 4 
因..3 1 !i随扩"示意图

思路分析

由于本例为*平管道， 具有轴对称性， 若在不考虑重力的条件下 ， 实际建棋时可以只建

立轴向剖面的一半， 而将管轴线设置成对称轴.

通过本实例的演示过程， 读者将学习到2

• 二维时非模型的建立，

• 企区网梧的划分，
· 撞击的判断，

123 
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· 惶惶显幸，

• 速度等值姐田的显示，
• 施面世菁值班团的显章:

• 速度措程变化曲盘的显示，
• Æ强措程变化幽量的显示.

(u.... )一#见附带先盘 .. Ch4\s14.2.msh "、 u Ch4\s14-2 .dbs" 、" Ch4\s14忡u" 、
"Ch4'、J4-2 .tm ..、 "Ch4、14-2.cas"、 "Ch4、14-2. dat ":

(，. AU)一参见附带她 "C阳.Y1\s旧 avz"

二、 模型撞立

1 启动 GAMBIT ， ~.J;~ -陌-r，;:'"，住次创建坐抨为 (0 ， 0 , 0). ( 0 , 0.2 , 

0). ( 1.5 , 0.2 ，川、( 1.5 ， 0.4 ， 川、 ( 4 .5 ， 0.4 ，川、 (4 .5 ， 0 , 0) 和( 1.5 , 

0 , 0) 的 7 个点，如圄 4-32 所示.

...rt.,‘ 2 
仙'" 制 1

lo'..rt .... " 
...rt.... :J 

...rt....7 

...rt.... s 

. .,‘ ..‘ 
阁4-32 绘酬'牙的点

2. ~.J;r百-fF-F，打开 Creale Straight Edge 帐，创建点 1 (Vertìx. l ) 与
点 2 ( VertÎx.2 ).点 2 与我 3. 聋 3 与占 4、是 4 与企 5、点 5 与 !i. 6. 在 6 与

点 7. 点!与也 7. 点 3 与哉?之间的线段，共 8 牵线段，如固 4-33 所示.

町时E
..... 
.d,_ 6 

回4-33 绘制"的线箴

1 将战段 1. 蝇段 2. 蝇段 8、线段 7 和线段 8. 蝇段 3. 妓段 4. 蝇段 5. 蝇段

6 分别扭且两个函，轴I百→陌→阳在 C"，即 Face from Wirerrame峭
的臼基因黄邑输入担中选取需要田成面的战段，单击 ，里L1按钮生成儿何

00 ， 本制生成的两个面如因 4-34 所示 • 

• 
• 市d l.c..2 

因4.)4 绘制好的面

二、 网格划分

1. H [8 -[F -[if，在 Mesh 田ges 峭的 Edges it 邑输入栏中;&<1'线，直 l
( edge.1 )和蝇段 8，虹色箭头由下向土，设置 Ratio 的节点距禽比例为

0.95 ，边4t Interval Count 分段方式，在左侧输入括中输入 10，单击-旦旦...J
接扭生成放线的蝇间品，其余蝇段划分方式如下.

• ~!I.标左键选中蛊段 2 和蛊段 7，红色情盖自左向在.设置 Ratio 的节点
距离比例为 0.99，选择 Interva l Count 分段方式，在左侧输λ栏中输入 2∞，

单击 ....， 按钮.



· 匾E岳阳左剧中姐们附加，虹色箭头囱右向左，世置 Ratio 的节点
距离比例为 。 99，选择 Interval C刷刷 分段方式，在左侧输入栏中输入 3∞，

单击 "'" 按钮.
• 选中蛙段 3，设置 Ratio 的节点距离比例为 )， 选择 lnterva l Count 分段方式，
在左侧输入栏中输入 10，单击 - 按钮.

• 选中蝇段 5，设置 Ratio 的节点距离比例为 )， 选择 Interva l Count 分段方式，
在左侧输入栏中输入 20，单击 ，旦LJ按钮. 划分好的住网格如固 4-35 所

习之 .

因4-35 罐网格的划分

，主意医画虱标左键选中被迫战段，按住虱标中候，可以使被迫线段的缸也箭头改交方向.

2 单击["""iØ -IB' -~，打开 Mesh Faces ifJ~. it. <f e..挂在此线附晰的面
1 和面 2，运用 Quad 单品与 Map 方法对这两个面进行划分，其他设直保持耻

认，其生成的.il同格如圄牛36 所示. 此面网格体现丁团体边界吏然主化部位

同格细划的效果.

罔4-36 划分好的画同格

面同格划分好后 ， 定义本例的边界条件类型.

3 单击而百- 1亩，在 S阳市 Bound町可pes 棚中将制 1 走义为速度入口
( VELQCITY _ INLET )，且非为 m 将线段 5 走义为自由出 ~t

(OUTFLQW )，名称为。ut; 斗夺或段 2、战段 3 和战段 4 走义为壁.il

( WALL )，名非为 bimian ; 将线段 6 和线段 7 定义为对非轴迫耳( AXIS ), 

名称为 duìchenzhou; 战段 8 不做走义，则在示其为内部区域，定义奸的边耳

如困 4-37 所示.

咽 Mω巨响 E

)!; "恤'世腼雪 民4.;?:· "一..... rt \IP8=o，nrl阳
因4-37 :.ζ义"的边界樊型显示

4 执行 Fìle -Save As 命令，将工程主件保存为 "sI4.2 " .同时， 执行 Export→

Mesh 命令，输出罔格主仲 sI4-2 .m由

四、 草帽计算

l 启动 FLUENT 二蛙单柑庄计算器，执行 File→Read→C"，e 命令，该入划分

峙的同格主件 "sI4.2.msh" . 读λ同格主件之后， FLUENT 控制台窗口会提示

圄 4-38 所示的警告信息，意为提示在们将间题修改为轴对#问题.

'" 
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w.røl",: '~e WSII .f ..ls o.四霄， c.....H1...s 1s Øllt ...,...,r t.h hr 
" !1I'30 fl.. pr.bl~.. Pl..se CIIRsI..铲 c~H，I"，‘1M Z.... 
tll'''' t. sJ_trll .r ...U. ... In. ，r削"也.. 川崎_tdc

_..呵'1M 11511 .f ...Is be~'叫 '.....lt1...' 15 ..t ."r.,r l.t. f ... 
.. H/n f1_ ，...U.. 问..511 c...sl'.r C~呵坷阳 'N'
t... u ‘,,_tr, ... "11 , ...阳，rHl_ U ..1归眩..，

图4.38 警告r.u，

2 网格读入之后，执行 Grid→Check 命令，检查同格的信息，如圄牛39 所示.

DomaÎn ExtenlS显示了计算区域的大小 ， Volume Statistics 显示了最小和最大体

杠. Face area statistics 显示了最小和最大面租如果出现T 负体和网掉，则必

须重伤划分网格.
h..t.. ht..U 

.-c..r.l".t.: .t.川 . 1.-…_1". ...川. ..5_…" .…"…-.…-'H ……"… U.lu.. st.ttstlcs 
odfti_ VOl叩【蝠， ， 川圳市，帽

ud刷"...lu.. (耐): '.117517…‘ 
totU 刷刷. (..:I j: 1 _ ~……… 

hCII ....U sUUsUCS 
.Inl.... f民" are.. (旧): 1.562115. -'" 
"川剧" faCII arU <a2): 3.'S"I'. -.~ 

回4-39 肉'鲁位沓的伯息

3 执行 Grid→Scale 命令，弹出 Scale Grid 时话桩，本倒不需要重新走且间格

的且寸，但是伺可旧从时话柜中看出计算E峨的尺寸范困 .

4 执行Define-Models-Solver 命令， 在国4-40 所示的 Solver 时话柜中选择

计算模型，本制为默认选择.

'阳­
e阳._.时 '­
俨…~ 俨- -" lO .. Il1o呻
... _....... r … 
r +,.,_..._ 
F 

…­， ~-
r … 
-瞻句- 阳-，-由·

' … ..c..._ "…叫
俨阳山.. _0.... r ~W.叫

- ~… s ... ,.. c.. 0.... 
~I!:到 lM. l

困4.40 基本..型边停

5. *-iI~ Ac iAl.迫庄为 0.05础，计耳雷诺盘kfz平ι则叫 因此， 苦耐
瑞i血流动，故执行Define→Models→Viscous 命令，在弹出的如圄4-4 1 所示

的Viscous Model 对话柜的 Model 迫项中选择 k-epsilon[2 eqn] . 在 k-epsilon

Model 选项下选择 Standard ， 其他事提取为默认恤，单去-巳J按钮-

6 本制材料与上倒-样，仍为水，事照上倒操作克成水材料的走;1.._

7 由于本倒不寺患重力作用，因此拉行 Define→Operating Conditions 命今，不雷

要吐直圄 4-42 所示的 Operating Conditions 对话柜中的 Gravi叨 ， .焦作i豆强~认

为一个大气压，住直默认为犀启 ( 0 ， 0)，单击一旦』安钮.
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8 定义边界扯据 . 执行 Define→Boundary Conditions 命令，在 Boundary

Conditions 时话柜中进行走5(. 在边的Zone 为持定义的边界.t林，右边则为

时应的边界典型 . 本制常要走义的主要有"f1uid" 、.. in" 和"。川" 3 个边耳串

件.

• 选择 fluid，其提型Type 为 f1uid I 单击二兰ι按钮，在回 4-43 所幸的 Fluid 对
话框中的 Material Name 下拉列囊中选择 water-liquid，单击」巳J按钮.

• 选择 m . 其提型 Type J.J veloc町-inlet . 单击」主二二按钮，在回 4-44 所示的

Velocity Inlet 时语框中的 飞剧。αty Specifi四川n Me由。d 中选择

.. Magnitude,Nonnal to Bound町. 表示速度进口方向垂直于人口边鼻，在
Vel阻ity Magnitude (mJS) 中输入 0.05. 表示进口速度为 5cmls; 在 Turbulence

中可以进行蛐班参晶的设置，本例选择 Specification Mehod 中的 Intensity and 

Hydraulic Diameter ; 在 Tu由ulent lntens峙中输入 1 ， Hydraulic Diameter 中输

入 0.4 ; 最后单击-巳』按钮完成速度进口 m 的设置.
h 川
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· 选择。以，其要型 乃pe 为 OU币。W . 单击 8et... 按钮，在回 4-45 所幸的

Outflow 时话框 Flow Rate Weighting 中输入 1 .最示进入的水均从读出口拖

出 .

国幽圄嗣…

阳~W~""" r

~12到 tter， 1

回4-45 Outßow时说模

9 执行 Solve - Control- Solut;oo 命令，弹tf: Solution Contro ls 时话枢，如圄

4.46 所示，本倒均为默认设直，单击-旦』安扭.

~ .. 叫叫C呻H

I~ 31 阳.-F由-
』由阿_.‘四

T__，;町._-阿瓦画画画

，-翩叫血M陌百Z百E

3333 

-旦J ~'-l l!豆国」旦」

国 4-46 SoI uÛOI'I O锢~b刘说报

10 接下来，对埠场进行初始化. lIt行 Solve- In it ia lize司 ln itialize 命令，在保出

的如圄 4-47 所示的 SolutÎon Initialization 对话柜中选择 阳， 瞄序单击~.

旦旦J. 旦旦二按钮.
| 二μ 函川三lII'II λ 以1
"阴阳，呻 Rde,elH)l F._ 
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1
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~ Ru到 旦旦l 旦旦丘U
回4.47 Soh.rti侧 I nitial陆皿嗣对话植

川明始也后 ， 执行 Solve - Monitors 吗 Residua l 命今 ， 在伴出的 R白idual

Monitors 对话柜中选中 Plot . 以打开战革曲线圈 . FLUENT 默认的各事敬的收

址柑血为 0∞1，本制为默认设置 ， 如圄 4-48 所示.

12 克且上述步骤的设置后，执行 Solve - Iterate 命今， 在弹出的如圄 4-49 所示



的 Iterate 对话柜中设置 Number of Iteralions 为 5∞，单舍里旦旦接扭即可开始

衅算.
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附‘4' ，忧""对话幅

本例在计算到 350 步后 ， 即达到了收敛，

提示语句，其残差曲线如图 4-50 所示.
叫中会叫 "So山 conve酬的τ

--

…- - -
一

阔'.50 舰差曲线阁

13 计算在后，为显示整个轴向剖面 ， 执行 Display →Views 命令，这中Views 对

话柜中的 Mirror Planes 下方的 duichenzhou，如圈 4-51 所示，单去 App~ 1按钮

后单岔五旦旦柱扭是间 Views 对话拒.

E王二
闸".51 、，~对话幡

14 下面将计算结果进行圄形显示. 执行 Display - Contours 命令， 佯出 Contours

满
漳

E 第
4 

鑫



时传框，选择 Contours of 下拉，'1在中的 Velocity 和 Velocity Magn阳出，并保

持Options 选择栏中的 Filled 未选中，单企E豆到按钮.圄 4-52 所示为迫庄

11'值线圄 . 若选中 Options 边缘栏中的 FiIled ， .ItJ 弹出如国 4-53 所示的追庄云

圄 .
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速度云图回4，53

遣.: Conlours 对话柜中的Levels 为设置标尺的分段ft ， SI剧p 为改变 C酬。urs of的逸项 .

而不迫Function . 

如固 4-54 所示.

再次单击 Contours of 下拉萨l品，选择 Velocity 和 Stream

单击~因棚，可，:.<*'*)直函数的等值线围，
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洼. : Velω町 "1 -1.中除了 V， I田ity Magnitudc 和 Stream Function 两个这项为常用之外，对于可压缩埠，马

'Ut也在斌 1'1.... 中 -

为得到轴向压强和速度的变化， 可以执行 Plot→XY Plol 曲~，在 Solution XY Plot 对
话框的 Y Ax is Function 下拉列表中选择Pres剧附和 Pressure Coeffic ient. 井选择 Surfaces 列

表中的 duich回由ou . 保持其他为默认设置，单击E豆豆1披钮， 弹出如图 4.55 所示的轴向
压强分布散点阁 . 若改变 Y Axis Function 下拉列表中的选项为 Ve l田即和 Velocity

lJl.由 Plot I按钮， 可见轴向速度分布散点阁，如阁 4.56 所示 .

幽国些-，m1" 一 崎
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自
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.. " .. .. 咱 .. ..圃 .. .. 

阳帽" 阳帽"

四4.~j '*肉压组分布 图牛，.输向速度分布

1 6 执行 File-Write-C础&Data 命令.将计耳结果保存为 sl4-2.c田和 sI4.2.dat

主件. 最后，执行 File- Exi t 命令，安全退出 FLUENT.

4.6 本章小结

本章主要讲述了精流的特征且研究耐流流动的相关模型 ， 重点给出了 FL四NT 中常用
棉流模型的控制方程. 通过三角翼绕流与突扩管内流体流动分析〈前者为外流，后者为内

流〉 两个实例的介绍， 帮助读者熟悉利用 FLUENT 求解柑流流动的过程，以便用户结合工

程实际问题分析端流流动.

/t 
v'"幸

~ 渴流的耻母及特征­
~ 常用的瑞埠棋型 .

> 鸡，且计算的实际操作过程.
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第 5 章

传热分析

热传递，是指由于温度控引起的热能传递过程， 通常也筒称为传热. 无论是能源、字

航、机械、化工、动力、制片、建筑、电子电工等工业部门，还是在业、生物和环域保护等

部门都有大量的热传递问题. 通过传热分析解决工程技术中所遇到的热传边问题1 对黯置莉1

耻备的技术经济性和l安全可靠性、热能的有效利用、工艺和生产过程的优化都有精重要的作

用.

! 111 FLUENT 软件传热的计算需要激活能量方程，通过能量方程中的 rilìr.t源项来考虑传热
问题 . 根据问踵的不问类型，能量源项中可以包括压力做功和动能项、粘性呢散项、组卦扩

散项、化学反应源项、辐射能源项、相间能量交换源项等各种典型，从而满足用户模拟计算

的需要 . FLUENT 包含的传热模型，可以求解绝大部分工程所需解快的热传递问题，如汽

车车厢内的熟交融、空调房内的温度变化等实际应用问题.

本章将介绍传热的各种方法且其相应的应用领域， 井通过两个实例的讲解帮助读者掌握

传热分析的过程.

本建要点

• 热情导.
• 热对植.
• 热辐射.

~ 本章案例
• 油轮加热‘保温温度崎模拟.
• 室内传热温度辑模拙

· 恃热分析的应用 lk方娃 .
• 传热分析的操作~例.



5.1 传热方法

热传递过程是一种复杂的物理现聋， 除了遵循热力学第 定律和第二定体外 ， 还有其特

殊的规1~ . 通常，按其物理本质的不同 ， 可以把它分为热传导、热对洗刷热辐射三种基本方

式. 在静止的液体中监生的热传递也主要取决于导热， 而在流动的液体且流动或静止不流动

的气体中热传递主要靠对流或热辐射.

5.1.1 热传导
• 

热传导简称导热， 它是物体中温度不同的各部分之间，或者相互接触的温度不同的各物

体之间 ， 没有相对位移时所发生的热传递现草 ， 是一种依靠物质的分于、ff，l于和1 自由电子等

微观粮于的热运动而进行的能量传递过程. 导热在固体、液体和气体中均可发生. 通常认

为 纯导热只发生在街实的团体内 . 另外 ， 在静止的液体中芷生的热传递也主要取决于导

热.

不同物质的导热机1.1M如下

• 在气体中导热是气体分于不规则热运动时相互作用或碰撞的结果，

• 在不导电的固体中，导热主要是通过晶格的提动来实现的，

• 在金属中，导热主要是通过自由电于的运动、相互作用和碰撞来实现的 ，
• 墙体中的导热，近代恃热学的观点认为主要是假靠晶格据动和布朗运动实现

的 .

1 822 年 ， 法国数学事傅立叶对热传导现草作丁深λ的研究， 提出了下面的数学武z

。T
QA= AAEJbu 

qJ =金=λ主 (5-2 )
‘ A ðn 
式中 Q， 为热流最 ( W ) . .1为导热系数( W/(m"C)) . q， 为单位面积的热流量

(W/m勺 • T 步~ l且JJt ("C). A 为而积 (m勺.
式 (5- 1 )、( 5-2) 称为傅立叶定梯， 是热传导自由基本定律，式中fl'J1!，号表示热量传递的

方向与温度梯度的方向相反. 该式表明当物革进行纯导热时，单位时间内通过垂直于热流方

向上的单位丽积的执流!l与温度梯度成正比.

导热系数 λ 是物质l固有的一种热物理属性， 其定义式由傅立叶定书l'式( 5 .2 ) 给 ttl:

，\ =-一旦L一 ( 5-3 ) 
。T /ðn

由式 (5-3 )可以看出， 导热罩数 A 在致值上等于每单位温度梯度作用下物体所传导的

热流睡，应值. .1可用于农征物体导热性能的强弱，其值随物质的种类而异 ， 且还与物质的结

构、密度、温度、温度、压力等因置有关.

• 气体的导热盖世值约在 0∞6 - 0 .6W/(m- "C)范围内 . 随温度的升高而增大. 在
1 0 个大气压力时下 ， 大多盘气体的导热系教仅仅是温度的画散，与压力无

关.

'
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• 革体的导!!， l且世约在 0.07 - 0.7W叫m' "C)之间 . 班体中，除水和某些水章班lJ<.
甘油外，绝大多世班体的导棉f-盘随握度的升高而"，小 ， 除非接近临界点，压

力对班体导热盖世无明显影响.

5.1.2 1，在对流

热对梳是指温度不同的各流体微团发生宏观相对位移时引起的能量传递过程. 简吉立 ，

是依靠流体的运动进行热量传递的现草. 热时流只能发生在流动的流体中.

在工程技术领域中所遇到的传热问题， 往往涉及到流体与团体监直接接触时的换热. 这

种流动的流体与固体壁面之间的换热过程， 称为对流棋热. 它的特点是，在贴近壁面处且有

一层流体薄层存在， 稍后中的热传递依靠导热进行， 而在流体薄12外的热传递主要依靠时流

进行.例如，电子元件的散热， 冰箱排热管散热， 暖气片的散热及冲库中降却臂的收热等.

对流换热计算公式-立沿用牛顿冲却定律， 表达式如下

Q. = αA(巳 -号) (5-4 ) 

qa = α(凡-号) (叩
式中 ， Q. 为单位时间内的对流换热量 ( W ) ， qa 为单位时间单位面帜的对流换热量

~ I ( W/m勺 T. 为团体壁面温度('C) ， Tf 为流体温度( 'C ) ， α 为对流换热系盘

挝 I ( W/(m" 'C)l , A 为对流换热面权 (m2 ) .
量 :'1 需要注嚣的是，对流换热系数 α 与导热系数 A 不同， a 不是物性#数，而是与流体运动
程流 |
体| 产生的原因，流动的状态 ， 流体有无相变，流体的物性以且壁面的形状、相对位置等许事困

在| 章有关的·
在 FLUE肝 可以模拟因流体受热引发密度变化而产生重力差异导致的流体流动，这种流
真 l 动称为自然对流的浮力驱胡流动.

134 

泪告对流中，浑力III响可通过格拉晓夫数与雷诺数来判l?) ，

Gr gßån 
(5-6 ) 

Re2 V2 

当此数值接近或跑过 1.0 时 ， 浮力对流动将有较大事响. 相反 ， 若此敏较小，捍力的III

响可以想略.

在纯悍的自然对流中，浮力引起的流动强度由南利数快定 ，

Ra = gßån'ρ 
=一

μα 

(5-7) 

若 Ra<lOl ， 浮力驱动的时流为层流， 当 I 08<Ra< 1 010 时，对自![为应流到端流的过波事

当 Ra> 1010时， 对流为端流流动.
当模拟封闭区域的自然对流时， 密度场的计算是流场计算的关键 • FLUENT 中有两种

方法来计算密度场=

• 对于计算E墙内温量较大的情缸，将问圃挂非定带来计算，



• 对于小温量的情况，可且使用 Boussinesq 模型假设按定带问题来计算.

5 . 1 .3 热辐射

热传导和1热对流都必须通过物体的江接接触进行传热， 然而 ， 自然界中还存在着不伍都

物体且接接融也能进行热传递的现草. 物体通过电磁波的形式向外发射辐射能的现且叫做辐

射. 物体企因各种原因发出辐射能，其中由于温差或热的原因引起的辐射能量的传播过程称

为热辄射.

自然界中各个物体都能平停地将其热能转化为辐射能向外发射，同时丑不断地吸收来自

其他物体的辐射能， 井将其转变成热能储存起来. 实验表明 ， 物体的辐射能力和温度有关，

同 温度下不同物体的辐射和吸收的本领也大不一样. 高温物体盎射的辐射能比吸收的事，

低温物体吸收的事于高温物体的 ， 结果串成辐射换热， 且效果是使热量由高温物体传至低温

物体.

当热辐射能量投射到物体表面上时，和可见光一样，也会发生吸收、反射和穿透现草.

根据世吸收、反射1同!穿透的能量百分数可以定义该物体对投入相射的吸收率、反射率和l穿透

率〈三者和为1l.吸收率为 1 的物体叫嚣体，反射率为 1 的物体叫镜悼 ， 穿透率为 1 的物

体叫做透明体. 气体中分子结构对称的双原于气体(如氧气、氯气等)实际井无监射和l吸收

辐射的能力 ， 可认为是热辐射的透明悻. 但是三原子 011 CO，)、多原于 (CHρ 以且结构

不对称的取原子气体〈如 CO ) 刽l有相当大的辐射本领. 气体辐射不同于固体和液体辐射，

具有两个突出的特点

• 气体辐射对革长有选择性，
• 气体辐射和理性是在整个在朝中进行的.
辐射换热是高植面矗件 F换#目的主要机制. 在相同温度下 ， 黑体的辐射能力量大. 它在单

位时间内发射的辆射能可按斯带芬.破!l飞蓝显定律计算

Q- . ",r (5-8) 

式中.Q 为辐射能量 (W ). T 为绝对祖皮 ( K (. A 为物质的表面积 (m勺， 白为黑体
辐射常数. (1.=:5.67)( IO-RW l(m2 'K可.

!k际物体的辐射能力均小于相同温度下黑体的辐射能力 ， 其辐射能的计算式为

Q - ,"",1' (5-9 ) 

式中， ε 为物体的发射率， 也称I!Wt .

对于两个互相平行且十分接近的照体农丽之间进行的辐射换热量可按下式计算

Q = σ'~A (7;' - T2‘ ) (弘 10 )

式中 • T， 为高温表面的绝肘温度(K ) . 乃为低温表丽的绝对温度 (K ) .

可见，辐射换热与导执、对流换热不同 ， 其特点是

• 不仅有能量的传递，而且有能量形式的特棋，即J!-热能转变为辐射脏，或从辐
射能转变为热睫，

• 不必惜助于中间介盾，在真空中也能进行，
• 在it射辐射能的同时也在吸收
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FLUENT 中 可以用 5 种模型来计算辐射换热问题 ， 分别为离散换热辐射模型

(DTRM ) , P- I 辐射模型、 Rosseland 辐射模型、表丽辐射模型 ( S2S ) 和!离散坐标辐射模型

<00).

• 离散换热辐射模型 ( OTRM )是一个比较简单的模型，可时通过增加射盘盘量

来提高计算精度，同时这个模型可以用于任何光丰厚度 . 1主模型假设所有幸面

都是理射最面 ， 即所有人射的辐射射量没有固定的且射角，而是均匀地且射到

各个方向 . 计算中挂有考虑蝠射的散射鼓应，且假设辐射是灰体辐射. 如果果

用大量射蝇进行计算的话，告蛙 CPU 增加祖大负担. OTRM 模型不能用于动

网格量存在拼接网格界面的情乱，也平能用于井行计算.

• p.) 辐射幢型的辐射换热方程是一个计算量相对较小的扩散方在. 在燃烧等先

学厚度很大的计算问题中， P-I 辐射模型的计算娃果枝好 ， P-I 辐射模型还可

"在*用曲蝇坐标革的情拖下计算复盘几何形柱的问题. 然而， P-I 辐射幢型
也假设所有幸面都是理射表面，即所有人射的辐射射最没有固定的反射角，而

是均句地反射到各个方向 . 另外，该模型也是呆用灰体假设. 如果光学厚度较

小时 ， 计算精度告受到几何~章程度的影响.

• Rosseland 辐射幌型本用盘 机 1 辐射模型那样计算额外的输远方程 ， 因此读棋

型的计算速度较快，需要的内存较少. 但是谊模型只能用于尤学厚度大于 3 的
问题，同时计算中只盹来用压力基求解器进行计算.

• *面辐射模型( S2S )用于计算在提有参与性介盾的封闭空间内的辐射换热计

算，如飞船散热1民辑、太阳能量热器和汽车机箱内的冷却过程等.虽然 S2S

模型视角因于的计算曹要占用较多的 CPU 时间，但其每个选代步计算速度报

快. 与 OTRM 和 机1 模型-样， S2S 模型也假设所有表面都是理射最面，并

3在用皮体辐射模型进行计算 ， S2S 模型不能计算有参与性辐射介盾的问题 ， 平

盹用于带周期性边鼻矗件或对非边界牵件的计算，平植用于二量抽时韩问题的

计算.也不能用于多种封闭区域的辐射计算，只盹用于单-封闭几何形扭曲计

算 ， ji 外， S2S 模型也不适用于拼接网格界面.牵挂节点存在的情况和网格的

自适应计算.

• 离散坐标辐射模型 ( 00 ) 是使用范围最大的模型，它可"计算所有光学厚度

的辐射问题，并且计算范围涵盖了从表面辐射峪半通明介质辐射到燃烧问题中

出现的参与性介质辐射在内的各种辐射问题 ， 00 模型最用皮带模型进行计

算，因此眈可回计算:IA体辐射，也可"计算非灰体辐射. 如果罔格划分本是特

别如时，计算所占用的 CPU 时间并不长，所时， 00 模型成为计算中盘带使

用的-个檀型.

选择辐射模型的标准主要有如下内容.

先丰厚度.光学厚度远大于 1 时，最好选用 机1 和 Rosseland 斟型 ， 光学模型

大于 3 时，选用 R。目.1四d 模型 ， 对于更高的光学厚度，推荐使用 00 模型和

二阶离散格式 OTRM 和 00 模型对任何先丰厚度都适用，对于光学厚度小

于 1 的问题， )III ，R随便用 DTRM 和 00 模型.

• 散射a但和皮射率 . P- I . Ros回land 和 00 模型均可1;(计算散射问题，而 OTRM



模型则是E略了散射的事响.

颗桂鼓应. 只能使用 机1 和 DO模型计算气体与颗单间的辐射换热.

• 半透明介盾与镜面边界. 只能使用 DO 模型.

• 非灰体辐射. 只能使用 ∞模型.
• 局部热罩问JII! . 推荐使用 DO 模型，如果乖用足够多的射且ö:目，还可w.;辑用

DTRM 模型 .

• 封闭腔内没有参与性辐射介盾的情现 . S2S 模型最为适用 .
• 外部辐射问题. 如果要寺犀计算区域外部的辐射"响，耶么 ， 在模型边界定义
时要使用外部辐射边界串件. 如果平关心计算E墙内部的辐射，仅考虑外部辐

射的事响，只曹要用户在边鼻定义的时候使用外部辐射边界矗件即可.

5.2 传热分析的应用及方法

FLUENT 软件可以模拟绝大部分工程所需解决的热传递问题.

• 理泡问题.

• 润滑问题
• j奥热嚣的结构ít1t与应用 .

• 式焰辐射问题.

• J民暖、通凤和空调工业中的空间传热问JII! .

• 汽车工业中车届的传热分析.

• 玻璃加工‘革璃纤蛙拉雄和陶班加工过程中的辐射.

• 钻井工程中理井的井温分布问题

• 固井时水花草在井内所处的植度增问题.
• 原油管道的加热输送a停输温降问题.

• 油轮加/!'.保温问厘.
• 表面辐射加热量冷却问题.

• 辐射.时施和热恃导的精合传热问题.
• 气体与颗植之间的辐射换热问题.

• 飞船散热系统传热问题.
• 太阳能靠热器传热问鹰.

Jl)户利用 FLUENT 求解传热问题时仰望进行如下设置.

• 酷活恃热计算模型，即执行 Define..... Models → En吨y 命

令，打开 Energy 对话框上的 Encrgy Equation 选项来最活

传热计算，如固 5.1 所示 . 若考犀粘性加热作用时，如润

滑问题及高速压缩施动时，曹要执行 Define"'" Models "'" 

Viscous 命令，在 Viscous Model 对话框中最活 Viscous

Heating 造项，如图 5.2 所示.
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图，-， 激活帖性细热边项

· 设 E施动人口也出口且壁面上的热边界条件 . 执行 Define - Boundary 

Conditions 命令，设置施动人口、出口的温度和壁面的热边界. 固 5-3 所幸的

速度入口与田 5-4 所示的压力出口的温度设置，用户只曾在入口( Vel国时

Inlet 蝇 Pressure Inlet ) 出口( Pressure Outlet ) 边界条件设置时话框的

Thenn创 造项中的 Temperature[K] 中进行设置 . FLUENT 默认进.出口边界上
的温度均为 300K_ FLUENT 提住的壁面热边鼻蛊型有 5 个，有热班边界串

件.温度边界晶件.对撞换酷迫界*'件辐射边界备件以及辐射和对班班告边
界串件，如回 5-5 所幸 _ FLUENT 默认在壁面上使用军棉班{绝热)边界条

件.
a -­II.'~I _' 

嗣… h叫 I~血1 .. 由. I~ 阳"叫唰 1

Y叩叫咱「一一-F且. 一丁

-旦」 王旦旦U

圈，-， 遮度入口边界温度设置

--".., 
嗣….-- 1-叫怕..w‘ l 脑崎翻.. 1 110也 l

…._.一H面 3 

~~....!旦
回，.. 压力出口地界温度设置
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阁，-， 壁画然也界条件设置

· 传热问题中介，u-融的设定. 执行 Define→ Materia l s 命令， 设置班体和壁面物

盾的比热和导热 ，U生 . FLUENT 允许用户调用自是J( 函散 (UDF ) 来世置物

质的热物理参拙，如固 5-6 所示.
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图S-6 Mf鸣"物理，数设'配

量a，璧画"边界命仲议罩对话植命的 Malcrial Name 下拉JoJ.f..可以设置壁画的材抖， FLUENT 默认的 :IJ

副田nmum .

出于计算稳定性的考虑 ， FLUENT 对计算过程中的温度范围进行了限制，上限为

5酬K，下限为 1 K. 1韭行温度的限制主要是为了保证传热计算的真实性 ， 因为根据物理特

性，现实中的温度应该处于这样的一个范回内. 如果在计算的过程中 ， 温度超出了上限， 则

将温度温制于到刷K，若温度低于下限， ，即J温制于 lK . 着实际传热问题的温度确实超过
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5∞OK . 且IJ用户可以悔改温度上限. 具体操作为 ， 执行 Solve- Controls- Lim由 命令 ， 将

Sloution LimilS对话框的 Maximurn Temperature 选项目内温度值设置均实际il，j耍的温度上限

值， 如回 5-7 所示.

剧时'由"阳'~I叫

--回翩峙阳"四'1叫1'""'1 . '

凶血牺叫" 甲阳""一-

..-SCMk Tu.,.,.MWe IkIJm" 

--确嗣 T...... V1.co啕-1'丽"
向惜耐_u酬fI.Z一

" 旦旦j 旦旦旦U
阁S.7 Slooli阴Limits 对话报

下ilfi通过两个工程实例 ， 介绍 FLUENT传热分析的过程.

【实例 5-1 】 油轮加热、 保温温度场模拟

袖轮在航行的过程中，根据不同的航线、航程， 舱内茧汕将会受到i者多因素罪响而监生

自然冲甜 ， 如果温度降到艇点温度 ， 将给部茧带来困难. 所以在这种情况下必须对其进行加

热， 采用何种加热方蛊以且后续保温方案将时汹轮货拙运输产生重大的睡响. 现内未有一种

特别方便而有效的方法来计算盘油加热保温过程中的温度场且流场变化， 且物理实验的精度

也无法得到十足的保障. 所以借助现代计算流体力学技术. ~;t油轮黄油ml热且保温时的温度

场进行模拟，以得到具体的加热血保温时间， 是目前景用的主要方法之一.

-、 实例慨述

现代大型汕船均盐1双究体船，在各黄油舱的边上都世布专用压娥舱，如l阁 5-8 所示.当

船KI在压戴航行时， 舱内黄油通过船内完体、压就水、外壳体向海水放热，不进行压载时，

舱内货汹通过船内壳体、空气、外究体向海水放热 此外， 舱内货汹坯与舱顶的惰性气体发

生对流换热 ， 其中惰性气体体积占油舱的 2%，情气通过甲板向大气放热. 为了避免袖温由

于上述因童自然冲却到凝点以下而ei响扭拙，在舱底还安装了加热盘管.

口 惰性气体 口口
口 货油

口 厂蛐酣 口

已口口口口 ι

加强'自

".水
阁，-. 油轮赁'血债.. 面示..回

本例时对运送 AROIUNA Crude Oil 货泊的 680∞DWT 型袖轮进行加热、保温温度场模

拟， 其袖轮结构.数和货油物性#数卦掉l如表 5- 1 和表 5-2 所示，井假设初始油温为 5 1 1:.

海水温度为 201: . 大气温度布 251: _



'晨5-1 泊轮的结构，戴

篇掏

袖..，掌权f/lm'

槽'庭内侧面..，回内J

....外侧面"'-"回2

....肉黯圃"'-"霄，

楠..外露面'现 A帽拙"

尺寸 结掏

蛐舱顶面狈 AJml

一'由民 11m

细盘'垒'肉模面椒'Jm'

细"盒."褒面飘JtJml

尺寸
, 
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.5.2 货泊的精性.戴

泊晶~ .. 
..,. 

Pf}I..lJ/m' 
比费'
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....晨'院
罔业旦
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运动!<Jl
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838.8 1.941 17.0 0. 1lω 203.5 

思路分析

若本例假设把所有汹舱当作一个整体， 忽略袖舱内货油的热阻且货汹与汕轮内究体的对

由换热热阻，另外，茧汕热力学#数变化取温度变化范围内的平均值，外界的大气和海水取

~测的平均值， 则可把问题简化为阁 5-9 所示的几何模型，相当于一个封闭方腔内的传热问

题.
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因，-. 泊.. 细俗、保温过程的二锥几何领"

通过本实例的演示过程，读者将学习到

• 热边界里且，
• 自定义材料的定义，

• 非定晴的计算，

• 时间步仕的设置，
• Boussin田q 模型假设.

(u....)一，见附带光盘 u Ch5\s15-I .msh ..、 . Ch51s旧 d趴 u Ch5\s15-1 .jou H、
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"Ch5、sI5- I .tm "、 u Ch5\s15- t.j .cas" 、 "Ch5、s IS-I-j I h.dat n 、 "Ch5、15-1 -

j5h.dat n 、 u Ch5\s15-1-j IOh.dat "、 u Ch5\s15-1 -j20h.dat . 、 u Ch5\s15-1-

j30h.da' .、 U ChS、1 5- 1-j40h .dat ，.、 u Ch5\s 15-1-b 四s • 、 u Ch5\s15- 1-

bl h .dat " 、 u Ch5飞sI5- 1 -b1 Oh.dat .. 、 u Ch5飞s I5-I-bSOh .dat " 、 .. Ch5、15-1-

b1 00h 也， "、 uCh5\s15-1-b 150h.dat". 

(uu)一参见附带光盘 "'Ch5叫川叭

二、 模型建立

本例模型相对简单 ， 只需启动 GAMB1T 软件，直接执行面建立命令. 具体操作为 单

剑百→[F-r霄， 在 Creatc Real Rec阳gu1町 Face酬的 wi拙和刷刷中分别输入 10
和 1 2. 如困 5- 10 所示. 单击..，.二l按钮，即生成了图 5- 11 所示的几何模型.

~....... . . .... . 

二 E L口 hL 
- ....j;:;;;, ~ 
- ..... c_..1 
_ r 
-"且J ...... 巳J!:!!巳」
阁$-10 矩形生..面'民 回S-II 建立好的几何面

二、 同幡划骨

考虑到黄油粘度相对艘菌 ， 在接近四壁的区域采用网格加密划法.

1 单去「百-r古吗~.在国 5-12 所示的 Mesh Edges 峭的 Edges 黄色输入
栏中选取线段 1 (edge. l ) 和线段 3 (edge.3)，接T Double sided 前面的接扭

使其呈红色选中显示，设置 Ratio l 和 Ratio2 的节点距离比例都为 1 .05. 选择

lnterval Count 分段方式， 并在左侧输入担中输入 35.

蝇段 1 和 3 的蝇网格. 按照同样的方法划分蝇段 2 和蝇段 4 . 臣.1'1在于分且

40段，得出的蝇同品如圄 5- 1 3 所示.…*.1" 
剧， 阿， 曰
'幅幅_ .....wl 

_.‘ 旦旦4
'幅幅啕呵

二季主主

号兰兰D
'…… 
d…… 

工豆匡二J ...... 旦JI:主里」

朋$. 1 2 d:网将划分 困5.13 J圳分好的钱网格

2 轴r--w-阳，打开 Mesh Faces !iJ~ . 用应N+1l.#.&.剧中巳眈



成此同格划分的几何函，运用Quad 单品与 Map 万法叶选该面进行画同格划

分，保留其他默认世直，单击键入生成如围 5-14 所示的网格.

3 单击r--f亩，在 S阳市 Boundary Types 面极中将边壁 4 牵线均定义为壁画
( WALL) 边界，且称分别为 top、 b。仅om、 wallleft 和 wallright，如困 5-15 所

叮亏 .

回5- 14 生成好的面网格 因S-IS 边界笑lIj定义

4 单击视固控制画板中的~按钮，在弹出的如圄 5-16 所示的 Spec均 Display
Attributes 函辄中将下万 M田h 后面的 Olf选中，是闸视图窗口中的同棉里示.

建重z 对于校且杂的几何图形，用户在之义边界4巴黎之前，可以将网格暂时关闭，以使定义时能够』正确选

命所需要的线A"' _

5 单去r--r-，弹出 Spe呻 Continuum Typ四帆，将面 l 定>U; itiA4< ß J.ö, 
(FLUID), .t非为。i!，如圄 5-17 所示.

蛐蛐嗣偏 P!1 1~1 目 l 田 1..1

""'- 二与JII一主l
」蛐- AM ~ltr一主j

"- 二与Jr- .!J 
」甸回二L二Jr- .!J 
..J_ "" 二Jr- .!J 
.J B. uyws A与Jr- .!J 
" C .，.二~II一主j

在主主多
J恤' 二江...::J

E豆立J_豆豆主L旦旦」
图5-17 介.. 笑型'"义因5 附关闭阙精显示

6 同格划分克后，执行 File→ Export - Mesh 命令，将同格输出为 s15. l.msh.

-
m
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四 、 草解计算

! 启动 FLUENT (2d 计耳器)， 执行 file→Read→C田e 命令，读入划分好的网

格丈件 "sI5- I .msh飞

2 执行 Grid_Chei:k 命令 ， 时间格进行栓剖 ， 持窗口.Jf.<f>中最后一行出现

"Done" 语句时在示栓"'1成功.

3 执行 Grid_Scale 命令，弹出如困 5-18 所示的 Scale Grid 时话框，用户可以

量看到本制的几何模型尺寸，长为 10m，高为 1 2m
"冒雪圄皿理

S.... F'町蛐…

'r一一-， ，耐w.. c..，庸...:;.-丁

Yr一一 旦旦出塑旦旦j

h酬 E鹰刷

刷ft lm! Fi一一一阳叫r一一­

V川F一一-- Y.-刷厂-一

二旦 旦旦j 画且 主U

4 

剧~-18 ScaJe Grid对 18幌

执行 Define→Models→Solver 命今，弹出如国 川9 所示的 Solver 时话植.

本例为非是常模型，故选取 Tìme 下的 Unsteady ， 其余保持耻认，单击一旦」

接扭.

1卢l'，"目前E

"阳
r. f'Ion.... B.-tI 
....'"…H 

F一' ，，"而d
Fε 

,,", 

岳重吕
T.__lut C叫"

y，协~ r,......'MiOft 

~ "'..1盹
("' Rel........ 

「 …，--…叫
r "町n Aux f..............

....旧的 r..-'....
俨

衔 '由c1e. ,..,11dt 
2nof.O"E' ImpNdI 

p,.",u. fonnol.tlon 
r. 5uc州d，1 Vdoc:lly 
俨 阙酬。C.I Veloc:lly 

GrMlent Opl'" 
(Õ GteeJt-G.... Ctll a..ed 
(' c...It'G ... …~odc e.nd 
' ..… s刷刷. Ctll e..cd 

一旦」 旦旦止旦J • 
罔 5- 1 9 Solvn 对话枢

5 执行 Define→Models→Visco旧命令， 在弹出的 ViSCOU$ Model 时话枢进行品

或稍啤模型的设置，如圄 5-20 所示. 通过式( 5-71 判断本制为品流流动， 故

保持 FLUENT 默认的品流棋型，直接单击-旦」按钮.

6 此行Define -0 Models -0 Energy 命今，句迫 Energy 对话框上的 Energy Equation 

选项， .. :.t激活侍热计算 ， 如固 5-21 所示.



E圃圈圈-四
时'

F … 
E丽.. 
…川
~ p..叫
_.~阉

1 …..... lIi唰

• 

一旦」 王E到 」旦j

闸5-20 Visc酬 Moo.'对薛樵 回5-21 自隙咽对话"

7 下面是义本制的材料---贯油 . 执行Define→Materia ls 命令，弹出 Malerials

对话柜. FLUENT 默认的材科为主气( ai叶， 由于本制肯油为特珠材料，不 ... 

于 FLUENT 自带的材料数据碎之刑，故需要用户自定义材料. 单击 Materials

时话框右侧的 F1uen' D.t.b..e 接扭，此时告弹出如圄 5.22 所示的Open

Datab国e 时话桩，若为f.一次走且自走义材料数据扉.需要用户捕入敛据库的

名称，如本倒输入的 new material s . 名称输入在后，单去…旦」柱扭，会弹出

如困 5.23 所示的询问时话框，意为是否晏建立一个新材料的数据碎，单击

11 Yn 11按钮'阿.

~丘旦l 且呈」 ![v..j 一旦」

8 

回5-22 Opcn Da烟....对崎岖 阳 5-23 矗立'而"剿"麟，事匍问阳

至此， 己叫立一个空白的1J;t>l材柑据库 . 单击克I! Ye. 1 1按钮后弹出如
围 5.24 所示的 User-Defined Oatabase Materials 对话框，对话括中的 User­

Defined Fluid Materials 列在为全宜，在示尚未定义任何嘶材料.

现在建立常材料世据感里的第 一个材料一一贯油 . 单企 User-Oefined

Oatabase Ma阳ials 时话握最下方的旦旦斗挂扭，弹出 Material Properties 时话
岖 ， 如固 5.25 所示 .

9 

-一 _=IM.. Ei ... • 
~flOI' ''_ 

._c..._ 1 0.叫

E斗←-.J ....，j王旦J lI!3 左空」
回5-25 Ma!erial prq隙.田川崎榄阳5.24 U蟹....D.efined Database MBlrnals >>ti8根

\0 在 Material Properties 对话柜的 Name 栏输入贯泊的名M- ardjuna-crude-oil ， 保

留 Formula 为宜{若不如材料的分于式，可以保留为宜 )， tr.后选择 Types 晶

型为 fluid . 并在 Avai lable Properties 111在中选择比热辜 (Cp[Specific Heat] ) 

密度( Density )，导热草草( Thermal Condu由vity ) 膨胀单数{ 刊ennal

Expansion Coefficient )、粘Jt.. ( Viscos町)， ，f}到右恻 Materia l Properties 111..f.. 

.
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中 ， 如围 5-26 所示.

H 于面对比热容、密度、...鸪革欲膨胀革盘和韩Jt.进行足义. 克选中 Material

Properties J!l在中的 Cp[Specific H叫，单击时话桓下侧的旦旦陆钮，弹出
Edit Property Methods 时话挂. 将 Available Properti回到在中的 constant ~入到

右侧 Material Propert阳列在中，并在左下万输入栏中输入 1 941.单去-巳且安

扭，即将比然在且常挂形式定义为 194 1J1 ( kg'K ) . 如圄 5-27 所示.

… 1-- 叮信卖画
...w......归-

」υ

.!!.I 

,.… 
1- 3~ 
1'"' 

二兰主旦主皇」
陶'-26 雄"价)jô义的"役，数 圃'-27 比，.. ，忠义

12 按照同样的方式是义密庄( Density ).导热革盘( Thennal Conduct川ty ).膨胀

~、数(Thennal Expansion C田fficient )和粘庄 ( Viscosity )，如圄 5-2g 王圄$

3 1 所示，其中定义粘度时选择 Avai1able Prope叫白 J'I在中的 boussine叫·

自?1一-

EF 一1 叫 在k.
二U

二υ

EE34 EE二工J

，主」主旦到 二里」

陶S.28 密度定义

-旦」 主旦到 二旦j

棚S.29 导然:，，，.定义

--
悻ip
…，惘 ……. '川
阳" - 一_. 
…·-h, 二二主υ」…·町•• F' - .. 
~_.幅'

• -
一一一 • ..… 
忡幅画 工J~ l 
在百-

-".1旦旦j 二里J

因 S.lO .11瓢徽定义 阳5-) 1 精!l定又



13 所有物性#歇的世值走扎克后，回到 Material Properties 对话桩，单去旦旦j.
卫生立挂扭. 此时， User-Defined Database Materials 对话植中盹已且有丁嘶材

料 ardjuna-crude-oil 1 ， 如围 5-32 所示.

宵 .-
r…，叫

h田上半」 二旦J 王旦J 旦旦j 丘U
因5-)2 I而材料已存在于自定义..割据席中

14 单击 User-Defined Database Ma创terial s 时话植下恻的 s~J桂钮，.t，.示斗将守足且奸
的耐材料储存在自走义材料欲据库中，以便队后调用 . 鼎后单击二2巳接扭，

在示将材料由自定义最据碎持且主'1 当前工程中 . 最后单击旦旦旦按钮，虽闽
User-Defined Oatab目e Materials 对话植. 呈此，我们完成了浙材料定义的整个

过程.

15 回到最初的 Materials 对话框，

圄 5-33 所示，单击

此时 ardjuna-crude-oi l 已出现在工租材料中，如

是间

"3 ~ =-r_刷

二到

n....oIt.oHI叫问 1叩M

fõ.言
归由酌1 1001_

严而言

~，~副问.......C..-dc..r啊 [c-ø.­

严丽百

阳-
u
z.空三」一二..， 一」生-.J

回5.)) Mal自划阳对话舷

1 6 执行 Define→Operating Conditions 命令 ， 在圄 5-34 所示的Operating

Conditions 时话柜中设置4义制的操作耳J.t. 保持左侧的环境压强为 1 个大气A

( 101 325Pa ) }.且在考住直为原点 (0 ， 0)，选中右侧的 Gnv呵，设置 y 万向的

'
5
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加速度为 6. 1 5 x lO-5 ，在 80ussinesq Parameters 下万的操作温度输入栏中输入

1回 ( 'C )，单去」巳J按钮.

17τòi 定义本制的边Ji-串件，单去 Define→Boundary Conditio时 ，选择

Boundary Conditions 对话植在倒 Zone 列在中的 oîl，单击」旦-按钮，在圄 5-

35 所示的 Fluid 对话括中的 Materia l Name 下拉列在中选择新材料 ardjuna­

crude-oil，单去一旦』安钮.
R 

P./.I'f'f咔 ωM川豆I
_.­
Fi1一

酌....... 也叫

阳制.-阿，.-忑古丁主主斗
'" (>......'11 
。叫…刷阳，..... 刷 r Po<n l Zo"" 

r S...,,:e r." ... 
ï f1nd '1.,,,,,. 

时1." I p"....z... j Re.由 l '… T."". I阳川叫

~阳_ Pr...ur. uw::曲. )(lmMl fI一一­

'1叫咱F万;:i5一X阳') 1 ' 一­

V如') 1 ' 一
-.巾。而仙

X同F一一-

'1'叫F

ρl 

信旦旦旦旦旦

v.唰巾..'"阳.....1<.. 

r S,eclllod Op..atinl O.n M)l 3j 恤阳 T.，.，. p阳阳明

一旦J 且国止'!J 一旦_H豆豆 止旦j

阁 5-34 IJ作环缆设定 栩5-35 流动介质)i;义

18 接着住次选择 Zone 列在中 top、 walll eft. wallright . 单去」丘」按钮，在 Wall

对话握中选择 Thermal Conditions 下方的 Tempera阳阻，设定温度值分别为

25 、 20 和 20，在示将这 3 帚边定义为恒温边界，圄 5-3 6 所示为顶边的走"--

Z酣睡 N...• 

.."回国 c..z-

.... "'."""" 111.....叫 R04'oII.. j S"呻_ 1 DPW 1 M'"阳.. 1 uos 
n..."，时，.. 酬.~，

r Hc.t Fl瞌翼 T.~.阳e即- i (." T...咱晤，因."
刷刷刊嗣...叫·

c ，_国恤'
(' _..... 

时Guc.. 阳阳伸到|· j f‘ 曲圃，唱.. 

M圃..... .... 

1.',,,,loIu., 3坐过

~岳副 主生j

四S-36 顶尬的压义

底边在加热和保温两个过程中的定义平-样

• 在加热计算时，读边走且为加热盘营时应的温度，即 1 40 'C ;
• 在惺温计算时，如热盘管已不如鹅，谊边与海水接触，定义为海水温度 20'C .

19. i九行 Solve → Control → Solution 命令，弹出如圄 5-37 所示的 Solution Controls 

时话框，选择 Discretization 丁方 Pressure 的格式为 PRESTO ! ， 其余保持默

认，单击i巳」制且.
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淫a . 初始化中的 Patch 能够克成区峡内各物性参4<-1三强 组分‘温度等的扑克定义，加快边界这

血.

22 初始化后，执行 Solve -- Monitors -- Residual 命令，在弹出的 Residual

Monit。同时话括选中 Plot . ~;.{打开蝇是曲蝇困， FLUENT 耻认的 contmU1ty .

x.vel国町、 y咽locity 的收盒式柑血为 o ωJ，J/l认的 energy 的收最蜻庄为 10-6，

本制为默认诅置 ， 如圄 5-40 所示.

安 1
翻.... -申叫

"-!'-一封 -[0丑
阳由血 - 阳- jiiii""""" iI 

俨 阳_u r;t SCM A主s- I c-__ I 

信悲旦旦L丁

t?丐'悖一「
• • 严百一­

g 严E一­

Iõ' !，.-_ 一

-­P 噩噩

4 

一旦J~ -I 王---- 1 ...!旦」
回，-<<1 .. ωdual MOI山m对话提

23 执At File-→Wrile→Cas. 命令， 将工程主件保存为 s15- J.j . c国.

下面设置完法代步数后就可以开始计算了.

24 加热计算.

(1) 执府 Solve - Iterate 命令，弹出如围 5-4 1 所示的Iterate 时话框，典中的 Time

51叩 Size 为时间步长，世直为 O. l s. Number of Time Steps 为时间步址，Jt设
直为 36仪泊 ， 即i在代时间为 1h ，

l!.c Sto，S1u间 !I.t

11_.01-'-叩j..- 量

阳……"_. 
' -啕
俨 "
。_.

r O_S叫……

…血..--'-Soo，~丑

陆内'楠，耐r-j丑

陋叫‘阿圄叫「一封

旦旦旦旦I 王- 1

回~1 ltente对话倔



注'障 时间步长选取应根据实际问题尽可能这小一些， 以确保精确度

(2) 选代 lh 后，执行 File→Write→Data 命令，将加热 l h 的结果文件悻存为 515-

I-j Ih.dal. 

(3) 执行 Display → Contours 命令，在图 5-42 所示的 Contours 时话柜中选择
Contours of下#列在栏的 Tempe阳ture 和 Stalic Tempera阳町，并在 Oplions 选

择栏中的 Filled 前单击(打刷，单击国豆国提扭，弹出如圄 5-43 所示的，孟
庄分布云圄 . 由此可见，加热 Ih 后整个背舱内的油温没有明显的主化.

锣 ，鞠.
锣 _v_.

. ，旧时

锣抽民­
r ,…[1.... 
r ._叫r__ 

I-T_，_τ一一丁

护一萨一

因5-42 Cωωn对话榷 图5-43 加热"后的温度场

(4) 将 Contours of 下拉列在中的选择项换为 Velocity 和 Velocity Ma伊itude，再

次单去E豆豆1接扭，可碍肯舱内肯油的速度场分布，如围 5-44 所示. 由此可
见，此时的肯油速度很小，最大仅为 O.OO0017rn1s，但在两侧边壁处己体现出

时流现阜.

--E 

E 

E -E -E 

因，.... 翩然 1h 后的速度扬

(5) 继续迭代 4h . 即在 Iterate 对话框内的时间步世内输入 144000. 这代结束后保

存结果文件为 s15-1 -j5h .dat . 圄形处理同前边步骤，得到此时的温度场和速度

场如围 5-45 和围 5-46 所示. 由此可见， 加热 5h 后的温度场主化仍不大， 但

速度已大于 T lh 时的追庄，且时，且现阜越加明显.
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曹雪R哩?曹雪-………苞 幽幽幽.IIiI国画画

-•• 
E 

E 

呻-m -E 

E -M -• 
四

" 
睛

" • -• 

-E _. ----------------

E -

圈，...翩然 lh 后的温度崎自国，.， 翩然 lh 后.，温度场

(6) 继培选代，豆 1 0h 时保存结果又件为 sI5-1-j 1 Oh .dat，后每隔 1 0h 保存-次结罩

主件，分别为 sI 5-1-j20h .dat ‘ sl5句 l-j 30h .dat 峪 s I5- I-j40h .dat . 直至'1肯油加热到

指定i益庄时，即可停且计算，得出最终的总加她时间 .

25. i来温计算.

者直i1l1温度为 56"C时 ， 停止加热，船底与海水搜触，温度近似为梅水温度 20"C ，此

时，货袖在四周均低温的情况下开始降温， 这个过程为保温过程.

( 1 ) 执行 File_Read_噜Case 命令，调入 s15- 1 -j 四s，修改凰边的地冉条件.设置

温度为 20'C ，如圄 5-47 所示.

' ---,. 
一一一…一}阳一唰
}一 T_._...~一一 =函r一;J
~.-

'一』相
咱一侧.

-榈.-阳-τ-甲-一'，'. '，;，，:0，--- ..,. , _. 
…』

自由· 王~

二U 画到二"'-'

回'.7 底地温".，隆重

(2) 进行啊始化正初始扑T过直，如圄 5-48 和固 5-49 所示.
… .i,iiiiilri'\ii J, ' :411 

-一- ~ 民主E 3 ' zzz-MZM 
俨

吕自
_ ... _. 

注生，.唱"阱..._ ....OCOII ., ------
".曲....τ-一-一一
、，… .一

'"___1<1 .. ---一由-
J~ - ~J 旦旦 _ h型电旦旦到

回，.. 切始化 1115-49 切始化外觅设"

(3) 执行 File→ Write→ Case 命令，将工程主件悻存为 sI 5- I-b.cas .



(4) 与加热计耳一样，打开蝇革幽蝇监视窗口后，单去 Solve - Iterate. ,_, Time 

SI叩 Size 为 0.15 ， Numher of Time Steps 为 36∞O . 单击旦旦旦挂钮开始解耳.
叶耳结束后 ， 执行 Fi le→Write→Data 命令，将保温 Ih 后的姑果主仲保存为

sI5-1-b I h .dat . 执行 Disp lay - Contours 命今，显示，且庄与速度分布的云圃，

分别如圄 5-50 和圄 5-51 所示. 由国可见，肯泊在四周冷壁的环境下开始降

温

曰川".川传霄'
" 
" • ,.. • --•• 
" 
" •• -皿
" •• 
•• 
国

" •• 
" 
" •• 
" 

帽 5-SO ~温州后的温度翩

uιWl.m.，昌面------E -

因5 .51 C扶植监 'h 后的温1'"

(5) 继续这代， 保存 1 0h 后的结果文件为 sI5-I-b I Oh.d砚 . 50h 后的姑果主件为 51 5-

l-b50h.dat , 1ωh 后的结果主件为 sI5- 1 -b I OOh .dat ， 150h 后的结果主伶为 51 5-1-

bI50h.dat. 

保温过程中，热量由舱壁向外传递， 靠近舱壁处置油密度发生变化，从而使整个油舱内

曹度不再均匀 ， 引起自然对流运动. 1 50h 后黄油的温度如圈 5-52 所示，下部温度分布成梯
度排列 i且明随着时间的增加，温度从上部到下部逐级降低.此时， 货舱中心温度已经降至

47.3 'C .温度梯度非常明显 ， 下部温度甚至触且凝点温度， 所以降温至此卫将进行新的一轮

拥热过程.

---E 

E 

E -E 

由-E --

F可Tτ士τ 目惊1

"
"
"
"
"
"
"
明
·
阳
"
"
"
川
凰
"
"
翩
翩
"
·

圃5-S2 保温'>Oh 后的温度输

连鑫 计算的过程中 ， 不应-'f子设置过多的时间步数 以免错过丁温度突变巍转折沓的'非伺.
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用户还可以通过 XY Plot 撞出各时间段货舱中某一点的温度，然后输入 Excel 进行温

度与时间曲钱的绘制，如货舱中部黄抽随时间的温降曲线 ， 如图 5-53 所示.

骑

55 

" ~ 53 

sz 
.. 

2s 协商 1∞

时阙(h)

圈5.S) 黄油的温降幽俄

'" '50 

26 持输出需要分析且整理的图形或数据后，执行 File - Exit 命令，安全退出
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E 实伊q 5 -2 】·室内传热温度场模拟

室内空调起到控制室温的作用 ， 在最热的直天可以利用它来桂暑， 事挣的冬天也能用官

来避瘁，那么空调在使用时 ， 直内温度分布如何'下面我们将通过 FL山NT 来模拟出空调

直内的温度场卦布.

-、 实例概述

固 5-54 所示为典型的宝内空调布置圈，阁中挂壁式空调下方为空气的出口，上万为空

气的进口，而对于房问而宫， 下方为空气进入房间的进口 ， 上方为房间空气进入空调的出口.

假设四盟约J与外界环境接触，温度为 38'C 上下边界与上下层房间接触， 温度为 28 'C 空调

制冲温度为 22'C . 空气进口速度为 0. 1 m1s o 下面针对这一问题计算该室内温度场的分布.

ι
F
 

3m 

3m 

H 'm • 
1115.54 空饲6画布置

思路分析

本例需建立三维模型，计算直内温度达到稳定时的温度分布， 故姐为定常计算. 整个房

间的六个壁面均世置为热时流地!JI-. 空调下方设置为空气的遮度入口 ， 而空调上方世置为自

由出口 .

154 



通过本实例的演示过程，读者将学习 ~J ，

• 三维模型的建立，

• 体与体的相减.
• 热对班边界的设置，
• 后处理切面的设置.

• 围彤的局部址大设置.

任HII)一#见附带光盘 u Ch5\s15-2.msh "、咄5\s15-2.dbs"、呗M忡川、
u Ch5\s15-2.tm"、 "ChS\s15-2.cas"、 "Ch5、 15-2 .dat飞

(uu)一事见附带她咄5\AVI\s15-2.avi飞

二、模型建立

l 启动 GAMBIT，直接刷刷与空调两个肯晶体. H["i"-~- I p ，弹
出如围 5.55 所示的 Create Real Brick tfJ板. 鼠标右键单击il板中 Direction 右

侧的 Cemered . 在下拉到在中选择+X+Y+Z ， *-示U坐标原点作为六面体左下

角的顶点进行蜡制. 在 Width (X). Depth ( y), Height (Z) 中分别输入二

如图 5.56 所示的1面体 I f专
热

lj~ 

._ -:'" 

回s-ss Creatc Rcal 8riçk 圃'医 回弘扬绘制好的第-个六面体

2 接着在该il扭的 W;dth (X). Depth (Y). He;ght (Z) 中分别输入 0.5. 0.2 、

0.2，单击E豆画工』按扭生成如固 5.57 所示的'*~体.

图S-S7 绘制好的第二个六面体

3 下面需要把主制直在正确的位置. ... '* Volume tfJ:.t&.中的F挂钮，在弹出

在第
5 
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的 Move/Copy Volumes 画品中选中宜调{体2)，保持为非动世直( Move 为选

中状毒，显示为红色). 在 X. y. z 输入栏中分J'I输入 1 、 2.8 、 2 . 在朵白这 3

个方向平移的距离，如圄 5-58 所示，移动后的两个体的住直如圄 5-59 所示.

i!"f二=二描矗曲曲1Ft

蛐m 丘江J I，~..' .!J 
. - ~崎，If"一一一

。... 回缸"
. "幽幽~­
v ReIKt v Scale 

"""由阳后Y'. 1 .!.I 

'''' 二旦旦4
国~叩

再|;仨 回

" 0翩翩民*.阳…v

, 
-旦旦J_旦旦J_旦旦」 ，~ - > 

111S-S9 移动后的体圃S-S8 MovefC响""四~面'民

4 由于在们研究的时阜是宜 内空气的传金属效且.因此计算区域不包括空调所在

的神体，故单击 Volume 制中的F棚，在圄 5-60 所示的 Subtract Real 

Volumes 00扭中的草一行、'oJume 中选择代在房间的体 1 (volume. I )，在第二

行 Volume 中选择代在空调的体 2 (volume.2)，单击~画工l接扭，得到如圄

5-61 所示的儿何体模型.

国 .幽幽画画画温" "0 !!! !,…-

… 主l1，-晴1
」 阴阳

lO'OIUmn I YOIUIIII .Z 主l

J 阳胁

-旦旦_.L旦旦...J -
罔5响，.'"回 Rcal Voluma 面'民 隙，~ ， 绘制好的儿何体....

- 、 网梅划分

1 时本例的体同格划分可以有多种形式，这里选择直接生成体同裕的方式. 单

击r-.--→陌→眩，制如回 5-62 晰的 Mesh Volumes 帆，在 Volum叫
恻的黄邑输入柜中选中画好的儿何体( volume. I ), ~:A Hex 与 Submap 结合的

划分方法进行体同格划分，网格的尺寸设直为 0.05. 且在击E豆豆主}按钮生A



体同掉，如圄 5-63 所示.

一蛐- 1τ_1 l.!.l 
:IItIIIMI: 11' ，.仰旦旦l

阳四..: ~ ...1 
"，.，二-. ...1 

~: .. 句肉旦旦l

.10'( 旦旦旦~
句幽圃 ， 栩栩

'…… 」…-­.J ~ Jllt il,ft;toM 

I!f!!r 1_旦旦」巳旦旦」

因~.62 Mesll Volum~ 面额 锢S.6l 绘制好的体阙榆

2 单去视图控制面板中的旦协扭，选中 ExamÎne Mesh 面极中 Range 质量也范
围按钮时，面板如圈 5-64 所示 1 最在恻的柱体最高，在示划分的体同格质量

桂骨，可U用于下步计算.

3 网格划分奸后走义边界提型， Jf-.t-[Wï -[莓，在 Sp四句 Boun血可 Types li1板
中斗守主调房的主7、左右.前后均>tSl为 WALL 迫耳. 名称分别为 shang.

x ia 、 血。. yOU. q lan 和 hou . 4守主调下方的<ii走义为迫庄进口 ，宝调上方的<ii

定义为自 由 出口 ， 主调其余的面也是义为壁画 WALL 边界，如圈 5-65 所示 • 

.... 町-
~ ..... 、， 匈帽.. + R..o-

主旦4西金坠l旦--旦旦旦4
白白

白响Il3 I El1 I剧且J旦J

"…'… .• 唰..-
• Quallly v Sl'l1Ide v 刷.~"

b ‘ ,",p. =""1.. 

btylle:VRl L 

bt ，叫e=VAll btwp.~ V肉LL

,,{ bt llPe=lIRLL 

:ES V , J E 

E审阳. T.,. 
.."川
yau I WALL 
qian I WALL 
恫IU I W 民"
shang I WALl 

E 
w …... 
，恒....翩翩. : 50 (50句

" '阳明…
且时 J 
E口

忡 F

,..".. m 

'"陆".
凋a一

WALL 
WALL 
VELOCπV_协al

OUTFLCW 
WALL 

" 工D
o , 
-旦旦L旦旦J--!!!巳」

四，... 同格'量撞"

。"
""明aobi

回，~， 鑫义"的地"提III
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4 最后执行 File - Export→ Mesh 命令， 将同格输出为 sI S-2.msh .

四、 求解计算

1 且击桌面上的 FLUENT 6.3 .26 快拔圄标，在弹出的 FLUENT Version 时话桂中

选择 3d (三维羊柑庄)计耳器 ， 如圄 5-66 所示 ， 单击 .... 1接扭启动
FLUENT 

团团-固

抽血
田一一

~ ~主J
回5-66 FLUENT 计算"边停

2 执行 Fi1 e→Read→Case 命今，读入划分畔的网格立件、15-2 .msh" • 

3 执行 Grid_Check 命今， 时间格进行桂删，窗口中会显示出桂删的基本仿息，

最后-行为 "Done" .在示本制的网格，生有问题.

4 执行 Grid_Scale 命令， 从囤 5-67 所示的 Scale Grid 对话柜中可"看到本倒

网格的坐标I! f司 .

5 执行 Define→Models→Solver 命令，弹出 Solv町对话抠，如围 5-68 所示.

本制为二维压力基是常模型 ， 故保持耻认，不做民动，直接单去一旦』安钮.

画画画

'一耐甲
r 

白白u.IIC_......

叮「一一 刷阳0.*.栩F丁

Yr一一一 丘吉~旦旦j
' 1'一一一

由-…} 俨}白

h 』

俨

俨

. .~ 

俨 -~
F w 
' 5 

…国嗣

-....[1一一 阳.....~----.....f. -....Ji 
z.. ....f. z...倒嗣

叫一'­c _阳
…白 白一

'…… "一『r一……『，庐山-~-

二里J 旦旦J [ãÕii'J Hc,," -呈」 庭副 .. 1

捆5-67 SCIJe Gri d 对t暑假 1115-63 Solver 对话'匡

6 执行 Define→Models→Viscous 命令，弹出如围 5-69 所示的 Viscous Model 时

话框 . FLUENT X!.认为层i.L模型 .

叩

俨}

‘ 自画画画
;c….. 11 喇
i 俨 "问时,. - "' .... i C…_.. 17 ... 

.C…时…
'一_u.
二豆主旦二型

捆，~⑩ v.民lUS Modd JIt语穗



7 圄本制空气为鸡 ~A. ~t.动，故选择标准的 k-， 模型，在 Model 迫项中选择

k.eps ilon[2 eqn] ， 在 k-epsilon Model 迫项下选择 Standard . 保留其他默认

过直 . 如圈 5-70 所示，单击一旦J按钮-
8 激活传晶计算，执行 Define→ Model俨 En吨y 命令，特 Energy 对话框上的

Energy Equation 选项句边，如圄 5-7 1 所示.
叹 .

M… ....I Con ... 四.. 

r ...."" • 
C刷

r ，_帽， 严高r 饵.，

• E严E4E二plllon
F 
「 阳，.，...1111 p .q叫

! r Det.dM:d Edlly Shn时，曾.. C2-Ep, "0II 
I r u，醉 Etl4y 81 ... 刷刷. ...剖

1r-e,.1I... ..HI TJ(f Prn '" Numh . 

StlII~'~ 二l俨 阳G

(" Reollu lll .. Un r-Oe1lned Fundlo",. 

2 
...俨响，.11 T,u',"",nt τF"南E"'eMW·回"

ti' St8ndoÑ W.U FUlldlon. 

斗
r .. 腼-EIIII....IIIII..... w.ø F....dIM. "M剑 "幢..."
re翩翩国l1li W.II Tre_ 1It 
r Uu...o唱.... ... 圃 ，.- 3 

阿了一 3 - " 

斗 '
I "nc咱V

一旦」 旦旦业 生!J
圃S-70 涮流帽型的被置 圃S.7 1 E肘..， 对话'医

9 模型选择克后，下面需要是1材料，执行 Define→Materials 命令，在

Material s 时话柜中进行流动材料的走义. 由于本制为宝气流动，而 FLUENT

默认的材料丘是空气( 8iT )，食生本倒不需要是义，且动的材料. 但是由于本倒要

考卓房间且主调壁的传热，这两者均为固体，房间壁农们默认为铝，通过在

边界定义时'*-吏扭的物性事数来达到材料的改置，而宝调壁的材料直接调用

FLUENT 自带的固体材料数据库 . 执行 Detine→Materials 命令，单去

Materials 时话框右侧的 Auent 0.，，，.. .. 一 接扭，在弹出的 Fluent Database 

Materials 对话桩中 ， 选择 Material Type 为 solid ， 然后利用堆动条选择 Fluent

Solid Materials :fl)在中的钢( steel ) ， 如圈子72 所示. 单击旦旦和王旦旦l接

钮，将钢材料导人J'J 当前工程并吴间 Fluent Database Materials 时话桓. 最后

单去 Material s 对话柜中的旦旦茹扭，克成材料的走"--

10 执行 Define→ Operating Conditions 命令， 在 Operating Condi tions 时话植中设

直工作压强 FLUENT 中默认为 1 01325阳，事考位直为原点 (0 ， 0 , 0)， 且

不幸卓GravÎty 作用，本制保持默认世直 ， 如围 5-73 所示，单去一旦』安缸.

在?然' , 
3 

事
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'由描画-幽幽国由~
阳啕闸'写问-

坦
μ一』一

阳明 .....,. 
r "剧创'.. 

叫咱f…"阿z
n叩￠由曲创陆侧忡时

F万

AdoruDO阳....re L.utI .... 

! X...., rt" 

V恻r­

z酬ji

~应国~
四5-12 空调壁画材料的法取 圈5-73 句ertting Condit酬， 对话但

11 下面是义边11-数据，执行 Define→Boundary Conditions 命令，在弹出的如圈

5-74 所示的 Boundary Cond山on，对话柜中进行定义.

m 

F 

圃5.74 B伽凶也ry CorIditior回到增逝'医

• 由于 nuid 的材料默认克 alr ， 故本倒平菁要再攻定义 fluid.

· 选择 剧。 ( WALL) 边鼻.单击」止战钮，弹出如图 5-75 所幸的 WALL 边界

定义对话框. 选择 Thermal 于栏，将热边界串件定义均热对ît边界，即选择

Thermal Conditions 下方的 Convcction . 在在侧的 Heat Transfer 

C回 fficient[W/m2.k)中输入 10，在 Free Stream Temperatur哩[kJ中输入 3 1 1.1 S .

即为 38 'C ;在 Wal1 Thiclrness[m] 中输入 O.2m，即壁厚 20cm; 悻持 Heat

Generation Rate[W/m3)为 0，即壁面不是热露.单击左τ方材料悟右侧的旦!':J
按钮，在势出的如回 5-76 所示的 Material 时话框中进行适当幢幢，时使壁面

#料置贴近实际. 最后单击一旦」按钮，克成左边鼻的定.:t .

. 按照同样的方洼世置右、前后、上和下 5 个边界，其中右前、后 3 个边界

的设置与左边界一样，而上和下两个边界与左边界的帷-UJ就在于温度吐为

301.1 5K. 
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-旦」 王-. I ....!旦J

阁5-75 在地界定义

,.01_ 
M响阳写阳时

且
坦
坦
一

句脚句问时

F丽
h叫( ， ....陆-111 1__

It-

王旦旦 ao.. I 旦旦J

圄 S-76 鹦面材料属性设置

• 空调壁面的设置与房间壁面iJt置相似，只平过空调边界的温度设为 303.15K .
Heat Transfer Coefficient 为 20 ， Wall Thickness 为 0.002 . 壁面材料为 steel，如

固 5-77 所示.

伽-~­" 1" 
胁__ --1_ ls.-oo! ÐPW I 怕"阳.. I uos

带血 一
一

「「w.，翩翩"同严E一一一"叫"…--理r一一一阵再一~
3旦:.I r _c吨由

~ß:副」旦J
罔5-17 空调壁画边界的定义
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• 选择 '" 入口边界，单击 8et. .. 按钮，弹出速度入口 (Vel ocity In l et ) 边界设置

时话框 . 选择 Ve1但町 Spedfication Method 为.. Magnitude , Nonnal t。

Bounda叩"最示进口方向垂直于所在面. 在 Vεloc ity Magn山de[mJs]的输入栏

中输入 0. 1 . 且为市报 . 瑞施模式选择为 K and Epsilon，其中 Turbulent Kinetic 

Ene哑[m2ls2]输入 0.02 ， Turbulent Dissipation Rate[m2Is3]输入 o∞8 . 如回

5-78 所示 . 至此完且了速度入口 的速度设置，温度设置需要单击Thennal 于

柱，在其中的 Temperature[k]中输入 295 . 1 5 . 即 22'(; .如回 5-79 所示. 最后单

击-主-H安钮完成速度入口边界的世置.
LaD_嗣 '"可--P· 
w__ jn.e" ... 1 1叫_ 1 5，.向 I DPW 1 .... 阳叫 00' I 

'"崎 S，edl回恤恤制|.，抽曲. .-川....耐 3 
阳..，."""fr_ |抽..- 4 

."呻嗣同4. [onþJ|.. , i 
τ.，，"，.Ie~.. 

"响~..叩di1:_"，.0.. 3 
r_...阳_'H睛"抽坷|"但 二j

r_.... Dk由曲·自嗣恒、Uoll !1._ 3 

一旦」 旦型J..!旦」
四5-711 遮应边界的速度..置

i3 

-旦」 旦旦旦主U
嗣'.79 速度边界的温度设置

• 最后还剩下出口边界的世置，选择。时， 单击」丘-按钮，弹出如固5-80 所幸
的 Outflow 对话框，其中 Flow Rate Weighting 为 1. 最幸进口进来的品质量掩

体都将从这个出口全部出去，这里不需要改动 ， 直接单击-巳殷钮即可.
画面 ---F" 

....-响-~
-旦」 且-I ~旦J
回'-80 四"口边界的设置



12 下面对卓解在数进行设直，执行 Solve→Control→So\ution 命令，伴出如国

5-8 1 所示的 Solution Controls 时话框，本倒保持默认设置 1

抽叫血

4
l
l
l
l

」
l

A

3333 
价…叫刷刷

叫田陌-，叩
V的...."' _h.咽IFIrotOrH.百高高

叫耐

园15-81 求解控制"世设置

13 执行 Solve四e→斗Ini t此阳tia l剖li田ze-斗lni山al田 命今' 在 Sol叫lut川"阳阳。on In Ît阳t

in ， 时进口初始化，顺序单去」旦J‘ 旦四、 旦旦旦按钮， 如圈 5-82 所示 • 
.. 孟画画司ι 画

,,-
"副_..c.. z.., AIo....... 

旦旦旦
，.，响曲同I f t.1 .!.1 

叩酬_Eo<<1)'阳Z] !" ..

M叩叫"阳阳写1".-丽而一 l

To_，由阳声:;r一一」

--"'.J 丘旦旦旦旦到 旦旦」

回 S-82 速度入口钥始化

14 明始也后， <九行 Solve -0 Monitors --- R田idual 命令 ， 在佯出的 R四dua!

Monitors 时话植选中 Plot，如圄 5- 83 所示，以动志显示计算蝇革曲蝇.
咱

。_. -湖.网-
勘向同一封 -1'呈

阳-，-陶，由" fiii'丑
r .........I.. F< Su"旦!=..l~日

商俨旦t丁
----百- .日石高……… ~ ~ 1".''''---

M唰丽丽 宵 .. 1"'" 
百百否， .. ..- 1"'" 

，.司百可. • 严百←一

百一 ..- .. 1'.-. :.:.t 

...!'!.J _旦」 旦旦旦二- I~

-­' "亟

回5 的残壁监搜n置

15 完成上述步骤的世直后， 执行 Fil e --- Write --- Case 命令. 持工程文件保存为

sI5-2.cas . 
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为

如圄 5-84 所

Number of Iterations 

问题收盘，

执行 Solve- Iterate 命令，过直Iterate 时话框中的

l∞O . 单去丘... 三按钮开始解耳. 当计耳到 40 1 步时，

其血革曲蝇如回 5-85 所示.

16 

圄国.... 回国国国 -
E:,1. .. ;~灿灿阳 蟹.'_ ...... D" 阳叫"抽.., 1 . ".S.-1厚 f.QUe-"…… .._.... .s_ 酌,.1 ' .n，如麟 2._"-1同. ..阳.. . ....…嗣.. .....

.. ' .n~_~ ，.~_" ' ._"'_10 . ._..... ..S"_ 
"" ' .'_- 1事 r."叶.. -.""… '.H'…...­
酌 ，._-& f.I....-.. .田M-'同 ' . 1..'.- 1同 ' .SH"

"'" ' .'51..._"" f.......-.. ....ft-.. .叩…m
酌 '_-1‘ ，."腼 .蝇 '.._- 1陶 '.IM'. 翻山川

az:τ泣'2:721CZE:1itz:1it2..，gt
111 . . ，..，.~._ .. t....,._.. ..."… ' .n"...‘ . ..n‘· 
... . .，.，..帽 2."""- 1陶 '. 11…陶‘ 7"， .- 1陶 1 . 61刷
刷刷削.. h <_....... 

示，

间"收敛键示回5.84

四--
四

四

" 

• • • • - -… • • • -• 

由于本制约二'食问题， 全区域显示困形计算结果不仅显示迫庄慢，且不晶畔

析 ， 因此需要切取几个具有代在性的剖面，通过分析剖面土的分布来且应整

体的分布. 执行 Surface..... Plane 命令，蝉:1:-1回国 5-86 所示的 Plane Surface 时

2舌Jß _

。_.

r剿-'喇…
「叩"曲-­r__........ 
俨…
俨

俨 町，~

"笙幽战图

…FMMM 
叮
叮4
4

ι 
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18 在 Plane Surface 对话植的 Points 下万的 3 个坐标点内输入能够帷一确是一个

面的三点坐标恤，并在 New Surface Name 中输入晶于分#的阜丰 .

· 本例在垂直于 x 轴方向矗取 ì 4 个矗面，定义的三点坐标分别生 仆， 0, 0). 

( 1 ， 0 ， 3) 与( )， 3 , 3), ( 1.25 , 0 , 0 ). ( 1.25 , 0 , 3 ) 与( 1.25 ， 3 ， 3)，

(2.5 , 0 , 0). ( 2.5 ， 0 ， 3) 与 (2 .5 ， 3 ， 3 ) ， ( 4 , 0 , 0). ( 4 ， 0 ， 3) 与

( 4 , 3 , 3) , .t草草分别为 X- I . X-2 . X-3 和 X-4.

• 在垂直于y 轴方向截取 ì 3 个矗面， )Vt的三点坐标分别为 (0 ， ), 0). (0 , 

), 3 ) 与 ( 5 ， 1. 3), (0 , 1.5. 0). (0 , 1.5 ， 3) 与 (5 ， 1.5, 3), ( 0 , 2.8 , 

0 ). ( 0 , 2.8 , 3) 与 ( 5 ， 2.8 ， 3 )，名称分别为 y- t. Y-2 和 Y-3 .

• 在垂直于 z 轴方向植取了两个截面，定义的三点坐标分别为 ( 0 ， 0，川、( 0 , 

3 , 1 ) 与 (5 ， 3 ， 1 ) ， (0 , 0 , 2). (0 ， 3 ， 2) 与 (5 ， 3 ， 2)，名称分别为

Z-I 和Z-2 .

19 最后羊击 c"酣 悟.1:三亘二卫接缸，克成切面的走J.. .
20 执行 Display → Contours 命令 ， 在圄 5-87 所示的 Contours 时话柜中选择

Contours of下#列在中的 Temperature 和 Static Temperat田0，选中 Options 选

择栏中的 Filled，并在 Surfaces 11)在柜中依次单击要显示的截函 ， 先选取 "X-

1 " 且 "X-4" 4 1、函，单击E豆豆1接扭，得到温庄分布如圄 5-88 所示.

liI. . τ2 限 I I ..... "-'1_. W叩叫
.崎时
r 
'- 0.__ 
r ~刷刷

"呻
,-
} 

一… … >

一
M 

一
} 

>

一
一
} 

} 

ι E 

E .--… 

r一一一「一一一

图S-S8 ‘度云圆的.次显示I1IS-87 C。画阳"对面倔

21 此时呈现在埃者面前的仅为植迫耻的 4 个面上的，孟庄云圄，但具体的住直不

能很快地l'J定，为此可以将模型的轮廓蜡出，勾边 Contours 时话挂 Options 选

择栏中的Draw Grid，此时会弹出如国 5-89 所示的 Grid Display 对话桂. 保持

Surfaces 111在栏中的壁面被迫中，特 Edge Type 下的 AJJ 特挟k\ Outl ine，其舍

不史，..，.去E豆豆1按钮，得到如圄 5-90 所示的模型特扉蝇.

遣. 悉保柿Edge TYf宽选为 A 11 . 则显示的为包含网格的边界晶 晶本例模型相对革命，同格彼密，是

显示同格则不利分ÒI.
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四川圃......川 1 ，，， ...13 
。四'0'

r NO'U (Õ" 翩
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f叫m

S阳町，但巾，< A"'IJ~ 

F一-p.-一
缸"'~…~ ""m
广一一一」旦J

、，

回 5-89 ÛI而d Display 对话枢 图5.'" 模型轮廓线

建意通过 Grid Display 对话但除了可以显示轮靡线之外ι 还可以显示节点 同格"'~模型元素t 周户

可按需这取.

22 生成轮廓蝇后单去卫旦出按钮关闭 Grid Display 对话框，回到 Contours 时话框
中 ，再次单击居豆豆1接扭，得到革二次温度分布，如困 5.9 1 所示. 此时，温
度云围为形且直现的视圄呈现，读者可时清晰地看到各截面的相片住直，有

利于比较分析.

U ....嗣 T 1111 ~，，，.'，，' 1,,, r 百

，且拥僧,­
-创圃

，.，圃,.. 
3剧唱

3… ,.. 
,­
S呵,.. 
,­,.. 
,--am

a唰
咽
幽
幽
幽

画
·
·
·
伽

•• 

因5-91 垂直辈子x输.面的温度云图二次显示

23. ~:J.同样的方法分别显示垂直于 y 轴和 z 轴截面的温度云围 ， 如圄 5-92 和圄

5.93 所示. 由围可见， 在主调房内不同住置的温度不一样，空调下方的温度

最低，即为最凉快的地方. 离宜调距离越远处的温度越高，如 X-4 和 Y.I 截面

的温度就相对较高. 因此，在平常的草庭生活中，要根据自身的身体串件和外

在环境4持合适的空调房内的生活住直，达到桂暑效果的同时避免生病.

连意z 氯标左.可抱动图形窗口中的视圈 .J.标中键可缩.\和放大圆形视图，用户可结合起来使用 使团

形以最佳4主直呈现
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24 鼠标中键框取 Z-2 .a;宜调附近的云围 ，则该处温度云围得旧社大，如圄

5-94 所示，通过圄唱的就大，可H帮助读者是清晰地分畔温度的变化细节.

25 执行 DispJay- VI四:tors 命令，佯出 Vectors 对话抠，如固 5-95 所示. 选取

Vectors of 列在中的 Velocity 和 Color by 列在中的 Velocity 且 Velocity

Magni阳出，选中 Surfa国将列在中要呈现的植面￥).将在侧的 Scale 改为 2 .

单击E豆到接钮，得到如圄 5-96 所示的追庄矢量圃，从圈中可H看到IJi夏截a;
」二宝气的运动情况. 用户还可队通过 Vectors 时话柜中的 S四le 与 Skip 来调节

矢量圈中骨头的大小ll.密庄，使失量圄且，青晰地呈现出束.

1115-94 Z-2.面温度云图的放大
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26 执行 Fil俨 Write"'" Case&Data 命令， 将计算结果保4年为 515-2 .础和 515-2 削

立件最后执行 Fi1 c..... ExÎt 命今，安全退出 FLUENT.

5.3 本章小结

本意讲述了传热的儿种方法，传热分析的应用领域且 FLUENT 中传热分析的基本世

置，重点介绍了 FLUENT 中自然对流与辐射传热计算的模型且选择标准， 通过汹轮加热、

保温温度场模拟与室内传热温度场模拟两个:!k例的介绍 ， 帮助读者了解利用 FLUENT 求解

传热问题的基本方法与过程.

τY? 
v矗

> 3 种伶然方法.

> 辐射伶热的 5 种模型及选择标准.
> 利用 FLUENT 卓解传热问题的操作过程.
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第 6

非定常流动问题

非定常流动是指流场中任 空间点上至少有一个运动要章要随时间变化的流动，如速

度、压强、密度、温度等. 实际工程中的绝大部分问题都是非定常流动问题，相比定常问题

具有极大的复杂性.光靠理论或实验研究十分困难，通过 FLUENT 等数值模拟软件来模拟

非定常流动问题可以大大节约成本与时间 ， 且计算结果亦能准确反映流动要素的变化过程.

本章将介绍非定常流动问题的概念且如何在 FLUENT 中启动非定常流动问题的计算 ，

通过典型的非定常流动问题一一圆柱绕梳分析"例的介绍，帮助读者认识和了解非定常问题

的模拟过程.熟I.!!<解算非定常问题的思路.

• 非是'曾班动的概牵.
• 非定常施动问题的设置.

• 非定常搞动问题的分析过程.

主黯旦
• 圆柱镜撞分析.

..............................… ' 

• 
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6.1 概述

流体是由连续分布着的质点所组成创. 在运动的情况下，一个质点在某一瞬时占据在一

定的空间点上，具有一定的速度、压力、密度且温度等标志流体运动状态的运动要章. 一般

来说， 这些运动要章都是空间坐标和时间的连续函数.

按流动要章是否随时向变化可以将流悻流动分为定常流动与非定常流动. 定常流动{卫

称稳定流或恒定流〉 是指流场中任一空间点上各运动要章均不随时间变化的流动， 而非定常

流动 〈卫称非稳定流或非恒直流〉中至少有一个运动要章要随时问变化.

在!I;际工程中 ， 绝大部分的流动问题都是非定常流动，如开关输液管蹄阀门的过耀、水

泵泵吸过程、空调房的温降过程、 闸门放水过程、榄坝过程、圆柱绕流的被涡脱落过程、 水

面披浪问题、 具有周期性的流动过程等. 非定常流动的运动要章时刻变化，因此研究起来有

很大的难度. 在 FLUENT 中 ， 执仔 Define- Models-SoJver 命令，打开 Solver 对话框，

可以选择流动问题是否与时间相关， 其中 Steady 为定常流 ， Unsteady 为非定常流， 如图 6.1

所示. 选择 Unstcady 非定常流动时，还可选择是一阶隐式或二阶隐式格式〈选择 Unstcady

Formulation 下方的 I st-Order Implicit 或 2st-Order Implic it ). 需要注意的是， 对于三维端流模

型中的大涡模拟 ( LES ) 和离散涡模拟<DES )，因其本身宿要在时间上进行统计，所以只

能用非定常流动迹行模拟.
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-里」 主~...!旦J

回6- 1 Sol~町'呀说拖

6.2 非定常流动的分析过程

非定常流动在法代计算时， 需要世置时间步* ( Time Step Si四〉、时间步数 (Number of 

Time Steps) 且一个时间步所占用的最大选代次数 (Max Ilerations per Timc St叩)，如图 6.2

所示.这 3 个#数均需根据实际问题具体世置，其中时间步t是不宜过大，时间步数乘以时间

步长为一执法代计算问题所经过的时间，而一个时间步所占用的最大法代次数关系到问题的

收敛性. 读者在计算时，要合理设置时间步佳与时间步数，且时观察流动要章的变化，以免

错过流动要章变化曲线的转折点 : 另外， 个时间步所占用的最大遮代次数要适中，尽可能

地加快问题的收敛速度.
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回~， 非定'信问题选代设置

下面介绍一个典型的非定常流动问题的模拟过程.

【实例 6-1l 圆柱绕流分析

• 
• 

在一直流动矗件下 ， 粘性流体绕过钝尾体会产生涡. 在钝犀体后面存在一死水区 ， 其宽

度略小于物体尾部横向尺寸.在这个死;水区的边界上舍出现一辈列的涡， 如圆柱绕流的雷诺

数在一定范围时，流体在圆柱表面的后驻点附近脱蔷，脱体被涡以周期性的交替方式离开圆

柱衰面，形成了著名的卡门涡街. 涡街的存在使得柱面周期性变化的丹力和阻力增加，从而

导致物体的振动.Ii响了拄体的稳定性. 实际生活中，近似圆柱绕流的现草曹遍存在， 如桥

增绕流、海洋钻来平台的直柱绕流、潜水艇的潜望镜柱体绕流等 当涡街发生时，周国的流

场有5样的变化，对它们的罪响有多大，这是我们需要分析的.

一、~例搬述

本倒模拟在一定雷诺数矗件下产生卡门涡街时的圆柱绕流现草. 圈6-3 所示为本例的几

何模型简圈，其中圆柱直径为 O.02m ， 计算区域为 O.6mx J .Om . 圆柱位于图示位置，左侧流

体λ口速度为 O.O l mls. 右侧出口为自由出流. 若流体为水，其密度为 998.2kgfm).动力粘

度为 o∞1∞3kgl ( m 时 . ~IJ霄诺数为 199.04 . 为层流流动.

思路分析

入

口

O.2jm 

1m 

D-O .02m 

回~} 圃位编模几何模型'跑回

O.6m 
幽

口

本例为二维非定市流动问题 ， 模型建立相对简单，同格划分可采用什块划分或者非结构

, 



网格，导人 FLUENT 启动非定常计算后需告理设置时间步佳，井进行动画的保存与回放，

以得到动态的游涡脱藩过程.

通过本实例的演示过程， 读者将学习到·

• 非结构网格划分，
• 非克市设置，
• 升力、阻力系教监视，
• 动画的最制与回撞，

• 速度矢量图、揭量固的显示 .

(U" fI)一#见附带先盘呗6、16-1. l'Qsh "、 u Ch6\s16-I.dbs "、" Ch6\sI6巾u"、
"Ch6飞sI6-1 .tm "、" Ch6'、16-I .cas"、 "Ch队s16- I .dat"、" Ch6飞，velocìty.gif"、

"Ch6飞.vorticity.gif"" 

(IoIAU )一参见附带她咄6\AVI\sI6-I .avi" 
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二、 模型建立

本例模型需要建立两个面域，然后进行布尔操作，生成如圈 6-3 所示的儿何模型-

l 轴陌-[百-霄， 在 Create Real Rectang由 Face 峭的 Width ;fø Height 

中分别输入 1 和 0.6 . 单击-豆量工J按钮， 如图 6-4 所示，提市中点与原点重

合

2 且非捕单击n=r楠，在弹出的列在中特阿拉扭，如圄 6-5 所示.
圃圄噩噩噩噩噩国E

|胃坦l工 F L口
- ~二=三4

E毫k叫·

- ~ 
-旦旦j -

图...炬形区就生成 回6.' 选得回形给帽命令

3 在固 6-6 所示的。因te Real Circular Face tiJ扭曲 RadÎus 中输入圆柱的半挂

0.01 . 保持 Plane 为 XY 这项，单击 '丽丽'叮接扭， 生成女，固 6-7 所示的圆形

区域…n " .".Y.. ... 



需要向 x 抽血向移动 O.25m. 单去 Face .，~ '" 1riJ1~ (Move/Copy) 梢，在
佯出的如圄6-8 所示的 MovelCopy Face培面板中选取画 2 (fa四川，保持 Move

为虹色选中状品，选择 Operation 下方的 Trans late (平移)，在 x 担输入

0.25，单击 .旦Ll桂扭，即克成了平#操作.
阁 6-9 所示为圆丽移动后的窗口显示，此时己生成有两个面，下面需要进行布尔诫操

作， 以生成本例的计算区域.

，- 主与J 1"''' 主l
.- .崎「一一
… 
句-
.. T......11IiI .., AOIIM 

.., "-1IK1 .., S比*

M ….,.. Ij;-'Y' I 一主j

- 二旦旦4

f| ;在二
。

M S 
』
，

"

、
­

E‘Fb 

J旬--

,.., I--!!里.J -
因6-8 MovclCopy Faces 画‘民 006-9 移动后的圆形面

5 轴 Face iJi(中的F按钮，在弹出的 Subtract Real Faces 峭的事一行 Fa田
中选取 face. l (提审.，域)，在第二行 Faces 宁边草~ fa由 2 (圆形.，域)，如圄

6- 10 所示.单击 "'" 按钮，克成布尔战操作. 此时的回形窗口与圄6-9

一样，但是中间的面战已捏植剪去，为了能够直咀地现事到圄彤的史化，可

旧单击右下角视国控制而扭中的.!!I按钮，这时就可以看到计算IilJlI.且在色显
示，如固 6-11 所示.

一F-. l,.,e.1 ..!J 

J ~_ 

… - 1_1': I 主l

."., .r.l--!!且」主旦旦」

阁制 o SlIbtracI RuJ Faces 面饭 阳.." 计算区棍示'阳

三、网格却j骨

下面对计算区域进行网格划卦，虽然本例的计算区域较筒单，但网格划分采取卦块划分

笛'
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·
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时则比校复杂，这里我们采用非结构化网格划分方法， 同样可以生成高质量的网格.

1 单击「百-Jfï-阳， 在 Mesh 臼g田峭的剧Iges 贵也输入栏中选刷刷
( edge 肘， 选择 【nt町val Count 分段方式，并在左侧输λ栏中输入 80，保持其

他默认设置，单击-旦旦.J按钮，生求生1段 6 (圃周}的蝇网品，如圄 6- 1 2

所示.

2 用同样的血肉格划分方式将拒形E域的上、 下两串蝇{蝇段 1 和蝇段 3 )划分

为 80 '"份，将提帝的左.右两串蝇{蝇段 2 和线段 4 ) 划分为帕蒂份，划分

好的线两品如囤 6-13 所示.

• 

四6- 1 2 .周编的同幡划分 图~13 划分蜒的毒集网幡

3. ...*[百司I古-~， 打开陆sh faces 拙， ;& '" *-""计算E域的缸， μ
"四ements: Tri " 和匾Type : Pave~ 的同格划分方式划分画网格，保持其他默

认设置，如围 6- 14 所示，单击 --2!画王i按钮， 生且如圄 6- 1 S 所示的画同格

「一一一-二午一-一|
h P;'1 ~ 
M帽 ，明旦旦l- , T~ ....1 

"'"", p立-=.J

巾 ，叫

" _.唰川
.J AIllIl'I'1阳刚

" "唰阳阳。-
-,., 1-旦旦J_旦旦」

回6- 14 McshFKCS 菌'民 回6川， 划分好的画同幡

4 单击视圄控制面扭中的旦如扭，佯出如圄6- 16 所示的 Examine Mesh 面札
单击ifI扭中的...-旦二』接扭，并接下右侧的三角市网格. 当选取RlInge 质量

值范国选项时，圄中显示最左侧的柱体最高 ， 在示划分的体同品质量较好，

可~;.t }fl于7步计算.

5 同制l仰后走>l~.jf."，型，特r-ï-f莓， 在 S阳市Bound町l'ypes ifI __ 



‘ 

中选排拒形左侧人口鸪段( odge.4 ) ，走义为追Jt.入 口边 耳

( VELOCITY _INLET) , .$ "*为 田，走义提形右侧出 口蝇耻 ( 回ge.2 )为自由

出口 (OUTFLOW)，名非为。ut; 走义圃柱边界(咀ge.6) 为壁画 ( WALU，

名称为由umlan; 其牵挂甜的土下边界不做走义，默认为 WALL 边界. 定义好

的边.Jf.如圄6-17 所示.

"啕自.-
、，向- . ..怕.' ，勘.. 

旦旦二J 陪F….-Z坐...巳二j---lI!J旦国i且凶
. - .幅"
民….-.叫.- .叩

E 
回』恒..

m一-_，J阳_.…

国-f;

一伊F

一四 1

-2旦L亘"' - ' -豆豆工l

咱

，t_:IlELllC盼…"'L t."，~ ç. 

.... 
• 
。"
阳m'~

T".. 
VEι。CITV_I盼崎LI

Ol/1'fLOW 
WALl 

回~I' 网憾...'.tJl:查 团~17 忠义"的Itl界突.. 

6 最后执行 File → Export - Mesh 命令，持网格输出为 sI6. 1 .msh .

四 、 章'串计算

'-'侧'"刷

1 启动 FLUENT 二，在单柑庄计算器，执行 File→Read_C国e 命令，读入划分

峙的网格文件气16-l.msh".间格讲人之后.拉行 Grid_Check 命令，桂量同

格的倍息，如固6-18 所示 . Domain Extents 显示了计算区域的 x. y 轴it圃，

Volume S回istics 显示 T 量，卜、最大与总体和 . Face 町a Statl StlCS 显示了量小和

最大<<J和.
5rU C"'d 

h嗣h r.tuu: 
. - n...that.: odn 川. -5 . 1嗣幅.~.由 (I) • S …N"- M1 
，-.，....翩翩翩 (II) • -1 . 1翩翩..-，n . ....例 - I.MIMk- N1 

h.帽阳U削"
101,,1_ ...1_ 恻 1 .17!.k-阳

阳虫_...1- {副 1 . 1"":'-蛐
UUl ...1_ ( 001 ): S 阳山唰

rac:. ar.a shUsUu 
oü..t_ f iK_ aru (001) : S.."I1S.-帽
皿1_ f ac:. arn 问 1 ."12嗣--

回~II 网格也沓的债息

2 执行 Grid→5国10 命令， 弹d:: Scale Grid 对话拒.由于在 GAMBIT 中是按照
m 为单位 1 : I 建立的儿何模型，本倒不需要重耐走义网格的尺寸，从固 6-19

司t

i , 
动 6
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所示的对话握中可u看出计算区域的尺寸跑回 .

3 执行 Define→Modcls→Solver 命令，弹出 Solver 对话桩， 如圄 6-20 所示.

选中Tîme 下方的 Unsteady. 启用非走常计算，其命悻持默认 . j位去-主』安

4旦

--………………………. 
阳『
阳._ø_.

C ~叫._.

… ， -剩
川唰l

h 

~~坦
安 |

" 俨…
俨…M
俨 '…一r…』…

r Fn...fl帽'一

町'在白 u."…嗣

只「一­

，['一一一

"'"阳~*'IoiF丁

旦旦旦旦旦旦旦l 国-""Y~-翩翩­
,.. ,. ... 
• ..。命，国酬.. 
俨…叩

_.f，叫"
何 S__oI'1<叫

F 阳~，.叫

... ~，-恤
'‘… " " ..... 。叫恤m

......川 fi了一一一 阳似阳甲.. 一一­

V..ln 1"" fl.I一-- '.0同 [ï.I一一一

~曲钳制"

.. a.....-G..... c.. lI .. d 
俨 阳时..._8_'
俨 u..阳....c..a....

二旦」 旦E旦旦 旦豆日 He. I 主」正因 」旦υ

因6- 19 SeaIe Grid 对话但 回6-20 Solvcr 对....

执行Define-M叫els-Vis四山命令， 弹出如回6-2 1 所示的阴阳回 Mode! 对
话框 _ FLUENT 中~认的为屉iA.模型 ， 而且过计算本制也为层施~A.动，故不

需改动直接单击-巴J柱扭.
定义克上述的计算棋型后，定义流动的材'←---水， 如圄6-22 所示.

4 

5 

忡...."". ..M_..Id_ .... 
M 3 

出二zm四川
…M幽翻.酌.-• c一句

.二

e 

,.,..... ，-叫 l丘CJ

…·嗣E咽IC 缸'

"呻-写l ' .. 
同万

句阳忡翩翩
川剧

F 阳、~.d.

ç~ 
俨 sp.....创阳.... 11 c.咱
F 协...胁.. (2.，.唱

F 坠"…. (2 ....1 
F 胁，..蝇，加雹.. 15.咧

.,a 

丽-~饵叫陆创 1-­

阿
向曲陆司忡由

严画面

-旦」 旦旦j 旦旦J 主主j =-..1 -"'.l -'旦J a- I HOIt I 

回6-22 f llle!l‘ ",.,.. Ma<ri血对话篝因6-21 viωα_ModeJ 对边幅

3 =.J 1 

3=.J<

3 -"--.J 

"3 -~~二」

d 

6 回到 Materials 时话桩， 即会且现在 Fluent Fluid Materials 于拉到在中存在了宜

气和水两种材料， 本倒地#为水. 单去 Matω阳e衍rial s 时话拒中的=三豆ζ二卫3柱
缸' 完成材料的定且.

7 执行Define→Operating Conditions 命令，打开如圄 6-23 所示的Operating



Conditions 时话框，本制保持耻认设置，单去一旦J桂扭.

8 下面定义本制的边界牵件. 执行 Define→Boundary Conditions 命令，弹出如

固 6-24 所示的 Boundary Conditions 时话框，定义如下边界.
咽

-画面"-z.'Qm , 
国-幽幽幽幽国-..
阳.- """" r " ..., 

Rde,eotee Pl'e.."", LealleR 

X "，归

v...归

~岳副主U
因6-23 0庐哑 ing Co阳Klitions 对滔" 回6-24 Bound副吧y "'"曲 。因对远程

• 在左边的 Zone 拦选中 f1uid ， 单击」丘~j主钮， 在固 6-25 所幸的 Fluid 封话框
亨的 Material Name 下拉列章中选择 water-liquid . 单击~.按钮

-一- .-.. --1"01
' 
…』r_.z_ 
f 由._.

r fb，dY，阳.

阳- I~叩画.. 1 ""_1 s.....τ-. 1 Fb<H y_. t 

回皿~王坐过

产斗阳~-翩翩，阳

X ""，， I'一一一一­

V酬F一一一一­

.._TII'"!$I.. .. 写一 3-" 
」巳」 旦旦到 -""'..1

1116-25 Fluid 定义

· 在左边的 Zone 栏选中 m，单击 8，1..按钮，在国 6-26 所幸的 Velocity Inlet 对

话框中的 Veloc町 Specification Me由回中选择 "Magnitude，Nonnal to 

Boundary " ，表示速度进口 方向垂直于人口边界，在 Velocity Magnitude 

(mls) 中输入 0.0 1. 表示进口速度为 O.Olmls，单击」巳』安钮.
以 I-­~一 -

-
33 V叫画"由叫-1町由陆

阳"阳"嗣同E二一一

h叫叫"忡1 1..... 一问M

~王旦旦L."空」
因~26 速度入口定义

· 在左边的Zone 拦选中。ut，单击 8et... 按钮，弹出如固6-27 所示的 Outflow
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对话框，对话框中的 Flow Rate Weighting 默认为 )， 最章进λ的水均从憧出口

班出.悻持默认，单击-巳」按钮.定义克边界后，回到 Boun也ry Conditions 

对话框，单击旦旦旦按钮，是闭惶对话框.

圄圄幽幽

F"一
阳...w，咽... ~

一旦J 庭副主!.J
回6-27 Outßow liI口定义

9 执行 Solve - Control 咱 Solution 命令，打开 Solution Contro ls 对话桩， 选择

Pressure抽locity Coupling 时直的卓解方式为 SIMPLEC，设置 Discreatization

时血的 PreS$ure 为 Second Order. Momentum 为 Second Order Upwind ， 如围 6

28 所示，

h …fiT 
。""lIyp

1I"Y' f"~Ur一

" 严「

1 ....... τ一一一--:3

严血里一量 国... o，~" l!~~ 

。‘

院6-28 Solu~帽c.刷刷s 对话报

10 掉下来，时流场进行相曲也. 执行 Solve - lnitialize - Initialize 命令， 在伴出

的女，圄 6-29 所示的 Solution Initialization 对话柜中选择 m，蝠序单击~.
Ap，到. 旦旦接扭.

G叩阳山脚叫r一一一

X制呻叫fi:古一一­

YV.l响叫「一一一一

M 

罔6-29 Sollllion IAitializatioa 对渴'匡

11 初始化后 ， 执行 Solve → Monitors - R，白idual 命令 ， 在弹出的 Resid回1

Monit。同时话握中选中 Plot . ~;J.打开战革前蝇圈， FLUENT 默认的各事数的收



世柑庄为 o∞1.本制将各u.:收姓标准均改为 0.0∞01.如国 6-30 所示，单

击一旦J按钮是闭式束时话框.
ττ-~ 

，阳

锣阳

-剑. -咱
…' 1'_ 量 …「呈

阳由自 阳由' r否「丑
「阳_n锣 蜘由 2空江l王--- 1

• 
恤曲C…睛"蛐伽 乒j

'"' g fï丁丽~

P 'i Ii丁丽~

W 锣 1"丽百一

d 

一旦」 旦旦旦旦旦」
阁6-30 R臼idual M佣飞回对话棍

下面介绍本例的特色之处 ， Up动画的世宜-

1 2 执行 Solve → AnÎmate .... Define 命令，妹出 Solutìon Anìmation 时话扭，如圄

6-3 1 所示.

此时的 Animation Sequences 坷。， 通过右侧的箭头将数字从 0 调成 2 . 如回 6-32 所

示， 在 Name 栏分别输λ velocity 和 vorticity. 将When 均选为 Tîme Step. 保持 Every 为

1. 即每一帧的最惶时间为一个时间步.

霄 '且由~'r量
1__嗣"町- 斗

.- 1_.0;., , 1 r丑1 '" 丁上」

r 1._.... .，.- 广丑 1"" .""" :3旦~
「 广ττo-r丑 1..，...... 丁与生」
r .,._.. r量 1... ..，，，，，， 3立工」

r I '~".' r ~I.""-- 丁 -C;"c..J"l .,j 

~ß3.1!立J

M-~'r丑

1_陶- "町- ~ 
r 1"1.0:1 1厂厂到阿瓦-:3 ~旦二l
r F"""UcltJ r量阿富;-:] ~-I 

~ F一ril~一3!且二J
r 1"..-..... r iI F古"'--:1;] L. , .. 

「 厂一-r:lJ I '~' JιιJ .，j 

~旦旦旦U
圈"如31 岛1. 例 Anlm削"对近帽 圄~12 动画个..，量置

口 下面需要时动品进行详匍诅置，首先单击 vel回町那行量右倒的卫虫己除钮，
弹出如圄 6-33 所示的 Animation S呵uence 对话桓. 选择时话柜中的 Storage

Type 为 Metafile ， 在 Window 中输入 1. 通过单击右恻 M陆也使对应的 ;d 窗
口生效，此时会出现-个宝白的图形富口 . 然后选择 Display Type 下方的

Contours ， 这时自动弹出如圄 6-34 所示的 Contours 时话桩， 选择对话据中

Contours of r万的 Velocity 和 Velocity Magni刨出，并将 Options 中的 FiI1ed

勾边上，单击E豆到接扭后，刚才的空白窗口 I 中即出现7朝性时割的选庄
云固，如困6-35 所示. 单击五旦旦接扭关闭 Contours 对话框，回到Animation
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阳.." ""'"民剧对i.I抱 回.."例'由时刻的遮皮场

vort lClty 的世置与 velocity 一样，将其显示在另一图形窗口中，即世置其窗口号为 2.

区剔在于选择 Contours 对话框中 Contours of下方的 Velocity 剧 Vorticity Magn刷出，其初

始时刻的涡量云阻如阁 6-36 所示.
I!IIl 川aa18Wfifiilil阳.....需I==--H-zzzz 

.-
h 

,­
H 

一 .._.­
呵，....-…『一一侧一

因6-" 初始时刻的满量云图

速建2 驭。rage Type 是 FLUENT 动画保存的方式， 其中 Metafile ，。将动画一铺帧地保存在硬盘中 ， 随时可

以该取.
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14 回到 Solution Animation 对话桩， 单企"" 且安钮， 克成动画章制的设直.

15. 4是下来世直升为与阻力革歇监视器 ， 为确保其柑确性， 在庄之前首克需要性

直事寺值. 执行民叩。同-0 Reference Values 命令， 在 Compute From τ拉列在

中选择 m . 并且 Area[町、2J ‘ Depth(mJ. Leng伽[叫右恻均输入圆柱的直径

0.02. 悻持 Reference Zone 为 Ouid ， 单含一旦业扭 K. 女，圄 6-37 所示.

阳-，，_• 
• 

.... 1oolI11.. 
M啕阳苟同:;面甲一

时间I"'~
M嗣嗣F一一一一

U响 '"' 1口「一一­

---叫「一一一­

h甲『阴阳了一­

h呻叫[ï.i1一一甲

懈'由阳叫1.. ...­

Mω ... 量悔自F一一一

" 
回6-31 ."值~置

违鑫^，回{m2]同样设置:h O.02m1 ， 这是因为本例'"二'但流动 t 对于来流的边洗面积可认为与且径-曼先

16 执行 Solve- Monitors..... Force 命令， 弹出 Force Monito同时话框，将 Options

中的 阳nt 和 Plot 勾边J:. . 并i&排 C田面Clent 中 的 0.咱，即阻力革缸， 之后边
取 Wall Zones 里的 由山m拙， 在 Plot Window 中输入 3 . 将阻力，民业监视窗口

设为 3 号窗口，最后将 File Name 设为 cd-history ， 如圈 6-38 所示 ， 单击旦因
按钮.

1 7 设直卑阻力革数监视后 ， 只需将 Force Monitors 时话框的 C回而cient .i!为

L恤， 窗口设为 4 号 . File Name 设为c1-history ， 其余与阻力革数监视器设直

到「一­

Y(O一一

\. 
「「
「陆h

E王hUr，

旦国工旦旦旦旦旦 旦旦
回~" 阻力艰徽摩...设置 四6-39 1t为系敛监饵"设置
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18 此时即克成丁升力与阻力革披监视的设直，单击旦旦二接扭是闲 Force Monitors 
对话植.

19 克咸丰迫步糠的世直后， 执行 File -0 Wrile → Case ...命今，将工程主仲保存为

s16.1 .c田.

20 扎行。Ive --- Iterate 命令，弹出如图 6-40 所示的 Iterate 时话桩，其中的 Time

SI叩 Size 为时间步长，设直为 0. 1 5 ， Number of Time Steps 为时间步缸，设直
为 10∞，即选代时间为 l∞"设直 M皿Iterations per Time Step 为 30 . J院去

Iterele 按钮开始解耳.

迭代完后的残整曲线如图 6-4 1 所示，问题已基本收敛 • 
• ，曹雪ik2 …………·町'

h 

T1noe Stc, Slu [11 F一­

NuooI~e. Df T1"，e 恤，.阿「封

曰_ SIeP9阳. ..自.. 
(Õ Fbcecl 
c ...川崎
俨'I'a ,þ 

O!'llOftl 

r o…S.."IIII ... n..e S.....Mu 

"比"...... 
阳胁，由. ,c, T1noe Sle, ~丑

h阳问蛐叫r-j司

瞄俯瞒句"恤叫「一丑 … 
主主j 主生J 旦旦j 旦υ 一一网....，恼~.对'"报 回6-4 1 Jit羞禽肆

革意 Max lteration! pcr Time 51叩也可设置得再长一些，当设置一定佳时，可以保证每步选代都能达到收

敛.

开力与阻力革数如图 6-42 和图 6-43 所示，两条曲线均呈现出周期性的变化.
阵且 IT 141 "".~ ， 'n _ r.乓 ，.…一.，，1111_" _1面'

。

E ---
E 

四
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阳M

一町一 蝇一一一 -.­
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捆...，升为J;e: llltl 1116-43 舰为..".箴

21 执行 Solve - AnÎmate - Playback 命令， 打开如圄 6-44所示的动画回就对话框



( Playback 对话框);选择 Playback Mode 右倒下拉到在中的 Play Once. 即回

址一次. 1"克选中 velocity. 保持 Slart Frame 为 1 . Increment 为 1 ， End Frame 

为 10∞，即从第一怕开始回址直至第一千蛐. 拖曳 Replay Speed 的温动串可

.:<控制动画田址的速度 . 最后在 Write/Record Fonnat (保存格式)中边排

Hardcopy frames，单击」生j按钮. 此时可以和情口 l 中的迫庄动品开始重

伤播放 . j矗址的同时，动品将~:J. jpg 畸形式保存每幢圄片在工作目录下.
区.

肉睛... -.嗣 Scqooe.."" .

"_....阿瓦~ ::J 

俨-3严3情里一封

古tte -" 
二l斗之F~二J~立j
主j .J.:J 
51_ RcjÞI.." S,ed F'… 
柑..，..田 d fonn嗣同...no.. Fr."，u 丁.."r>J立旦巳二」

卫生J 生旦 E豆豆1 且U
因6-44 Playbad，划活舷

22 油量动画的田社与悻存步骤同迫Jt.动画，最掉生且每锁的 jpg ~件.

23 将生成的速度与涡量的每锁国片分别保存在新建立仲先下 ， 然后以主件史的

形式导人 Adobe ImageReady 进行动画处理，生且动画立件 velocity.gir 和

vorticity.gif， 并保存于当前工作目录下.

24 执行口isplay - Contours 命今，在 c。时OU"' 对话柜中选择 Contours of T 4主到

在中的 Velocity 和 Veloc町 Magnitude ， 并选中OptÎons 选择栏中的 阳led ，

单击E豆豆1按钮，得到 1 00，后的选庄分布云困，如圄 6-45 所示.
25. 1支~ Conlours of 下拉萨l在选项为 Veloc町和 Vorticity Magnitude. 再次单击

圄，如圄 6-46所示.

肖，

阔....，遮J!纱布云阳 回.....祸.分棺云阳

若取消 Contours 对话恒中的 Auto R副醉， 世置 Min(1 /sJ为 0 ， Max( lIs}为 2. i(J.击

按钮， 则得到涡量也在 0-2 范围内的涡量分布云图，如圈 6-47 所示. 由此可见，

缩小涡量值范围的显示区间，可以更加清晰地看到圆柱体后的旋涡脏手事情况.

1~ 
E 

b 
动 6

昌章
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违章 云图显示时，在默认的区间内若不能清晰地观察到物理参数的变化， 则需要合理地设置显示E闸的

范圈.

罔6-4 7 ~竟变程回后的精量分布云图

26 执行 Displ町司 Vectors 命令，弹出 Vectors 时话桩，选取斌对话植 Vectors of 

下方列在中的 Vel田，ty 和 Color by 列在中的 vel国，ty 正 Velocity Magnitude , 

将左侧的 Scale 改为 2 ， 单合理豆豆按钮，得到如固 6-48 所示的追庄矢量
围 .

回6-<. 速度矢量图

27 鼠标中幢植取拉体附近的迫Jt.矢量围，刷该局部;;:围的追庄矢量圄得U就

大，改变 Scale 为 3 及 Skip 为 5，得到局部速度失量如圄6-49 所示.

1‘ 

回....，速度矢量图用·戴大显示



28 执行 File- Write - Data 命令，将计耳结果保存为 sI6- 1 .dat 主件. 最后执行

File → Exi t 命令，安全退也 FLUENT.

6.3本章小结

本章主要讲述了非定常流动问题的概念且 FLU四T 草解非直常流动问题的过程，通过

典型:õ:例 圆柱绕流分析的介绍 ， 帮助读者掌握非定常流动问题的分析思路.7解

FLUENT 草解非定常问题的过程.为研究实际工程中的非定常流动问题打下基础.

7苦
Y""' i 

> 非定带乱动的植企.

~ FLUENT 中启动非是常计耳的过直.
~ 利用 FLUENT 卓解非走常i且动问题的操作过程.
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第 7 章

多相流模型

物质具有气菇、液态和困态三相，自然界和工程中很事问题都涉且到事相流动. 宰相施

是在流体力学、传热传质学、物理化学、燃烧学等学科的基础上发展起来的一门新兴学科，

其"相"定义为具有相同典型的物质，西类物质在所处的流动中具有特定的惯性响应井与班

场相互作用. 宰相流体力学具有非常强的工业应用背景， 己广泛应用于石袖、化工、能源、

动力、情盘、环保、航天带国民经济生产的各部门.

宰相流可以升为气液流动、气困流功.液液流动、液因流动及三相流动. 如空气泵、气

穴、黯监的气泡流、喷勇、干燥机、气冲的液滴疏、旋风分离器的位于负载流等都属于事相

流动.

本章将重点介绍常见的儿种事相流模型，井用三个主例来介绍 VOF 模型、 Mixture 模

型、 Euler 模型在工程实际中的应用，帮助读者熟悉 FLUENT 模拟多相流动的方法.

本章要点

• VOF 模型.

• Mîxturc 模型 .
• Euler 模型.

本章案例

一• 融口旋转喜器内班休班动模拟.

• 二量珊扭过程施动模拟.
• 汹水两相撞曹营施动模拟.

• 多相班模型的选择与设置.
• 多相撞耕模掘操作实例.

,--_.................. 牛.. • _. •• •• .- 电令 ........-..--.......φ _..-.-------- ,-- --- .-.---_.--- _._._-- ------- _....._- -, 



7.1 VOF 模型

VOF 模型是一种在固定的欧拉网格下的表面跟踪方法， 通过求解单独的动量万程和处

理穿过区域的每一流体的体积分数来模拟两种或三种不能混告的流体. 当需要得到一种或多

种亘不相融流体间的交界面时 ， 可以采用这种模型. 典型的应用例于包括卦层流、射流破

碎、流体中的大泡运动、自由表面流动等.

7.1.1 VOF 模型的局限

在 FLUENT 中使用 VOF 模型具有如下限制

• VQF 模型只盹来用压力基卓解嚣，

· 所有的控制体积品甥克满单-班体相或者相的联合， VQF 模型平允许在空的

区墟中没有任何提型的掩体存在，

• VOF 模型中只有一相允许植定义为可压缩理想气体，但是不限制使用 UDF 定

且可压缩液体相，

• 周期性撞动问题早脏和 VOF 模型同时计算，

二阶盹式的时间格式平幢用于 VOF 模型，

· 组分迅合和反应制问题早盹和 VOF模型同时计算言
• 大涡模拟满班模型不盹用于 VOF 模型

|惯"
• VOF 模型不能用于井行计算中追踪植于 .;' ~ ... 型 7
无粘施动不盹使用 VOF 幢型 ， , 章

· 壁面壳恃导模型平盹和 VOF 模型同时计算.

另外 . VOF 模型通常用于计算时间依赖解， 即麟态问题. 但是对于只关心稳态解的问

匾，如求解不依赖初始矗件井且各相有明显的流入边界的问题 ， 它可以执行稳态计算. 例

如， 槽道顶部有空气的水的流动与分离的空气λ口可以果用稳态公式计算，而旋转杯子中的

自由衷丽'"状依赖流体的初始水平 ， 就必须采用非定常计算.

7.1.2 VOF 模型的设置

在 FLUENT 中 ，执行 Define→ Models→ Multiphase 命令，弹出如回 7. 1 所示的

Multiphase Model 对话桩. FLUENT 默认的选择为 Otf (即不启用多相流模型λ 由阁可见，

Model 下方剩下的 3 个选项分别对应着 VQF ， Mixture、 Eu\erian 模型.
E1 ,) ', .10 , , 1...1. 1 .，噩

...时

6 国
俨 Volvme .，同ωa
俨 血，.

r[曲曲"
rw，， 1 惘

一旦」 王芝L~旦J
因7-1 多栩派很重选葬对西棍



当选择 Volume of F luid 选项时，即启用了 VOF 模型，如圈 7-2 所示 . 其中 VOF

Parameters 下的 VOF Scheme 可选择显式和隐式. 当选择显式时，需要输入适当的 Co山田t

数_ FLUENT 默认的是 0.25 _ 在 Number of Phases 中可以指定多相流模型计算的相数，量事

为 20 相. 选择 Open Channel Flow 表示问题为明渠流. 涉且体积力计算时， 还需要选中

lmplicit Body Force ， 通过解决压力梯度和动量万程中体职力的部分平衡提高了解的收敛.
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回7.2 选锋 VOF 4I1!'

7.2 Mixlure 模型

混合模型 ( Mixture 模型〉是一种简化的事相流模型，可用于模拟两相或多相具有不同

速度的流动(流体或颗植 ). 混古模型主要实现求解混合相的连续性方程、动量方程、能量

方程、第二相的体积分数且相对速度方程等功能. 典型的应用包括低质量载荷的位于负量

流、 气泡流、沉降以且旋风分离器等. 混合模型也可以用于没有离散相相对速度的均匀事相

流.

7.2.1 Mixture 模型的局限

在 FLUENT 中使用 Mixture 模型具有如下限制.

• 混合檀型只盹用于压力基卓解器，

• 只有一相允许植定义为可压缩理想气体，但是不限制使用 UDF 定义可压缩革

体相 ，
• 不能用于卓解周期性班动，

• 平盹用于模拟提固和融化过程，

• 无枯埠动不能使用 Mixture 模型，

• 在模相气穴现盘时，若瑞流模型为 LES 模拟则不能使用 Mixture 模型，
• 在 MRF j旋转坐标革与现合模型同时使用时.不植使用相对速度岳武，

• 不能和固体壁面的热情导模掘同时使用，

188 



• 不能用于并行计算和颗植轨道模型，

• 组分现合和反应施动问题不能和混合模型同时计算，
• 二酣睡式时间步算注不能幸用混合模型.

混合模型和 VOF 模型的相同之处在于它们都是一种 "单流体"模型，即只求解一牵动

量、能量方程 ， 不同之处在于z

• 理合模型尤许相间穿插，即在同一控制体内各相体积分数可以是 o 到 1 之间的
任意歌，品和j自 1 ，

· 相问允许有速度滑事 .

7.2.2 Mixture 模型的设置

在 Muhiphase Model 对话框中选择 Mixture . 如图 7-3 所示. 其中 Mixture Parameters 下

方的 Slip Velocity 为滑移速度，若选中则考虑相间滑移， 若不远则相间速度一致. 其余的

Number of Phases 和 Implicit Body Force 选择同 VOF模型.

7.3 Euler 模型

-画幅画画 -

:"e d | 厂一封
r We1~1um 

.即向".酶，.

W 国E亘E面
时F_F_..由

「 楠，椒'因..，，-

~王国旦旦j
因，.， 边舞混合穰'"

欧拉模型可以模拟多相流动互相间的相互作用 . 相可以是气体、液体、固体的任意组

合. 每一相都采用 Eulerian 处理.果用欧拉模型时， 第二相的数量仅仅因为内存要求和收敛

行为而受到限制， 只要有足够的内存， 任意多个第二相都可以棋拟. 然而，对于复杂的事相

班流动 ， 解全受到收敛性的限制.

欧拉宰相流模型没有液液、液-固的差别. 颗粒流是种简单的流动，至少涉且有一

相瞌指定为颗粒相.

7.3.1 Euler 模型的局限

在 FLUENT 中使用 Euler 模型具有如下限制

• 不能对在相使用雷诺应力瑞施模型.

• 不能用于求解周期性施动，
• 不能用于模拟提固和融化过程，
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• 无枯班动不蛙使用 Euler 模型，

• 平盹用于并行计算和颗扭轨道模型，

• 不允许存在压缩施动，
• 颗粒I(黯仅与主相相互作用，

• 模型中不盹考虑热情输，
• 相间的质量侍输仅允许在气大问题中，而在嚣皮和压缩中是不可行的，

• 二阶隐式时间步算浩平盹3辑用欧挂模型.
FLUENT 巾的欧拉模型中各相兴卒单一的压力场 ， 对每一相都敢解;;1)量和连续性万

程. 颗粒相才可以根据颗粒动力学理论计算颗粒拟温皮、缸子相剪切和体积粘性、摩捕帖

性.

7.3.2 Euler 模型的设置

在 Multiphase Model 对话框中选挥 Euler，如阁 7-4 所示.歇拉模型选择相对简单，只

需要读者定义模拟的相数，即在 Number of Phases 中输入相应的相撒.

国幽嗣幽国蛐矗

M恤'….......

: ZME叫‘ 「一一封
俨 翩翩e

< (;距困
r 

-2!.J正主主L!!立j
酶14 盗ft; EIII町徊型

7.4多相流模型的选择与设置

7.4 .1 多相流模型选择的基本原则

通常， 先决定采用何种是能符合实际流动的模式，然后根据以下原则来挑选最佳的檀

型，包括如何选挥官有气泡、液滴和粒于的流动模型:

• 坤于体积分散小于 10%的气泡、玻璃和植于血就班动，革用离散相模型，
对于离散相遇合物或者单植的离散相体lR率超出 10%的气地、 玻璃和植于虫

在施动.!It用现合檀型或者欧拉模型，

• ，才于桂皇班、泡拉施，最用 VOF 模型，

• 对于舟屉/自由面施动 ， 革用 VOF 模型，

• 对于气动输逞，如果是均句流动，则果用现合模型 ， 如果是植于埠，则果用欧

拉模型，

• 对于施化尿 ， 最用欧挂模型模割草于施，

• 对于现最璋和水力输远，来用现合模型直欧拉模型，
• 对于沉降，在用欧拉模型，



• 时于更加一般的，同时包告若干种多相施模式的情血，应根据最感兴趣的温动

特征，选择合适的施动模型. 此时由于模型只是对部分班动特征做了辑好的模
拙，其精度.j.-然低于只包告单个模式的革动 .

7.4.2 混合模型和欧拉模型的选择细则

混合模型和欧拉模型部适用于流动中有相混合或升高，或者分散相的体事1分数越过

1凹的情形. 然而， 两者井不等间 ， 在选择时要考虑以下细则 z

• 若分散相分布鞋广，最好选择混合模型，分布辑窄时，可以使用欧拉模型，
• 若相间直力规律已知 ， 欧拉幢型比现合模型更精确，若相间曳力规律平清晰，

此时理合模型可植是更好的选择，

• 若希望计算量小，最好选择理合模型，因为它比欧拉模型要少解一部分方程;
如果希望计算精度菌，则欧拉模型是更好的选择.

【实例 7-1]，触口旋转窑器内流体流动模拟

融口旋转容器内的液体具有自由液面，在一定转速下 ， 容器内部液而告出现下四. 那

么 ， 原本静止的事辑旋转后，容器内液体的液面是如何变化的?这是我们所关心的问题，下

面我们就利用 VQF 模型来求解该问题.

-、 宴例概述

圈 7-5 所示为敞口旋转容器， 顶部学径与高均为 O.5m . 底部半径为 O.3m. 其中装有 215

的水. 初始时事IJ水为静止状态，随后容器以 2radls 的角速度旋转.

同
「

1m 
叫

O.Sm 

问 叫
O.6m 

倒1.' 融口簸"蒋'示.囱

E路分析

'"例为二维轴对称问题， 计算区域可以取容器的一半. 由于 FLUENT 规定轴的方向必

攫与 x 轴一黠，因此建模时建立容器的右半区域， 待导λ FLUENT 后再镜fl与旋转.

通过本实例的演示过程， 读者将学习到

• 圃弧绘制，
• 轴对称模型的矗立，
· 旋转;

· 幢惶;
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• VOF 模型选择;

• 定义流体相，

• 初始化区域，
· 查看体积分散固 .

哑u)-.m附带光盘 "Ch7\s17- l.msh" 、" Ch7\s川b，飞"吨Ch川7\s17肌!η肌叫7弘-
" Ch7、、，1口7- 1 甜n " 、 "Ch识到7- l.cas " 、 " Ch7飞sI7-1-0.48 由t "、 "Ch识sl7-1

O .6s.dat"、 "Ch叭817-斗1 -1 s 由t俨"

侄E一#觑见附叫叩m刚阳肌l口肌7弘-1 旷.

二、 模型建立

l 且击 GAMBIT 的桌面快捷方式，启动 GAMBIT .

2 单击I百吨|言→V. 在 Create Real Vertex 画板的 x、 y . z 坐标输入栏中输入
(0.0.0)，单击o量工l接扭生成~一个点，随后接同样方法住次建立占

(0.5, O . 川、 点 (0 ， 0.5 ，川和，务、 (0.5 ， 0.3, 0)，这是在器右半E域的 4

个点 . 由于在器的一串边为国蝇，所时还需要建立一个圆心，通过计算，圃

蝉的圆心为 (0 ， -0.09 , 0 )，最后蜡制好的 5 个点如困 7-6 所示.

3 下面首先连接酬， u f'i' -~ -F. 制如圄 7-7附的 Create Circul缸
Arc lfI板，选择第一个 Method，并在 Center 中选择忡， -0.09，旧，在 End­

Points 中选择 (0 ， 0.5. 0) 与 (0.5， 0.3 , 0)，保持A<c 为草一个选项，单击

土豆豆:J按钮生成圆弧.

• 

M由.. 3ys. 1:F-，y，. I 一主l

二旦旦二J可"

叩 U臆.

缸 r一一 1 " ，，-一­
V 阿T一 I y: fO.09 

""-一一- 1" ，，-一一-

一幅_. +V) v () v j.i 

… 国- jj;;陶M
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阳
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!:!!亘工I!:::豆豆旦

因7~ 点的绘制 图7-1 Create Circlllar AK 面'民

4. Jt'-，j; [百→~→F， 在 Create S国ight Edge 帆中选择点 1 (Vertix.1 )与点
2 (Vert以 2 ) ， 连接这两条生A线段，然后依次建立点 1 与点 3 、 点 2 与占 41司

的线段，共 3 串蝇段，如圄 7.8 所示.

5 此时，圆心点已不再需要特 Vert.x ..，~ r万的I万， 在Delete Vertic白面
板中选择圆心点 (0 ， -0.09. 川，即 vertex.5 ，单击E豆画~按钮删除圄心

点，如固 7-9 所示-

6 轴I百→陌→厅，在 Create Face from Wireframe 1f1;{:9..中利用应ji)t1l.#



左键植逸事器右半部分的 4 条边，然后单去 .. 画CI按钮创建函，如圄 7- \0

所示.

地 f.c.. l 

. 、J飞
…主与JI ......5 到
~且J_旦旦J_旦旦」

回7-' 剿..回心点
• -"飞
回7. 10 创煌的面

忖

• 
回 7-1 始制"

至此， 本酬的几何模型己建立好， 下步将进行网格划分.

二、 网幡 .. 1骨

1 单岳阳.-[F司厦，在 Mesh 田ges 峭的剧伊黄邑输入担忧刊段 3
和线段 4 (edge.3 和 edge 刑，址.1. Ratio 的节点距离比例为 1 (哥间距)，选择

Interval count 分段方'式.并在左侧输入栏中输入 40，单击二至画工i按钮生且
在器右半部分上下边的战同格. 按照同样的万法，将战段 1 和蝇~i 2 也划分

成等问J.的线同格，只不过 Jnterva l count 为 50，得出的战网格如圄 7-11 所

示.

建窜z 由于零~;t，萨区ll.Jc下丰径不- ， 呈现i!疵，缺钱网格可以采用等伺Æ划分，最终仍体现出南史的

同格分布.

2 单去「百-[F吨I亩，打开 Mesh Faces 帐，用医画且标左键选中已经克
成线网格划分的面 t. i运用 Q皿d 单止与 Submap 方法对由面进行面网格划

分，保留其他默认设置，单击--2!擅自J按钮即可.其网格生成如固 7- 12 所

示.

,,' 

阁'-11 Il网俗的划分 圃7-12 面网稿的划分

3. ó1 JiII品划分奸后.需要走义边界是型 ， .<;..，[盲咱[亩，在 Spe响 Bound町
乃pes 函极中将圃弧迫和血边是且为壁画边界( WALL )，且非分别为

youcebìan 和 dibian，将 x 抽上的中战定义为轴边界 (AXIS )， 名非为由OU ，

笛'
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将在器开口边走义为压力人口 (PRESSURE_INLET ) ， 且称为 shangbi町，如

围 7-口 所示-

4 同格划分克后.执行 File→ Export -0 Mesh 命令，将同格输出为 sI7. 1.msh .

~，-咀比

如~.~声142L
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.，叫句、合作

和要EP飞7
咄咄k
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e
-
-
ι
 
--

;0.' .._.. 

因 '-13 边界类型应义

四 、 求解计算

1 启动 FLUENT 二银单精度计算器，执行 Fi le_Read→C田e. 命令，读人划分
奸的网格立件气17. l.msh " . 此时，窗口中出现如圄 7-14 所示的警告馆

息 ， 提示用y有轴边界帝件，需要修改相应的卓解器设直，暂且不管.
W~rn皇ng : lht USf of ~篇1s bound ..俨J condltlons Is not .pp~oprl.笆， Fe,. 

.. 20/30 flo_ problt.. Pl...室. cons1d,r chilnging th. z… 
typ. to sy~t，.y 0" -.11 , 0" th. problt. to ...lsy..etrlc 

回7.1 4 警告情"

2 执行 Grid→Check 命今，时间品进行栓删，成功桂删后窗口界函中最后一行:l:

现"Done" 语句 . 执，{t Grid→Scale 命令，设置计算区域的尺寸和单位制定
义. 由于本制模型在 GAMB1T 中是按 m 生成的，故保持默认设置即可，直接

单击o豆曰接钮是间 Scale Grid 对话枢.
3 下面调整同格的显示 ， 使其显示为全在嚣的计算E域. 首克且示同品，执行

Display-Grid 命令，得出一个圄市窗口，如圄 7- 15 所示.

打开如圄 7-16 所示的视国调整对话掘.
.- ,... 

法吾

望自
皇宫-­,1_1 

J世」 王_..... 11 0.- 1 ... 

罔7.IS 网'岛的显示 回7. 16 VÞ信晒对话很

5 执钝啤乎oiJ M盯。r P1阳回到在中选择 zhou ， 单去旦旦推钮， 此时克前的圄理
窗口中显示为整个容器的计算E域， 如圄 7-1 7 所示.



1 0 -'> _.... . 

四川' 全区罐显示

6 单击Views 时话柜中的正_'"._ ~蛮钮，打开如圄 7-18 所示的 CameT3 Parameters 

(照相机事敛}对话框， 用且梓调整对话柜中的在盘的指针， 顺时针方向特

动，同时观事视圄窗口中的容器，在特动 90' 时停止 ， 呈现出如圄 7- 1 9 所示

的网#圈 . 最后单含两次旦旦二按钮朵闸 Camera Parameters 对话柜和 Views 时

话植.

. .." . "...""… :;1 m，.，.，.士-一一一一一一一一一一...，霄琦

c…1"-'- 丁问由阿瓦丁

响I".I'.Ø .:.1 1 "町二d
v.... J. .. t'I芝 -1 1 ', 1,- .J 

""1 1 1 .'-'事 』 二J .J -"且

旦旦国画 卫生j
赔7. ]8 CerMra Paran刚'"对面制医 院7.19 旋转后的同幡显示

7 执行 Define→Models→Solver 命令， 佯虫 Solver 对话框，如围 7-20 所t

选择 Space i!.项7面的 Ax isymmetric Swirl . 因本制为非定常模型 ， 故选择

Time 下的 Unsteady，单去」巳』安缸• 
• &111 …………-哩

,-­. ..融'

』

俨 ~呻
o' lIIo ... 啕

.....Io..C叫

r …,-…,. r , 

…一"… r … "…甲
俨…-

-，一-嗣...叫
PIIyoI<al V.叫

…屿

.~…c.. a. ... …..… r I.a." s._. C.I 11.... 

四7-20 ，1画本"'''霉的设置
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8 由于水的密庄和动力帖庄分别为 998.2kg/m' 和 O.OOIOO3kg/ ( m's)，在 2radls
的角迫皮下，提特水的雷诺盘的 106 ，故需要启动涡流模型 . 执行

Define• Models_ Viscous 命今，弹出Viscous Model 对话框，在 Mode! 追项

中选择 k-叩si1oo [2 eqn) ， 在 k-epsilon Model 选项下选择 Standard，保留其他"

认谊直，单击-丘」按钮-

9. 下ó1霄要启用 ß 相iLl.型 . 执行 Define→Models→Multiphase 命令， 伴出如
圄 7-2 1 所示的 Multiphase Model 对话框， FLUENT 耻认的为单相流模型 ，即

为 Off. 列在中的 Volume of Fluid 、 Mixture. Eulerian 分别时且 1 VOF模型

混合模型和欧拉模型. 本例需要来用 VOF 模型，故选中 Volume of Fluid . 

Mu1tiphase Model 对话担自动展开，保持默认事盘设直，如固 7.22 所示. 单击

-巳如钮，关闭斌对话植.

国幽翩翩翩蛐 .

产盟主主

• • '. ",... • "圃圄

,.,… 
酣-­. ""嗣
F叩

C翩翩…

F丁否一一一

「阳川阳

...，阳咽，.-... 
「 叩...，，-

阻'... 
r"阳-"叩
F 血，

r EIIIetI .. 
rw. 吁

~ I!.:副主U 一旦」 王..<11 1 ....!旦J

回7.21 Multiplulsc Mookl 肘;t植 回7-22 VOF.型槐置

遣..由于本例为舍有自 由法面的流动， 因此应该选择 VOF模型进行计耳.

10. ~队照前面介姐的方法，走义流动的材'←一一水，克成材料物性的定义.

1 1 执行 Define→Phases 命今，打开如圄 7.23 所示的 Ph国es 对话枢进行相的是

5i.. . ~义制i!Þ及到宜气和水两相，即基本相( primary-phase )为宝气.第二相

( secondary-phase )为水，是义如下 .

• 在 Ph酬列最中选择 ph脑时，在 Type 选咂中选择 pnm町 ph脚，然后单击
」丘』按钮，打开如固 7.24 所幸的对话框，在读对话框的 Phase Materia l 列囊

中选择 alr. 并在 Name 丈*'框中输入 "" 代替原来的 phase-I . 最后单击~

按钮，克成基本相(空气)的定义.

· 在 Ph四列章中选择 phase-2，在 Type 选事中选择自∞nd町呐町，然后单击

1旦ι瞧钮E 打开如圄 7.25 所幸的对话框，在t束对话握的 Phase Materia l 列囊
中选择 water- Iiquid. 井在 Name 丈本框中输入 water 代替原来的 ph缸。2，最

后单击一旦且安钮，完成第二相{水)的定义.



回国国国…-

…皿皿…四-四·田 ð -国矗画圄归国……-且

圃7-23 pt由田里'说但 阳7.24 缉拿徊的定义 阁7.2S 第二棚的定义

12 下一步设置计算的耳境 . 执行 Defïne→句erating Cond巾。ns 命令，打开

Operating Conditions 时话报. 如困 7-26 所示， 选中 Gravity. 指定重力方向为

x 轴，在 X[m!s2J右侧输入 9.81，即重力方向指向在aJil.~ . 选择 Specified

Operating Density .i!项，保持 Operating Density[kgl/m3]为1.225 ， 此为宝气的

密度 过里通常把密庄较小的相的密庄值设直为事考密庄，这样可以战小计

耳两相动量乎街时的教值截断误呈，而压力事考点的位直为坐标原点，该点

正是在器敞口正中间，所处的压力值恰为一个大气压，故默认的1.225 值是合

理的 . 最后单击~接扭，是间谊对话桓.

‘ ..川"""""川，-川、 f去

帮结出坐坐u.q

G,...., 
• "...., 
G .. ""由副Aotel，.，.阳

阳，..tll" Prn.u,,. løo;Ml." X Io晒叩."

'1喃喃X1叫 [i

V l-l ji 
V.,;Ñle-Oe".1ty Pto..mc笛"

信 面豆匾，01 O，.，r章亘E亘'"

悟空旦回丑

"" 王aaa:l j ...!!主J
回7-26 魏作环缉的设置

13 工作压强诅直克后，需要定义边阜数据. 执行 Define→Boundary Conditions 

命争，弹出 Bounda叩 Conditions 时话桩，走义如下.

• 在左边的 Zone 栏选中 shangb酬，保持 Phase 为 mlxture，单击」旦旦按钮，在
固 7.27 所幸 Pressure lnlet 对话框中的 Specification Method 下拉列囊中选择

Intensity and Hydraulic Diameter ，在 Turbulent Intensity(% ) 中输入 1 ，在

Hydraulic Diameler[叫中也输入 1， 保持其他默认设置. 单舍-坐-1按钮. 压力

入口的第二相 (水)的比例且为 0，故回到 Bound町 Conditions 时语框中选择

Phase 为 water，单击」丘-按钮，在固 7.28 所示对话框的 Multiphase 中的

Volume Fraction 栏输入 0，单击一旦』安钮.
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回7-28 压力入口的第二相设 .. 

· 在左边的 Zone 栏选中 youcebian ，单击」旦~挂钮，弹出如回 7-29 所示的

Wall 对话框. 选中 Wall Motion 下方的 MovÎng Wall，表示在器在旋转，选择

Motion 下方的 Relative to Adjacent Cell Zone 和 Ro阳tional ， 在 Speed[radls]栏输

λ 2，保持其他为默认，单击J巳』安钮，完成右边界的定义.

』阳

F币

…… 陌.. 
跑啊啕. 1-"，" 1--1 SfÞed.. I D嗣 i 脑嗣.... 1 ωs

Fi..... 

W而叫 叫·

r _ ...,w ... 
. 叫叩 FEZ-崎四川-严旦旦一

,. f<_.I_" .… r c. ....… 
阳C帽巾

'‘ 嗣 ，-.- s，.dIk~ S.四『
俨 .‘
俨

..咆雪_.. 
h唱..... 1Ic刷同r-一-1- 3 
~.. C-'-F一一一问:百一…--"3

一旦J I!:国 - 1
图 7-29 ~懂西边界定义

• 同理 ， I在边的定义和右侧边的定义- l!!:，也lV. 2rad/s 旋转 .
. 保持 zhou 为 aXls 边界.



14 τ面对卓解事数进行设置. 执行 Solve司 Control- Solution 命令， 在 Solution

Contro l s 时话植将 Discret i曰uon 项的 Pressure 设直为 PRESTO! > Yolwne 

Fraction 世直为 Geo-Reconstruct. 将 Pressure.Velocity Coupling ß.力速度相合

方式改为 P1S0 格式， 悻持其他耻认世直，如围 7-30 所来，

量

量
…n…甲

.‘ 
回7.30 刻...撞制"险的设置

IS 接下来时 i血场进行相始化，执行 Solve -0 Initialize - lnilialize 命令 ， 在

Solution lnitialization 对话柜中选择 shangbi町 ， 时进口初始化，蜡序单去

」旦」 旦旦擞钮卫旦旦性钮.
16 本制A~存有 Z巧的水， 霄要将底部区域进行初始也_ 11克用品也同格自适应

的方法定义一个区域. 执行 Adapt 司 Region 命令，在圄 7-31 所示的 Region

Adaption 时话握中 ， 设置 X Min(m)为 03 ， X Max[m]为 0.5. Y Min(m)为 0 ，

Y Max[m]为 0.5，然后单舍旦旦除扭创建一个临时寄存在器底部 Z巧的区域，

单击旦旦旦如扭关闭谊时话桓.
17 执行 Solve - lnitialize吨 Patch 命令，选择 Ph国e 为 water ， 单去 Registers to 

Patch 中的 hexahedron 呻(已在义的临时寄存E域 )， 选中 Variable 列在中的

Volume Fraction ， 在 Value 担输入1，单去E旦l按钮川在器且~ 21S 1&制
水的初始化走义， 如圄 7-32 所示

0,I000o ...... cwc ' • 
. 山
俨叫

I~ _ ' 

' 简 1阳"
F 嗣

E国剿脑-

除L

萨L泞L 声一丁
" '-' 产L户­
~i r一一

旦旦旦旦旦旦旦三」

旦旦旦旦j 旦到 旦旦j 旦旦旦旦 旦旦

回7.)2 例'自化区罐圃，到 Rq;俑 '‘缸"眼泪对..德

18 此时 ， 我们可且桂查一下容器血部是否有水的存在 ， 执行 Display 司

Contours 命令，选择 Contours of 为 Phase 和 Yolume fraction. 选择 Phase
为肌勾埠。ptions 栏中的 Filled 选项，单击且国楠，制如国 7-33 所
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示的视圄窗口，围中显示丁宝气体积分数的云国 ， 红色区域为宝气，蓝邑区

域为水.

建意 由于使用的是临时区峡，是多再次读入=文件时，必须重新初始化区农

ME

m 

因 7-33 切始化区棍后的空气的体帜分戴显示

19 接着定义一个用户函数. 执行 Define → Custom Field Functions 命令. 在国 7.

34 所示的 Custom Field functions Calculator 对话板的 Definition 中单击 2 和
爽 ， 然后选择 Field Functions 中的 Grid 和 Radial Coordinate，单去主旦l按

钮，使得 Definition 输入握中显示为 2*radial-coordinate，最后在 New Function 

Name 又本桓中输入函敬4 宇 swirl. 单击旦旦且按钮克成函数的是二义 ， 单击
王旦旦姑妄钮是闭该对话挂.

'-州-川川.

… Fτ.'hl-画面II.te

t l . l x l / l ý'X 1 娼叫 Seled Openn' flcl' f'阴ctio" ， 刷刷

刷v 1 ,1" 四川恤 n I leall l ~lel' Funcll.". 
七七二-::=i IG他 . 1 

u …… SORT I I 」

--，~--'.J~--'.J--'.J旦些J IA..i.' 臼叫回盹 .:J 
ιI I Pl I e 1 . l ou t l'tl睛"
一一一一一一一一一一一… Imb<tu.e _..:l 

旦旦
Ncw flnalln Nlmc !~w1 rl 

」旦U 旦旦=l-E旦ιL止"-.J
商7_34 Custom field FunctiOll$ C创cula阳对话倔

20 执行 Solve- Initialize → Patch 命令，如困 7.35 所示，在 Phase 下拉列在中选

择 rnlxture，在 Yariable 11J 在中选择 Swirl Velocity ， 在 Registers 10 Patch 列在中

何选中 hexahedron-rO ， 句选 Use Fie ld Function 选项 ， 在 Field function JI)在中

选择定义峙的函数 swirl，最后单击旦旦j接扭克材特串连庄的耐化走义.



$ Rd_..CtNZ-

1- ::J 一
{由

回7.35 初始化旋转温度

21 初始化后，执行 Solve → Monitors → Residual 命令，在弹出的 Res idual

Monitors 对话柜中选中 Plot，打开战革曲蝇圄 . 时话框下方的 Criteria 中可时

输入各事数的收盘柑Jt.要求. FLUENT 耻认为 0.001，本制保持默认，单去

~按钮.

22 执行 File- Write- Case 命令，将工程主件保冉为 sl7- l.c描.

23 执行 Solve→ I阳'ate 命令，世直时间步长为 0.005s，时间步为 80 . 如圄 7-36

所示，单去生旦巳接扭开始解耳.

24 计算停止后，执行 File- Write吨 Data 命今，保存 s17-1-0 .4S.dat . 接着继续以

同样的时间步长选代 40 步和 80 步，分别保存结果丈件为 s17-1-0 .6s.dat 和 sl7-

l-I s .dat. 

25. 4九行Display→Contours 命令，查看 3 个时割的空气体租分数分布.如国 7-

37 至固 7-39 所示，体现了水面随时间的变化.

M 到 |
nm. 

nm. 笛"叫.) 11.115 

M怕 01 Thne Slep. fi'一封

TImeS枪叶pping "e伽..

r- flxcd 
r Ad . p曲vo

r V.rl.ble 

0lltion. 
t r Om S.mpllng for nmc StlltI.tlcs I 

t.:;... --===士一 --一二­
叩.。

…呻"'…峙p r::I ':-' _~ ' 
耻'叫'脚叫「一封

阳Profllc Upd.lc I脚IY1Il r一封

口lDIii'IMmlDl…巴ll!I

睛
"
"

国

翩
翩
翩
翩
·
·
"
"
回
国
"
四
"
"
"
国旦旦旦旦j 旦旦J Help I 

因 7.37 0 ，4 5 时的空气仰体狈分数云副因7.J6 选代步妖设置
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回7-38 0.61 时的空气的体职份数云图 圄'.)9 1 1 时的要气的体坝纱'世云图

26 最后，执行 File- Ex i t 命令，安全退出 FLUENT

E 实例 7-2 ) ， 二维溃坝过程流动模拟

坝是重要的水利水电工程， 亘接关系到下游人民的生命与财产的安全， 一旦发生溃坝，

其泄流速度且流量是人们关注的时聋. 下面针对这一问题利用 FLUENT 进行二维榄坝过程

的流动模拟.

-、实例梅述

如图 7-40 所示，左侧为曹水 8m 高的水库，一旦右侧坝悻峙塌，水将迅速冲向下游.

同

r 
.... .. 

1伽，

2m 

回740 溃坝阂.示，院回

思路分析

本例为二维溃坝问题，图 7-40 左侧的柱状区域表示为静止时刻的水 ， 一旦榄坝 ， 柱战

区域的右侧壁〈水坝〉 相当于突然拿去，所以本例可以不用画出坝体， 而是采用区域初始他

来模拟榄坝前静止的水.

通过本事例的演示过程，读者将学习到

• 面城布尔喊操作，

• 区域初始化，
• VOF 模型设置，

• Æ强选代掉止准则设置.



(u....) 参见附带光盘 "Ch7\s17.2.msh " , "Ch7\s17-2.dbs"、" Ch7\s17-2.jou 飞
.. Ch71s17 -2 衍n "、 " Ch7飞到7-2.cas " 、 " Ch7飞s I7-2-0.2s.dat" 、 .. Ch71s17-2-

O.5s.dat "、 "Ch7、17-2- 1 s.dat " 0 

哑至2一#见附带她 6川.V11s17-2旷• 

• 

二、 模型建立

1 双去 GAMBIT 的桌面快捷方式，启动 GAMBIT

2 本伽l模型需要建立两个.，域，然后进行布尔战操作生成如圄 7-40 所示的几何

模型 . ......fi"'-陌→[霄， 在 Create Real Rectangular Face 峭的 Width ~ 
Height 栏分别输入 20 和 1 0，学去 .....按钮，如固 7-4 1 所示，拒形中点

与原点重合.

3 在 Create Real Rectangular Face li1扭曲 Width 和 Height 中分别输入 2 和 8，单

击 App1y，生成如圄 7-42 所示的两个面域.

L ,. 
e 
e 
t.. j ... 1; 

回7~1 垒成的第-面域 图7~2 生成的两个面精

4 下面需要将革二个面移动豆合适位直，单击 Face 帆中的F按钮，在
Move/Copy Faces ti1祖中选择函 2，保持 Move 植选中，在 Globa l 下的 x 栏输

入-9 ， y 栏输入.\，单击.型Ll按钮草且该面的非动操作

5 轴 Face 翩中的F按钮，在制的如圄 7-43 附的 Subtract Real Fac叫
4氏的草一行 Face 中选取面\，在草二行 Faces 中选取面 2，并单击宁方的

Retain (即保留面 2 )按钮呈虹邑显示，单击-旦旦-.J按钮，克成布尔战操

作. 此时的视圄窗口中的儿何模型如围 7-44 所示.

一m |如" 主I

" '耐
门

b 

… • 
-|)""..2 主j L.ι 

.. 回耐

.... 旦旦旦-.J --!!!!!二」
回7~3 布尔被像你 回7-"4 布尔以厉的商‘民

6 为了分析万佳，将建立奸的几何模型的丘底角移王与原点重合，单去 Face 面

极中的F按钮，在 Move/C叩y Faces 51担中选择面 1 和剧，保持 Move iJtit.. 
中，在 Global 下的 x 栏输入\0， y 栏输入 5，单击』豆豆-.J按钮，如圄 7-45

所示.
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卜一

; '1 

泣，-，

因745 移动后的儿何极盛

7 最后需要读者，王章的是在面 l 与面 2 内部接触的两串边存有重合的钱段，需

要将重合的蝇段合并为一串. 特 Edgo <iJl6.中的肝制且，选中重合的边，
单击 - 桂扭

三、网格划分

1 下面对计耳区域进行同格划分，由于酬的计算区峭简单，时击日-
陌→萨，打开 Mesh Faces 帐，选中本制计算区域的面 1 时 2，时

"Elements: Quad " 和 "Type: Map" 的网格划分方式，并革用 Interval size 

为 0. 1 划分<iJ网棒，保持其他默认设直，如固 7-46 所示，单击 ，里LJ接

扭，生成如圄 7-47 所示的面网格.

|田圃幽幽幽，
F四 oME 国

… . ，附 0_1

町u

可" .~ --
。巾. r.t..~ 

. 陶叫"川
」阳川阳Mllh

.J 19nOrI .111… 
-"'"旦旦.J -

因，.7 划分好的面网将副746 面同俗划分设置

2 同格划分时定义边界类型，单击~-Ii岳的面 1 的上迫与础，以
为压力出口边界( PRESSURE_OUT)， 选中<iJ 1 的在倒边与且边，定义为壁画

边界( WALLl，如国 7-48 所示. - l PRESSωRE_O旷

IWALL 
时

.，~剧

回7 锦定义好的边界典型



3 将原先份血的水所在 E域以为埠体 1 ，单击I富『阳面，在 Sp'呻
Continuum Types 面扭中将面 2 定义为 FLUID，名非为 fluidl .

4 执行 Fi1e -. Export→ Mesh 命令，将同#输出为 s17-2.msh .

四 、 草解计算

l 启动 FLUENT 二维单柑庄计算器，执行 File→Read→C国e 命令，读入划分

好的网品主件 "sI7-2.msh '" . 同品诠λ之后，拭行 Grid→Check 命令，检查同

格的信息，持最后一行出现 "Done" 语句

2 执行 Grid→Scale 命令，弹出 Scale Grid 时话框，由于在 GAMBIT 中是按照

m 为单位 l:l 建立的JL何模型，本倒不需要重新定义网格的尺寸， A比如围 7-49

所示的对话柜中可时看出计算区域的尺寸范围

三习二豆l
Sule F.嘟"
' Xγ一­

I Y j1一一一

。....In Extent. 
时间F一一一一 阳叫叫1"一一­

V耐 Iml [l一一一 Ymax l'叫 1"一一一

二生J 旦旦~ [ 000日」旦J

回749 Scalc Grid 对该相E

3 执行 Define→Models→Solver 命令，掉出 Solver 对话框，如围 7-50 所示.

选中 Time 下方的 Unsteady，启用非定常计算，其余保持默认，单击」二且安.... 
4 执行 Define→ModeJs→Multiphase 命令，在弹出的 Multiphæ坦 M叫，1 对话柜

中选择 Volume of Fluid , Multiphase Model 对话握自动展开，悻持默认在数设

置，如圄 7-5 1 所示，单击一旦』安钮，关闭a:对话框.
MjufEi|. 圄蝴幽幽匾幽幽画-, ' 阳n.. 0 .. ,,4 
俨 o.ft.~a...，4

，--翩­" -但r , .... 
而 却

俨 ~.…
俨 M…M
F 川

;孟晶

阳."
r 惆

(ò ",. Iumc M Fl.i. (" w_.. 
r E ，I. 州-

rw，什 St， .. 

W阳叩m

VOFScheme 
Ii' E><pIiclt 

".州d

l'一一一封

T.....Io..Ç.叩

「…-，…r F......阳f."".._

~阳曲h叫-

6曲"
r Il0l1_ 

M由F川酬­

rr'r' i, 
" 川剧叩a
r , .... 酶'闹.刷

c......nt Num~er 
I' .zs 
r 0""0 Che.nel阳

Ðo4y f "",", f_ul-'lon 
「 阳plk:H Ðoðy Fotee 

，，~酬。~" ........F.时~"

'" GH.o-G..... CIIIO..d (ò l>嗣叫h叫
r- en.elri;;…. _c ""..4 俨 PIoyokal V.叫
r L...IS_町 Cd Ba..4

一一~王.....，1 1 --!:坦j ~ 旦-r l 2!旦」
恻7.SI VQF 模型设置回，-so 基本求解键设置
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5 定义流动的材牵←一一水，克A材料物性的走义.

6 左义基本相和第二相 . 执行 Define→Phases 命令，在 Phase 列在中选择

ph目时 ， 在 Type 迫项中选择 pnma吁ph脑e，然后单击」主L按钮.在打开对

话柜的 Phase Material 列在中选择 alT，并在 Name 主本框中输入'"代替原来
的 ph因时，单去」巳j!HJi. . 在 Phase 列在中选择 phase-2，在 Ty归迫项中选

择 secondary -phase，单去 Set.. . 接扭，在打开时话柜的 Phase Material 列在中

选择 water-liquid，并在 Name 主本柜中输入 water 代替原来的 phase-2，单去

」巳-*4<.
7 执行 Define→Operating Conditions 命令，打开 OperatÎng Conditions 对话植.

如固 7-52 所示，选中 Gravity，指定重力方向为 y 轴，在 Y[mls2]右倒输入

-9.8 )， 即重力方向指向明底. 同时选择 Speci自ed Operating Dcnsity 选项，保持

Operating Density(kgl/m3]为 1.225，单击」巳』安钮.
叫-刷雀川"，叫 • 

脚.. ...rc Gr.鸭"

阱四川凹问叫

Rm.ence Pfeu ...c Lo"öo的 X I时.ZJ [ï 
11 Y lmI叫 9 .1 1x叫­

Y I叫 ~

四旦旦旦回

~旦旦!.L~坐J

8 

倒7-52 级作环糖位置

接着走义边耳条件，执行 Define→Boundary Conditions 命令，弹出 Boundary

Conditions 对话括. 本制只需将出口水的回;Ii.体杠分缸定义为 0，即在在边的

Zone 拉选中 ouI，选择 Phase 为 water，单去二丘二m按钮，在固 7-53 所示的

Pressure Outlet 对话柜中的 Backflow 、olume Fraclion 栏输入 O .

川~m 阪 I

I...t 一 能
M 翩翩叫 Th四".' 1 R.ldIMlo_ 1 Spedn I 0阳 M响p...c luos 1 
M阳嗣同，..叫「一一-F百r一一丁 i

」υ 庭副主U
图7.S) 边界定义

9 执行 Solve • Control • Solution 命令，在 Solution Controls 对话框将

Discretization 的 Pressure 1:主直为 PRESTO ! ， Volume Fraction it直为 Geo­

Reconstruct，将 Pressure-Velocity Coupling 压力速度相合方式改为 PISO格式，

保持其他耻认世直，如围 7-54 所示，单去」巳业安钮.



r一一一­

F幢坦虫

阳..~严. ;J 

M啕「一

时F.......p

.._......严「 斗
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3 

;| V町，叫…
时向阿币.u_

141

4
j 

o .桂_..创Ie~C.啕... 

~丘剧院到 .."， 1
阳，.，. 求....，院 ~置

10 与」二倒不同的是，本制设置 T 一个压强选代掉止准则 ， 执府 Solve→ Contro ls-

Multigrid 命令，弹出如国 7-55 所示的 Multigrid Contro l s 对话框，将时话梧

的 Pressure 右恻的 Tenn inalion 值设直为 0.00 1 . 单去-巴且安钮是闭 i束时话

植.

i3 
-'-，....回

桐恒… 刷G国.....刷Z睛"恤阳 』
.....-阳陆 二l 1...., 1-- i |阳 j 

i 严「 萨「 l句..- i 
二l 严「 严「 问...- 二l

.,j 
Alte~'MC ""咽... C,,"'II ......… "咄咄阳帽.. 

sw.~' 1Z一封
.00崎Flel.......... p.--呈

阳"四

_.""幅PIor_.. c.....刨.. "*_C1Ie .. 

肉t-Sweqa [l一呈 阳阳"叫.~型

向盼阳酬「一丑 c._. 1ot 1Z一呈

阳Cydit.~虽 s--.c. T)1ÞC 

。... 阳·
h嗣啕F一丑

-丘」 旦旦!l 旦旦 tte.， 1

隙'.55 尴代"止设置

11 接τ束时 ，虱场进行扭曲化，执行 Solve 司 Initialize ~ InitiaJ ize 命令，在

Solution Initialization 对话柜中选择 all-zones ， 时会JlJ&.初始化，顺序单击

10M 1. 旦旦、卫旦旦按钮.
12 执行 Solve→ Initializc→ Patch 命令， 选择 Ph""， 为 water . 单去Zon田 to Patch 

中的 fluid 1 ， 选中 Variable 列在中的 Yolume Fracrion . 在 Yalue 担输入 1 ， 单击

旦旦如扭克成明始时剧铮阜水且岖的明姑化定义，如围 7-56 所示.
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r Uaefleld F… 

D 
时

图7-56 I!!粮初始化

口 同样 ， 走义克后可旧查看此时的体和分数分布情且 . 执行 口isplay -­

Conlours 命令，边排 Contours of 为 Phase 和 Yolume fraction，选择 Phase

为 al r ， 勾.i& Options 栏中的 Filled 选项，单去应豆豆l接但，体出如圄 7.57 所
示的现国窗口 ， 圄中显示了初始时刻静止水的区域， 呈蓝色显示.

I!I川M 川 ， ::1 1113，1_'" 吃 bIa

啤
喃
幅
幅
画
"
翩
翩
帽
"
·
·
"
"
"
"
四
四
"
"
·
· 阳7.S7 ~J始时剿空气体"分敏分布

14 啊始化后，执行 Solve • Monitors • Residual 命令，在弹出的 Residual

Monitors 时话抱中迫中 Plot. 打开战呈曲战圄 . FLUENT ~认~事数的收最精

度要卓为 0.001.本制保持默认，单击~柱扭.

匹 克成土i卓步骤的设直后 ， 执行 File → Write → Case 命令，将工程文件保存为

sI7-1.c田 .

16 执行 Solve -- lIerate 命今，设直时间步长为 0.015，时间步为 20 . 如圄 7.5 8

所示， .醉金主旦二接扭开始解耳.

17 计耳停止后 ， 执行 File→ Write-Data 命今，悻存 517- 1 -0.25 也t . 接着继续"

同样的时间步长选代 )0 步和 50 步 ， 分]'1悻存蜡果主件:h ， 17.1.0.5， 由t 和 s17-

1-1 s.dat. 

18 执行 Display - Contours 和 Display可 Vectors 命令，量看 3 个时刻的宝气体

租分4t分布和追庄矢量圃，如圄 7-59 至圄 7.64 所示，体现T随时间才'进，贵坝

后的水流流动过程.
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恻 7-63 11 时的空气体极分'段分布

"'哩" ' ".... J . 霄啊
" • -仙
" '" •• • ,. 
=E ‘ 
a .. 
' " • • .. 
• • • 

回?毛‘ "时的，.Il矢A"

由圈中可见，榄坝井不矗幌时的，而是存在一个短暂的过程，京先由下部开始垮喝，京
体区域的高度随之下降. 由遮皮矢盘阁可见， 在水流下泻的过程中 ， 水与空气间存在剧烈的
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0.2s 和 0.55 时 ， 水流下泻的最大速度在逐渐增加，由 4.26m1s 增大JlJ 7.38m1s. 1$且圃

7毛0 和图 7-62 .

哇1:. J!I y 可以稽'束时间步鳞鳞选代，也可以定义动画观察溃坝的签个过程，本倒不再;f述.

1 9 执行 File- Exi t 命令，安全退出 FL山NT.

相互作用，水卷眼部分空气形成气泡.

违章，时间步钦的设直是根据最大可能这血和同格单元的尺度来决定的.-*-例网格单元 O.lm，最大可能造

皮 l伽nJ.. 放选为 0.015.

【实例 7.3 1 油水两相流弯管流动模拟

弯骨被广泛应用于石化、热能动力、给排水、钢铁冶盘等工程领域的流体输送， 其内回

流体与管壁的相对运动将产生一定程度的振动而使管迫系统动力失稳，严1Il时会给罩统运行

带来灾难性的毁坏.而现今原油集输管线中曹边为油水两相流， 较Jll.相流动直杂 ， 且通过弯

'il'时由于回壁的突变 ， 使得流动特性更为'唐如.因此， 研究水平弯管内汹水两相流的速度、

压力分布等流动特性 ， 不仅能够为安全输运、流动#数控制等提供#宅r. 还可为管线防腐、

节能降娓措施选取等提供依据.

一、 ~例概述

ì!取某输袖管道工程管径 6∞mm 的 90'水平弯管段，弯径比为 3 . 井在弯管前后各咂

5m 直管段进行边摸. Jt几何模型如阁 7-65 所示. 为精确比校流体流经哥啻过程中的流场变

化，磁取了阁1-65 所示的 5 个截面进行辅助分析. 弯管迸出口的压:1:!为 8∞p，.袖梳吉水

率为 20%.

出口

a毒面 B
r-~，MI>~ ----1 

._;1:1=三3

!正mlm
惠阳=三二1

锁商 3

选口

回7~' 句"儿何损型示塞圈

思路分析

本例为三维弯t!'内的油水两相流动，可以使用混合模型，也可以使用欧拉模型.那么.

本例同时采用两种模型进行卦析， 最后做一简单比较.

通过本实例的演示过程，读者将学习到

• 三撞弯营的建4量，



• 混合模型设置，
• 欧拉模型设置，

• 压力入口水的体和分散世置，
. 切取世面.

• $桂面云图显示 .

哑" 01 ) ..见附带先盘 " Ch7\s17叫"、 "Ch7\s 1 7-3 .dbs >> 、 u Ch7\s17-3.jou ，. 、
"Ch巩sl7-3.tm " 、 " Ch巩sI7-3 .c缸"、 "Ch巩s17-J-mixlure.dat ，. 、 " Ch叭517-

3-euler.dat " • 

(uu)一参见附带她 "Ch1\AVI\s 1 7-3.avi n•

一 、 模型建立

启动 GAMBIT，单击陌司陌司ß:f， 选择圃面生翩翩 Plane 为 ZX，输
入丰径 Radius 为 0.3 ， 单击 ，旦LJ按钮生成圆函，如圄 7-66 所示.

- Fi .8 
国·帽.，... li.，，.， 一主j

』 丘二J
叩「←

-"堕..J - -
回 ，... 生成的田面

2. 单击 face m，#-中的F按钮，在 Moy仙py Faces 面棋中选择圃函，保持
Move 植选中 ，在 Global 下的 x 担输入 1.8 . 单去 -二」接扭克A谊面的#

动棉作.

3 轴[if-~-商，在国 7-67 晰的 Revolve Faces 峭的 Faces t .i&.~oo 
1, Angle 担输入-90 ， Ax is 选择为 (0. O. 0 ) • (0 , 0 ， 门， 单击-旦旦-.J

按钮， 生且如国 7-68 所示的霄管主体

民协

F_ 1,..., .!J 

-E兰兰兰兰主
皿-一 -

" e 
囚，

r…) -, (1 . "η 

M 

"'" , … , ­
呻 I

,--- ~ 
... -里」一旦旦」

因，~，躯'帝面尘..，协商'晨 四 1-68 .，，，主体

4 下面创建霄营前后的 5m 1i.苦段，单击而 -f百 -f吉，在。目te Real 
Cylinder 1i;r品的 Height 栏输入 5，在 Radius l 栏输入 0.3，不用输入Radius2 ，

'
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即在示 Radius2 与 Radius l 同数值. 选择 Axis Location 为 Pos i t ive X , 

，堕立」按钮生成沿 x 方向的 5m 1i管段，如围 7-69 所示 .

单击

-帽-品伽副..... 战-， I! 7 

叩 E二 rf..Cl
M.211 1田峪
伽巾饵，现在古?一..!J

-0院由 主坐立二j

叫 H

|厂OfItIIIIY L!旦」一旦」
回7-69 阴位体生成面也反

5 同方法，民主 Axis Location 为 Posi tive Y 生成沿 y 方向的 5m 直营段. 此时的

视围窗口如圄 7-70 所示

6 下面需要将直营段移动豆豆确住直，执行 Volume 面拉中的 Move/Copy 命今，

选中沿 y轴的直营段，在 x 栏输入1.8，即向 x 轴丘向平~ 1. 8，单去一旦旦-.J
按钮. 然后，选中沿 x 轴的直营段，在 x 栏输入-5，在 y 担输入- 1.8，单去

，堕旦」接扭，最后的模型如圄 7-7 1 所示

lu.... 3 

的 ι吨, 
:;'T j 

oju....l 

剧7-70 绘制的直管段 阴7-71 生成的 3 个儿何体

7 下面需要将 3 个体合并且一个， 特 Volume 帆中的声制丘，弹出如固 7
72 所示的 Unite Real Volumes 面扭，选中生成的 3 个体，单击 "'" 挂也.

此时视固窗口中只剩下一个体，女，圄 7-73 所示.

也 0>ω4

一
, 

1..!J • 

J叫

L旦旦J_旦旦J-!!旦」
回，.，哩体合并面扳 圈7-73 旬"几何艘'自

• 



三、 网梅划分

....t. 1百呵Iti-1官， 制 Create Bound町问叫扭， 在国ges it @' l/t^ 
栏中选取钱 3 ， 视圄中诚战会出现一个虹色的箭头 ， 代，u-边界品生成的万

向 . 选中 1 : 1 的边J!-品生Jll，方式 ， 并设直第一个点距壁画距离为 0曲1m ， 递

增比例圄子为 1.2，边界屉为 4 品. 单击豆豆画二1接扭即蜡制克边界屉网品，

如固 7-74 所示. 此时显示的为三角形同格， 要等该面的面罔格生Jll，后才能看

到J且正的边J!-品同格.

2, ....t.r- - r百→I否， 打开 M出h Faces 翩，运用Quad 单元与 Pave 方法时
ii.圃a;进行划分，在 Interval size 担输入 0.05 ， 单击 .".， 接扭， 生成的面

网格如围 7-75 所示.

- ，、
• 叮叮

4 

飞

/ 

回1.74 边界房问将划份 园 1-7S 划分"的四面陶幡

下面以该面为源面，生成整个体的体同格.

3. ....t.r--w -r亩， ~J!1 H川'edge 轨与 C∞阳方法对该圆面进行划
分，在 Interval size 担输入 0. 1 ，单击 - I接扭， 生成的体同格如固 7-76

所示.

4 同格划分奸后走义迫耳提型，本倒只茸要走且进出口边界，迫捧a; 4 

(臼ce的 作为进口 ， 定义其为 PRESSURE_INLET，命且为 m; 选择画 9

( f.四川作为出口，定义其为 PR臼SU阻:_OUTLET ， 命名为 out. 走义好的

边界是型如圄 7-77 所示.

5 执行 File→ Export..... Mesh 命令，输出二"模型同格立件 sl7-3 .msh .
~.军帽g酬LOO1LET

'" ' G,. .. n~ 

回1.76 划份好的体同幡 图，_n 边界，跑'且定义

四、 求解计算

l 启动 FLUENT 三'但单精度计算器，执行 File→R四d→C皿e 命令， 读λ划分

'
7

章

多
徊
浪
镇
里

213 



F
c
m
Z
」
『
液
体
分
析
及
仿
真

实
用
教
程

好的网格式件 "sI7.3 .msh" . 网格读入之后，执行 Grid-Check 命令，桂圭网

格的信息 ， 持最后一行出现"Done" 语句 .

2 执行 Grid_Scalc 命今，伴出 Scale Grid 对话框，本倒不需要重嘶定义网格

的尺寸 ， 从如圄 7-78 所示的对话柜中可"看:!:计算IH民的尺寸范圄 .

3 执行Define→Models→Solver 命令，弹出 Solvcr 对话柜，如圄 7-79 所示 ，

本制保持最认设置，直接单击一旦J按钮. 执行 Dcfine-Models→Viscous 命

令，弹出 明scous Model 时话柜，在 Model 迫项中选择 k-叩silon[2 呵叶，在 k­

cpsilon Model 边项下选择 Rcal izab le. 保留其他匪认设置，单击甲巴」按钮.

í3 

信.

S白，

信 防~...re8..d I 
r De...My 8.... I 

" .四
c .。

俨 ^"'.~"''''rlr比
俨A><1~VIßm."" 、呻1
" 30 

"协dIY f.......letIoIo 
(ò AlI..hotR 
r Rel......, 

c...elOtDph .. 

(ò c.n ll-G…. <,…M 
呵呵呵叩
俨 leHts.o-. C.. 8_~ 

叫「
「
「

U州 CMYIII.IeR

GrI~ W.. C，uld 阳F丁

旦旦旦旦旦到 」

0.",.1.. Extc耐
川同r一一问嗣同百­

VIIIIII [，叫 F I . ， v.....þj厂一一

boln "'" fiT""一- ...似闸1'-1一一一

" .... 白
" .... 拍来
r 1. '1" .1. 

即
由
m

Ehhm M
a
r 

.......，叫由

" ，啕幅"d"Yc~
r 1. .,. ..... I \II't.曲

二- 1 旦旦J .a豆!l - ~J!!副 主'!J

'自7.78 S铺峙。rid 对话"医 回1.79 Sol~ef对罐罐

4 执行 Define→Models→Vis回国命令， 体出Vis∞us Model 时话框，在 Model

迫项中选择 k.epsi lon [2 eqn] . 在 k.epsilon Model i阜项下选择 Rcalizable. 保留

其他默认诅直， 单击-立」按钮-

5 执行 Dcfine→Models→Multiphase 命令，在得出的 Multiphase Model 对话枢
中克选择 Mixture . Multiph国eM咀el 对话握自动展开，保持默认事数设置，

如围 7-80 所示，单击一旦业安钮，关闭该时话艳

国幽幽幽圃蛐国……画
翩翩4 阳阳.向..u

吃 M l'一一一封
「 刷刷c "， f luW 
画 画画画
俨 .翩翩

俨 w.，

lIIb<IU<C _dc .. 
「 崎h叫

.制~，.四，-­

「叩时h

-丘J 五里H 主U
阁τ" 多相穗'震型设置

6 执行Define→Materia l s 命令，单击 Materials 对话柜右侧的

A，酬。"…eF--按钮，在弹出的 Fluent Database Mat cria l s 时话柜中，利用



埠动条选择 Fluent Fluid Materials 列在中的 water-Iiquid . 单击二旦旦按钮， 再

执'"列在中的 fuel-oil-liquid . 单金正主L接扭，即梓欲据感中的材料---水和

油都持且到当前工程中.且在岔五旦旦接钮关闸该对话植.回到 Materials 对话

框， 即会提现在 Fluent Fluid Materials 下拉列在中存在了宜气. 水和油 3 种材

料. 最后-'f击 Materials 时话柜中的主旦旦按钮，克成材料物性的定义

7 τ步走义基本相和第二相. 与前面制于一样， 执行Define_Ph固自命令，在

Phase 列在中选择 ph剧。1.在 Type 选项中选择 pnma可 ph四e ，然后单击

J坦性钮， 在打开对话扭曲 Phase Material 列在中选择 fuel-oi l - Iiquid . 并在
Name 立本柜中输入。iI代替原来的 phase- I ，单击-旦Jl<<s. . 在 Ph...，列在中

选择 ph缸。2，在 Type 选项中选择 secon血可 ph田e ， 单击」旦按钮， 在打开

时话桂的 Phase Material 列在中选择 water-liquid . 并在 Name 丈本柜中输入

water 代替原来的 ph蹈。2 ， 单击一旦J接扭-

8. 执行Define→Units 命令， 弹出女回国 7-81 所示的 Sct Unit5时话框 ， 选择
Qu四川u目中的 p"田S町e，在 Uni臼可以看到目前工程中是于压强的单位. 单击

"阻陆委钮，在弹出的女，圈 7-82 所示的 Define Unit 对话枢中的 Unil 栏输入阜

#: mpa. 在 Factor 担输入 1∞0000 ， 单击~按钮 ， 定义且强的新单位

MPa. 

.， 旦旦到

一!!-l
.，旦旦j

-"'-.l 
恤et l ' 一

'圆圆圈'回
陆7陆「
L加. "". 
F一- 1'一-

~ !c._到~

、，

旦"，j止旦」 旦旦J .-!!旦」
回1-8 1 单位设'对语幅 图τ" 篝单位提置

9 执行 Define→Operating Conditions 命令， 打开Operating Conditions 对话拒.

如困 7-83 所示 ， 选中 Gravity ， 指定重力方向为 z 轴， 在 Z[mfs2)右侧输入

9.8 ， 单击"" 且会Ù.
I I 0 ,..., .! ，旷 l 川 t响限E
肉c.....c 户勘W

. ...呐~自驴旦旦叫
G,…… 
X ，""司 ~

YÞOOMI fi 
Z ....,.z) I-u 

X""" [i 
V"",, [i 
z t-I [i 'M幽幽.....勘向翩翩-

r s院喇eOI ~c，嗣同。....1Iy

~J!3止U
侧7-83 1I作环绕设置
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10. .t盛看走且边界串件，执行 Define→Boundary Conditions...命令，伴tI:: Boundary 

Conditions 时话框，在1如下 .

· 在左边的Zone 栏选中 m，保持 Phase 为 mlXture，单击」EJ挂钮.在回7-84
所示的 Pressure Inlet 对话框中的 Gauge Total Pressure[mpa] 中输入 1， 在

Super四nicllntital Gauge Pressure[mpa]中输入。 9995，选择 Spe<:îfic8tion Method 

的下拉列囊中的 Intensity and Hydraulic Oiameter ， 在 Turbulent lntens ity[%] 中

输入 1 ，在 Hydraulic Diameter[m]中输入 0.6 ， 保持其他默认世置， 单击一旦J

蜻钮.

Q z-._ 
fi'一

阳ø，

I.bt..-t 

W-e_ l ne叫 I RadI.....1 s.巾 1 ..... 1 抽嘟"叫剧

"咱T~ Pre..嗣同叫「一一一-1....- 丁

Swper..nldl 川Mle Pre..y,e (mp.' fï.'r一 1....- 丁

~.巾阴阳dleMloft时叫._-旬 a.......ry .:.J 

Y由I.ft""

加"'.....嗣"阳"曲时怕-~阳"帽 .:J

M喇阳."同「一一一一

响曲"…，..，阿

~画画」旦J
因，." 酌~皿哩，.'"对话报

• 压力入口的第二相(水)的比例且为 0.2，故回到 Bound町Conditions 对话框

中选择 Phase 为 water. 单击」坠ι按钮，在固 7-85 所示对话框的 Multiphase

中的 Volume Fraction 栏输λ 0.2，单击…旦且安钮.
及 E

h阳 M

1'" P否
阳呻翩叫1 ""跚叫副 1 '"曲巾"叫1问s匈'

v"…m衍由由" 1'萨.， 一一一 1....二百百一一丁 | 

~~里l -'!旦U
因7.8~ 压力入口水的体似分戴定义

· 在左边的Zone 栏选中。ut ，保持 Phase 为 mDtture . 单击1且~按钮，在图 7-

86 所幸的 Pressure Outlet 时话框中的 Gauge Pressure[mpa]中输入 0.9992，同样
选择 严cificalion Method 的下拉列章中的 Intens呵阻d Hydraulic Diameter，在
Turbulent lntensity[%]中输λ 1， 在 Hydraulic Diameter (m1中输入 0.6 ， 保持其

他默认世置，单i!;~按钮.

11 执行 Solve司 Control- Solution 命令，弹出 Solution Controls 对话植，保持lR

认设置，如圄 7.87 所示 ， 单去一旦」按钮.
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12 接下来，对流场进行朝她化 ， 执行 Solve -0 lnitialize -0 I nitialize 命令，在

Solution In itialization 对话柜中选# 田，时进口相始化，蝠序单击~
旦旦J. 旦旦巳棚，如圄 7-88附.
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4
寸
1
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丘

G.申阳"嗣同-IfU陌..

x<，叫叫 11 . ..，'百

YV....拘...."一­
Z'h叫叫·

J嗣 ， "旦旦旦l 王旦旦L."主j
筒7-88 钢筋化
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口相始化后，执行 Solve → Monitors → Residual..命令 ， 在伴出的 Residual

Monitors 时话柜中选中 P1时， 打开且呈曲战国 . FLUENT 默认各事业的收姐柑

庄要卓为 0.00 1 ，本制保持默认，单去-旦J柱扭-
H 串成..t.过步骤的议直后，执行 File..... Write→ Cas. 命令，将工程1件保存为

s17-3 四S .

15 执行 Solve..... Iterate 命今.吐直迭代步为 1∞0 步 . 单击卫er.te 接缸开始解

算.

16 待追代克毕后，执行 File → Write → Data 命令，悻存结果主件 sI7-3-

mixture.dat 

11. Too截取有助分析的几个战函 ， 执行 Surface → Plane 命令，在 Points 下方的

三点坐标中分别输入 (.2.5 ， 0 ， 川、 (-2.5， 0 , 0.3)和 ( -2.5， 0.3 ， 0)，在

New Surface Name 中输入 x=.2.5. 单击 c.旦」按钮， 生A第一个戴面. 其他

截面的生成方法提饵，只肯定义在枉法然面的 3 个点的坐标即可，如圈 1-89

所示.

句…·
「 础.-~....s..t.a:
r .蝇.-~....w悔.网"幡
r PMOI MOII JMnaaI 
「…
「
「 阴阳，... 

坷' 1'一丑
情 「一封

里旦旦旦~

问 N.., 

自一带一带-rL­
p且-FL-P严一|严­

F且-t乒- F且一作L一

-""""­F.-r . 5 一一一

生旦」 旦旦旦斗一旦旦J ... 
阁下89 ，阳恕 s..r.泪对话罐

依次生成回 1-白中的儿，1'戴丽之后，再定义一个横剖面.

18 执行 Dωplay ..... Contours 命令，选取 Contours of 为p，.田sW"e 和 Static

Pressure . 保持 Phase 为 mixture ， 句i& Options 栏中的 Fi11ed 迫项，选择

S町races 列在中的 x--2 .5 . x斗、 x-p . y啡、 y'2.S 及础，单击应豆豆1按钮按
钮刷掉出如围 1-90 所示的且强云围. 政主 Contours of为 Velocity 和 V.1田IIy

Magni阳d.，员l 显示为速度云围，如圄 1-9 1 所示.

19. T 00 改史 ß 相流模型为欧拉模型，在 Multiphase Model 对话柜中选择

Eulerian . 单击-巳如扭，如圄 1-92 所示.
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再次初始化，执行 Solve - Initialize - ln itialize 命令，在 Solution lnitialization 

时话柜中选择肌蝠J!-"" ,t, -'!!'.J .旦旦j. 旦旦旦制.
执行 Solve - Iterate 命令，设置追代步为 10∞步 ， 单击丘... 接钮开始解

算. 追代结束后，结果保将为 s17.3-euler.dat .

执行 Display - Contours 命令，其且强云固与追庄云圄金，圄 7-93 和圄 7-94 所

示.

欧徨模型设置回7-92

20 

21 

22. 

n J 叩 ，----"二?警 E
曲

' E 

E -m 
m 

m 
m -m .­m 
m 
m 

u. 
m 

‘· 
‘­m -

欧组惯型计算出的温a去翻

通过图 7-90 与阁下93，图 7-9 1 与圄 7-94 的比较可见， 棍告模型与欧拉模型计算得出

的抽水两相流哥营内的压强与速度分布基本相当 ， 没有明显的区别.

2 19 

回，.，‘瞅锺镇组计算出的原量去回回7-93



遣'段 混合模型和欧总模型都适用于乱动中分散相的体积分数超过 1"".的价够，本例的油水两相流动这拇

两个模型都;t合.

23 最后执行 File- Ex it 命今 ， 安全退出 FLUENT.

7.5 本章小结

本章主要讲述了多相流的概念、分类与 FLUENT 中的事相流模型且应用 ， 详细介绍了

VOF 模型、 混古模型与欧拉模型的使用范围与世置 ， 通过三个实例帮助读者了解利用

FLUENT 求解事相流问题的操作思路，熟悉求解事相流问题的过程. j句后续利用 FLUE町

解决实际工程中的!f-相流问题打下基础.

/t 
ψ/晕

> 相班的分提且应用 .

~ FLUENT 中的 VOF模型.混合模型和眈#模型 .
> 利用 FLUENT 解决 ~ia流问题的操作过程.
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转动模型

对于且在一物体运动或旋转时，我们可以采用坐标变换的方法来简化问题. 然而，当事个

物体之间存在相对旋转的时候，简单的转换盎寺坐标革已不能解诀问题，如涡轮置动机、 叶

轮机械中静子和转子的干扰问题等， 无论草么世置#母系 ， 都舍遇到固体边界随时间变化的

问题. 这类问题可以利用 FLUENT 中相关的转动模型来解决.

本章将详细介绍 FLUENT 中的动#毒草模型、滑移网格模型且动向格模型用于模拟移

动和变形区域的流体流动问题. 通过十字搅拌梅内流体梳动模拟且实体入水过程模拟两个例

于的讲解， 帮助读者熟恶利用 FLUENT 模拟移动和变形区域流动问题的革解过程.

• 动参考革模型.
• 滑替网格模型.
• 轴网格模型 .

• 转动模型的分析~例 .
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8 .1 动参考系模型

当计算区域中同时存在运动区域和1静止区域或者存在多个静止、可动区域时 . FLUENT 

可以采用功#毒草 ( M盯)模型、视台平面模型和滑动同格模型来解，草. 其中动盎寺革檀

型和混合平面模型可用于定常流动的计算，而 MRF 模型则是最简单的，因而也是最经济和

常用的模型.

8.1.1 动参考系模型概述

动#毒草模型是将不同旋转或移动速度的每个区域进行稳i!i近似， 因此当边界上流动巨

域几乎均匀混合时， 这种方法比较适直. 如转于和定于之间交互作用相对较弱的叶枪机械可

以使用 MRF 模型，叶轮片交互作用相对较萄且无大范围麟态.，响的混合樱也可以使用 M盯

模型. 但要精确模拟叶轮片的瞬态流场时， MRF 模型就无能为力了，而可以草助于滑动罔

棉法.

MRF 模型的整个计算区域被分成多个小的于域，每个于域有各自的运动方式，或静止

或旋转或平移. 控制万程在每个于域内分别进行束麟， 在于域的交界面上则通过速度换算且

绝对速度的形式进行各于域流场信息的交换. 如果交界面上的网格是正如l的，即两侧区域在

交界面上共用相同的同格节点 ， 其网格划分方法与常规方法一样. 如巢交界面上的网格是非

正则的，即交界面两侧区域网格不一样且交界面是理合的两个面，分别属于不同的区域，边

时交界面上的信且是通过插值相互传递的.

8 . 1 .2 动参考系模型的设置

运用 MRF 模型时需要进行如下设置.

· 使用压力基卓解器时，在 So\ver 求解器对话框中世置速度的形式，如圈 也l 所

示，选择是相对速度( Relative )还是绝时速度( Absolute )，使用密度基卓解

器时只能用绝对速度.
很 l
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· 在边界是且时，时于擅体( Fluid ) ([域!Ii.固体( Sol;d ) I!辙，世置相应的~

转轴罩点和旋转方向 . 在运动提型( Motion Type ) 列囊中选择运动参考革
( Moving Reference Frame )，并设置旋转速度 ( Rotational Vel国町}量平移速

度( Translational Vel田町 ).如固 8-2 所示 .
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四，.， 区粮运动设置【础"每系〉

定义壁面运动方式及其速度，在 Wal1 对话框的 Momentum 中选择 Moving

Wall ， 设置壁面运动方式是革特.平静卓眈旋转又平静，且)Vl旋转和平槽的

速度，如固 8-3 所示.
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8.2 滑移网格模型

滑移网将是在 MRF 和混合平面法基础上发展起来的，可以描述计算区域的运动. 如毒

草、转于运动、风机运动等都可以用滑移罔格法进行计算.

8.2.1 滑移网格模型概述

滑移网格模型可以处理非定常问题，这是它与 MRF 模型的报大区别. 该模型在两个量

更多的单元区域应用滑移网格技术，每个单元区域至少有一个边界的分界面，该分界面区植

和另一单元区域相邻， 相邻的单元区域的分界面互相联军形成"网格分界面飞这两个单元

区域E相之间相对沿同格分界面移动. 在计算过程中，单元区域捕网格分界面相互之间滑

动，而两个区域的网格不合发生变化.

滑移网格模型允许相邻同格之间相对滑动，因而网格丽不需要在分界面上排列，对于晴

移网路关键是计算流进每个网格分界面的两个非一致的分界面区域.

消移网格技术中设定的交鼻而在计算过程中一部分与相邻于域相埠，而其余区棋不与相

邻于域相连. 与相邻于域相连接的区域被称为内部区域，与相邻于域不相连的区域在平动问

题中被称为壁面区域，而在周期性流动问题中则被称为周期区域. 当每次选代结束后 ， 解算

器生重新计算内部区域的范围 ， 将交界面的其余部分划定为壁面区域或周期性区域，井在堕

面区域或周期性区域上世定相应的边界条件. 在新的选代步上，只计算内部区域上的通量.

如圈 8-4所示， 卦界面区域由 A.B 面和 B.C 面以及 D.E 面和 E.f 丽组成，交叉处产生

a.d 面 、 d.b 面、 b.e 丽和 e.c 面等. 在两个单元区域重叠处产生 d.b 面、 b.e 面和 e-c 面而组

成内部区域，剩余的 a.d 面和 c.f面形成成对的周期性区域.
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8.2 . 2 滑移网格模型的设置

运用滑移网格模型时需要进行如下设置.

· 计算非是常时，童话非是常设置，即在 So\ver 时语框中世置 Tìme 为

Unsteady. 

• 在边界牵件ìU.对话框中 ， 世置班体或团体E峨的事动，在运动提型( Motion 

Typ<已 }列章中选择滑事网格 ( Moving Mesh ). 并设置旋转速度( Rotational 

Velocity )卓平移速度( Translational Velocity ).如图 8-5 所示.

阳川剧I叶M-- 3 主主斗

第
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圃 8.' 区螺运动设置 《槽移向幡〉

• 定义壁面运动方式及其速度， 与动参考革模型设置一样.

• 与动#考~平同的是滑事网串串模型需要定义分界面，执行 Define → Grid

lnterfaces 命-t.弹出如回 M所示的 Grid lnterfaces 对话框. 在 Grid Interfac臼

输入栏中输入分界面的名称，在 lnterface Zone 1 和 lnterfa四Zone 2 列章中在

选择-个组成网格分界面的商分界面E绒，在序无关 . Interface Type 下方有

Periodic (周期性)与Coupled (辆合)的塑造框，若为周期性问题即选择
Periodic . 若分界面位于固体和施体E绒，则选择 Coupled . 最后单击」旦旦」

按钮，建立新的网格分界面 .
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8.3动网格模型

动网路模型用于模拟由于流域边界运动引起流域形状随时间变化的流动情况. 流动既可

以是明确的运动〈如具有明确的线速度或角速度) ， 也可以是未知的运动

件重心的战速度或角速度是由流城中固体上的受力平衡得出的) ，

当前时间步的计算结果确定的.

动网格模型用于计算运动边界问题，以且边界或流域内某个物体的移动问题.

前要先定义体网格的初始状态，在边界发生运动或变形后 ， 其流域的网

FLUENT 内部自动完成的 ， 而边界的形变和运动过程可以用边鼻型函搬来定义 ，

UDF 函数来定义. 动网格模型求解的是非定常问题， 需要消耗较大的硬件暨源.

动同格模型可以求解刚性运动、转动或者平动问题， 如汽车发动机

动 ， 注射辑中的话器运动， I!L嚣的副翼、襟翼在飞行过程中的运动带:还可以

形变的问题， 如气球充气的过程、飞行器的气动弹性问题等 FLUENT 提供的六自

网格模型束解辑可以定义和描述边界或运动物体的运动状况， 可用于解决事体分离过程.

FLUENT 提供了 3 种动网格运动的方法来更新变形区域内的悻网格，

法、动态层技术和用部网格重构法.

弹性光顾法是根据边界节点上的己知位移来光滑调整流域内节点的位置.

节点之间的连线被理想化成互相连接的弹簧. 边界上任意一个网格节点

相互连接的弹簧中产生弹性力 ， 进而导致临近同格节点上的力的平衡被打破，

上的位移就通过体罔格在流域中传播过去. 经过反复迭代，

平衡时， 就可以得到-个变形后的、新的同格罩统.

对于六面体网格、模形网格等， 动态层技术可以根据与运动的物面邻近的

来决定增加或减小网格的层数. 它在边界上假定 个优化的网格层高度 ， 在边界移动、

时， 如果邻近边界的一层网格的高度大于优化高度 定比例时， 就在边界面与相邻

间增加一层网格. 若邻近边界的一层网格的高度小于优化高度 定比例时，

一层的同格删除. 动态层技术就是通过这种方法来保持边界附近的同幡保持一定的密度.

当边界位感栩如I用部lji元尺寸校大时，单元质量将恶化或单元将温化，从而且轴下­

间步的求解收敛困难. 为了避免这个问题，把质量萃的网格单元进行重新划分，

同格lIi;构法 . 时于单元尺寸小于指定单元尺寸的最4 值，或大于指定且在元尺寸的最大值.

畸变度大于最大畸变度时，需要进行重新划分. 除了体网格重构抖，

或线性面也将随同体网格一起重构.

除了具有上述 3 种更新变形区域内体网格方法的动网格模型技术之外 ， FLUENT 

供了六自由tJI' (6 OOFl束解辘 . 6 00F 可以根据作用在流场中某个物体上的重力、

力或其他力、力矩来计算物体的位置和委主. 6 ∞F 

糯告、事体分离的实际工程问题.

8.3.1 动网格模型概述



8.3.2 动网格模型的设置

在 FLUENT 中进行动网格计算时，需要激活动网格计算模块，井进行相应的世置， 其

相关世置如下.

· 执行 Define - Dynamic Mesh司 Parameters 命令，算出如回 8-7 所示的 Oynamic

Mesh Parameters 时语框，句选 Dynamic Mesh 造项，对话框自动展开，如固$

8 所示.
度 |_. 

9 届圣画亘豆豆s
r _伽禽，

r 
「 阳晒_.

wc...._曲

0_蜘-
r L~""， 
r Rc..calll啕

h刷刷啕 1 ..，.崎 l 伺脏"曲同 1 0.0份由 I Ibc DOI' _.1 
S,.IOOt C--F-r一一

B叫町盹阳-1'一---

，-咖lICe T..c fMlOO r.I'c. ~;;;---
h川k.由叫r一封

~五-'l~
回1-7 Dyll&lt\ic Mesh Par田-霄，对精穗 图8-8 Dynamic Mesh Par田.-对话偌

• 固 8-8 所示对话框的 Models 选项组内有 Dynamic Mesh (动网格讥 In-Cylinder

(活.内腔). Six DOF Solver (大自由庄}等造项，对于活嚣腔内的桂复运

动，需要选择 ln-Cylind创造咂，其4惊世世置对话框如回 8-9 所章，主要iR:I幽

柄抽、曲柄轴起始角度.曲柄周期.活塞冲程等李敬. 对于如自由落体尊六自

由度问题，曹要选择 S ix OOF Solver 造项 目 其...世置对话框如回 8-10 所

示，主要设置重力加速度方向.
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阳阳"旧叫川…，.川川.，巾山Suoh [叫r一-

COllft叫1 Rod l.e响{叫r一一
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日 I
Modell 
'" Dynlmio; Mn h 
r ，仲C明inder
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嗣
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回8-10 六自囱度"由设置

• 固 8-8 所示对话框的 Mesh Methods 选理组中有 Smoothing (弹性同格先顺更

新)、 Layering (动在层网格更新)、 Rom田hing ( 局部网格重构)等选明 选

择 Sm∞thing 时，网格先顺参<<1主要包括弹性常教因于、边界节点桔弛.收敢

告是 进代教等. 选择 Layering 时， Options 选项中有带数高度和市曼史变化率
两个选项，常撤离度用于统一层高度的惜现，而带散变化率用于有弯曲的 E

墙，如固 8. 11 所示 . Split Factor 为分裂因于. 0.4表示网格高度超过理想高度

1.4 倍时宜生分盟 Collapse Factor 为合井因于， 0.04 表示压缩到理想高度的

0.04 倍时与邻近单元层告井 . 选择 Remeshing 时. Options 造项中有尺寸函

数、品jjj 改善扭曲、面重划分(仅只才三雄 ) 3 个选啊，其中，最小长庄、最大

长度比例且最大单元扭曲 a'jjj世定，而当革用尺寸函盘时，还需要设置尺寸面

世求解、尺寸函散的变化率等参踵，如固 8- 12 所幸 .

叹 I
Model. 
P Dynomll; Mu h 
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s_曲.. ...，.巾I I Rem时间 I 1!t'CyIlnlllc' I 51>< DOF 5olYe' I 
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Colllple Fld叩7百一一

o. 旦旦~~旦j

阁8.11 动态层彼术"配设置
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• 动边界的运动方式可以最用动边界文件( Profi1 e ) 和自定义面世 (UDF ) 来~
现. 其中，动边界文件只需在记事本中挂固定格式编写后导入 FLUENT 中 即

可 . UDF 主要有 3 个辈辈世置动网梧的运动，即 DEFINE CG MOTION 、

DEFINE GEOM 和 DEFINE GRl D MOTION，辑写好的 UDF 编译成功后导入

FLUENT 即可实现所需运动.

【实悟。 8-1 J 十字搅拌揭内流体流动模拟

在工程实际中，经常涉且到搅拌的问题. 那么经过搅拌后容器内流体的流动情况如何，

担梓速度世置为多少才能达到我们预期的效果，这些都是工程中所面临的实际问题. 下面珑

们H对十字搅拌器内的流体流动运用转动模型进行模拟，通过采用 MRF 模型与滑移网格模

型分别模拟以帮助读者熟串两种方法的求解过程与差异.

-、 ;l;例慨述

二维十字搅排器中间叶轮* h=9cm. 宽 1=2cm ， 搅拌桶中盛有水 ， 半径卢O.5m，搅拌

器以角速度 aT =5目d/s 运动 . 坐标草原点取为叶轮中心，模型简国如1回 8- 13 所示.
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思路分析

事例利用 MRF 模型与滑移网格模型两种方法进行模拟，建棋时可以将计算区域分解血
动区域与静区域两部分，故可设置 个稍大于十字搅拌器〈涵括搅拌器)的圆面作为动区

域，剩下的为静区域.

通过本主例的演示过程，读者将学习到

• 面域布华操作;
• 动静区域介质!Jt型定义，
• 转动模型边界条件设置，

• 史界面定义，
• MRF 模型，

• 滑略同格模型.

(u.... )一#见附带光盘 u Ch8\s18-1 .msh 飞" Ch8\s18- 1 .d旷、咄h剧81518陋叫8
"Ch8\、sl附8- 1 衍η"、 "Ch8、18-1-mrf.cas "、" Ch8'、18- 1-mrf.dat"、 "Ch8飞sl8-

l-sm.c缸"、 "Ch8\s18-1-sm.dat"• 
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(uu)-#见附带她 "Ch川、18- I.avi飞

二、模型建立

1 且去 GAMBIT 的卓ó1快捷方式，启动 GAMBIT.

2 首克建立十字搅拌器的模型，搅拌器可时看成是两个提部合并而且，矩形的

长应为 2树， 宽即为 1. 址单击fj"-陌→阵， 在机C削叫e Real R阳凹剧才叫叫叫'"皿叫叩n吨咱咿3咆耶耶g'肝u
Face 1i1担的 Wìdth 和 Height 栏分别输入 0.2 和 0.02，单击-.豆E二l按钮，再
输入 0.02 和 0.2，单击二豆豆...J按钮，生成女，国 8- 14 所示的主叉的两个提

彤，扭彤的中点与原点重合.
] 

G川
、

Ii:I .. \j x l 

L 
1118-14 十平交叉短形

3 将两个主M形合并为一个酬. Jpi.i- Face 制中的萨棚， 在弹出的叫
8- 1 5 所示的 Unj re faces li1址中i&取刚建好的两个提形函 ， 单击土豆盟主j按钮

将两个把形合并，如围也16 所示.



,- nlfOt;;;.，，---一- .!I.-
.". .阳、，叫

-旦旦...J - cτ- 叮
倒8.15 Un Î1e F_菌'眼 阁8-16 合并后的徊，字画面罐

4. T面创建搅拌刷科动制版界的两个回 . ...，，[百-W-f霄，制如
圄 8- 1 7 所示的 Create Real Circu\ar Face 画报，在 Radius 栏克输入 0.5.单击

-旦旦...J接扭. 再在 Radius 栏输入 0.12 . 单击-旦旦...J接扭，此时视圄窗口
的E示如围也 1 8 所示.

由 IQ.l ii' ③ @ 
~自..，..(i:言-， -.!I 
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111&. 17 Crute Re创 Circ:u抽 FK' 面扳 回1-18 圆形面罐的绘制 • 

1 接下阜成走进行面域的机操作. ..." Face 制中的w-剧，在弹出面扭的
靠一行 Face 中选取 fa四 4 (大田面战).在草二行 faces 中选取 face.5 ( . J 圃

ó1域).并接r Retain 接缸(保留小圃ó1域).如圄 8- 1 9 所示，单去-旦旦...J

按钮，在成布尔;t操作. 此时的图形富口与围 8- 1 8 一样，但是大圃ó1峰巳

坦植剪成-个圈耳丁 .

6 用十字搅拌器西域去咸小圆ó1域，同样在 Subtract Real Faces .fJ品的革-行

Face 中it.取 face.5 (小圆ó1域).在第二行 Face海中选取 face. l (十字槐拌器ó1

战).这里不肯接r Retain 接扭，单击 ，旦LJ接扭， 此时的儿何模型撞撞效

果如围 8-20 所示.

，国 1:;":" .!J 
」叫

… 『四 l}ac. 5 一一-~.-
."., ...... a-

图画 19 Subu富‘ Rnlf徽珑，菌'医 回'.20 几何领"菌"攘攘
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三、网格划卦

几何模型建立好后简要进行网格划分 ， 本例可以直撞对而域进行面网格划分.

1 特阿. -口'f - f否，打开 M田h Faces 帐，如围 8-2 1 附. 在 Faces <f' i& 
取圆环面11(. ( face 刑， 设直网格划分万式为 Quad 单元和 Map 法划分，选择

Spacing 下面的 Interval count，并在左恻输入 200 . 在 Proj Intervals (桂向划分

的间隔盘}右侧输入 50. 单击一旦旦Ll按钮，生成如固 8-22 所示的面网格.

|圄…H晶晶晶
』 |阳A 主j

… .. 酬y o.Iau~1 

… 
",. "~ 
白配 4苦斗2

………… 
必高@ 

￡结 是
-旦旦」一旦旦L旦旦」

因8.22 帽环画同协因ι" 困环画网将划分设置

2 接著 1 在 Mesh Faces Iii板的 Faces 中选取中间在征动区域的面J.&， ( face 川，如
围 8-23 所示运用的网格划分万式为 Quad 单元和 Pave 法划分，远择 Spacing
下面的 Interva l s ize . 并在在倒输入 0.005 . 单去 - 接扭， 生成如国 8-24

所示的面网格.

11--曲"四--1
阳n IÞC.s ..!.J 

相_: ...阳 卫旦旦

a.-: GI\I立~

Typo: p巳...:Ó.I
, 

甸回唱 . "均γ 旦旦旦U
IQoo:[ W旦旦..=..1

。，也_: . ""州
.J R...vI 刷刷'向

.J ~..，，" 二 ""，"""...价
」 咆附. li.. u.;ton. 

- - -.旦旦」
剧8.2) 动区域面倒恪划分设置 剧也" 动区域面阙榕

3 轴r-.;--r-.在 $peci巾 Bound町乃pes 面时选择十字搅拌器的口串
边，将它们定义为 WALL 边-lI'.名#为 jbq-w. 然后选择圆耳与动区域主耳的



两条埠， 这里的两串址是重合在一起的 ， 可时通过医画且非非中键进行切栓，
将两条边都走义为 INTERFACE 边界，-&..分别为 Înterface-I 和 interface过，

如圄 8-25 所示.

4 计算E域分静区域与动E域. 单击r.-→陋， 在 Spec均 Continuum 乃pes if> 

扭中将if> 4 定义为 FLUID ， -&林为 Jmg . 将if> 5 也定义为 FLUID ， -&..为

dong，如围 8-26 所示.
m 

i峙唰

巾"
l吨.，

"'" h 

阳明'
阳啕

5 

阁8- 25 边界樊E目的定义

最后执行 File- Expon 吨 Mesh 命令，

罔8-26 区罐介'健典型定义

将同格输出为 sI 8- I .msh .

四 、 求解计算

1 启动 FLUENT 二然单柑庄计算器，执行 File→Read→C町命令，该入划分

峙的网格主件 "sI8- l.msh" • 

2 执行 Grid→Check 命令 ， 时间格址行桂制，成功桂删后窗口界函中最后一行出

现 "Oone" 语句 . 执行 Grid_Scale 命今， 在圄 8-27 所示的 Scale Grid 对话

握中世直计算E域的尺寸和单位制 . 由于本制模型在 GAMBIT 中是按 m 生Jl<，

的，故保持E认性直即可， 直樵单击王旦旦接扭是问 S国le Grid 时话框.

三lIIl二叫

…「
「川同阿「一一陆叫fiT一­

v.阳 1叫fI.S一-- y"'.,..... r-s一一

二ale I 旦旦!!J U豆丑 ...

回8-27 Scale G面对运棍

下而分 MRF 模型和滑移罔棉模型两种方法进行介绍.

MRF 模型计算

1 执行 Oefine→Models_Solver 命令，弹出如圄 8-28 所示的 Solver 对话框，

本制保持默认设直，单击~接扭.

由于水的密度和动力粘度分别为 998.2kg/m3 和 0，00 1 oo3kgl ( m 时，在 5radls 的 111速度
下，旋转水的宿诺数约 104，故需要启动泊流模型.

2 执行 Define→Models-Viscous 命令，绰出 ViSCOllS Model 时话框， 在 Model
边唱中选择 k-epsilon[2 eqn]，在 k-epsilon Model 这项7选择 Standard，保留其

他默认设直，如圄 8-29 所示 ， j在去~柱钮.
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事照前面介绍的方法. ;t;(. j，t动的材非卡一一水，克成材料物性的;t;(. .

7一步设置计算的耳境 . 执行 Define→Operatìng ConditÎons 命令，打开

Operaling Conditions 对话提. 本倒保持为耻认设直，单击一旦」接钮 .

执行Define→Boun也ry Conditions 命令，在妹出的如圈 8-30 所示的

Boundary Conditions 

3 

因8.3~ 埠'厚'民伶定义对话舷

· 在左边的 Zone 拦选中 JI吨，其 Type 为 fluid，单击」且J按钮， 打开如回 8-3 1
所幸的 Fluid 对话框 . 在对话框的 Material Name 下拉列章中选择 water.

liquid，单击-巳J按钮. 即设置静区域内的植体为水.

· 在左边的 Zone 拦选中 dong，其 Type 也为 f1uid，单击 8~.. 按钮.打开如回

8-32 所示的 Fluid 对话框. 在对话框的 Material Name 下拉列囊中同样选择

water-liquid. 与上面设置平同的是，这里曹要选择 Motion 中 Motion Type 为

Moving Reference Frame ，即启用 MRF 模型 ， 在 Rotational Veloc町的



Speed[nulls]栏输入 5，单击-坐J按钮. 即设置动区城内的施体j均水，且I!<

5rad/s 的角速度在旋转.

-­F百一--­「 阳--
「甲』r_,_ 

--
回~ "制』忡-­c__ 

C~_ 

r _T_ 

3王~旦旦

「阳叩w阳• 

嗣.腼"阳-~

血-牛 J

c _.阳.

陶h阳四h叫陆睛- 1…T.... I fb<t~V自， 1

_.酬陌石-，-一

…叫一…
岛-.. 制

3<" 
".... [1一一一­

v....r一一

阳"加陌- 一一一一丁 J

--".J 丘-I ....!旦」 -旦」 王-t ....!旦」
阻8.31 ..区攘攘体~. 1118-32 动i!iII穗体提置

· 在左边的 Zone 栏选中 jbq-w. 其 Type 为 wal1.单击 ...μ按钮，打开如回 8-

33 所幸的 Wal1 对话框. 在对话框的 Momentum 下选择 Wall Motion 中的

Moving Wall ，井选择 Motion 下方的 Relative to Adjacent Cell Zone 和

Rotational，保持 S阳d[nulls]和 Rotation-Axis 归gm 的 X[m] 、 V[m]为 0，单击

-坐J按钮，即定义十字搅拌11叶轮与邻近的区城一起I;J. Sradls 同步转动 .

掏国- I~I-I ..... I酬 1-阳， 1四 l-- 四

F…帽
.叫四 '….一… r

r … " 一呻
民间r一--­
V"'ji"一一一一一

:巳位.

阳一..… ,-­俨 - • 
,. "w. 
阳}国

_..陆刷"1'一一一一问- 一----:3

........._-[ï.T'"一-1 一一丁

一旦J c_ 1 二旦j

捆S.)) +事掘，字'壁画设置

6 暗T 定义旧上边耳之外，还要走且直界面. 执行 Define_Grid Interfaces 命

令， 弹出如圈也34 所示的Grid Interfa国S 时话艳，在Grid Interface 输入栏中

输入..t M- jiaojie . 在 Interface Zone 1 列在中选择 Înterface址 ，在 Interface Zone 

2 列在中选择 interfa国-2，单击 c.. 主」按钮创建立界面.
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因'.)4 交界面设置

7 下面时卓解事扯进行设直 . 执行 Solve -0 Control• Solution 命令，保持耻认设

直，如圈 也35 所示， j在去」巳』安钮.

巴士 f壳'
Pre..un:严「 寸

h由r I 
B呻h_.p一]

归田怀「 4
肉e..u.e-Ve l..，tly C.""'''I 

I s "，Pl.f 一丁
Dbadiz.tien 

JIIoc"u"'p叫"
..... _-"阿雨，旧"

Turt.ltIc.... KlnIt1lc EH咽际市Z百....

M创ent Dl..i，巾"' 1"'"百司高高

J4 
「3
1
4可
d
「d
」

""旦旦J !c-I I ~坐」

罔8-35 求解，数设置

8. i集下来时 ，现场进行朝始化 . 执行 Solve -- In itialize ... Initialize 命令，在

Solution lnit ia lization 对话柜中选择 all-zones ，时会匹马战初始化， 顺序单击

」旦J、主E剧、 卫旦旦接扭.
9 相始他后，执行 Solve → Monitors → Residua ! 命今 ， 在妹出的 Residua l

Moni tors 时话握中选中 Plot . 打开战呈曲蝇困 . 对话'ßT方的 Criteria 中可"

输入.IH民数的收业柑庄要卓， FLUENT 默认为 0∞1，本制设为 0.0001，单击

-旦」接扭.
10 克咸丰~步糠的世直后， 执行 File→ Write- Case 命令， 将工程主件保存为

s18. I.mrf.cas. 

11 执行 Solve - lterate 命令， 过直选代步为 l仪泊，单金主:旦按钮开始衅耳.
12 计算Z后，执行 Display → Contours 命今，选择 Contours of 下#则在中的

Vel国''Y 和 Vorticity Magnitude ， 执行 Display -0 Vectors 命今，选取 Vectors



of 下万多，)在中的 Vel回町， 可U分别看到搅拌桶内与十字搅拌器周国的~.t追分

布， 如圄 8-36 王圄 8-39 所示.

Um町 川Ol.，.， '"' "咽 1

• 
•• .. 
•• •• 
M
U
"
"
四
"
"
"
"
"""···" 

囚州"""川 ""en' 1., r-;d ，'5<~ 
侧8-36 企区拔的罐速纱布去附

国

" 
国 J 

国

" 

动Z转 第
伽

" M 

" 国
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;⑥ 
" 

" " . ‘『、.. 
" " 8 
" 国

" " 
、、 意

国 国.. •• .. •• 
•• •• 
•• •• 
" • 
• ' 
" -

阁1-)8 全区蜡的植遗失量固 酣自-" 1.宇檀排'周田的植速.?<.A圃

13 . 执行 File- Write- Data. ..命今，悻存 sI8- 1 -mrf.dat .

滑移网格模型计算

阻8-)7 t一字愧，事'周峭的流选分布云阳

'"翩翩翩捆翩翩h……….rI!!J!到

利JB II'I格同格模型计算时， 可以卫艇在 sI 8-1-mrf.C田上进行悻改.

由于 滑 移网格模型卓解的是非走常问题， 所 队首 先 4九行

Dcfinc→Models→Solvcr 命今，将 Time 下方的 Steady 且为 Unsteady，如圈

8-40 所示，单去」ιJ按钮.

2 需要改变动区域的埠体定义， 执行 Define→Boundary Cond itions 命令， 在在

边的 Zone 栏选中 dong ， 单去i旦ι接扭， 打开如圄 8-4 1 所示的 Fluid 对话

把. 在时话柜的 Material Name 下且J')在中选择 watcr-liquid ， .i&.取 Motion 中

Motion Type 为 Moving Mcsh . 启用滑非同格模型，并且 Rotationa l Ve l回町 的

Sp时[mdJs]中输入 5 ， 单会 .. 

Jt他边界定义、交界面、草解#数的定义与 M盯 模型设置均相同 ， 这里平用lE!l世

置.
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阳.~， 动区域设置则8 钊基本习忧解..设置

3 接下来时流场再次初始 f巳 执行 Solve -0 Initialize → Initialize 命令，在

Solution Initia\ization 时话挂中选择 al1.zon田，时全ß~初始化，顺序单击

~、旦旦J. ~旦旦按钮.
4 完成土述步骤的设直后，执行 File- Write→ Cose 命令，将工程主件保存为

sI8-1-sffi .cas . 

5 执行 Solve →Iterate 命令，设直时间步长 ( Time Step Size[s] ) 为 0. 1 ，时间步
(Number of Time St叩s) 为 500，并将 Iteration 下方的 Max Iterations per Time 

SI叩改为 40 . 如国 8-42 所示，单去旦旦旦按钮开始解耳.
二

,.. 1... !Ilzo fOI F一一

…, ,,-r-. 50<,. ~丑
11.... so."崎悔-
， ~巾, 
。....

r _.叫……

-~血·阳-......~量

~.....-咽F一呈
阳_...".....…r- 1I

生:到 全创旦到 旦旦J

因.~， 法代设置

洼章。 FLUENT 默认的 Max Iterations per Time St叩为 20，这里符其改为 40 是为了保证每个迭代步的收集

性.

6 与 MRF 模型计耳克后的后处理一样，执行 。1叩I，y → Contours 命令，选择

Contours of 下拉列在中的 Velocity 和 Velocity Magnitude，执行 Display 吨

Vectors...~今，选取 、ectoTs of 下方，'1在中的 Veloc町，分别查看搅拌桶内与
十字搅拌器周围的流速分布，如固 8-43 豆国 8-46 所示.
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7 后处理克后，将清移同格模型的计算结果保存，且行 Fìle -咱 Write - Data..... 

令，保存为 sI8- 1 -sm.dat .

8 最后执府 File- Exit 命令，安全退出 FLUENT.

【实伊IJ 8.2> 实体入水过程模拟

在日常生活与工程中 ， 经常遇到实体入水的问题. 例如，跳水运动员以一定速度λ水 ，

草样才能使得入水时水面溅翅的水花段小?这也是运动员比赛成绩好坏的关键之 . 下而我

们利用动罔格模型来模拟实体入水的过程.

一、 在例概述

如图 8-47 所示 . iII-li:为 O.4m 的一个等边三角形实体，初始时刻为静止放置， 突然以

ω· 角向在下万运动 ， 在 0. 1 ， 内实体加速到 2∞m1，. 之后为匀速运动.下万计算区域的点

挥为 5m. 直为 10m .

思路分析

本例果用动同棉模型 ， 等边三角形实体周围的网格要监生不断的变化，遮模时需要在实

体外国画-层近似边界层的同格区域跟随重体一起运动. 根据问题的实际情况， 本倒应该采

用动同格模型中的 Sm回thing 和 Remeshing . 除果用动同格模型外，还需用到事相流中的

VOF模型.
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当T 空气, 
、3m 、
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水

10m 

院8-47 3在体入水问题筒阳

通过本实例的演示过程，读者将学习到·

• 等边三角形的蛙制，

• 边界型函数的定义与使用，
• 动网格模型，

• Smooth ing 世置;

• Remeshing 设置;

• 用格预览，
• 动画世置与回放 • 

哑u)一#见附带光盘咄剧8-2.msh" 、 咄比18-2.dbs"、咱8\s 18-2.jou 飞
" Ch8、18-2.tm"、" Ch8、sI8-2.cas" 、" Ch8、18-2.dat" 、 "Ch8、dong.lXt ..、

"Ch8飞dm.gi f"• 

哑E一#觑见附附带先蛐盘"吃'Ch川川I叩151

一、模型建立

1. ;f, i/J GAMB IT，首克建立等边三角形. 单去~ -fEi -I!C ， 在 Create Real 

Vertex tfJ板的 x 、 y ‘ z 坐标输入栏中输入忡， 0 , 0 )，单去 ....， I接扭生A

草一个点，接同样方法建立点 (0.4， 0 ， 0) 然后H~-rt仁F，在
Create Straight Edge liJ板中选择点 I (Vert ix.l) 与占 2 (Vertix.2)，连接迫雨点

生成战段，如围 8-48 所示.



• 

" 
机 】

因8-48 ~贼的第一条缝段

2 单击 Edge 面是时的f?l ( Move/Copy Edges ) 接扭，弹出如固 8-49 所示的.，

板，选择线段 \，单击王E旦接扭，并选择 Operation 为 Rotate . 在 Angle 栏输

入 60 ， 默认 (0 ， 0 , 0) - (0 , 0，门，单去一旦堕二」按钮.

一申丘二~~石7一 主l.- .-lt 
剑"帽饵"
'" TrOl'lIUrM .. 协 同。缸*

、，叫 .., Sc... 
叩阿
相 问

，阳时.....­

..队的 (CI. •• 1) 

J国，-­
V蛐叩…

J崎，-."..

「-旦旦...J-""，二」
阿8_49 Mov~/C呵'y E地，，~面扳

3 赴特草制生成的第二条战段，如围 8-50 所示 ， 剩下的一串战段只需连接右恻

雨点即可-

4 单击!百司1百→阳一， 在 Creale Face from Wireframe 面板忖i用匾坠鼠标左
键桓边等过三角形的 3 牵边.然后单击-'!堕LJ挂扭创建函，此时的等边三

角形如围 8-51 所示 .

6引

J • 
回8-50 旋转生成第二条线 1118-Sl 建立的吨边三角形

5 三角形面域所在的位直并不时，首先需将其旋转 2 10' . 单击 Face li1板中的

~ ( Move/臼py Edges) 按妞，在 Move/Copy 臼g四面扭中，选择面 l
( face. 1 )，单去 Move 并选择 Operation 为 Rotate. 在 Angle 栏输入 21 0 ， ~i人

( 0 , 0 , 0 ) → (0 ， 0 ， 1 )，单击 - 按钮. 其次，需要将三角形乎移，

在 Move/Copy Edges 00辑中，选择Iil 1 ( face. l )，单击 Move 并选择 Operation

[
转
动
b
L
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为 Translate，在 x 与 y 栏分别输入 3 和 8 .4，单击-旦旦---1按钮克成平#操

作 . 此时的等且国窗口如困 8-52 所示.

6 τ函生成整个计算E峰的时 ， if- "， [百『陌-["1 ， 在国 8-53 阳的
Create Real Rectangular Face 面板的 Width 和 Height 栏分别输入 10 和 1 0 ， 并

选择 Direc t ion 为 +X+Y (在示H 坐标;r，.点为提彤在左下角进行蜡舍I )，单去

- 按钮，生成的矩形如圄 8-54 所示.

<1 

21 F 口1" d 

[; .. 

恤由. ，.，..自~.， 1 ..!.l 

h阳E王三3
叫 b 一

-旦旦J一旦旦.J -
阳也53 矩形生成设冒 因8-54 生成的矩形面

咀

l:. .. [j ~ 卢

因 8-52 旋转与移功后的三角形面罐

7 五此， 还需要给制包裹二角形的外国区域. 在国 8-55 所示的 Move/Copy Faces 

面扭中，选择.00 1 ( face.l ) ， 单击 Copy 按钮，并选择 Operation 为 S四怡 ， 世

直 Factor 为 1. 5 ， 其余为耻认设直， 单击 .堕LJ接扭， 生成一个社大丁的三

角形面域. 然后将i!个新生成的面战#动豆合适住直 ， 即在 Move/Copy Faces 

面板中 1 选择.00 3 ( facc_3). 单去 Move 并选择 Operation 为 Translate . 在 x 与

y 栏分别输入 1 .45 和 4. )， 且在去~堕LJ接扭，此时的两个三角形住直如图 8

56 所示.

户一~且iIIII:O:O.l&A二ι一一一|
，由主~萨"一- .!J

" ...... • co,y F""一一

。四"阁"
、， rran师 、，阳

、， 阳111<1 • Sul. 

f-= ",," fTr' 
~甸阳 在市「一 旦I

W 二旦旦-=ól

J阳阳抽血

J阳-一
"_.嗣."..

-""" 1-旦旦J_旦旦J
因，-，币 三角形放大复制 1118-56 两个三角形阴阳置

8 轴 Fa叫树的F棚，在固 8-57 肝的 Subtrace Real Faces 帆的第一
行 Face 中i!.取画 2 (大提市面)， 在单二行 Faces 中选取.i1 3 (放大的三角形



面)，并尊击下方的 Retain (即悻留<fJ 3) 桂钮呈虹色显示，单去 ，旦LJ按

扭，克成布尔lii.操作.豆豆章此时大三角形 3 杏边都含有重舍的边，需要单击

划，榈树合的战合并且一串.
9 下面利用户刷刷三角形时刷刷梢，然后单击~-陌-rJ]，将

两三角币 1司的宝"。处建立成 3 个梯形面埠，如圄 8-58 所示.

10 至此，大、小三仰面域都已不再耐，畔击~'"缸，选择函 1 ofo <fJ 3 , 

单去 ..... I按钮删除.剩下面 2 函 4 . 函 5 和面 6.

1-幽幽幽幽'F '" 
'K 

，国 IÞu :一一一一一主l

」时
1"=. .5 

… f_ ~ 

. .阳

主j s 

-",. __ c-

倒8-S7 面.. 睛却 础 11" 阳8.S& 越立 3 个..川巴西罐

二、 网幅划分

几何模型建立完后需要进行同格划分，本例在三角形外国加了一个区域用于模拟边界层

同格，且该区域要跟随三角形一起运动.

1 杭州~iJ:I&:l&，~<fJ叫们进行同格划分. 轴「百-[百-[歹，制
如圄 8-59 所示的 Mesh Edges iJ担. 在 Edges 中选取大二角略的 3 帚边，运用

lnterval size 划分方法 1 并在左侧输入 0.05，单击 - I按钮， 生成如圄 8-

60 所示的线网格.

'8·· 

a
n动
模
型

如~-r:酌'惜，、

』 忡' .. .!I 
' 同'由- "."...1 --
' 怕.-…-
曲_ .喃旦旦.... 阳.，-~... ...I

旦到 d阳明

由

r::口

'呵 ，响旦旦l
F可- 蛐呻嗣 :J

'回 '即
. 同-同，--圄
... _......酣-

阳 』

圈'叶'战陶幡划纱 帽.... 三角彤边的鲍肉"

2 酶后对连接两个三角彤的 3 ~各边进行划分，仍然在 Mesh Edges li1 ~民中进行相
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是操作. 如困 8-61 所示， 在 Edges 中选择两三角形顶占的 3 串连线， i!./t时

，豆章蝇-'-虹色骨头的指向，应均为大三角形顶点指向小二角形的顶点，若方

向相反可以通过鼠标中键进行更换. 选择克后设直 Ratio 为 0.9 ， ~;J. Interval 

count 的方式进行划分，并在左侧输入 10 ， f!p 划分为 10 个间陆，单击

--'!型LJ按钮生且这 3 串边的线网格，如围 8-62 所示.

3 刷刷刷刷仰后1 轴r.-- föï -~，打开 Mcsh Fac白面板，边
取这 3 个面，运用 Quad 单元与 M，p 方法时3桌面进行面罔格划分，保留其他

默认设直，单去 - 接扭即可，其间品生成如围 8-63 所示 .

甲 J."ll .!l 
W崎呻盹 旦旦到

~- 二旦斗
"‘翩……
四-咽' 崎例"旦旦j
'-主<......_ ... 1

旦旦 "-四
m 阿

「τ工立

呵'喃叫

jllf I ...!豆豆豆二l
问.-

"…白刷刷
J阴阳…

-2旦J - -
恻8-61 渐变搜网将划分设'世 附8-62 惭变统阿怖 刷8~3 梯形而峨划:J jti网幌

4 接下来对外围计算区域进行间格划分，首克时大担形区域的 4 4持边进行拽间

格划分，在 Edges 中选取提形的 4 串边，运用 lnterval size 划分方法，并在左

耐输入 O.!. 单击--'!堕LJ接扭，生成如圄 8-64 所示的线同格.

5 单去「百-föï- [亩，在 Mesh Faces 1iJ~ <f .i&.lf:t-ji函，运用 Tri 单元与 Pave
方法时项<iI进行面罔格划分，保留其他耻认设直 1 单击--'!旦二」柱扭即可，

其网格生成如围 8-65 所示.

4 4 

四8~' 矩形区域的面网将阳8.6< 矩形面的战网恪



至此完成7 4 个丽的网棉划分，下面定且边界与介质类型.

6. "，;J;~→[亩， 在 Speci市 Bound町 Types òj~刊小三角形的 3 制定义为
壁画边界 ( WALL ) ， 名非为 dong-w. 将提Jj ß.t.i，的阜.右、血 3 条边也走义

为壁画迫耳 ( WALL ) ， 名非为 w-w ， 将提形 E域的主~;t义为压力出口

( PRESSURE_OUTLET ) ， 且非为p-out ， 如圄 8-66 所示.

7 由于本制步及与三角形实体一起运动的0;域，故宫将其单推进行介盾典型定

义， H~-r-， 在 S阳市 Continuum T.阳 峭中将榈树(面M
0; 6 ) 走义为 FLUID，且非为 dong ， 将外国计算E域 [ 面 2 )也走义为

FLUID , ..t#为 budong. 如圄 8-67 所示.
m 2旦

阳咆
b叫

阳

伽喻咽

M 

.~ 

刷品，."提型定义 囱8-67 介E曾提姐姐:义

8 最后执行 Fi1e→ Expo同 -Mesh 命今，将同格输出为 sI8-2.msh

四 、 求解计算

l 启动 FLUENT 二锥单柑庄计算器，执行 File→Read→c.耐命今，埃入划分

好的网格文件 "sI8-2 . msh" . 网格墙人之后，执行 Grid→Check 命今， 检查网

格的仿息 ， 峙矗后一行出现"Done" 语句 .

2 执行 Grid→Scale 命今，弹出 Scale Grid 对话框， 由于在 GAMBIT 中是按照

m 为单位 I : 1 建立的几何模型 ， 本倒不需要重新定义同格的尺寸，单击王旦旦

按钮是闰该对话拯.

3. II时于 Define→Models→Solver 命令，弹出 Solver 对话桩， 选中 Time 下万的

Unsleady，启用非走常计算， 其余保持>>.认，学去一旦」柱扭

4 执行 Dcfjne→Models→Muhiphase 命令，在佯血的 Mult抽ase Model 时话扭

中选择 Volume of Fluid . Muhiphase Model 时话握自动展开. 保持默认#耻设

直， 如圈 8-68 所示，单击」巳J按钮，是间运对话握.

"'"幽幽幽 .
叩 ….. 

「一一- ~俨 。.

，川叫
俨 阳", ，翩翩
F 

阳阳_....

W抽回

'西-制
. ..伽'

e翩翩阳"

!US 一
「 阳.b_阳

时'恼，-­
r .......~f_ 

~ I!::型 -"".J
圃.... 启用 VOF 榄型
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5. ~民照前面介姐的万法，村牢←一-水，克成材料物性的定义.

6 接T""-，，"-义基本相和第二相. 执行 Define→Ph自由命令，在 Phase 列在中选

持 phase- I ，在 Type 选项目护选择 pnma可-phase . 然后单去二旦L拉扭，在打开

对话柜的 Phase Materi创刊在中选择 alf，并在 Name 立本框中输入..，代替原

来的 phase- I ，单击~iH.. 在 Phase 列在中选择 phase-2，在 Type 选项中
选择 secondary -ph田"单击二旦-按钮，在打开对话柜的 Phase Material 列在

中选择 water-l叩id，并在 Name 立本框中输入 water 代替原来的 phase-2，单

去~按钮.

7 相定义Z后设直操作环境. 执行 Define→Operating Conditions 命今，打开

Operating Conditions 时话柜如图 8-69 所示，边中 Gravity，指定重力万向为

y 轴，在 Y[mlû]右恻输入-9 .8 1 ，即重力方向指向庄都. 同时选择 Spec i ficd

Operating Density 选项，悻持 Operating Dens町[kg//m3]为 1.225，单击」巳』安
钮.

F耳;二;二"ιι------_!;ïI
肉e..w，c 。呻

" 0，叫
0，.，.巾..也cele..u，，"

Relu.,na: Prc" Ufe lecollen x (..v.21 JI 

' 1叫F百万「一一X同庐一一一­

'1叫旷一一一一
V.....ble-Oen.1\y Po,.me..,. 
~~J!ec匾豆豆..m画面画豆盖

瞎且盟皿丑

」】王aaul l ~

8 

1118~9 操作环蝙"置

接着定义边耳帝伶执行 Define→Boundary Cond itions 命令1 弹出 Boundary

Conditions 对话框. 这里只需在义 p-out (压力出口边耳)，且在击 8.1. .. 峙扭，

弹出如圄 8-70 所示的对话框，保持 Gauge Pressure[pasca l ]为 0，单击一旦』安
扭. 回到 Boundary Conditions 时话桩，选择 Phase 为 water . 再单去 S.t.. . 按

钮，在困 8-7 1 所示的 Pressure Out1el 时话挂中的 Backnow Volume Fraction 中

输入 0 ，

胃 E
Zn~ N.",. 
I，-..t 一

向...

j"bt..." 

刷刷刷'" ! n."，，"叫 Redl.tlo. 1 句Cdu J 0阳 | 抽刷阳oe I uos 
G.UIC ""'"UfC阳叫「一一一-- F石r一一丁

6~_0I叫叫.dflc....n t.letIo..d ~;;;川'叫脚 i 

~ ç.."，丑 -""'!..J

因8.10 肌刀川口就重



• .川? -
叫
阿胁"刷-， '阳 ...... I R...由 I S,.cIn 1 OPM 陶阳0" ! UOS I 

e-抽_f'-re一一一-1-'- 丁|

~臣旦主U
剧8-71 lih ll:l口东西蜒的体权纱It ii.

上述步骤世置完后，到了本例的关键一步，即动网格模型的定义.

9 执行 Define - Oynamic Mesh 叫 Parameters 命令 . 在弹出的 Dynamic Mesh 

Parameters 对话植中句追 DynamÎc Mesh 追项，对话植自动展开如围 8-72 所

示. 在 Sm∞thing 边项卡输入困亲事数，然后在 Remeshing Jt项寺的 Options

栏中选捺 S ize FunctÎon 和 Must Lmprove Skewness，其在数i.l:I如圄 8-73 所

示，单击一巳」接扭.
罔|
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10 由于本制适用边界型函欲来控制实体的i是动，仗打开一个主台记事本又件 ，

输入女，国 8-74 所示的情息，并保存又件为 dong.txt .

1 1 执行 Define_Profi1es 命今，弹出如圄 8-75 所示的 Boundary Profiles 时话框，

单击 Ru"-. f接扭，找到书写好的 dong.tx t 主件，读λ后时话框会自动显示相关

信息，立后单去旦旦旦接扭提问该时话植.

归国. .' t. _画画圈
...嗣‘) U e/ ..1() .111., 
((dona 3 po;nl) 
(11.. 0 0. 01 0. 05) 
，.事 。 1∞ 1∞}
，.二， 0 -173. 2 -173.2)) 

。.恤

回8-74 汹界'且踊数 阳8.7S 慎入边界'阻橱'自

12 执行 Define→ DynamÎc Mesh→Zones 命令，设置边耳型晶数的使用时草， 边排

Zone Names 中的 dong-w ， 设置其是型 Type 为 Rigid Body (刚体运动)， 选择

Motion UDFlProfile 下拉列在中的 dong (主步已经将其导λ FLUENT)，保持
Motion Attributes 迫项卡中的其他默认设置. 边4t Meshing Options 迫项卡，设

.1. Cell Heighl 为 0.05 (部近网格的尺寸 )，单击".. 旦J接扭克成宰你的运动设

置， 如圄 8-76 所示. 然后选择Zone Names 下拉到在中的 dong (包革实体的

外层区域)，进行与实体一样的i运动设直. 最后单去五，.. 二按钮关闭的 lamlC

F阳m
q 阳...咱W

F ω .... 啕
俨…

r -.., 
" 句"…w
p … r ~叫

陶h愉勘.. ~由"田- 1 .....句句- -翩翩翩由叫 Gc~.，..._ Yo .... 句句…rEm 
'''''~I' . 

，..制"" IMI j' . 15 一

F'一一

AoI1OU"' Z- ro叫1 
M 广一一一阳.叫抽m

~_l l*tlll'一一

阁8-76 ~比体垣动设置

13 动网格模型设直克后 ， 执行 Solve → Control 司 Solution 命令 ， 在 Solution

Controls 对话植将 Discretization 项 的 Pressure 设直为 PRESTO! ， Volume 

Fraction 设置为 Geo-Reconstruct . 保持其他耻认设置 ， 如圄 8-77 所示，单击

~接~A.



~ 
阳......严-， - ..J 

阳雹"'r
B呻 FO'..， I r-一

........Mllm严「 」

脚".....e-榻制.CIIY c..~耐，.，

问m
阳...由 333 31 阳"-JPRE钉创

..._.....'"陌市阳 U.....lld
V阳_ f..由萨高..........et

一旦」 旦旦J Io._,g 

"，~n 习民解'数设置

1 4 接下牵叶 i且场进行初始化，执行 Sotve --- Initializc -0 lnitialize 命令.在

Solution I n i t i alization 时话柜中选4t all-zones ，时全区域明始化，顺序单击

Init I、旦E挝、卫旦二按钮.
15 扑龙初始 E域的是义， 首克用是相网格自适应的方法走且一个区战. 执行

Ad由ap严t尸司 Re咱8缸阴tω阳m。创n .. ， 4命争今' 在圄 8-归-7咱8 所示的 Regi伊'呻。on Ad由a叩昭p酬to阳o

Min [阳m叫l均 O. X Ma剧x[m叫n叶1叶l为 10 ， Y Min [阳πm叫E叶l为 0 ， Y Ma阻x[阳πm叫E叶l为 5ι，鼎后』单在去旦兰J 镰­
' 

接扭创建一个临时寄4存导底e部~ 1山甩水的E域' 单去卫旦二接钮关闭i谅鑫时话植 ， -，

M 接着执行 Sol ve司 Initia l i ze 吨 Patch 命今，选择 Phase 为 water，选#- Registers 意

10 Patch 中的 hexahedron 呻 (巳走义的临时寄存IH民)，选中 Variab le 列在中

的 Volume Fractìon，在 Value 栏输入 J.单击主旦j桂钮克AJi..部 1 12 区域为水
的明始化走;;(.，如圈 8-79 所示.

-由国幽幽
0，咽.. . I nput Coa.dln."" 

,;0 1,," l<Ie X 101111 '"咱 X lroI ax lmJ F 
(" Ovttldc F 

"呻司" γ嗣同 y...... tml ..... 
~ o..~ 
川崎

r e回』白， 缸." 时- F叮

... .....,.- 1 
COM'OI. ,.. | 

Sele cl J>.I... 回由 W.ue

旦旦旦旦旦旦旦j 丘U

「 υu Fl"'~ r...a:lI .. 

亡1
庐"确

阔'←78 临时区峡库又 回."饵'自区峨定义

17 此时，农们可以检查一下且都是否有水的存在. 执行 Display -- Conlours .. . -4争

令 ， 选择 Contours of 为 Phase 和 Yolumc fTaction，选择 Phase 为 31f ， 勾埠

。ptlOns 栏中的 Filled 选项，单击应盟且按钮，伴出如圄 8-80 所示的祖国窗
口 ，圄中显示了宝气体杠分盘的云圃，红色区峰为宜气，蓝色区域为水.
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罔B-80 初始化区域后的空气的体积分数蝇示

1 8 相姑化后，执行 Solve • Monitors • Residual 命令，在佯出的 Residual

Monitors 时话柜中选中 Plot，以打开战革曲纯国. 对话框下方的 Criteria 括中

可以输入各事数的收敛柑Jt.要卓 ， FLUENT 耻认为 0.001 ， 本制保持默认， 单

击」巳」制且.

19. r面说X$.制的动函， 执行 Solve • Animate --- Define 命令 ， 佯出 Solullon

Animation 对话握，通过右侧的箭头将提字从 o 调成1，如固 8-81 所示， 在

Name 栏输入 ph脑e ， 将 When 选为 Time Step ， 设置 Every 为 25 ， 即每-楠的

最悻时间为 25 个时间步.

伺候崎时动画进行详捆诅直， 单去 ph目e 行最右侧的阜豆目接扭，得出如围 8-82

所示的 Animation Sequence 时话枢 . 选择对话柜中的 Storage Type 为

Metafile ， 在 Window 担输入 1， 通过单击右侧，.陆扭佳时血的 ;d 窗口生浆，

此时会出现一个主白的圄市窗口 . 选择 Display Type 下方的 Conto山'1， l!时自

动体出 Contours 时话框，选择对话柜中 Contours or下方的 Ph国固和 Volume

fraction . 将 Options 栏中的 Filled 句边，单去2豆豆1按钮后 ， 刚才的空白窗
口 1 中即出现T明始时割的空气体和分数云固，事且圄 8-80 ， 单击王EEL接扭

关闭 Contours 时话框，回到 Animation Sequence 对话柜中单含一旦-*Ù，

-幽幽幽圄… - -E ………咱

制血'响嗣-r .;l

_.三了 E.....,. _. ..:J 

F 阳一- 1"到阿百丁岳E
r r r过r~，，，">，，丁~
r r一一~I'丑1........" 丁 .. ζ」
r 1-...，"."."广丑 1....，..，.丁主之」

r f._.. r量I Jιc:.J." 

-立J 王-1 .2旦J

h_~… 
叫T~ 11_ 

F 嗣陶町， F-
俨 白巳，叫-r封里jS1ot_DIro_ 

时~'­
俨刷

' 匾画画ac_. 
r _T_ 
俨问

俨 ~阳
俨}

~ι丁
旦堂里!d

~旦旦」里J
阁，←11 动画个Ihi.

2 > 克A上述步'霞的设置后 ，

sI8-2 .c回 .

回8-82 A.nim割刷，，.，....，曾说愿

执行 File --- Write- Case 命令， 特工程主件保存为



22 执行 Solve→ Iterate 命令，过直时间步长为 0.000 1 5，时闭步为 400 ， 如固 ι

83 所示，单去旦旦旦桂钮开始解耳.
23 选代克后执行 Solve -0 Animate → Playback 命令， 打开如图 8-84 所示的动画田

址对话柜( Playback 对话柜)， 选择 Playback Mode 右侧下拉多'1在中的 Play

Once，即回就一次. 选中 phase，保持 Start Frame 为 1 ， lncrem ent 为 1 ， End 

Frame 为 1 6，即从第 1 帧开始回放直至第 1 6 帧. 拖动 Replay Speed 的革动牵

可队控制动画回放的速度. 最后在 WritelRecord Format (保存格式)中选择

Hardcopy Frames ， 单击卫生j柱扭. 此时可以看到窗口 1 中的速度动画开始重

新播址，播放的同时，动画将以 lPg 的格式保存每楠图片在工作目录下 .
- …气翘

h 
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_， ..n....问.~一封
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，霄 _.
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旦旦 旦旦J 旦!!..l I1clp I 

三百二，.I 
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同呐…"阿瓦" ::J 

r一封「一丑 1 16 一丑

ill 
F. . me 

』

~~~.:J.:J主l
.'l ..1且 0.1_翩

帕ltcJR.cor<l fotm"'~日on F.....eo 丁 11.'d,.'I ,.' 

2旦旦」 生丘J f!S ~旦J
因8-83 这代设置 剧8-84 动画回欲与保布

24 将生成的空气体租分盘的每帧圄片保存在新建立件央下，然后以文件失的形

式导人 Adobe ImageReady 中进行动画处程，生成动画又件 dm.g汀， 并悻存于

当前工作目录下.

25 执行 Disp lay -0 Contours 命令，此时的空气体租分业云固如围 8-85 所示 • h人

圈 中可以清晰看出 实体入水后蝇起的较大水花.
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因8.85 0.045 后的空气体权分数云图

26. 4材于 Fi1e→ Write - Data 命令， 持计算结果保存为 sI8-2 .d副 主件. 最后执行
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File- Ex i t 命今，安全退出 FLUENT.

8.4本章小结

本章主要讲述了转动模型的概念且其使用方法，详细介绍了动#考罩模型、滑移罔格模

型且动同格幌型的基本思想和世置方法，通过两个实例的讲述分别展示了动声考革模型、滑

移网格模型与动网格模型的世置过程且求解步骤，另外还阐述了如何采用了边界型函数定义

物体的运动，喃助读者熟I.!\ FLUENT 求解移动和变形区域流体流动问题的过程 ， 学会利用

转动模型分析相关实际工程问越.
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第 9 章

组分输运与化学反应模型

在工程实际中，经常遇到有组分输运与化学反应的问题 ， 最常见的化学反应是燃烧.

FLUENT 强大的化学反应模拟能力能够模拟各种直杂的燃烧与化学反应过程，如 No累和其

他污lI!形成的气相反应，固体壁画发生的表面反应， 植于表面反应等.

FLUENT 提供了多种模拟反应的模型z 通用有限速率模型、非预混燃烧模型、预混燃

烧模型、部分预混燃烧模型且 PDF 输运方程模型.

本章将详细介绍利用 FLUENT 求解组分输运与化学反应问题 ， 通过官硫天然气泄漏扩

散模拟与圆柱型币炕火焰燃烧苦苦模拟两个例子，帮助读者了解求解燃烧与组分输运的过程.

章要点
一 F

· 反应模型概述.

• 通用有限速牟模型.
• 层施有眼速率模型.

• 涡能散模型.
• EDC 模型.

• 组分输运计算的世置.

• 燃烧反应的世置.

主A坐塑
· 告琉天然气描揭扩散扭扭.

• 圆柱型甲兢业焰燃烧器模掘.

~、:

----_. ------- ._-_. ._----------- . ......... ---_. -. -..... … 一一 - _.. ••••• ..‘ 句.._ -_..._-_..__. ..... ........__..，
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9.1 概述

FLUENT 强大的化学反应模拟能力能够模拟各种复呈阳的燃烧和化学反应过程 . $年辈

帮助工程师节1解决T$个工程实际难踵. 例如 FLUENT 可以模拟 N岛和其他污!Ii!形成的

气相反应，帮助环保工作者且时卦析污染物的组分与陆度 FLUENT 能够模拟植于表面反
应〈捆炭颗粒的燃烧).帮助工程师设计是优的节能降挺措施.

在工程实际中 ， 经常遇到有组分输运与化学反应的问题，簸常见的化学反应是燃烧. 燃

烧按照#与反应的流体可以分为单相和宰相燃烧，按照反应前后备组分的分布可以升为预混

燃烧、扩散燃烧和部卦预混燃烧， 按照燃烧的状态可以卦为稳态燃烧和非稳态燃烧，按照反

应时间和扩散时间的关罩可以分为快速反应和有限反应.在涮甜i燃烧中，反应速率和流动是

相互精告的.燃烧速率除了取决于化学动力学抖，还取决于流场 . FLUENT 针对不同的组

分输运与化学反应问题具有相应的解算模型，下面对相关模型进行简单介绍.

9.2 反应模型

FLUENT 提供了事种模拟反应的模型。通用有限速率模型、非预iIi.燃烧模型、预混燃

烧模型、部分预视燃烧模型且 PDF 输运方程模型.

通用有限速lf<模型是基于组分质量分数的输运方程解.利用预先定义的化学反应机制对

化学反应进行模拟. 反应速且在在这种方法中以源项的形式出现在组分输运方程中，计算反应

速度有几种方法。层流 Arrhenius 速度表达式计算、从 Magnussen 和 Hjertager 的榄涡辑做模

型计算、从 EDC 模型计算.通用有限速率模型应用范国且为广泛，可以模拟化学组卦檀

告、输运和反应的问题， 壁面或粒子表面反应问题等. 下面我们还将详细介绍.

非预混燃烧模型不是束解每个组分输运方程 ， 而是求解一个或两个守恒标量〈混合卦

数〉的输运方程， 然后从预测的混合分数分布推导出每一个组仕的浓度. 此方法主要用于模

拟揣流扩散虫焰. 在守恒标量方法中，通过概率密度函数或者 PDF 来考虑涮流的量在响. 反

应机理是使用 f1ame sheet 方法或者化学平衡计算来处理反应罩统. 层流:k焰面 f1amelet 模型

是非预混燃烧模型的扩展，它考虑到了从化学平衡状态形成的空气动力学的应力诱导分离.

预泊燃烧模型主要用于单一、完全预先混合好的燃烧军统. 在这些问题中，完全的混合

反应物和燃烧产物被火焰前缘分开 ， 通过草解反应发展变盘来预测火焰前缘的位置. 梢流的

黠响则是通过希虑揣流:k焰速度来计算出来的.

部分预混燃烧模型是描述非预混燃烧与完全预混燃烧结合的系统. 通过结合混合卅数万

程和反应物发展变量辈分别确定组分浓度和大焰前缘的位置.

PDF 输运方程模型结合 CHEMKlN 可以考虑详细的化学反应机理， 而且高度的非线性

化学反应项是精确模拟， 无须封闭模型，可以合理地模拟揣流和详细化学反应动力学之间的

相互作用. 缺点是该方法睛要消挺额大的计算机内存和计算时间.

9.3 通用有限速率模型

通用有限遮率模型是最常用的模型， 其计算反应速度有儿种方法，下面详细介绍.



-、 层流有限速草模型

该模型使用 Aπhenius 公式计算化学源项， 忽略了揣流脉动的"响. 因此对于层流燃烧
或化学反应相对缓慢的揣流燃烧是准确的，而对于高度非线性的端流火焰一般是不精确的.

化学物质 z 的化学反应净源项通过其垂加的 N，个化学反应的 AπhenÎus 反应源的和计算

得到.

尺 = MwaZR』 r (9-1 ) 

;:\ 

式中 • MMI，J 为第 2 种物质的分子量 • RI，r 为第 2 种物质在第 r个反应中的产生1分解速率.

第 r个反应可以表示成如下形式2
N N 

EA寸?ZvLME (9-2 ) 

式中.N 为革统化学物质数目 ， vtrJ自反应 r 中反应物 z 的化学计量革数，的J为反应 r 中

生成物 a 的化学计量罩数.M，为第 z 种物质的符号 ， 协为反应 r 正向速率常数 ， kb，r ;为反应 r

逆向速率常数.

反应 r 中物质 t 的产生/分解摩南飞速度为 z

A = r(hr)(叶[Q ]nJJ KI[CJTJJ (9-3 ) 

式中 • N， 为反应 r 的化学物质数目 • C}J 为反应 r 中每种反应物或生产物 J 的摩尔陆

度，町，为反应 r 中每种反应物或生产物J 的正向反应速度指数 '" 为反应 r 中每种反应物

或生产物J 的逆向反应速度指数 r 为第三体对反应速度的障罪响 ， 每是省状态为不包括.

反应 r 的正向速草常数如通过如下 Arrhenius 公式计算，

kfr =4TAe4/RT 〈叫

式中 • A， 为指数因于 . /f 为温度指数 • E， 为反应活化能 ( JI ( kg'mol 门 . R 为气体常数

CJ! (kg' mol 'K)). 
在 般工程计算中 ， 通常不考虑逆向反应 ， 但是 FLUENT 中提供了设置逆向反应垂数

的选项， 可以通过化学平衡常数的设置来计算逆向反应常数.

二、 涡耗触模型

大部分燃料都能快速燃烧， 整体反应速率由揣流混合控制.在非预混火焰中 ， 油流缓慢

地通过对流/混合燃料和理化剂进入反应区，在反应区内快速地燃烧.而在预泪大焰中 ， 揣

流流体 片的反应物和热的生成物通过对流或混合的形式进入反应区 ， 在反应区迅速地发

生反应. 在这些情况下，燃烧称为混合限制的，即扩散控制的燃烧， 可以忽略复杂而未知的

化学反应动力学速率.

FLUENT 提供的梢流一化学反应相E作用模型称为涡能散模型. 反应 r 中物质 i 的产生

速率 R;，r 由下式给出 z
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凡←川川=叩叩叫mm叫n叫川{
[""" k' lvη'R.，Mιιw时R川j 严 ,< 'k ~ ; ν弘::LvfJ川川，1川M、"'.叮j [ | 

式中 • Y，是任何一种产物的质量组卦 Y，是某种产物的质量组分 A、 B 为经验常数，

分别取 4.0 和 0.5.

在武 (9.5 )中 ，化学反应速率由大尺度涡混合时间尺1!í kJe 控制.只要揣梳出现

(kJ庐的 ， 燃烧即可进行，不需要点燃火源来启动燃烧. 这通常对于非预混虫焰是可以接受

的，因为此时往往是扩散控制化学反应速率.但在预混火焰中，如果仅仅使用涡挺散模型就

不是很合理了，因为此时化学动力学因素也在控制着反应.为了佳正这一点 . FLUENT 提

供了有限速率/涡耗散模型，其中式忡 忡 的 Aπhenius 反应速草和武 (9.日的涡挺散反应

速率都遭行计算. 挣反应速率取两个速率中较小的.实际上.Aπhenius 反应速率作为一种

动力学开荣 ， 用于阻止反应在大焰稳定之前发生. 一旦火焰瞌点燃，涡挺散速军事通常会4、于

Arrhenius 反应速率， 井且反应是混合限制〈扩散控制燃烧〉的.

尽管 FL山盯允许采用涡耗散模型和有限速率/涡娓散模型的事步反应机理〈反应数划，

但可能会产生平正确的结果.原因是多步反应机理基于 Arr如emus 速率， 每个反应的具体#数都

不一样.在涡耗散模型中 ， 每个反应都有同样的揣流速率，因而模型只能用于单步〈反应物一

产物)或是双步〈反应物 中间产物， 中间产物一产物〉草包反应. 模型不能预测化学动力学

~I 控制的物质，如自由基.如果希望考虑揣流流动中的事步化学动力学机理， 可以使用 EDC 模

实 E| 型.
里写| 涡辑散模型需要产物来启动反应.当初始化求解的时候， FLUENT 世置产物的质量百
罩在| 分数为 0.0 1. 通常足够启动反应.在端流模型选用大涡模拟时，涡耗散模型中的时间尺度

在|将被亚格于混合速率时间尺度所代替.

~I 三、 EDC 模型
真 EDC (涡-税散概念〉模型是涡耗散模型的扩展 ， 在漏流流动结构中包含详细的化学反

应机理.该模型假设化学反应都发生在小涡中 ， 称为精细涡 ， 而反应的时间是由精细涡及化

学反应本身需要的时间荣共同控制的.

256 

小祸的空间分辨率为。

/、314

( = c, I ~: I ~，- -. (9.6) 
一 ξI ,. 2 I 

式中， c，为容权比率常数，取 2.1377 .
化学组分在 f时间内宜生化学反应，，·表达式为

/、 112

/' = c, I 旦|
飞 liJ

式中， C，为时间尺度常数，取 0.4082 .

组分守恒方程中的化学反应源项为 z

(9.7) 



R J止(y，' - y,) 
T' II- ({)' I 飞 ， I 

式中 ， y'为精细涡的时间尺度 「为化学反应之后的组骨质量分数 y 为问样的物质在

E应前的浓度.

EDC 模型能够在涮流反应流动中考虑详细的化学反应机理， 但消轮的内存较多 ， 时间

佳 ， 所以通常在快速化学反应假定无效的情况下才使用该模型 ， 如快速熄灭火焰中缓慢的

CO烧恩、选择性非催化还原中的 NO 转化等问题.

I实例 9-1 】 吉硫天然气泄漏扩敢模拟

( 9-8 ) 

天然气是一种清洁、方便的能源，肾道运输是天然气最主要的运输方式，已经成为国民

屉挤不可替代的"生命线 ". 然而 ， 由于管道的腐蚀老化、管材最陷、第三万破坏、误操

作、施工缺陷等原因，管道常常发生泄漏、 破裂、燃烧爆炸等事故， 严重威胁曹道周困环境

和人员圭盒， 井可能造成巨大的经济损失. 随着输气管道向大口径、高压的方向发展， 管逝

世漏和爆裂的危险性阳之增加 ， 对天然气泄漏扩散规律的深入研究己刻不容罐. 本例将利用

FLUENT对平坦地区吉硫天然气集输管道的泄漏扩散进行模拟，下面进行详细介绍.

-‘ 实例愤述

垂照某集输管道工程 ， 选取管道直径为 610mm，考察长度为两截断阀间距离 5km，理

事段营造的起点压力为 3.5MPa . 终点压力为 3.35MPa，天然气年均输量取 20x l0'm3 ， 硫化
氢吉量较高. 取为 20mg/L 世计年工作天数按 350d 计算， 外界耳境温度鼓高气温 38 'C , 

最低温度 IO'C ， 平均气温 1 6 'C ，天然气的年平均气温为 26'C ，

取一个足够大且包古泄漏区域以且扩散区域在内的空间〈商 l∞m、泄漏半径为

5Om)，研究天然气在此空间内的扩散情况.泄漏口罩用二维孔口模型， 口径均 I Ocm . 左侧

水平向右的风速为 5m1s . 模型简罔如回 9-1 所示.

--+ 1ωm 

--+ 
风

--+ 
，徽区

1∞m 

--+ 

11捕口

圈，- ， 儿何损型简回

思路分析

高速气流经由泄漏口喷射出，在泄漏口上万一定高度内的速度梯度较大， 因此有必要将

计算区域划分成几块. 且泄漏口上方的区域需要同格细如，) ， 由于本例涉及到泄漏扩散问题，

所以应读来用组分输运模型 (Species Transpo时，而不启功化学反应模型.
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通过本主例的演示过程， 读者将学习到.

• I!城分块，

• 用棉细划，
• 组分足J址 ，
• 组分输运模型设置，
• 多入口边界定义，

• $-出口边鼻直立，

• 组分云图显示，

• 安全区城显示.

(UH)一#见附带光盘" Ch9\s19-1.msh n 、.. Ch9\s川旷、 u Ch9\s19-I .jou ..、

.Ch叭sI9- l.tm"、..Ch9\s19-I .cas"、.Ch9\s19-1.dat". 

哑E一，见附带光盘 "Ch91AV1\s19-1 旷.

二、模型建立

1 启动 GAMBIT，首先建立模型的控制点 . .;t;t，f百司[('ï -1J7'， 在 Create Real 

Yertex li1扭的 X. Y 、 z 坐标输入担中输入 (0 ， 0，的，单击 .旦旦」接扭生且

21 第一个右，接同样方法啤立哉( 49.95. 0 , 0) 点 (50.05 ， O. 0). 点

ZE| (lm ， 0 ， OL 点 (0 ， 1盹川和点 ( 1∞ . 1∞ ， 0). 由于需要将计算E域
都| 分块， 放再建立 4 个点，坐标分别为 ( 45 . 30.0). (55.30 , 0). ( 咽 ，

\j I 1∞， 0 ) 和(剧， 1∞ ， 0 ). .f，此，头创建了 1 0 个控制点，如圄 9-2 所示.
在街
1>. 
仿
真
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• 

" 
• 

陋'.2 创煌的点

2 轴['i' -[('ï -F. 在 Creale Stra胁t Edge .，lÁ中选择占 J (Yertix.l) 与但
2 (Vertix 川，连接过两点生成线段，接矗按照同样的方法追徐其命线段，分

别为点 2 (Vertix.2) 与点 3 ( Yertix.3 ).点 3 (Yertix .3) 与夺、 4 (Vertix 川、在

1 (YertÍlc:. l )与点 5 ( Vertix 川、点 4 (Vcrtix.4 ) 与我 6 (Vertix 川、点 5

( Vertix.5 )与点 9 ( Vertix.9 ).点 9 ( Yertix .9 )与点 10 (Vertix. IO ) 点 6

( Yertix.6 )与点 10 ( VertÎx . 1O )点 7 ( Vertix. 7 )与点 9 (Vertix .9)、点 8

( VertÎx ,8 )与点 10 (Vertix. I O). 点 2 (Vertix.2) 与是 7 (Vertix. 7 )和我 3



( Vertix.3 )与点 8 (Vertix 川之间的线段，共 12 串辑段，如图 9-3 所示.

从圈中可以看出 ， 我们大体将计算区域分成了三块. I世漏口上方的中间部分较狭小，两

侧区域稍大一些.

3 下面在们将生成的线段时所需要的 3 个耐，特fi"-陌-厅，在
Create Face from Wireframe 帧中利用匾琦鼠标左键框选中间区域的 6 条
边，然后单去~塑L.J按钮创建谅函，西侧区域的面生A方法与其相同，均

为扭边各自的 5 杏边后单击 - 1接扭生成，最后生成的 3 个.，女，图 9-4 所

汀τ.

i 
阳，.，生成的 3 个画

" 
.. 卢

.，ι 

阳阳 3 创煌的线段

、 网格划卦

本例的计算区域划分成了 3 块，中间区域需要较密的同格. 我们遵循由钱到面的同格划

分步骤.

l 单击[百-[古→眩，弹出如固 9.5 所示的 Mesh Edg困面板. 在 Edges 中选
取或段 1 (edge 川、线段 3 (edge.3). 或段 8 (edge 川、线段 10 (edge. 10 )、

蝇段 11 (edge. l1 )和蝇段 1 2 (edge.12) 6 帚边，运用 Interval counte 划分方

法，并在左侧输入 75. 即为l分为 75 个间陆，单去-旦旦二」按钮，生成这 6 杏
蝇的战同格.

F帽 d

' 响旦旦到
相主，.. _ ... 旦二j:::; ~-由

- "一一一一一OD 

附9-5 Mesh Edges 面额
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2 按照同样的线网格划分方法， 将钱段 6 ( edge.6) 和线段 7 (edge.7) 划分为

125 个间隔 ， 将蝇段 4 (edge 川和蝇~i. 5 (edge.5)划分为 50 个问脯 ， 将蝇

，生 9 (edge.9) 划分为 60 个间 陆， 将满口战段 2 (edge.2 ) 划分为 20 个问隔，

最后生成如圄 9-6 所示的蝇间格.

3 刷刷分克后，特r.--fð1- [歹， 打开如围 9-7 所示的 Mesh Faces 面
桩，选取中间 E峰的面(函 1 )，运用 Tri 单品与 Pave 方法时该<f1进行<f1网格

划分，保留#他耻认设置 ， 单击-旦旦-l接扭即可.

… 
. .啕.. . 1 2 -- --二--=.J

• 
-- 叫删除 旦旦
「一一」旦"'--=.1

' 
.1_"'_ 

J…-­J一一
钮'.6 战网将 阳9. 7 Mcsh Fa.ces 面'民

4 同样，选取左右两耐的<f1(<f1 2 与<f1 3 )，运用 Quad 单品与 Map 方法时这两

个<f1进行曲同格划分， 保留 ~f也默认设置 ， j在击一旦旦-l按钮.

最后生成的面网格如圈 9-8 所示， 中间区域的网路较窜，且泄漏口上万一定高度内的同

格最密，这样可以满足中间区域计算精度的要求·两侧区域的网路稍疏， 且采用的是四边吊

同格，这样可以有量节约计算暨源.

至此完成了 3 个面的网格划分 ， 下面定义边界类型.

5. ..."，[富→晴，在 Spec'市 B剧nd町 Ty阳制中将叫口(吨，e.2 )定义为
速度进口 ( VELOCITY lNLETI， 名称为 on，将左侧过 ( edge.7 )也定义为迫

庄进口 (VELOCITY lNLETI， 名#为 wind-in ， 将计耳E域量上边的 3 串蝇

段 ( edge.8 . edge.9. edgc. lO)及右侧迫( edge.6 )定义为压力出口

(PRESSURE_OUTLET) , ~非分别为 top-out 1. top-out2 . top-out3 和 right­

out . 如国 9-9 所示.

m mM……… 
圃9-' 面陶楠 圃，-， 撞界类型定义



• 

6 最后执行 Fi le - Export - Mesh 命牛，将同格输出为 sI9- I .msh .

四 、 革解计算

l 启动 FLUENT 二难单柑度计耳器，执行 File→Read→Case 命令， 读入划分

峙的同格主件 "sI9- I .msh" • 

2 执行 Grid→Check 命令， 时间掉进行桂剖，成功桂嗣后窗口界函中最后一行出

且 "Done" 语句 . 执行 Grid→Scale 命令.在 S回le GrÎd 对话柜中世直计算

E堤的尺寸和单位制. 由于本制模型在 GAMBIT 宁是按 m 生成的 ， 故保持默

认设直即可 ， 直接单去卫生..接扭关闭 Scale Grid 对话枢.

3 执行 Define→Modcls→Solver 命令 ， 弹出 Solver 对话柜 ， 本例保持默认设

直，单击-巳』安钮.
4 本倒需要启动能量方程计算，故执行 Define→Models→Encrgy 命令，勾迫

Ene电y Equation 选项 ， 如圄 9-10 所示.

5 由于输气管路均 高压输逞 ， 泄满口 速度A民大，故应为瑞流i且动 . 执行

Definc-Models• Viscous 命今，弹出 Viscous Model 时话桩，在 Model ~豆选

择 k-epsilon [2 eqn] . 在 k-eps i lon Model 栏选择 Standard，并选中 Oplions 柜中

的 Full Buoyancy EtTects (考属企浮力都响)，保留其他耻认世直，如圄 9- 11

所示 ， 单去」巳J按钮组

用9. 10 的川能.刀割

叩 …… 
一 』.. 

一F 霄-…，，~

' HH"町，m.-，F.....F，EM嗣.m·同·H -F'" 
(1-(_ ... 
剧由-- ... 

一 ~.刷刷.-幽暗，
H 
~幽幽

圄..岛_.盹-国

.…'一.…__F_ 
一…-E一-旧'N一F一-…… 叫一- """'--嗣-

'…'"-叫.- 由

四嗣"'_..~幅幅'-
..圃.-.…晤'-

三旦旦注2士
阳9. ]1 汹流锁'"讼 I!

,a 

~ 

6 本制步且到甲统和破化盘，故宫调用 FLL厄NT 自带的材料扯据库 执行

Define→Materials 命今，单击 Materials 对话枢右倒的 Fluent O.t.bese 按

钮， 在弹出的 Fluent Oatabase Materials 对话柜中，利用革动串选择 Fluent

Fluid MaterÎals 列在中的 methane[ch4]和 hydrogen-sulfide(h2s] ， 单击王E巴按

钮. 最后单击两次王旦旦按钮 ， 是间 Fluent Datab描e Matcrials 对话括与

Materials 种话框.

7 下面启动组分崎运模型，执行 Define→Models→Speci田_Transport & 

Reaction 命令， 伴也如围 9-12 所示的 Species Model 对话框，选择 Model 栏

分
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中的 Species Transpon，选取 MÎxture Material 为 methane.air，单击右侧的

旦且如扭，俘出如圄 9.13 所示的 Material 时话植.
咀

圃.

甲
、
…
一
一
一
一

~… 

r一----e …，.帽}
「闹一…
]… 

。‘明」睡到 叫

1119.12 SpecÎes M咽.，对面倔

R-…………………………·气事

….一1 隔时·怕自. <;;;田' -可 EιJ
「一一一-

』曲嗣同百平;;;;画面「 专 • I 
「一

c:o........崎岳. ← • ... J 
「一一一一

~帽.-…"伽.写- .' 
.. .幅

8 

些雪旦 E豆司-""'.l

阳9_ 1 3 MaI~1对话枢

在 Material J叶话柜中，单击 M山lre Species 者侧的主坐斗接钮，弹出如圄 9- 14
所示的 Species 时话框，对话框左侧 Avai lab le Materials 为可用姐分f'I!.. 右侧

的 Selected Speci因为巳选组分f'I!. . 本制主要考Æ甲坑植也盘和空气 3 个

姐分，故通过刷}té.~主l柱扭添加旧s. ch4、."到 Sol田ted Speci回到在

中 . 在移加的时候需要将大比重的组分( air ) 址在 Selected Species 列在的最

下蜗 1 其次是，h4 峪 h2，在则在的量上棉. 持组分定义麦子后，单击-旦』安扭，

退出 Species 时话植.

-..，.…-.且，

一…a…m.,, w 
副食- -如4曲
}同

--=-'一--1

I 
E"0. -=-.,.-.-;J 

~~呻

闸9-1 4 Spec田对..幌

9 回到 Material 时话柜中，单去旦旦陆缸悻存组分主吐吐直，单击主坐三按但是间

Material 对话植. 最后回到 Spec.田 M叫01 对话桩，选中句1>005 担中的 lnlet



Di fl:ì.剧0" 和 Di町ùs ion Ene瞄 Source ， 单击-坚」接扭，克成组分柑远模型的定

义.

10 下一步设置计算的耳境. 执行 Define→Operating Conditions 命令 ， 打开

Operating Conditions 时话担 . 如圄 9-1 5 所示 ，这 中 Gravity ， 设 E

Gravitational AcceleratÎon 栏的 Y[m1s2]为 -9.8 ， 在 Boussinesq Parameters 栏的

Operaling Temperature(k]中输入 288. 1 6 ， 其余保持默认设直，单去一旦且安扭-

11 执行 Oetin←崎Boundary Conditions 命令，在国 9- 16 所示的 Boundary

Condi tions 对话祖中走义如下边界条件.

国蛐W'B'IFIR白 国幽幽国幽幽'" -1 -_. 叫

法画

耐-

……-- .叫.刷，自 …… 
……一 "'...,.1I I 

，~ • 、'.事"同 .-，~ • 
…川…
句et"""' ，"_，.些E塑
'U." 
刷刷o...II\I P..町..

..由帕'向0.0'，""

，。

一一J c""，- l l!坠J~。‘ If.....， 阳"

阴阳 IS 11作环雄憾'巨 舰9.16 .it.I:界'民件也义别的回

• 在左边的 Zone 位选中 m，其 Type 为 vel阳ty-inlct，单击 8." .. 按钮，打开如

固 9-1 7 所幸的 Velocity I nlet 对话框. 选择 Vel四町 Specificalion MClhod 的万式

为.. Magnilude. Normal 10 Boundary ". Refercnce Frame 为 Absolute . 在

Velocity Magnilude[ mls)右侧输入握中输入 213 .42 ， 即璀蝠口的速度为

213 .42m1s. 选择 Turbulencc 的 Specitication Method. 为 lntens町 and Hydraulic 

Diameler，世置 Turbu\ent Intensity[均为 1 0 . Hydraul ic Diameter[叫为 0. 1 . j世

揭口速度值且瑞植#撤设置克后还平能直接单击」巳」按钮，还需要设置璀揭

口在组合的班皮.选择 Velocity Inlet 对话框中的 Species 造项卡，如固 9-18 所

示，在 Species Mass Fractions 下方有 h2s 和 制，分别输入 0.065 和 0.935，代

表在泄揭口位置两者的浓度分布情况. 世E完组分浓度后，方可单T!;~按

钮，共同 Vel时ity Inlet 时话握.
一 ."..ao 唱rm 
m倒- 1 '"时 1 "-_.I DPW 1 _... 1 恤. 1 
~嗣.....-翩翩"阳-‘胁耐.._..， ,j 

…，与町… " 
叫-叫，而斗~F局一一百

一...曲--'....... 惜时'恤-胁- 二i
Y卢.-由"rτ一一一一

……i00i,0. 1 

~ 1E!l二旦J

阔'队" 溃豁口速度定又

笛'
9
·
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Z士士士"士ALi 幽幽……-咆喃-­~一

』甲I~叫，~- 阳西' 1 """ t刷刷翩翩 j

…户
3-" 
3 

J 

-".J且咀 响

圄9- 18 激漏口组分归fl:1i:~义

· 在左边的 Zone 栏选中 wind- in，其 Type 也为 velocity-inlet ， 单击二止J按钮，
打开如固 9-19 所幸的 Velocity Inlet 对话框. 风进口的边界设置与世揭口的边

界世置基本相同，也分为速度值设置与组分班度设置两步 . 风进口的速度值设

置为 5m1s ， 其 Hydraulic Diameter[叫为 100. 风进口的组分班庄设置如图 9-20

所示， h2s 和 ch4 的组分地度均为 O. 最后单击~按钮， 完成风进口的边界

定义 .
111""""川跑.

…阿 -133 
陶

士响曲阳也甸蜘嗣同画画司_..._...，

民副幅幅阳 hmHgM

..叫t.I...""ðe叫厂一一一问时

Y呐阳"

加捕睛"胁时问响...1tydt_0I.町 j 
，-民υ咸阳·响阿jiI一一一一

忡忡M缸刨翩翩『同币，-一』司"一

~--1 E到 些翌」

倒9_ 19 风进口速度正义

雪曹雪胃四n

蜘..._ 1 1110""01 1 RdI由句.d.' 1酬 I N.IIIPh叫酣

3'"' 
!do4 1'一一---阿" 001 丁

4 

。眼

剧，.，灿 风边口细分旅搜定义



· 在左边的Zone 栏选中 lop-outl ，其 Type 为 pressure-outl et，单告」坠ι按钮，

打开如固 9-2 1 所示的 Pressure Outlet 对话框. ，罪持 Gauge Pressure[p出臼IJ为
0，即环境气压为 l 个大气压 . 在 Turbulence 栏的 Specj fication Method 下拉列

章中选择 Intensity and Hydraulic 0眩meter， 设置 Turbulent Intensity[%]为 1 0 ，

Hydraulic Diameter[叫为 40. 然后选择对话框中的 Species 造项卡，如固 9.22
所示，在 Species Mass Fractions 栏的 旧s 和 ch4 中均输入 0 和 0 ， 单击 "

钮.关闭压强出口边界定义对话框.

-­,.,._. 

一…---呻』圃
缸--四.._!- 1"翩翩

--由怡瞩申陶田画画言画画石一一一-一-4

T咄阳，-阳

'… 

卫星星兰- 1
锢9-2] 压强出口比义

._ OA • -­‘..-_. 
一…一-四叫』唰

--,… 产.. '::::::=，;----士 4

-.一
" 

.民 医3 "

阂~22 应强出口组分橡皮定义

· 剩下的 lOp-ou12 . lop-out3 和 right-out 与 top-outl 的定义相同 ， 均为压强出口

边鼻. 本同的是在自的 Hydraulic Diameter[m]不一样， top-out2 、 top-out3和

right-out 的 Hydraulic Diameter(叫分别为 20m 、 40m 和 1∞m .

12 边-If.>t.且克后，对卓解事数进行过直执行 Solve→ Control- Solution 命今，

弹出如圄 9.23 所示的 501Ulion Controls 时话框，保持默认设置，单击。K

钮.

:工严 J
-'-r 
蛐-，....，...-

」咀

êf 叫一- ..… 
'一一---,---...._-

.‘国" 甲崎

则9-23 束...，院设置
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Solve 司 lnitia lize → Initialize 命令，在

顺序单，t，~、
接下来时，且场进行相始化 . 执行

lnìlìa li z.ation 时话枢中选择 m .

13 
9-24 所示，如圄Solution 

主~. ~旦巳接缸.
.&222 2=.哩mu: …………·百E

画画面-圃EMζ;:江山

喃喃阳百万一一一』

，.伽侃.~-匠".c'W恒扮"'百丁言:言---

阳山.

, ...... ,u. 01..1，__协抽写写再正:三千

112. '1.画「一一

doo. <;;言言-一 业

-"!'J 旦旦旦旦旦旦 丘旦l

相始化后，执行 Sol ve • Monitors - Residual 命令，在佯出的

MonilOrs 对话枢中选中 PI时，打开战Á曲线国 . 谅时话桩下方的 Criteria 栏可

以输入.&-~在世的收仕柑庄要)'t， FLUENT 耻认 encrgy JJ 1 e-6 ，其余的为

0.00 1 . 本制保持其默认过直， 单击一旦」按钮.

执行 File- Write司 C国e 命今，将工程文件保存为 sI9- l.cas .

执行 Solve- Iterate 命令，世直选代步为 lωO . 单去旦旦旦按钮开始解算.
峙问题收最后，执行 Dis play - Contours 命令，如圄 9-25 所示，选择
Contours of栏中的 Speci田和 Mass fraclion of h2s .i!项，勾埠 。pllOns 柜中的

日lIed ;t项，单击匾豆豆1接租可以看到此时的耻化虱组分班庄分布云田，如
围 9-26 所示.

Residual 

>J始化设置回9-24
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.‘化'且饱分割./1纱布云图

将 Contours of 担命的 Mass fraction of h2s 改为

居国到制且可以看到此时的甲炕组分来庄分布云田，如圄 9-27 所示.
考虑到属也盐和甲舵在空间的浓度超过一定范圈后会片人提造成生命凰胁，

故此直云圄显示的把圈，以明确显示安全区域. 取消 Conlours 时话桩句tiOns

单去

帽9-26

Mass fraction of ch4 , 

C拥阳"对话棍圄9-2S

18 

19 



栏 Auto Range 迫项的勾埠，勾i&. Clip to Range 选项，在右侧的 Min 和 M.. 主

本植输入要显示的上下，~. 首克里示植化盐的安全区域，如国 9.28 所示，在

Min 主本括中输入 0 ， M副主制时输入。ω础，单合国国按钮，此时的
组分班庄云圄安。围 9-29 所示，其范圄为 0-0.00∞2，超过 0∞∞2 的 E统被

挖去.

同样，对于甲就而吉，设置 Min 为 0 ，

安全区战如圄 9-30 所示.

M剧为 0.03585 ，单击E画国棚，其20 
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改变云侧显示施掏
一l

圃9.28'伊统鲍份翻".分布云图阳9.21

且且... 翩翩 .国n …四吧r.II

---------------------
用烧'每金区域

若要显示危险区攻，只需将这里的，ι'"值( Max )设E成下'"值( Mi时，

剧9.)0德化组3但全区.. 

这里显示的是安全区埠，

而将上'"值设置为1.

阴9.29

埠E

执行 File→ Write→ Data 命令，保存 sI9-I.dat.

执行 File→ Exit 命令，安全退出 FLUENT.

21 
22 

圆柱型甲炕火焰燃烧器模拟

燃烧是应常见的化学反应，圆柱型甲炕火焰燃烧器是工程中常用的燃烧精之一. 那么，

甲统进入燃烧器之后是怎么燃烧的'燃烧是否完全9 燃烧完后的产物酣皮是多少'这些都是

工程实际中丽临的问题. 下面我们!l1 FLUENT 来模拟圆柱型甲筑业焰燃烧器内的燃烧情

况.

【实例 9-2 ] ，



- 、 实例概述

囱 9.3 1 所示为国桂翠甲炕火焰燃烧器， 宝气以 O.5 m1s 的速度进入燃烧器 ， 而甲炕以

80mls 的速度从中间喷口进入，过盘空气系数:民~ 1.28 . 高速甲炕在燃烧器内与低速空气混

合，井发生反应.

i可豆' 工?:二?飞阳
。吁士立一一...工>-"

O.22Sm 

对'华辅

叫
2m 

因9-31 圃桂型用统火然燃馅"根型简剧

思路分析

本例可选用单步完成反应机制的燃烧模型，即燃料完全燃烧成二氧化碳和水. 反应是扩

1 散控制的 ， 故这里应使用涡辑散模型对其进行模拟.

川 通过本实例的泌示过程，读者将学习到·

I I • 涡耗散模型设置，

=| • 组分材料定义，
~ffi • 反应机理设置，
z 王 . 进出口组制度定义1
岳阳 • 燃烧室壁面条件定义，
在 I • 温度分布云图的查看，
F · 届比热分布云图的查看.

真

A
'
叫
吁

4'f' • 

哑.... )~.lI'.附带光盘咄咄9-2.msh" 、" Ch9\s 1川
"Ch9、19.2 .tm飞 "Ch9\s I9-2.cas"、 uCh9\s19.2.dat " 0 

每E 凯附带她W山，VI\s19-2 .avi气

二 、 模型建立

1 启动 GAMBJT. 首克建立棋型的控制点 . ["i"" - [i'f - í;C . 在问te Real 

Vertex 00担的 x . y、 z 坐标输入栏中输入 (0. O. 0)，单击--!!血..J接扭生A

第一个占，接同样方法建立点 12. O. 0) . 点 12 ， 0.225 . 0). 在 1 O. 
0.225 , 0) 点 1 0 . 0 .005 . 0) 和点 1 0.04 ， 0.005.0) 为后续同格划分方

便，再建立 3 个用于分块划分同格的控制点.坐标分别为 10.04. O . 川 、

10.04. 0.225, 0) 和 12. 0.005 , 0 ). 建立好的几何点如图 9.32 所示.

. _. G~ • 
制9-32 建立的技制点
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2 单击陌-厉-17， 在 Create Stra胁t Edge ii'.K 中选择点 I ( Vertix .l )与点
7 ( Vertix 门，连接迫雨点生成战段，柱，盹同样的方法追樵其命战段，分别为

主 I ( Vertix. l )与我 5 (Yertix.5 )占‘ 6 ( Vertix.6) 与占 7 ( Yertix .7)，点 5

( Vertix.5 )与占 6 ( Vertix.6) . 我 5 ( Yertix.5 )与 在 4 ( YertÎx 材、点 4

( Vertix.4 )与我 8 ( Vertix.8). ，亭、 6 ( Vertix.6 ) 与 ，点 8 ( Vertix.8 ). ，在 8

( Vertix.8 )与点 3 ( Yertix.3 ).点 9 ( Yertix.9 )与点 3 ( YertÎx.3 ).点 2

( Vertix.2 )与点 9 ( Vertix.9 )、点 2 ( Yertix.2 )与点 7 ( VertÎx.7 )和鼻、 6

( VertÎx .6) 与点 9 ( Vertix.9 )之间的线段，共 1 2 牵线段，如圄 9.33 所示.

户
巳

-‘ .. 
-‘且

因协J] 建立的钱

3 轴陌→~-厅， 在 Create Face from Wireframe Iil K忖l用~鼠标
左键桂边 edge. l 且 edge.4，鼎后单击 - 接扭创建函，其命 3 个面的生
成方法与其相同，均为枢边各自的 4 串过后单去 .，..， 按钮生A. 最后生

成的.，如固 9.34 所示.

:七:j; l.c..3 

ι""""'且

阴阳讥" 建立的面

三、 网幡划分

本例的计算区域划分成了 4 块， 中间区域且左侧啧嘴附近的两个区域需要较密的同格.

1. ....l>[百-[F-W. 在 Mesh Edges 峭的臼阴性制段 1 (吨e.l ) 
或段 3 ( edgeJ )和钱段 6 (edge.6) 3 牵边，保持 Ratio 值为 \， 远用 Interva l

counte 划分方法， 并在左侧输入 4 . 即划分为 4 个间隔，单去 .，..， I按钮，

生成迫 3 串蝇的线网格.

2 战吨同样的战同格划分万法，将线段 2 ( edge.2). 战段 4 (edge 川和线段 10

( edge . lO)划分为 5 个间隔.

3 选择线段 8 ( edge.8)，蝇段 11 (edge. lI )和战段 1 2 ( edge.l 2 ) ， 并悻证虹色

箭头方向为从右向且，政~ RatÎo 值为 0.95 ， i孟周 Lnterva l counte 划分方法 ，

划分为 1 00 -1、间隔 . 将战段 5 ( edge 川、或段 7 (edge 门和蝇段 9 ( edge 引

以比例国子 0.9 划分为 22 个闯陆，最后生成如圄 9.35 所示的战罔格.

侧9.JS 划分好的钱网梅

4 刷刷J~Â:后. HIi" -f百「斗否，打开 Mesh Faces 恤，选取 4 个
函 ， 运用 Quad 单克与 Map 方法对这 4 个.，进行.，同格划分，保留真他默认

设直.单击 .，..， 接扭， 生成的.，同格如圄 9.36 所示.
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E 
一

2 可三「 在气二有百扩­

一用9.)6 划分衔的画同能

5 下面定义研制. 特阿富-Ii茧，在 Sp，咐 Bound町乃pes .，...中将甲蝇
进口( edge.4 )定义为速度进口( VELOCITY_卧<LET )，名称为 m-m ; 将空气

进口 (edge.5 )也是义为速度进口( VELOCITY _lNLET) , .f，林为 a-m ; 将喷

嘴壁画( edge.3 )走义为壁画迫;ff. ( WALL ) ， 名非为 p-wall ;将出口

( edge.9 )定义为压力 出口 (PRESSURE OUTLET)，名称为 out; 将对林轴

( edge.l 与 edge.ll )定义为叶林轴边;ff. (AXIS ) ， 名称为 a脯，女，图 9-37 所

司τ .

问 立旦
x阳

• 
-阳., • ..... 
M 

皿

侧9.37 边界樊型~义

6 最后执行 File - Export - Mesh 命令，将同格输出为 sI9-2.msh .

四、求解计算

l 启动 FLUENT 二维单精度计算器，执行 Fi1e→R臼d→C国e 命令，该入划分

奸的网格主件 "sI9-2.msh " • 

2 执行 Grid→Check 命令，对网掉进行栓剧，成功栓制后窗口耳函中最后一行出

现 "Done" 语句 . 此时， FLUENT 控制台窗口会提示如图 9-38 所示的警告信

息，意为提示我们将问题暗改为轴对非问题. 这里我们克不管它 .
Gfhult-inu川w

~ .. 
~- 1n 
r嗣U.., 
画鬓b

嗣U

f1 ulø 
cru t1ng p-... 主 l -uaaow

确el1 conouctlon .0005 
" .. Warnlng: The uSe of ._1. boundary conOltlon事 15 not .pproprtate 筝~

a 2D/3D flo. prGDle田 ~lea.e constoer changl咱也he ZORf 
tJpe t. s,...tr, or ...11 , or t.. p叫e_ tO axts, ...trlc 

Warnlng: The us. of ..1. Doundary CDndtttons 15 not .pprø，rl at e 旬，

• 2D/3D floo proDl... '1.... consløer Cn呵呵阳 ZOOI
啊. to .,...try Dr ...11 , Or 阳 probl.. to a.t.,...trlc 

园~38 警告..息

3 执行 Grid→Scale 命令.在国 9-39 所示的 Scale Grid 对话柜中设置计算区域

的尺寸和单位制 . 由于本制模型在 GAMBIT 中是按 m 生成的，故悻持默认世

直即可，单击旦旦旦按钮关闭 Scale Grid 对话桓.
4 执行 Define→Models→Solver 命令，弹出 Solver 时话桩，本例为对非问题，

故选择 Space 栏中的Axisymmetric ， 如国 9-40 所示 ， 其余保持默认， 单击

」ι」按钮.



由温
,-
. 阳.. 响'…·(" o..."V Ð...~ 

"叫"
" 叫
俨

li3 
句- h 

h呻
俨 阳'叫

' m 
省画画画

刷一MP 

、，叫叫"

… " • • 腼唱
Q向阳 Pa_F，叫阳

6饵.~…""…nd <Õ '-ofω.~阳.. 
(" Gto....G..... ..... ….. r 阳~，.叫
(" l.ul s.~. Cd 8..&1 

0.-.'. ExI.OItI 

时间r一一一即同r一一一

田间F一一-- V.."!"I "I'Õ, "SK---

三生J 旦旦J J:!豆旦 旦旦J -旦」 主些~ -2旦」
栩9-40 $olver则说"网9.)9 sa巾αid 对"舷

5 与主制-样，本倒也常晏启动能量方程计算，执行 Define-Models→Energy

命令，句边 Energy Equatìon 选项，如圄 9-41 所示 .

阁..， 启用"量方黯

6. 4ζ制的甲坑，且迫较大，故且为埠，儿且动 . 执行 Define→Models-Viscous 命

令， 妹出如困 9-42 所示的 Viscous Model 时话桩 ， 在 Model 栏 中选择 k

epsilon[2 叫n] ， 在 k-eps ilon Model 栏中选择 Standard. 保留具也E认设置，单

击-丘J柱在且.
Ta ØA…电

俨筐窒齿"唰
"町'阳....
…~..阳明

信二
徨E

H，如叩 得世­

r-一一一
~ 

… 「 嗣

r 110."_ 
即时'阳四" 出一….

f嚣茧吉黑2fMpm哑 3 

剑"…
r…"叫

d 

.三J 王旦旦L.'当U

鹏、" 揭模模型设置

7 启用姐分输远与化学且且模型 . 执行Define→Models→Species-Transport & 
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ReaClion 命令.弹出如圈 9.43 所示的 Species Model 对话框，选择 Model 栏

中的 Species Tr皿sport ，勾选 Reactions 栏中的 Yolumetric 迫项，此时

Turbulence-Chemistry Interaction 下方出现几 个i&项， 本制选择 Eddy.
Dissipation，即启动了涡托散模型 • i是母在 Mixlure Material ""F.#列在中选择

methane-air ， 单击右侧的旦旦斗挂扭， 弹出如圄 9-44所示的 Fluenl Database 

Malerials 对话框.

8 在 Fluent Oatabase Materials 对话柜中，单去 Miture Species 右侧的旦旦斗接扭，

伴'"如圄 9.45 所示的 Species 对话框， 其中的 Selected Speci因为己选姐分1'1
品，从上到下恤次是甲坑.氧气 二氧化硅、水和虱气，满足盾量分数远南

增加的现律{最大姐命一一且气在盘下精)• 
• a 

阳

" ......… 
r …… 叫一
俨叫h由·…

，…"一阴阳翩翩

篇一
F 
r 

……­阳M叫 声227主兰-"""'''' ，凡

"呻制，刷E饨阳..，

…… }… 

r …… -(--' 医院

~.曲" r.帽嘈-

-9嗣…
a抽血E叩}

r ，.一­
r__ 

二二三旦二二」主
阁9-<1 3 Specics M创M对简报

一J 旦些J -"" J 
圃9-<< Fluml o.uoblote Materiab 对情舷

蛐晴-掏..-晶剖，

J 坠些i 响

期...， s肘。"对话低

9 单击，.-且按扭关闭 Species 片话框，单击卫出L接扭县间 Fluent Database 

Material s 时话框，最后单击-旦」按钮，克成组分输远岛化学且应棋型的Z

;/" . 

10 执行 Oefine_Models→Species→Transport & Reaction 命令，单击 Mixture
Material 右侧的旦旦二i接妞 1 回到 Fluent Database Materials 时话桩，单去
ReaClion 右侧的旦旦斗接扭，佯出如圄 9-46 所示的 Reactions 时话桂. 从中轧们

可H看到 Arrhen ius 下方的革盘均为在色显示，这是因为我们选用 T 渴耗散模
型 ， 而忠略了 Arrhenius Ji.且连辛的化学动力学都响所致 _ Reactions 时始担还

且映T本制克成的化学且应方程 CH，，+20z→CO，+2H，O. 保持时话柜中所有默

认址置， 且在击-巳」按钮.
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陶~-46 Re阳:t10rt5 对...握

11. r一步设置材料的比热 . 由于燃烧产生的高温会使各姐分的比热随温庄且生

主化，故执行 Define→Materials 命令， 在国 9-47 所示的 Materials 对话柜中选

择典型为 f1uid ，克选择 carbon.dioxide[co2] ，设E其 Cp 为 pleceWlse­

polynomial (分段~项式)方式，此时会弹出如困 9-48 所示的 Piecewise­

Polynomial Profile 时话桩，保持其默认设置，单去」巳」接扭 回到 Materia l s

对话柜中单击旦旦望旦业w保存设直.
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甲倪.氧气、水、直气fl'J比热设置与二氧化碳一样， 这里不再详述.

12 执行单击Define_Boundary Condilions 命令，在 Boundary Conditions 时话框

中走义如下边界条件.

• 在左边的 Zone 桂选中 aXIS，其 Type 为 aX1S，单舍i止-按钮，打开如固 9-49

所示的 Axis 对话框，

帽...， 对你输边界u

• 在左边的 Zone 拦选中 a.in，其 Type 为 veloci ty.inlet，单击」主ι按钮，打开

如图 9-50 所幸的 Velocity In let 对话框. 选择 Vel田ity Specification Mcthod 的方

式为 " Magnitude. Nonnal 10 Bounda可.. Refercnce Frame 为 Absolute . 在

Velocity Magnitude[mJs] 右侧输入框中输入 0.5.选择 Turbulence 的

Specification Method 先 lntens ity and Hydraulic Diameter ，设置 Turbu lent

Intens ity(%]为 10. Hydraulic Diameter[m]为 0.44 . 然后选择 Velocity Inlet 对话

框中的 Thermal 造项卡，保持温度 3田K 不变 . 选择 Species 选项卡，如回 9-

5 1 所示，在 Species Mass Fracti。阳下方有 ch4 、 02. co2 旧。，这里只幅在。2

后面输入 0.23 因为空气中只包告氧气和氧气，而氯气为质量分数量大的组

舟，在这里不显示，也不用定义，其质量分量将通过 l 减去其他组分卓得. 世

置完组分浓度后 ， 单击」巳」按钮，关闭 Velocity I nle 对话框.

--川… m ... 幽幽
Z_ N_ 
守了i'---一 -­...-r.--一---… ,....... -.." 阳..副司阔 -胁... UOI I 
h倒.....剑-- '.. 咱翩蝇蜘_.伽- .:1 

阳帽"的目嗣- 二j

h叫.-阳军「一一 - 一一丁

翩翩--叫M由楠.... ! DPW .. 叫"唰

… 

JJ 3323 

J …………… 
v…….... 
-四-ω_.恒咱 ..... ---

-旦J 丘~~"' J 。‘ 」 王雪H 土些j

用9.50 空气造口iIl界足义 附9. 5 1 空气边口组分定义

• 在左边的 Zone 栏选中 rn-m . 其 Type 也为 vel饵ity-inlet . 单击二旦』按钮，打
开如固 9-52 所幸的 Velocity [n1et J才话框. 选择 Velocily Specification M础叫 的

方式为 "Magnitude， Normal 10 Boun也可" Reference Frame 为 Absolu比 在

Velocity Magnitude[mls]右侧输入握中键入 80 . 世置 Turbulence 栏中的

Specifi cation Method 为 Intensi ty and Hydraulic Diameter , ìi I Turbulent 

Intensìty[%]为 10 ， Hydraulic Dì ameter[m]为 0.01 . 选择 Velocìty lnlet 对话框中

的 Thennal 栏，保持温度 3∞K 不变. 搓着选择 Species 柱，如围 9-53 所示，





使 l

"_.阳帽TlwI....' I A.o.'d叫加~. I 。阳 l 刷刷..1 1 国S

"巾，川同同一一一- f刷刷刷 可
二
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E画豆画面
俨 c_~.. 
r ，，-，110剑"
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Wd'血"叫

阳也...，oII_A.oIo时「一一- f…

"刷刷m

1.1 ， 1 ζ一一丁王坐过

倒9-56 壁面埠界)j!又

15 初始化后执行 Solve→ Monitors→ Residua! 命令，在伴出的 Residual Monitors 

对话柜中选中 PI时，打开战呈曲线困 . FLUENT 默认 Criteria 中，n，电y 的收最

精皮要卓为 le-6 . 其命的为 o剧，本倒悻持其默认，生置，单击-坐监钮.

克成上述步骤的设置后 ， 执行 File→ Write-C画e 命令，将工程主件保存为

sI9-2.c国 .

执行 So\ve- Iterate 命令，世直选代步为 500. 单击旦旦旦旦按钮开始解耳. 这

代豆 225 步时， 问题收敛， 其残革曲线如圄 9.57 所示.

执行 Display → ContQurs 命令，选#:- Conlours of 下方的 Temperature 和

Static Temperature . 句迫 Options 下方的 Filled ， 单击E豆豆』按钮， 可.-;.看到
温Jf分布云围，如国 9.58 所示.

17 

18 

l 'UWlW旦司-面""回孟iIOiII

四-
四

四

--
" --
" ……. - -… 

圃9-57 费'"自搜 锢9-" 温度分布云图

19 改:t. Contours of下方的i&项为 Propenies 和 Speci fic Heat(C时，

按钮，可且看到定压比然的分布云圈，如圈 9.59 所示.

20. lt~ Contours of 刊的i&'lí为 Species 和 Mass fr则。n of ch4，单击 1 01.，12 I 
按钮，可以看到此时的甲就班Jf.分布云国，如固 9.60 所示 .

276 



叶叫 'm_ 尸川，. '~ 'c:'x 

一二.

圃9-59 定应比..纱布去阁 圃，... 甲娩赔Il纱布云图

21 再眈史 Contours of 下方的 Mass fraction of ch4 为 Mass fraction of 02 ， 单击

E豆因接扭，可且看到此时的氧气M分布云圈，如围 9-6 1 附
22 查看克相关云围后，执行 Fi1e -噜 Write → Data 命令，保存结果立件为 s19-

2.dat . 

23 最后执行 File- Exit 命令，安全退出 FLUENT. 「[口.川川liIIi工 工悦'
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9.4本章小结

本章主要讲述了组分输运与化学反应模型的基本思想与应用范围，详细介绍了局常用的

燃烧模型 通用有限速率模型. 通过古硫天然气泄漏扩散模拟和圆柱型甲烧火焰燃烧器模

拟分别演示了组分输运与化学反应两种问题的模拟过程， 帮助读者了解利用 FLUENT 求解

相关问题的思路，熟悉解算细分输运与化学反应问题的操作过程，为解决相关实际工程问题

打下基础.

'/雪
.，/矗

> 组分输运与化学且应模型随述­
> i!J1J有限i!.牟模型思想.

> 利用 FLUENT解决组分输远与化学且直问题的操作过程.



第 10 章

流动分析后处理

经模拟得到的结果怎样形直直观地展示在他人面前是流动分析后处理的主要工作­

FLUENT 自身具备强大的后处理功能及图形可现化技术. fl指瞎显示各物理参数的云图、事
值钱团、速度矢量阁、流动轨迹囱等 ， 同时还能求得力、力矩且对应的力矩~数、流量等，

井生成简要的计算报告 . 除了应用 FLUENT 自身所带的这些功能外，读者还可以借助

Tecplot 软件进行流动后处理分析， 它是 Amtec 公司推出的一个功能强大的科学绘图软件，
不仅可以绘制二维阁形、函数曲线 ， 而且可以进行三维面绘图租三锥体绘图 ， 井提供了多种

图形格式，且界面友好、品学品用 .

本章针对流动分析后处理的需要，将介绍利用 FLUENT 且 Tecplot 进行模拟结果后扯理

的操作过程. 通过利用 FLUENT 且 Tecplot 对同样的两个实例进行后处理的讲解， 帮助读者

熟悉两个软件的后处理功能，学金如何进行后处理操作以得到理想的分析姑娘.

• fLUENT 的云图与尊值最显示.

• FLUENT 的速度失量图显示.

• fLUENT 的班动轨迹显示.

• FLUENT 的 XY Plot 散点 曲蛙回显示.

• FLUENT 的施插曲撞的定义.

• FLUENT 的世据显示与文字报告.

• Tecplot 网格与标尺的设定.

• Tecp\ot 曲等值蝇围的显示.

• Tecplot 的矢量固的蛙制

• Tecplot 的 XY 曲蛊蛙制 .

主主革旦
• FLUENT 二撞撞动后处理实例 吏扩管内班体温动.

• FLUE肝三量班动后业理实例-一弯管内油水西相革动.

• Tecplot 二撞撞动后处理实倒一一吏扩营内班体温动.
Tecplot 三撞撞动后处理~1foJ-弯管内油水面相施动 .
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;二 :J吕困;;/伊 :
10.1 FLUENT 后处理

FLUENT 自身具有强大的后处理能力 ， 主要体现在图形可视化技术与文字报告上 ， 下

面对其相关后处理功能进行详细介绍.

10.1.1 FLUENT 的图形及可视化技术

FLUENT 的图形且可视化技术主要是将流场分布以云图、等值钱阁、矢量阳等形式呈 ， 二二

现出来，通过这些图形的显示可以帮助用户分析流场的变化且相关物理参敏的分布. 川

-、 云回与篝值蜡E示 lι 

迭代计算结柬后'执行 Di呐y-→C臼。删n川阳11

话框.该对话框的 Contours of 为待选的物性参数 ， 第一行下拉列表中主要包括速度 |靠第
( Velocity ... ) ~压强 ( Pressure ... )，温度 ( Temperature... )， 密度 ( Dens ity... )等物性~ I量 10

数，如图 1 0-2 所示. 用户可根据实际需要，选择要显示的倒. 第二仔下拉列表为要显示 |盖章
物性#数的二级细化分类，如压强( Pressure . .. )还分有静压 ( Static Pressure )、压力系数

( Pressure Coefficient )、动压 (D归田nic Press田。、 绝对压强 (Absol ute Pressure )、且压

(Total Pressure ) 租相对且压 <Relative Total 阶."町0> 6 个于类，如圄 1 0-3 所示. 对话框

中的 Phase 为相选择， 当为单相流动时，不需要选择，若为宰相流动时，可以在下拉列表中

..... "_'1_. 

.叩町

霄…民-..
r ，协，. n, ,... 

r- 0.__. 
r o._GIW 

I 一
叩

阳-

1"- 一一丁
协" "'t ‘ 
「一一一「一一

回 10. 1 C例棚m对话很

c…. 
何E百士

… .. -....-

• 

回 1 0.2 cor嘘舰norM-行l'位列'曼
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因10.) Con\O响 。r防'"町的第二行下役'烟'是 回 10-4 PItase 下组列袋

对话框中的 Surfaces 为可以显示的面，通常包吉边界定义时的进出口且壁面等， 用户还

可以自定义相关的切面或截面，通过选择 Surfac目下的选项以显示对应面的物性#数卅布.

时于二维问题， 通常平需要选择 Surfac白，因为二维问题本身就是一个面. Surface Type 为

面的英型， 当要显示的丽惟一确定时，可以不用时其类型进一步定义.

Contouf'S 对话框左侧的 Options 下方有儿个重要的选项， 若 Filled 被勾选，则会显示云

阁，若不勾选， ~'J显示的为等值钱图. 突扩管速度云图与等值线图如图 10-5 和国 1 0-6 所

刁唁 .
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因10吨速度去四 m ，(l.6速度..但线图

当 Auto Range 选中时为全范围显示，当不勾选 Auto Range 时，则罩统自动勾选 Clip t。

Range. 用户此时可以在 Min 与 Max 中输入要显示的上下限. 如设置突扩臂的速度上限为

O.8m1s. 下限为 O.2m1s. 因J显示的云图如 10-7 所示.

回国
E·E·-m-HA而揭…0.-.

国 '且 国

回 10叮改变上'"!后的速度云阴

Draw Grid 可以帮助用户在云圈和等值线圈显示的同时显示罔格及几何模型轮廓 ， 当句

遮 Draw Grid 时，自动弹出如回 1 0-8 所示的 Grid Display 对话框. 若想显示儿何模型的轮

廓， 可以勾选 句tions 下方的 Edges. 井选择 Edge Type 中的 Outline. 单击E豆到按钮即
可， 如第 5 章 E实例 5-2 】 的轮廓如阁 10-9 所示.

r_. 
H申

俨 ，-
r … 

回 IC卡. Grid趴."町"面岖 IÐ lO.9 [实例 5-2 1 的轮廓图

280 



轮廓显示可以在很大程度上帮助用户辨别切面或截面所在位置，井能形草直观地辅助呈

现物性#数在纵向、横向上的分布变化，如 【"例 5-21 有轮廓显示时切丽的温度云圄分布

如图 10-10 和图 10- 11 所示 • 

• 
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四
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•• 
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H 

•• 

回"叫o ， ，;例 $.2 ) 有轮.的愤饲面温度云图

回 1 0-] I (实例 S-2] 衡轮廓的重切面温度云图

二、速度提量图显示

除了云图与等值线圈外，用户还常用速度矢量图反映流体的运动情况. 执行Display→

Vectors 命令 ， 弹出如阁 10- 12 所示的 Vectors 对话框，该对话握与 ContQurs 对话框相似，

但 Vectors of下拉列表中只有 Velocity 和 Relative Vel田呵，因为只能显示速度矢量困. 除了

Yectors of下拉列表外，还有 Color by 下拉列表，该列表中包吉 Pressure、 Dens町、 Vel国町

等常用#数， 当用户选择其中一个时，显示的矢量图的数值为该#数对应的数值，由于各#

数的取值范围不一，所以颜色呈现不一.通常选择 Velocity. 以显示速度矢量图.对话榷中

的 S町f.c田、 Surfa四Types 与 Contours 对话框中的一样，均为待显示的面且面的类型. 同

样. Options 下方的 Auto Range 11 Draw Grid 用法也与云图显示时一敦.当默认 Style 为

arrow、 Scale 为 1 、 Skip 为 0 时， 突扩营的速度矢量图如图 10-13 所示. Scale 用于改变箭头

的大小， Skip 用于改变箭头的密度，用户可以调节 Scale 且 Skip 以使得矢量圄清晰呈现.

当设置 Scale 为 3 ， Skip 为 5 时突扩管的速度矢量图如圄 10- 14 所示，较阁 10-13 要精晰­

Style 中除了町ow 外， 还有 cone (阻锥体) ~ fi l1ed-arrow (实心箭主1.). harpoon (鱼叉L

headless (无头绪}等种类，如圄 10-15 所示.
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温度失量图 回 10-14 改变""，， 与侃"后的速/J.l限量圃••• 
f忡巾叩

i7 
f善

二.

主b_. 
....,.,., 

因 1 001S Sty 1e 的神贫

....，~ 

-、 流动轨迹且示

非定常问题可以显示流体的流动轨迹，执行 Display→ Pathlincs 命令，弹出如困 1 0- 16

所示的 Pathlines 对话框. Release from Surfaccs 为位于轨迹的初始源面 St叩白白为*度间

隔，用于计算下一微粒的位置 Steps 为步数，通常应为 个微粒能够前进的最大步数 ，

St叩 Si由 与 St叩§的票权近似碍于路径长度. 【 !k例6- 1 】 的轨迹困如固 10- 17 所示.
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四 、 流场函鼓的定义

有时除了要呈现 FLUENT 自带的物性参数分布之外，还需要显示 些特殊的物理变量
分布. 这时就需要借助流场函触的定义，执衍 Define→Custom Field Function Calculat肝 命

令， 弹出如阁 10-18 所示的自定义流场函数对话框. Definition 下方的输λ往会即时呈现出
要定义的函数表达式，但是这里不是从键盘输入公式，而是r从对话框中选取需要用到的数字

或变量， 在 Select Ope阳、d Field Functions from 下方提供了 FLUENT 自带的流场变量，基本

的数学关系且函撒在对话罹左侧可以选择. 如肘 【实例 4-2 】 寇且一个单位体积动他的函

数，则需要依次单击对话框中的 "0"、" "、 "5" 、 "x" 然后在 Select Operand Field 

FW1ctions from 中选择 Dens町， 井技下旦Icd l按钮，接着单击 U X "，再在 Select Operand 

Field Functions from 中选择 Yeloc町，按下旦旦按钮，再次单击 U X "且选择一放
Ve\ocity. 即会出现如图 10-1 8 所示的数字表达式. 最后需要在 New Function Name 中输λ

直且好的函数名称， 单击旦旦到按钮完成流场函数的定义.
定且好流场函数后， Contours 对话框的 Contours of 下拉列表中告出现 Custom Field 

Fun由005... (自定义流场函数)选项， 选择定义好的 四咽，单击E亘国技钮则可见 1 31;
倒 4-2 】 的单位体积动能的云阁，如阁 1 0- 19 所示.
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五、 XY 做点且曲钱回

有时除7需要形草Il观的云图、矢量图显示之外，还需要显示相关变量的坐标曲线图.

这时读者可以执行 Plot-XY Plot 命令 ， 在回 10-20 所示的 Solution XY Plot 对话框中进行

显示世置 . Options 程中的 Pos ition on X Axis 表示位置显示在 x 轴 Plot Direction 栏中的

X、 Y、 z 表示需要呈现变量沿何方向分布，当 X 为 1 时，即显示沿 x 轴方向的变化情况

Y AxÎs Function 下拉列表中为持显示的相关变量， 因前面已经自定义了流场函数，因此这里

可以选择 Custom Field FunctiOT洒 的 ener田 Surfaces 为需要显示的面，对于二维问题

Surfaces 可为线.

我们显示一下 E实例 牛2 1 的单位体积动能沿 x 轴方向的变化情况， 设置如圈 10.20 所

示，单击 Pìii l按钮后动能分布如图 10.21 所示.
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. "…. " 
.....侧

回 10-21 单位体..""泊z 输方向的份布111 10-20 SOI脚帽 XY Pk到对话很

单击 Solulion XY Plot 对话枢中的 _.-J按钮，会弹出如圈 IC如22 所示的 Ax回 Solution

XY Plot 时话桩， 在该时话框中用户可以世置 x， y 轴的数值范围 ( Auto Range 为全范围显

示〉和坐标轴数值的显示格式{浑点数、整数等).
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单击 Solution XY Plot 对话框中的王旦旦按钮， 弹出如图 10-23 所示的 Curv时。lution

该对话框可以帮助读者世置散点且曲线的颜色、显示方式和大小等.

" ‘ 俨 V f j 

… 量 F
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"嘲 -j ' 二l 1- i 

", E 
辆伽.民 h 

」 F 

句…
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r呻h
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回10-22 坐标..设置 回 1 0-23 I院/1&幽俄设置

埠，监 当同时显示多命..伐时，通过改变不同曲曲线的报色和形状可以有效帮"用户分"份钱之间的区别.

10, 1,2 FLUENT 的数据显示与文字报告

FLUENT 提供了很多数据显示与文字报告的工具. 用户利用这些工具可以得到边界流

量、作用力、投"面积、面积分与体积分等. 下面对各功能进行详细介绍.

-、 '毒值设定

在计算作用力系数、力矩、娟、热传递系数等时需要用户世置#考值， 以用于相关物理

量和无因放军数的计篝.

在 FLUENT 中执行 Report-Reference Values 命令， 弹出如囱 10-24 所示的 Reference

Values 对话框， 用户可以手动输入#考值或基于某个选择的边界区域的物理量的值来计算#

考值 【 Compute From ) ， 可以设置的#考值有 Aern、 Dens町、 Enthalpy、 Leghth Pressure、

Temperature、 Veloc町、 D归amic Viscos町和Ralio of Specific Heats 等.
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二、 边鼻流量报告

FLUENT 可以生成所选边界区域上的 3 种不同变量的流量，包括质量流量、且的热流
量和辐射悻热流量.

• 边界上的质量璋量由边界E城各个网格面上的质量班量相jp带到，在个面的质

量擅量等于密度最阻量向速度再革以所在平面的投tí面租.

• 边界上的且热班量由各个面的热在量相加得到 . tc个面的棉流量等于财璋恃热
与辐射换热之和.热施量的计算与计算中设置的边界串件有关.根据模型的不

同，息的熟班量可盹包告对施恃楠、惜的对施通量和睦量的扩散通量等 .

• 边界上的辐射换热量等于每个面上的辐射换热量之和. 辐射换热量的计算取决

于计算中所使用的辐射模型 .
需要注意的是 . FLUENT 在质量和热量平衡计算时，仅仅考虑的是挥过边界而进入和

离开主体的流动 ， 不包括用户定义的体积源或颗粒喷射的作用 . 因此，可能出现质量或热量
不守恒的情况. 那么，为了判定一个包吉离散相的解是否收敛， 读者可以把边界流量计算的

数值与粒子轨迹报告中得到的质量和热量改变的数值相比较，若两者相籍，就可以认为满足

守恒矗件.

生成流量报告的步骤很简单，只嗖执行 Report→Fluxcs 命令，弹出如圈 10-25 所示的

Flux Reports 对话框 I Options 栏中包含丁 Mass Flow Rate (质量流量)， Total Heat Transfer 

Rate (总热流量)， Radiation Heat Transfer (辐射换热量) . Boundaries 列表为持选的在取流

量数据的边界区域. 对于 E实例 6.叶，选择计算迸出口边界的质量流量，单击E豆豆司按钮
可得边界上的流量数值， 井在右下方显示流量，目和的结果. 另外，在 Flux Re阴阳 对话植显

示计算结果的同时. FLUENT视图窗口中也会显示计算结果的详细倍息，如回 10品所示.
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三、 边界作用力报告

FL四NT 可以计算和报告指定方向的作用力及关于选择区域的一个指定中心位置的力

距. 该功能可以用于计算升力革数、阻力革数、力矩系数等空气动力学系数.

边界上的作用力是通过每个边界网格面上的压力和粘性力与指定方向的方向矢量的标量

租相加带到.除了计算压力、粘性力和合力抖，还可以用 Reference Value喝对话框中的#唔

值计算作用力罩数，前面已经对此有所叙述， 这里不再详谈. 作用力罩数被定义为作用力与

单位体积动能什ρv'A l 的商，其中 p、" A 为 Reference Value巧输λ框中给定的密度、速
度和面积.

力矩是通过每个网格面上的作用力绕力矩中心的力矩求矢量和得到的.除了压力、粘度

和力矩卦量之外，还可以计算力矩革数. 力矩系数被定义为力矩与声带动压、#毒面积和#

考-ts::度的商 .

最终得到的力和力矩有两种表现形式=有量纲形式和无量纲形式.

执行 Rcport→Forc目."命令 ， 弹出如图 10-27 所示的 Force R，晤。由对话框 ， Options 在
包含 Forc田 ( 作用力 〉 和 Moments (力炬 l ， 若要生成作用力报告，需要在 Force Vector (作

用力矢量〉程中指定作用力方向的 x ， y、 z 分量，若要生成力矩报告， 需要在 Options 栏选

择 Momen筒， 然后在 Moment Center (力矩中心〉 指定力矩中心的 x， y 、 z 的坐标 . Wall 

Zones 列表中为要计算的待选边界. 单击J主」按钮即可在视图窗口中生成相应的力或力炬

报告 ， 【实例 6- 1 】 的作用力报告如图 10-28 所示.

…「
「
「

W回--「一-一一一」旦

回]0-27 Fottt Rcporu 对话但
hrct' ",",t... : (1 • 1) 
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剿
，

,, • w 

'则• 
旧"萃-翻

• I.l.n",.-I'> I.T...."~- 1I!i • . ...1…t1Z . ..."'.111 
1 . 1117'耻... 5.""…-.. 1.6Il1HW-1'> 1. .:1"15'51 .帽刷刷， .四"四

" 1 . '."嗣... "."1'1...-陈 '.".n…~ .陋'四.51 .刷刷1." ...."'''., 
阳 10.28 [ J<例~" 的作用力报告

四、投影面积计算

用户可以利用 Projected Surface Are皿 对话框计算指定的面沿 x， y 或 z 方向的投黠面

帜. 执行 Report-Projected Areas 命令， 弹出困 10-29 所示的 Projected Surface Areas 对话

框，其中 Projection Direction 为要选择的投靠方向 b、 y 或 z). s町fa四s 为要计算披靡面积

的面. Min F四IilleS因 为最小特征尺寸，用于指定面中最小的几何构形的任度〈若不能确

定最小儿何特征尺寸 ， 也可以使用默认值l. 单击E豆豆按钮， 计算值就会出现在 Area 框和
视图窗口中 . (实例 5-2 1 的 kongtiaobi 沿 x方向的投靠面积为 o刷m2，如圈 10-30 所示.
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因 10-2~ 防.j町tcd S\IIÛI;e Attu对话很 回 10-)0 tII:..菌..报告

五、 靠面积分与悼积分的计算

FLUENT 可以计算特定丽上的场变量， 如面职或质量流率、面职加权平均、质量加扭

平均、丽平均、面最大值和最小值、顶点平均、顶点最大值和最小值等. 面是数据点的靠

告，这些面可能是计算模型中创建的，也可能是用户在后处理过程中定义的.

由于面可以被任意放置在流场中，因此每个数据点处的变量都是由节点值钱性内插值得

到的 . 对于一些变量在网梅节点上的值，可以由或解器直接计算得出，而另外一些变置在罔

格节点上的值 ， m'J通过对网格中心处的值取平均得到.

执行 R叩ort→ Surfa四 Integrals 由令，弹出 Surface lntegrals 对话框 ， Report Type 为所

要得到的报告类型. Field Yariab le 下拉列表为要计算裴面积分的场变量 ， Surfaces 为要选挥

的面，单击E豆豆司按钮则在右下方 Box 和视图窗口中同时显示计算结果. 【实例子2】 进口

的质量流率计算如图 10-3 1 所示.p
c
m
Z
4
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图10-) 1 S田宜邮e Inte.，.ls 对话罐

体积分计算与面职分计算方法相同 ， 主要可以族得指定同格区域的体积或指定变量的体

积积分、体积加权平均、质量加权积分、质量加权平均等. 执行 Repor←Yolume Integrals 

命令 ， 可以打开如图 10-32 所示的 Volume lntegrals 对话框. Report Type 为要选择计算的类

型， Field Variable 下拉列表为要选择计算所晴的积分类型. Cel1 Zones 为要计算的区域，单

击应豆豆目惊钮则得到相应的计算值. 图 1 0-32 即为 I实例子2 1 的压力最大值计算.
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E实例 10-ll FLUENT =维流动后处理实例-一突扩管内流体流动

执行 File→Read→C田e & Data 命令 ， 读入 s14-2.c国和 sI4-2.dat 文件.

(UHI)一事见附带她叫旧阳"、 "Ch4\s14-2 曲"·

(uu)-.见阳光盘叩

-、云圈且每值钱圈

' 执行 Display→Contours 命令，弹出如图 10-33 所示的 Conto町S 对话框， 选择 Contours

。f 下拉列表中的 Pressure 和 Static Pressure ， 句边 Options 下方的 FilIed . 由于本例是二维

问题，故不需要选择具体的面( Surfaces 列表平做选择)，单击l:2!2!到按钮 ， 出现如图 10-

..... 
1õ1 .....~. 
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" • 
• 

厂一一一

M抽

居国旦旦到阳·

图10如34 压强分布云因因 1 0-33 C佣，~对话掘

由于该问题的长宽比比较大，标尺在云图左万显示，占用了视图窗口左侧的位置 ， 值得

云阁显得稍小 些. 这时， 读者可以执行 D;叩lay→Options 命令，弹出如图 10-35 所示的

Display Options 对话框，在对话框的右下角有个 Colonnap Alignment r拉列衰，其中的

Left. Ri刷、 Top、 Bottom 表示云图标尺所在的位置，我们选择 Top 后，单击丘创按钮.

w…… 
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这时在们回到 Conlours 对话框， 再次单击E豆豆1按钮，出现如困 10-36 所示的压强分
布云图. 该云图比困 10-34 的云圈稍大一些，可以使读者更清晰地辨析物理变量的变化. 除

了通过这种方式鼠大云困外， 读者还可以通过鼠标控制来改变云固的大小和万向 . 若想且

大， 则按住中键向右下方框取云团中欲放大的区域， 松开匾标即完成了$.大操作， 如图 10卡

37 所示的$.大云图 . 若想缩小 . m'l按住中键向左上方框取云圈中的部卦区域， 松开鼠标以

完成缩小操作. 对于二锥问题， 还可以按住

剧\C}.)6 云图摒尺在上方的压蕾"布云剧 团 10吗?放大后的局"速度舌帽

选择 Conlours of 下拉列表中的 Velocity 和 Velocity Magni阳巾，取消 Oplions 下万

Filled 的句选， 单击J!E画画按钮， 得到如回 10-38 所示的速度等值钱困.
若觉得回 1 0-38 所示的等值钱比段事，可以在 Contours 对话框的 Levels 下将默认值 20

改小，这里改为 10 时 ， 速度等值线图变为图 1 0-39
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四 \ 0-38 i!!l IWf。‘篇回 回 10叶， 被少簿'应线后的iltI"'{UI回

二、 速擅矢量图

速度矢量阁可以帮助用户辨析流场中各处流体质点的运动趋势，执行 Display ­

Vectors 命令 ， 弹出如阁 10-40 所示的 V四(0"， 对话框， 选择 Vectors of 下拉列表中的

Veloc呵，且在击 Display. 得到如图 10-4 1 所示的速度矢量圈.

若觉得图 10-4 1 所示的速度矢量图丰略清晰，可以调节对话框中的 Scale 和 Sk甲，这里

将 Scale 和 Skip 部改虫 5. 再次单击E豆豆1按钮， 得到的速度矢量图如圈 1 0-42 所示.
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我们还可以将速度矢量图与等值线图重叠显示在一个视困窗口中，此时需要执行

Display→ Scene 命令， 在回 10-43 所示 Scene Descriptìon 对话框的 Scene Composition 栏勾

选Overlays. ij1击旦旦掖钮启动图形的重叠显示.
卦别在 Contours 和 Vectors 对话框中完成速度等值线和速度矢量图的显示操作，

因 1 0-44所示的重量阁.

得到如
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三、 XY 曲线图

执行 Plot→XY Plot 命令， 在困 10-45 所示的 Solution XY Plot 对话框中进行相应的显

示世置.这里选择横坐标为沿 x 袖方向的'"度值，纵坐标为静压强，显示对称轴上的压强曲

线 ， 如图 10-46 所示.
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四 、 立字报告

执行 Report→ Fluxes 命令，弹出如回 1 0-47 所示的 Flux Reports 对话框， 选择 Options

栏中的 Mass Flow Rate (质量流量 )，选取 Boun血时回列表中的 in (进口〉和 oul (出口).

单击庭豆豆司按钮可得进出口边界上的流量数值，井在右下方显示流量草和的结果为 o. 由此
可见， 本例的计算结果很精确，达到了很高的收敛效果. 其他相关文字报告 ， 读者可以根据

实际需要选择生成， 具体生成方法在前面已有阐述，这里不再lIW.

I~川 %I

• 
一』恤-

I 一一旦主~ 同回地

「

因 ' 0-<7 厦量流量通量很告

I 实例\0-2 1 ， FLUENT三维流动后处理实例一一弯管内油水商相流动

启动 FLUENT 三维解算器，执行 Fìle→ Read→Case 命令， 读λsI7.3 .c植 芷件，执行

File-Read• D'Ja 命令， 读λs17-3-mix阳re .d拙 文件.

(u t.")-.见附带她 "Ch7\s旧时'、 "Ch7\s17-3-mix阳re.dat "• 

g豆~一番见附带她"川
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对于三维问题 ， 要显示某一面上的去阁、等值线阁 矢盘阁部 ， 需要先应义而. 执行

Surface• Plane 命令， 弹出如阁 10-48 所示的 Plane Surface 对话桩， 三点确定一个面 ， 用

户需要在 PoinlS下方的 ( xO. yO. zO) , (时. y 1. zl)和 ( x2. y2. z2) ~Il输入三点对应的

坐标，然后在 New Surface Name 中输入定义的丽的名丰 ， 最后单击-生些-怯钮生成该面.

一、 云图E等值雄固

执行 Display→ Contours 由令 . 弹出如圈 1制9 所示的 Contours 对话框，边排 Contours

of下拉列表中的 Yelocity 和1 Ye l田呻 Magnitude ， 勾选 Options 栏中的 Fi ll时， 选摒 Surfaces

列表中的 in (进口面)， out (出口丽〉且定义好的 X甲、 x=-2.S 、 x=O 、 Y.O 、 y'2.5 五个碰

面， 单击且豆豆l按钮， 出现如回 1 0.50 所示的速度分布云图.
此时的速度云阁垂直于槐角 ， 用户可以按住鼠标左键拖动来调节视角 ， 如1闯 1 0-51 所

巧言.
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回 1 0-50 带植面温度z阳 回 1 0-51 回角圃节后的去回显示

由于各截面孤立呈现， 相互位置不清楚， 用户可以通过显示儿何模型的轮廓辈分清各报

丽的具体位置. 勾选 Contours 对话框中的 Draw Grid，弹出如阁 1 0-52 所示(fJ Grid Display 

~-I话框 . 句选 Options 控中的 Edges ， 井选择 Edge Type 程中的 Feature . 设!l Shrink Factor 

为 O . F剧ture Angle 为 8. 且鼻而E豆副按钮，得到的轮廓如图 1 0-53 所示.
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[ /1 11M . _16M .':<11 

吐.

回 I O- S2 Gri~阳刚w 对笛"医 圃 100Sl fIJ"~.蝇示

轮廓显示后 ， 回到 Contours 对话框， 再次单击E豆豆1按钮，可以看到有轮廓显示的各
戴而速度云阁，如!因 10-54 所示. 该云阁的显示 ， 可以帮助用户清晰地辨别各截面的具体位

置 ， 也能清楚地进珩到物理量沿流程的变化趋势.

I扭曲 Options 栏中的 Fi lled ， 使其为非选中状态 ， 选择 Surfaces .YlJ袋中已定义好的 z-h 截

而(横剖面) ， ""击且豆豆l按钮，可以得到如图 10-55 所示的速度等值钱阁.
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二 、 速度提量固

执行 Displ ay→V民WS 命令，选取 Surfaces 如l表中的 z-h 截面 ， 帕E豆国按钮，得
到的矢:m因如图 1 0-56 所示.

改变 Scale 为 3. Skip 为 5，井左键框取弯管段部分以股大速度矢盘阁，如阁 10-57 所

币，用户可以清晰地和到该处流体质点的运动趋势.
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三、 XY 幽蜡固

执行 Plot-XY Plot 命令，在回 1 0-58 所示的 Solution XY Plot 对话框中进行相应的显

示设置.

这里选择。ptions 拦中的 Node Yalues 和 Position on X Ax也世置 Plot Direction 的 X 为

1.其最为牢， 选择 Y Axis Function 列表中的 p，目sure 和 Static Pressu町， 井选取 Surfaces

列表中的 z-h 磁面， 单击Pï;ï l按钮仰jlJ横剖面上的压强曲线 ， 如回 1 0-59 所示.
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四 、 立字报告

执行 Report- Flux自由令， 在 Flux Reports 对话框中选择Opt ions 栏中的 Mass Flow 

Rate. 同样选取 Boundaries 列表中的 m 和J out . 单击岳豆到按钮得到边界上的流量数值， 如

图 1 0-60 所示.
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本例的进出口质量流量相差 O.04769897kg/s . 相比上例硝盖一些， 但也达到了收敛精度

的要求.

10.2 Tecplot 后处理

Tecplot 是一款功能强大的科学绘图软件，提供了多种图形格式，有针对 FLUENT 软件

的专用数据接口， 可以直接读入算例文件和数据立件， 也可以在 FLUENT 软件中选择而和

变量， 然后输出 Tecplot 格式的主挡再导人jlJ Te叩10t 中进行处理.
• 
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10.2.1 Tecplot 界面

Tecplot 界面直好， 工作区 4 部分 ， 如图 1 0-61 1开示.

阳 1 0-61 T，四pl. 界面

(1) 辈1(!栏 : 与一般的 Windows 程序类似， 可以帮助用户完成绝大多数 Tecplot 功

能， 如图 10-62 所示.
[;1. tdit ïi... [lot l hu rt Q6h ''-_. lorkIP.o. 10010 Hdp 
艾 组副 愧 幽 捕 " '现 工 王 " 制 很1 阻 靠集 入 翻腾 作 Jl 助

给 区

制

四 10-但"蛐拦

" 
EE 
附 Z

噩.，

程在 (2) 工具栏 包含丁常用的画剧控制按钮 ， 可以进行常用的画阁控制，另外还可

在 | 以控制帧的模式、活动刷刷刑模式. 如图 10-63 所示 ， 包括帧模式、区域/
鼻 | 阁层、区域放果、童画按钮、工具按钮等部分.
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(3) 状态栏 位于窗口底部，在盹标指针移动过工具栏时会给出帮助提示 ， 如图

10-64 所示.状态栏可以利用 File-Preference 命令进行设定，包括颜色、大小

等，如图 10-65 所示.

IIII!盟! 'i …四 t.1... 

t.o.<k ll" ~t." <<;01 . . 

~;， Ctd唱，叫

1型单到1 1 :-1 "'" ;: 
.,...11....... 

• l' ~.".." ~ 'p 11 阳阳 d
军-，.们 _.t ， ... 

罔 ，.... 状态在 四10-6S P町r，"卧愣 列袤

(4) 工作区 用于绘制和创建图形，在默认的情况下， Tecplot 同时显示网格和标

尺，如阁 10-66 所示， 所有的操作都是在当前帧中完成的.
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1 0.2.2 Tecplot 读取 FLUENT 文件数据

在 Tecplot 中执行 File→ Import 命令，弹出如图 10-67 所示的数据拥载对话框，提供了

可供选择的数据类型，共有 1 2 种，常用的介绍如下.

国国-rrrrr翩翩画面

EPZ 
队

l!l--‘飞g.t， Lod宁
叫. ，.皂… .. 
BL唱:"

、，

国，...， 数辙加貌对话枢

• CGNS 格式，计算班体力学通用证辑革提格式 .

• DEM 格式，数字评价田格式.

• DXF 格式，数字史换格式.

• Excel 表格式.

• FLUENT格式.

• Gridgen 格式.

• HDF 格式，层组晶据格式

巳三ζ:1 C_ol. 一旦u
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• lmage 文件格式，映啤文件格式.

• PLOT3D 文件格式

• Tcxt spreadsheet 格式，文字表单格式.

这里我们只讲解读取 FLUENT文件数据的过程， 其聋的可以盔和专门的 Te叩 10t 书籍.

选择 Select 1m酬 Format 对话框中的 Ftuent Data Loader. 单击~钮， 弹出如图

10-68 所示的 Fluent Data Loader 对话框， 该对话框的上侧选项如下.
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• Load Ca目 and Data Files 如量工程和矗据文件.

• Load Ca四 File Only: 只如草工程文件.

• Load Rcsiduals Only 只如草或是世据.

• L田d Multiple Casc and Data FÎ les 如在多个工程和数据文件.

Optîons 栏槌供了辅助选项，有只加就单元和边界 ， 只加载单元， 只加载边界之分. 在

导λ FLUENT数据时，通常用到的是 Load Case and Data Files . Options 则选为 Load Cells 

and Boundaries. 然后在 Case Fi le 和 Data File 的输入框中输入加载文件的详细路径，或者单

击斗按钮， 从硬盘上选择要加载的文件.

对于某些需要特殊分析的数据 ， 也可以从 FLUENT 中先导出为 Tecplot 敛据 . 在

FLUENT 界面巾 ， 执行 File-Export 命令 ， 弹出如图 1 0-69 所示的输出文件对话植.

对话框段左侧 目lc Type 中为可以输出的文件格式， 政下端即为 Tecpl。数据格式，除此

之外， 还主持 ABAQUS . ANSYS Input、 ASCI1 、 AVS. NASTRAN 、 PATRAN 等常用软件
> I 的数据格式. 对话框中间的 Surfaces 列表为欲输出数据的面. 对话框右侧的 FunctÎons 10 

Write f1J表声~~输出的变量，包括常用的 '"阳山e . Dens町 、 Velocìty Magnitude 、 Streom

Function 等.选择好相应的丽且变量后，单击旦主二揪钮，即可把对应数据输出为 Tecplot 格

式的主件.

在 FLUENT 中完成立件输出之后 ， 可在 Tecplot 中通过 Fi le- Load Data File(s)命令， 读

取刚输出的数据文件来进行处理，如图 1 0.70 所示 ， 选择 v tec . 单击E豆豆1按钮即将
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10.2.3 Tecplot 绘图环境设置

罩统缺省设置的绘图环境可以满足大部分绘图的需要，但悻改绘图环境可以提供更多的

选择， 使所绘制的图形亚加丰富多影.

-、 帕的曹l疆和蛐铺

在默认设置中，工作区仅有一个绘图帧， 用户可以单击工具栏中的E按钮，或者执行

Frnme• Create New Frame 命令，此时光标变成"十字线"形状，用户只需在工作区中拉住
鼠标左键井拖动即可以创建出一个新的绘图帧， 如因 10-7 1 所示.

> 

回 1().7 1 I断锁的创建

创建帧后 ， 可以对其进行移动、删除、改变尺寸等操作. 首先用鼠标J1i击帧的标踵桩，

选中帧时帧的边界舍出现几个黑色万块，移动光标到边界上， 光标扉状变成十字箭盐， 按住

Ii标左键井拖动即可实现移萌操作，如回 10-72 所示. 若移动光标到黑色方块上，光标变成

'
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双向箭头 ， 怯住鼠标左键井拖动可以调整帧的大小. 另外，在选中帧的状态下 ， 按键盘上的

国画键，可以删除当前帧.
观击帧的标题栏可以打开 Edit Current Frame 对话框， 如图 10-73 所示.在对话怪的

Left、 Wîdth、 Top Side 和 Height 中可以输入帧的左边位置、帧的宽度、帧的上边位置和l帧

的高度。 对话框中部的三行分别对应丁边界、标题栏相背景的显示与否且宽度或颜色的编

辑.对话框下部的 Frame Name 中可以输入帧的名称.
烟

一, ,,.. .…_ tt.._ w..叫
.... ... ...;,,-

"" 旷 ..ω矿­
h 岛. .言- 10.... ，-甲

P- 昼.... n，;伽"创忻­

，-‘但 由 - ".
萨_.由- '...旦旦'-.J

f. .. I-.日E画页

n... ... 
阳 10-72 移动帧 因 1 0-73 Ed il Currenl framc对话岖

- 网格与标尺的世定

同棉可以方便地定位对聋，在添加立本和几何图形时可以选择对齐到罔格.标尺可以方

便地放大或缩小对且. 标尺的显示单位可以选择为厘米 ( cm )，英寸( i川、点数 ( pt ) 或者

不显示标尺. 要进行网格与标尺的世定， 需要执行 Workspace→ Ruler/Grid 命令， 打开如图

10-74 所示的 Ruler/Grid 对话框 ， Show Grid 为显示同路 ， Grid Spacîng 为阿格间距 ， Show 

Rule 为显示标尺， Ruler 为标尺的问距.用户可根据实际需要 ， 进行相关世置.

三、坐标系统

Teplot 提供了多个坐标系统， 其中工作纸、帧、 20 和 3D 坐标军统最为重要. 4 种坐标

系的相互关系及原点位置如图 10-75 所示，其中 20、 3D 坐标系统是根据数据集合进行绘制
的坐标系统， 二维间题通常选 20 坐标系统，而三维问题可选 20 也可选 3D 坐标系统. 峭

的坐标茧的*宜比例可以任意调节 ， 但是在水平方向和垂直方向的取值范围为 o '!)J 100 . 

p
c
m
z
4
流
体
分
析
且
仿
真

实
用
教
程

x 
工作纸

坐标系统

:1.7十
' 

'庐 Å • 
"圃'帽i …-咱咀 • • 

三锥坐标系统

• !5Jõi歪王$....画

.~川叫加叫阿~

.~斟.. Il0l)... 11 ;a :.!J 

.Y _ 

• Z 
'眶

二罐坐标系统

E豆::J C_ol 一旦u '真(Ii标系统 x • ‘· 

因 1 0-74 Ru1crlOrid 对说缸 阳 1 0-75 Tecplot坐标系统

3田



10.2.4 Tecplot 圈形及可视化技术

Tecplot 具有强大的阁形且可视化技术，下丽我们对其进行详细介绍.

-、 舌圈显示

执行 file→Ncw Layout 命令 ， 生成新的工作文件.

执行 File- Load Datafile 命令 ， 盯开 Tecplot 圭装 目录下的"Qemo\2 D\ve l田町 plt " 立

件. 此时帧窗口如1匪I 1 (扣76 所示， 只能看到问题的网格 • 

• 

• 

1‘ 
图 1 ().76 同幡显示

在工且在中取消选中 Mesh 直选岖 ， 而选中 Contour 复选枢， 舍弹出如圈 1 0-77 所示的

对话框， 选择 阳RFR. 即可显示出该问题的云圈 ， 如圈 1 0-78 所示 • 

• 

览

图 l D-78 云隙显示回 IO-n con‘ωr De\ailt Wi拮据Z

图 1 0-78 所示的云阁没有标尺 ， 若想添加标尺 ， 需要单击 Contour Details 对话罹中的

」旦立」阪钮 ， 使时话罹展开如图 1 0-79 所示， 选择时话框的 Legend 选项卡 ， 井在 Show

Contour legend iiíf打勾 . 这时的帧窗口中叩包吉了云图的标尺 ， 方使用户读数，如阁 10.80

所示.

洼滥 用户可以在 Contour Deta ils 对话柜的 Levels 选项卡中设置标尺的问觅及密庄， 默认为 10 个刻且.

二、 等值钱图显示E搬据标注

等值线图是在云图之上建立的 ， 在上述云图之上 ， 单击工具栏中的」旦旦止~章钮 ， 弹

出如!回 1 0-8 1 所示的 Zone Sty le xt~框. 单击对话框中的~钮，伸出包宫 Lin町、
Fl00d. 80由Lines & F I∞d 、 Average Cell Flood 和 Primary Yalue Flood 的下拉列袋 ， 这里选

择 80th Lines & FI回d. 即同时显示等值线与云图.
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在对话框中，还可以世置等值线的线型、颜色和宽度等#数， 以达到蝇佳的显示效果.

• 单向ne Style rii!框中的主l按钮，弹出如困 10.82 JIi幸的对话框，用户可
<;).!J.中选择想要显示的等值钱颜色.

• 单击 Zone Slyle 时话框中的主主陆钮，即出现如固 10-83 所示的下拉列章，用
户可以从中选择 Solid ( 实蝇). D国hed (虚线)， DashDot (点划蝇). Dotted 

(点姐). LongDash (长盛蛙)和 DashDotDot (点划点蝇)靠靠型.

,--

'" ... 

因 10.83 貌'自罐"11110-82 色'彭远"

• 单击Zone Style n语框中的战悔钮，即出现如回 \0斟 所示的下拉列章 ， 其
中告有 0.02. O. \. 0.4 . 0.8 和1.5 等最直.此时的等值姐回如固 1 0-85 所示 .



~ I[ID 
。但 '庐

'‘ 

回 10-" 烧宽选知 园"的等值线图

违章 在云图色彩变化极大时，等4直线乌云图同时显示则不太清楚，这时可以选择 Lìnes 只显示等值轮廓

线

若想在等值线上加注数据， 用户需要打开 Contour Detail s 对话框 ， 选择 Labels 选项

卡， 井在 Show Labe l s 前打勾.若显示的数字太小， 还可以调节 Font 到告适数值来放大字

体， 加注数据后的等值线图如图 10-86 所示.

> 

在

回 1 0-86 加注数'匠的簿值钱回

一、 速度提量图及迹线图显示

延续上述问题， 在工具栏中取消选中 Contour Jl选框， 转而选中 Vector !l.选框 ， 均时舍

弹出如图 1 0- 87 所示的 Select Variables 对话框 ， 保持 U 为 U甩FC. V 为 VIRFC 的默认世

置， 单击」巳』宝钮.
此时， 帧窗口中的速度矢量图如图 10-88 所示 ， Tecp lot 默认的颜色为红色， 不能反映

速度的大小， 所以应对其进行着色.

国国圄国 岖'
n.. .......叫0l0i... .... M' ...f; ao(. 
CM... 山........_;斟"
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• 
" I '/M 一一----:=J
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四 10-88 I民认颜色的速度矢量图因 1 0-87 Sc lttt Variables 对话枢

笛'
同
意

流
动
分
析
后
处
理



p
c
m
z
→
流
体
份
新
及
仿
真

实
用
餐
程

304 

单击工具栏中的二旦王坐μ』古钮，弹出如图 10-89 所示的 Zone Style 对话框，单击对话框

中的主l掠钮 ， 在弹出的颜鱼选择对话框中选择多色 ( Mult忡，然后单击豆豆豆J阳
关闭 Zone Sty le 对话框. 这时的速度矢量已经披着色， 如图 1 0-90 所示，用户可以消晰地辨

别各点速度的大小.

流动迹线是在速度矢量阁的基础之上绘制的. 单击工具栏中的u按钮，然后在速度矢

图上上下拖动鼠标光标， 便可以绘制出如图 1 0-91 所示的迹线图.

区I
·州 1 <__ ，..，.. 1 ...".. 1 ..... 1 ......， 1 凯 、 I ... .~.. I 

,­
h 

.坐」

四 10-89 Z拥c Stylc 对话枢

' 

黯

四1也91 1Æ烧圆

>Z

圈 1 0-9(1 精包后的遗度矢量图

建意 当速度矢量剧较密时，上.，-1也动鼠标有时会生成很密的注线图 ， 这时可采取挚击若干个失量朱生成

校疏的迹线.

四 、 XY 曲线图显示

执行 Fi1e-New Layout 命令， 生成新的工作文件. 执行 File→ Load Datafi1e 命令，打开

Tecplot 圭装目最下的 "Demo'飞X叭rainfal l. plt "文件. 在工具栏的帧模式中选择 XY Line. 其
图层格式有直线式、符号式、柱状式等 ， 如图 1 0-92 所示. 此时帧窗口中的 XY 曲线如阁

10-93 所示， 只有矗曲线.

历 L.i". ::!J 
.., 4'.... 
'"' L.i" .. r S,.h. h 
r .险，缸'隘
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1 南队

2 
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&晌 [

四 10-92 XY Line 锁..式 圃 1 0-93 XY 曲线



单击工具栏中的1，_;.. " 71• H愤钮， 弹出如阻 10-94 所示的对话框，单击 Map Show 选择下

拉列表中的 Activate 以激活 Oallas RainFall 和 Miami Rainfall 曲线，如图 \0-95 所示.

若选中图层的符号 (Symbols) 显示，可在 Mapping Style 对话框的 Symb Shape 中选择

不同曲线点符号的样式， 选择 Seattle Rainfall 曲线点样式为 Square ， Dall国 Rainfall 曲线点

样式为 Delta ， Miami Rainfa l1 曲线点样式为 Circle ， 曲线图即可变成如图 10-96 所示的形

式， 以方便用户进行分析.

阴1伽94 Mapping Style 对话幢-a
.
,,

,
,
a 

-3

2l 

il

i
a--la 

5·z

,,

2

, 

-321 1·
li

ii! 

.. .. E 
M 

-"---,, E睛
罔 1 0.95 三条 XY 幽俄 因 10-96 倍'ff点样式的曲线图

五、 三维流场圆显示

三维问题的云阁、等值钱图、矢量图的处理方法与二维 样.针肘三维数据， Teo币101

还有特殊的绘图格式 围墙图 ， 其形状类似于用围墙将平面分割成许多小格子.

围墙而的数据可以是 IJ 有序数据 ， 也可以是 1 ， J, K 平面和 IJK 数据 . 围堵面的特别

之处在于要绘制出底面数据，然后绘制出垂直于底面的数据作为围墙，井把面分割成小格

于.下面我们介绍围墙阁的绘制.

执行 File→New Layout 命令，生成新的工作文件. 执行 File→ Load Datafile 命令，打开

Te叩101 圭装目录下的 "Demo\3D 飞lolume旧uid . plt " 文件. 取消选中工具栏中的 Mesh 直选

框， 而选中 Contour U.选框 ， 在回 10-97 所示的 Contour Details 时话框中选择 v" 为 E .

单击旦旦三弦钮，关闭 Contour Details 对话框 ， 此时的云图如图 1(弘98 所示.

卜 l
匾"'___ 11 

回"弘97 Contour Oetai ls 对话枢 回 10-98 三维云惆

第
山
章

流
动
分
析
后
处
理

3且5



下面进行回描阁的具体绘制. 单击」旦 ...ιJ查钮， 在固 10-99 所示的 Zone Style 对话框

中选择 Surfaces 选项卡，然后尊击 I t'1t;; It;c钮，在下拉列表中选中 j.J-K-plan白，此时可以
看到只有 x 万向有了阻捕面， 如图 10-1∞所示.

1 E 
-. ,.;... 

阳刚.

，dóìlííil喃喃

隘ι·国

回

.宝-1

阁 ，俗" 7_臼"，对话"医 倒 1 C).. I(IO 只有x 方向的罔蜻萄

接着llt们需要调节回墙阁的范围. 在 Zone Sty le 对话框中的 Surfaces 选项卡中 ， 单击

主主战钮， 弹出如阁 10- 1 0 1 所示的 En阳 Range 对话框， 改变 Skip 为 5. 单击 "
钮. 同理 ， 时旦旦按钮， 也将其 Skip 改为 5 . 单击旦旦酬，将其 Skip 时lJ Mx. 

最后雄奇工具程中的#按钮，将图形调至合适视图 ， 如!因 10-102 所示.

人，
恤翩翩 口p
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「一一

... 
F一一 KA H 

C王三，-- 一旦LJ

阁 1 0- 1 01 穗，.~定对"德 阁 1 (). I02 削'"..敛'民

违章用户可根据实际需要调*" Rang for J.Planes ‘ J-Planes. K-Planes 中的Bcgin、岛、d 和 Skip .

【实例 1 0-3 l Tecplot 二维流动后处理实例-一突扩管内流体流动

执行 File- I mport 命令，选择 Select Import Fonnat 巾的 Fluent Data Loader，单击句空」

按钮. 在弹出的时话桩中选择 Load Case and Data Files . 然后单击 Case File 和 Data Fi le 输入

框右侧的J除饨，从硬盘上选择要加娥的主件 " sI4-2.cas" 和 " sI4-2 .dat 飞 单击~Iíi

钮.

(U<.II )一参见附带她 "Ch阳14-2 旷、 "C则叫at"• 

(uu)一，见附带她 "C川.v~ll叫VE "·

-、 王固

数据文件导人 Tecplot 后，默认只显示网格及边界， 如阻 1 0- 103 所示. 圈中 x. y 轴的

范围均是 0-4. 而本例的长直比比校士， 所以呈现出挟仕的图形. 卫由于本例是对称问

题，所以只显示丁模型的一半网格.

3时
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3‘ 
回 1 1). 1 03 嗣。入敛据文件的倾懊陶

单击 x 轴Iæ y 轴，使其显示为黑色方块包裹的状态 ， 然后双击， 弹出如图 10-104 所示

的Axis Deta i1s 对话框，在 Rang 选项卡中设置 x 轴与 y 轴合适的尺寸范围，得到如回 1 0

105 所示的网格图.

暖 I
1"' _ ....i. íx豆

'曲曲1.0.. .. .. 
_ tr ,. t ,,.. ..-

胁 . 一圄 -.-1 
... ~ . 圄

1:1 þ......叫-_.… r
「 阳.. ..i. ,....". 
…一俨…
彼一

I J,o I .. ,;. 

r一 > 

r ~_山曲崎皿...._. ‘ . ，. y,‘ 

豆豆二 一些」
附f]1). 104 Ax i$ 0由ils对话幅 图 1 1). 10S 改变鳞'示'由尺寸施阴后的网格回

执行 Data→Create Zone- Mirror 命令 ， 在回 10-106 所示的 Create Mirror Zone 对话框

中选择 Mirror Axis 为 X-Axis ， 选择 Source Zo 叫。中的 nuid ， 1'(1甜可"'..按钮，即合生成
镜惶区域 M盯町。fZone 1 . 然后按照同样方法，依次生成 Source Zone(s)中 bimi四、。"' 和 l

m 的镜惶 ， 这时的网格闺如图 1 0- 1 07 所示.

I "." ..".., "fi 军 .
酌.... .... 件旦主Fl

" ，幅"
俨 E 缸"

口百三盯m丁

lQl1至::ïI -"巳J _旦t..J

回 1 1). 107 ..后的网格图回 11). 106 crute Mirror zon而对话报

在工具栏中取消选中 Mesh :!l.选框，选中 Contour 直选框， 在弹出对话框的 V'" 中选择

Pressure. 即显示出该问题的压强云圈 ， 如阁 10- 108 所示. 接帮单击 Conto田 Details 对话框

钮，选择 Legend 选项卡，井在 Show Contour legend 前打勾 ， 得到有标尺的云

阁，如阁 10-1 09 所示.
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阑 1 0- 108 压翻云剧 团 1 0- 1 09 有标尺的血债云副

改变 Conlour Detai l s 对话框的 v... 为 X Yeloc町， 可得速度云阻 . Jm圄 1 0- 11 0 所示.

?咱

主自 | 圃 10- 110 建厦云图

量 雪 | 二 、 等值线图且挝值标注
吨 | 单击工具栏中的且且应钮， 弹出 h叫叫话框·
在 | 在Conlour 选项卡中 ， 选择 Zone Name 中的 f1uid ， 单击匡哥按钮，应择 8。由 Lines & 

在 I F1耐，即同时显示等值线与云图 . 然后帖主j按钮，将等值线颜色世置为捕鱼.
真 | 同理， 选择 。uid 的镜惶 Mirror of Zone ) .单击~按钮， 选择 60th Lin田 & F1时，

3田

然后也将其等值线颜色设置为黑色，此时的等值线阁如阁 10- 111 所示.

接着打开 ContQur Oetails 时话眶， 选择 Labels 选项卡，井在 Show Labels 前打勾 .

Tecp lot 默认的 Font 为 1 .5% . 宇件太小，我们可以将其调节到告适数值来放大字体 ， 比如1调

节到 3 .5% . 对于得值钱枝苗时， 加注的数据全显得过多，这时我们可以特 Labe ls 地项卡的

Level Skip 调大到古适数值， 比如调至 4. 此时加注数据后的特值钱阁如阁 10-112 所示.

> ' 

1111 0- 111 司'值 ..10 111 10- 112 细注敛'随后的等。，..回



• 

三、 速度矢量固血迹钱图

在工具程中取消选中 Contour 直选框， 选中 Vector 直选框. 此时， 帧窗口中的速度矢量

图如回 10-113 所示， T，四plOl 默认的源面颜色为红色， 镜悻颜色为粉红色，均不能反映速度

的大小，

" 

x 
11110.11) ~J筒速度矢量图

单击工具栏中的」旦且一血钮， 弹出 Zone Style 肘话框，选择Zone Name 巾的 nu;d ， I I 
单击对话框中的剧协钮， 在弹出的颜色选择对话框中选择事色 ( Mu1tD . 然后按照同样的川 | 
方法世置 fluid 的镜悔 M盯or of Zone I 也为多色显示， 最后单击 Closc r:按钮l关闭 Zone Slyle I ~量 ' 
用话框. 这时的速度矢量已经被精色， 如图 10- 114 所示 ， 用户可以消晰地辨别各点速度的 |塑
大小 . 量第

崎工具栏中的叶钮， 然后在速度矢量图中单击若干个矢量，便可以绘制出蛐 1 0- 悔:
l1 S 所示的迹线图. I ~ 

> 

四 1 0- 114 着也后的遮lI~.嗣 阳 10叫" 施鲍搁

四 、 XY 曲线圈

首先从 FLUENT 中导出要处理的数据士件，执行 File→ Export 命令，弹出如阁 1 0- 11 6

所示的输出文件对话植. 选拇对话框最左{lIJ File Type 中的 Tec币10' 数据格式 ， Surfaces 选为

duichenzhou , Functions 10 Write 选为 X Velocity . 单击主主二隙钮， 把管轴线上的x方向速度

输出为 sI4.2.v 1皿 p1' j(件. 在 Tecplol 中通过 File→ Load Data File(s)命令，读取 sl4--2-

v _lec.plt 文件. 在工具栏的帧模式中选择 XY Line. 固层格式则同时选择卫线式和符号式两

个直选框.
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回 1 0- 117 M每酬地'"怡对话帽

单击 x 或 y 轴，使其显示为照色方块包裹的状态后双雨，在弹出的 Axis Detail s 对话框

中调节 x 与 y轴告适的尺寸范阁，仰到如1图 1 0-118 所示n<J XY 曲线图 .
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【实例 10-4】 Tecp10t 三维流动后处理实例 弯管内油水两相流动

执行 File→ Impor1 命令 ， 选择 Select Import Format 中的 Fluent Data Loader. 单击-丘」
按钮.在弹出的时话框中选择 Load Case and Data Files. 然后单击 Case fi1e 和 Data File 输入

框右侧的斗按钮，从硬盘上选择要加载的文件 "sI7-3.cas" 和" sI7-3-mix阳re.dat ".单击

-巳J按钮.

‘ 

(.....11)-.见附带她 .Ch7\s17-3 旷、 uCh7\s17-3-mixture.dat". 

('IIIU )一参阳光JIt .Ch l川ful1 0-4.avi n . 

导人数据文件后的帧砚图田口如图 10-119 ， 弯曹模型呈畸形显示 ， 故需要调节坐标轴

的范围.

A 

回 10- 1 1 9 。入'度'属文件后的锁搜回

单击 x、 y 或 z 轴，使模型区域被黑色方块包裹，然后双击，弹出如阻 10- 120 所示的

Ax is Details 对话框.在 S ize Factors t'JCJ Z 输入框中输入 1.1 845 1 7 ， 得到正常显示的模型 ， 如

阁 1 0- 121 所示.

.，咀 u_

"- .;. 
· 田__ --11 
.... .. ....高高一-1

." ". 
d些旦旦旦J

山

A "b.._ ~_""....... r 
r 

… '1"&.'" 
r一 l r-Il 

， .--圈
， .百而言圄

110. ，因削-，

俨一
.四…
俨 m~… r-:-:o 
旦旦旦旦旦旦

E王三2 咆」

阁 1 0- 1 20 Axi! Detai ls !tf悦倔 回 10- 121 正常蝇示的同精削

、 云图

在工具程中取消选中 Mesh !l.选框 ， 选中 Contour 直选框， 在弹出对话框的 v.. 中选择
阶.ss山e ， 即显示出该问题的Bi强云图 ， 如图 1 0-122 所示.

这里的云图只能看到外表丽的分布情况，不能体现内部的变化. 因此， 在们仍然果取切
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面的形式来呈现沿梳理不同横削面上物理变量的变化情况.

在 FLUENT 中导人 usl7.3.c田"和 usI7.3.mixture.dat" 文件，执行 File→ Expo民 命令，

弹出 Ex阳" 时话框. 选择对话框.Q左侧 目le Type 为 Tecplot 数据格式， 在 Su巾C臼选择

U i n "、 u out"、 "x-p"、 u x=-2.5"、 "x=O"、 " y=。"且 "y=2.5" 7 个截面 ， functions 10 Write 选

为 Velocity Magnitude . 单击......二做钮，把 7 个截丽上的遮皮输出为 s17-3-v_tec.p1t )(件 . 在

Tecplot 中通过 File→Load Data Fi l e(s)命令， 读取 sI7-3-v_lec.plt 文件，得到如困 10-123 JI1示

的帧视阁.

A A 

回 1 0- 1 22 三罐E区司云 111 11110- 123 7 个德面的间幡圈

同样，在工具栏中取消选中 Mesh 直选框，选中 Contour !l选框， 在弹出肘话框的 V"

中选择 Vel田町-magm阳出，得到的速度云图如圄 1 0- 124 所示.

1111 0- 12" 7 个偏面的速度云图

二、等值钱图

在上述圈彤的基础之上.lf'-击工具栏中的~"丘~按钮，弹出如图 10- 125 所示的对话

据. 在对话恒的 Zone Name 中选择 m. 单崎击E亘按棚钮'设甜置其蛐棉式拙为 Line酣e也帕韭l除舷
钮'设置其颜色为多彩显示 (Multi Co!or) . 按照同样的方法世置其余 6 个截丽的显示方

式，得到如圈 10-126 所示的速度锦值钱图.

己豆王3 一旦.w
回 1 0-125 .zo，晴 S~. 刘说"



白一一• 
• .. 
" " " .. 
" " 创
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国 10- 126 7 个a画面的速度等值线图

若用户想得到更消晰的速度沿程分布情况， 可以绘制沿轴向横剖面的二维图形.

在 FLUENT 中输出轴向横剖面 ( z-h ) 速度 ( Veloc町 Magnitude) 的 Tecplot 数据 ， 即

选择 Export 对话框最左侧 File Type 为 Tecplot 数据格式 ， 在 Surfaces 选择 z-h. Functions to 

Write 选为 YoJ阻ity Magnitude ， 单击旦旦斗按钮， 保存数据文件为 sI7-3-hv_tec.plt . 在 Tecplot

中通过 File-Load Data File(s)命令，读取 sI7-3 -hv t四 plt 立件，得到如图 10-127 所示的帧

槐图 .

此时的视图仍默认显示的是同格，在工具栏中取消选中 Mesh jl选框， 选中 Contour 复

选框， 在弹出对话框的 y"，中选择 Velocity-magnitude . 即可得到该横削面上的速度云图.

接着单击工具栏中的二旦卫生.CJ按钮，在弹出时话框的 Zone Name 中选择 z-h . 单击

~钮，设置其格式为 Lines，单击旦旦按钮 ， 设置其颜色为多彩显示 ( Multi Col时，
此时的速度等值线如图 10- 1 28 所示.

g 

• 
3 

2 

' > 

f 

。

自ty
4 , 但 2 

x x 
回 10比127~民侧面网格 困 1 0-128 惯例面速度等值钱阻

若想对等值线进行数据标注 ， 可以在 Contour Details 对话框的 Labels 选项卡中进行相

关世置， 前面己有详细讲述 ， 这里不再重复.

三、 速度矢量图

在工具栏中取消选中 Contour !l.选框 ， 选中 Yector 直选框. 弹出如图 10- 1 29 所示的

Select Variables 对话框， 在 U 中选择 X，单击」巳』按钮.
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因1 0- 1 29 se四v.;份幅对话植

此时，帧窗口中的速度矢量因为红色显示， 单击工具程中的」旦旦豆!..c..l按钮， 弹出Zone

Sty le 对话框， 选择 Zone Name 中的 时，单击对话框中的到按钮，在弹出的颜色选择对
话框中选择多邑【 MultD . 这时的速度矢量已经披着色，如图 1 0- 1 30 所示， 用户可以清晰

地辨别各点速度的大小. 为观察哥管用部段的速度矢量， 可以利用鼠标中键且右键调整槐

图 ， 得到如图 10-131 所示的局部放大阁.
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:‘ 
四 10叫 30 速度矢量回 图 100lll 莓'局部段的遮虞矢量图

建慧 除了鼠标中链和右键可以龙成图形的放大和移动撮作外，工具拦上的I育及f+校钮也可以精麟读者
在咸丰这楝作.

103 本章小结

本章主要讲述了流动分析的后处理， 介绍了 FLUENT 且 Te叩101 软件的后处理功能，通

过两个实例的讲解，帮助读者认识和利用 FLUENT 且 Te叩l时 进行模拟结果后蛙理的操作过

程， 了解 FLUE刑T 且 Te叩101 对同样的实例进行后处理的区别 ， 学会如何进行后处理操作以

得到地佳的分析结果.

/雪
s/幸

:> FLUENT 的后处理功能.

:> Tecpl时的后处理功能.

> 利用 FLUENT 且 Tecplot 软件进行后处理分析的推作过程.
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第 11 章

UDF 使用及编写

对于一些草杂的初始条件、边界串件、物性垂数等，用户可以自定义相关程序导λ

FLUENT 中使用 . 这类用户自定义函数称为 UDF (User.Defined Function. 简称 UD凹，是

用户自编的程序，可以植动态地连接到 FL四川求解器以提高束解器的性能.

标准的 FLUENT 界面井不能满足每个用户的需要， UDF 的使用可以定制 FLUENT 代码

来满足用户的特殊需要. UDF 用 C 语言编写 ， 使用 DEFlNE 宏来定义 . UDF 可以使用标准

的 C 语言库函数， 也可以使用 FLUENT 提供的预定义辈 ， 通过这些预定义章可以获得求解

桔得到的数据. 自定义函数通过解释成编埠导人 FLUENT 中使用 ， 主要用于定制边鼻条

件、材料属性、表面和体积反应率、源项函数等.

恩曹 UDF 在 FLUENT 中有广泛的用途，但是井非所有的情况都可以使用 UDF，官井

不能访问所有的变量且 FLUENT模型.

本章将介绍 UDF 的基础知识， UDF 宏且 UDF 的解释与编译，使读者了解 UDF 的基本

理论. 在此基础之上， 通过一个实例讲解 UDF 的基本使用方法， 帮助读者掌握 UDF 的基本

用法且相关操作过程， 为实际工程运用奠定基础.

• 用户自定义函数<UDF ). 
• UDF :i. 
• UDF 的解军事且辑译.

主主主旦
• 槽进内箱体运动的 UDF 应用 • 

.. 田 ~....:.;..，.，.→一霄，耳国 ; ，adER j



11.1 用户自定义函数

用户自定义函数允许对 FLUENT 进行个性化设置 ， 这对充分发掘 FLUENT 在功能上的

潜力意义深远.下面我们首先介绍 UDF 的基础知识.

11 .1.1 UDF 概述

p
c
m
z
→
液
体
分
析
及
仿
真

实
用
数
程

UDF 由 C 语吉编写 ， 可以被 FLUENT 求解器动态地加载， 从而增强 FLUENT 软件的

现有功能 . UDF 通过 DEFlNE 宏定义，所定义的函数使用预定义章和函数从 FLUENT 求解

器中访问披据. 每一个 UOF 都要在程序的开头包含 udf.h )(件(削nc1ude .. udf.h勺，使得

在程序编译过程中 . DEFlNE 军以及其他由 FLUENT 提供的主和函数所定义的内容都能被

引用. 在 FLUENT 中 ， UDF 作为解释的或编译的函数被执行. 不论是 UDF 传送到求解器

的值， 还是被求解辑返回到 UDF 的值， 都必须使用国际单位制.

在 FLUENT 中， UDF 可以完成各种不同任%- . 如果它们在 ud拙 文件中没有被定义为

void，那么它们可以退回一个值. 如果官们没有返回一个值， 它们还可以佳改一个哑元，或

修改一个没有被作为哑元传递的变量， 或者借助算例文件和数据文件执行输入输出任务. 概

括地说. UDF 能够完成下列任务.

• 返回一个值.

• 修改一个哑元.
• 返回一个值同时修改一个哑元.
• 静改一个世植作为一个哑元进行传递的变量.
• 从算例文件或数据文件中写入!t读出信息.

UDF 允许对 FL四川进行特殊设置以便满足边模的特殊需要，其实际应用如下.

重新设置边界条件、材料特性、最面和体积反应速率、 FLUENT 辅远方程中

的罪事，自定义标量 (UDS) 输远方程中的罪项和扩散面世等.

• 在每攻选代计算后调整计算结果.

• 解的韧始化.
• 根据计算要事，非同步执行 UDF.

• 加强后处理过程.
• 加强 FLUENT 中现有的物理模型(例如离散相模型、多相混合物模型、高散
点辐射模型).

UDF 的源文件只能以扩展名 "c'F 保存. 通常源主件中只有一个 UDF 函数，但是也允

许在一个文件中包啻多个前后相连的 UDF 函数.源立件在 FLUENT 中既可以被解释也可以

被编译. 对于解辑型的 UDF ， 源主件将直接被加载和解释 而对于编译型的 UDF. 则首先

要建立一个共草的目标模块库，然后再把它加载到 FLUENT 中 . 旦解释或编译了 UDF ，

相应的 UDF 名字将会在 FLUENT 的视图窗口中出现， 井且在相应的对话框中通过选择这个

函数将其连接到一个求解器中 .
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11.1 .2 网格拓扑

流场的网格是由大量控制体或单元所构成的. 每个单元是由一组网格点(或节点 J ，

个单元中，e，..和包围这个单元的面所定义的，如图 11-1 所示 . FLUENT 使用内部数据结构定

义同榕的域，井将单元、单元面和阿格中的节点按序排列 ， 从而建立相邻单元之间的连通

性. 钱程是 FLUENT 中数据结构的内部名牌，它用来表示一个〈边界或单元〉区. 单元钱

程是单元的组合，面钱程是丽的组合. 域是 FL山NT 中数据结构的内部名称，它被用来表

示网格中的节点、面和单元钱程的组合.

\ 
可防点

·元
命心

v" 

面

单元

1盲点

边

面

简单二健网幡 简单三.网'备

'自 11-1 网格组分

单元和单元面组成代表流场各个部分的区域〈进口、出口、壁面、流动区域等 J. 一个

面围住的是一个还是两个单元(用 cO 和， 1 加以识别〉取决于它是一个边界面还是一个内部

面. 如果是边界面， 那么仅有呻存在 (对于一个边界面， 不定义 cl );如果是内部面， ~IJ 

需要同时定义 础和 cl 单元.一个面两侧的单元可以属于同一个单元钱程 ， 也可以属于另一

个单元钱程.

FLUENT 的罔格拓扑束语如下.

• 单元( cell )告有植制体的分离墙.

• 单元中心( cel1 center )存储单元世据的位置.
• 面( facd。单元(二蛙]jt三维)的边界.

• 边 (edge) 面(三蛙)的边界.

• 节点( node ) 网格点 .
• 单元钱章( ce l1 thread ) 分配了材料数据和罪项的单元组 .

• 面蝇章( face thread ) 分配了边界散据的面组.

· 节点最章( node thread )节点组.

• 区域( domain ) 节点、面.单元盟章的组合.

11.1.3 数据类型

除了可以使用 C 语言数据类型编写 UDF 之外，还可以直接使用 FLUENT 指定的与束解

器数据有关的数据英型，常用的数据类型如下.

• Cell t是盟章内单元#识特的..据提型，是一个识别给定量章内单元的整矗章引.

第
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q
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用
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• Face_t 是蝇章内面标识样的姓据英型，是-个识别蜡定盟章内面的盛世章引.

• Thread 是单元直面的组合相关的歌据容器.

• Node 是单元蝇面的据角相关的世据容器
• Dom刷n 是 FLUENT 最高水平的矗据结构 ， 是一个与网掉中所有节点.面和单

元蝇章组合相关的最据容器.

11.2 UDF 宏

UDF 宏主要包括访问 FLUENT 变量的预定义宏、实用工具宏和常用 DEFINE 宏簿 ， 下

面将卦别介绍-

11 .2.1 访问 FLUENT 变量的预定义宏

FLUENT 提供了一革列预定义函数来从求解器中读写数据. 这些函数以茸的形式存放

在代码中. 可以存取 FLUENT 解算器中变量的预定义章有单元宏、 面宏、儿何图形宏、节

点宏和$相章等.

单元宏

单元宏是由求解辑返回的实数变量，井且这些变量都是定义在一个单元格中的.

( 1 ) 访问单元流体变量的宏，如表 11.1 所示.
p
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褒11-1 在 mem.h 文件中的流体置量宏

"发费型 温回值4昆德 (.IU

celU c,ThrcadO

‘ 温度

温度."'，晨'‘
温lt.dI:*t的分重

C_T(C,I) 

C_Tß(C,I) 

C_T_G<C,I)(i) 

C_T_RG(ε.自}

C_T_RG(c,I)[ i] 

C_T_MI (c，。

C_T_;阳(c，l)

C](C ,I) 

C_DP队'j

Cßp(c,l){i] 

C.U{仇。

C.V艇.')

C_ W(C,1) 

C_YI(c,t.i) 

celU C,ThrcadOl 

celU c,Thrcad. t. inl i 
-< 

"遮后的温度"鹰，电.

读边后的温11.11'思量的分量

温度的"-~iP民

"'"的阳二次"'*

↓ 压力
.~ 

压力"虞矢.

压力.."'，眩晕的份.

" Ji~司的埠'"

，方向的选皮

celUc厅、.... . ，

时Uc，l、n"气，时'

.J ~I吧
cdUc，引"'..吨， lnl 1 

cel1_1 c, Thrcad .1 

celU c,Tltread. ' 

<<IU‘ '.τ、rcad . l w方 "1 Q\'J温度

.....分a院

副槐运动鲍

涮派运劫"的纱'配...

<<IU民""""飞回且

C_K(C,I) 

Cß(C,I) 

<<IU c，l在rcad. l

<<IU也，Thrc:ad. l
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罪 ll.l 中有 G、 RG、 Ml 和 M2 下标的单元格温度的宏可以应用于除了单元格压力

(C-P ) 外的所有求解器的变量中.这几个下标分别表示矢量梯皮、改造的矢量梯度、前一

次的步长和前两次的步长. 而对于单元格压力，它的矢量梯度和相应的分量是使用 C DP 得

到的， 而不是 C]_G. 每个下标的描述和用法如下.

• ，章写梯庄矢量及其#量. 在章中加λ下标_G 可以得到梯度矢量和它的分量，

例如 C T G ( c，仆 可 H返回单元格的温度梯度失量. 需要连章的是只有当已
经卓解出包告这个变量的方在时才能得到棉度变量. 例如定义了一个关于盹量

的罪程序，那么所骗的 UDF 可以使用 C TG 来读写单元格的温度梯度，而不
能使用 C_U_G 读写 x 方向的速度分量. 在调用梯度失量时把某一分量作为参

盘，这样就可且得到梯度分置了，其中，参盘 。 代表 x 方向的分量， 1 代表 y

方向的分量， 2 代表 z 方向的分量. 例如 C T G(c，t)[O]可以返回温度掉皮 x 方

向的分量

• t章写改造过的掉度失量和其分量. 通过如下标 RG 可以在章中得到改造过的

棉度矢量和其分量. 通过使用恰当的整世作为参数来获得想要的矢量分量. 当
完成自己的插朴计划时可以使用改造过的棉度 改造过的温度梯度和其分量在

最 II斗 中列出了，可以推广到所有的变量. 要违章的是改造过的梯!t矢量和

棉度失量一样都只有在梯度方在世草解出来时才可以得到

· 读写1世-止步长时间下的变量值. 在茸中如入下标 Ml 就可以得到前一攻步

长时间下 ( t- 6 1) 的变量值，得到的这些世据可以在嚼在模拟中使用 . 例如，

C T Ml(c，。可1)(返回前一步时间下的单元格温度的值.
• -1:章写前商在步长时间下的变量值. 若在章中加入下标 阳 就可以得到前两攻

步长时间下 ( 1.26 1 ) 的变量值

(2) 访问导数的宏， 用于读写速度导数的章 ， 如表 11-2 所示.

褒1 1-2

返回<1

U迫II对 z方向的导徽

U速度对y方向的导数

U速度对 z 方向的导'段

V速度对x方向的导数

V速度对y方向的导数

各称 〈唱"自 〉

CßUDX(c,t) 

C二DUDX(c，。

CßUDZ(c,l ) 

CßVDX(c,t) 

CßVDY(c，。

çclU 队币、read' l

CßVDZ(c,I) e地"_t c,Thread' t V 速度对 z 方向的导敛

一一一 寸丁二♂王readf t一 W速度对 x方向的导"C_DWDX(c,t) 

C_DWDY{c,t) 

CßWDZ(c，。

W 速度对y方向的尊数问巴，T'hread"t

çeIUc,Thread ' t W遮II对 z 方向的导狼

'

川

章
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在 mem.h 文件中存取材剧性质的*

.11集型

口江高了一

褒11-3

~. (. Il> 

CJt<但AN(c，。

C_ FMEAN1(e.I) 

C1v....R(仇。

C_ fVAR2(c,l) 

C]REMIXqe,t) 

C_I.AM FlAME SPEE剧C，I)

C CRlT1C...... STRA.IN RAT回C，I)

C POLLUT艇，。

C_R(c,t) 

C_MU L(c,t) 

C_MU T(c,t) 

C_MU EfF(c,t) 

C_K_Uc,t) 

C_K_T(c,t) 

C_K_EFf(c，。

C_Cp(c.,t) 

C_RCi....S轧"

C_DlfF L(c.t) 

CßIFF EFF(c,l) 

C_....oS ∞EFf(c，!) 

C_SC .... T∞EFf(c，l) 

C_NUT(c,l) 

cc ll I c.ThI'Cld ' t 

罐圄恤

11-1'视台纱'脆的平均值

"工"泪命分煌的平掬Ii

才 ，，-依旧分..~.

'民二"视台份'民变.

反应量'程~.

厦巍烙遂11

"界也受迫J!t.

""个精....的...乡'敛

程度

1 ，.制度
i 楠耀..11

有效袖11

'部份粤系.. 
F 
.槐份份'1".

葡敛~f~.fJ ..ft

确定的销量

气..衔'由

屠罐....的扩做.

..，晴的有徽扩融事

.."蕉'院
矿'障'晨'配

涮视..l.t

如表 11 -4 所示.归) 访问用户自定义的单元标量和存储器的章 ，

在 mem.h 文件中访问用户自定义的尊元标量和存储.的宏

celU C, Thread ' t 

时Uc，Thrød'!

cclU c,llIrcad' ! 

时U c,ThrcId ' t t twt 
cclU c,Thn:ad't, Înt i 

ccll I c叫叫

cclU c;丁、n:ad 't

ce lUc厅、n:ad't

celU c,Thread' t 

cclU c,Thread' t 

1 
cclU‘ c, Thn:ad't 

cclUc川.....‘

celUc，叫.，

cclU C, llvad't 

celUιη....气 înt Î , înt j 

celU币四四飞M

celUc叫"

cclUc厅、""，.，

cclU c，刊，回"

褒)]-4

在陈 ，.世〉 '翻费型 返回罐

CßDSI{c ，。 I cclU c，th晤时't，int i 用户应义的单元幡标量

CßDSI M(c，。 回IU c，由目时't，int Î 前-，，'"佳下用户窟义的单元幅标量

C_UDSI_Dlf f(c,l) 回IU c,Ihn:ad't,Înt i 用户在义的标量单元怖分融事

C_UDMI(oι。 cell t c,Ihn:ad' t,int i 用户定义的单元幡存筒'
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囊11-5 在 mem.h 文件中访问'话整压力锁型壤写噩噩的宏

.ßO ， .擅} '噩噩噩 返自值

C_RU叫"。 国II t e,Thrud' , 剧 '由董压力

C_RVV(e咽。 ulU e,Thrud' 1 " .瑞撞压力

C唱.RWW(e，t) ce1U e，Thrnd气 ~霄瞄锺压力

C_RUV(c,t) 回n 1 C川lread ' ， "' 霄畸擅压jJ

C_RVW(e,t) 国11 tC,Thread ' l .w 霄诵蜡压力

C_RUW巾." u1Uc，T而read'l ，w 雷诺锺压力

二、 面宏

面宏是在单元格的边界面上定义的 ， 井且从草解器中返回一个真值， 该类主仅可在偏析

求解器中用.

(1) 访问面流体变量的宏，在表 11 .6 中列出的宏可以在边界面读写流体变量. 注

意如果表面在边界上，那么流体的方向是由 飞FLUX 决定的点指向外国空间

的.

囊11-< 在 mem.h 文件中访问面涯悻置量的宏

在掠 ，.跑 〉 '黯篝噩 返回11

F_R(r,I) f.:e_1 r,T'Ivud 't 曹t重

'.叫f，l) fK暗自r，T'IIrød ' 1 压力
】『

F_U(f,I) k雷_1 f,T'hrød ' t M 方向的埠厦
咱'甲~唱，回 呵' ' - --

F _ V(f,t) f.:e I r,Thread ' t v方向的迫!l

-" ! liIo ,i 叶~-... 

F _ W((,I) r.国'_1 f,Thtead'l . jj向的温度
飞...

F_T(f,l) f.四:_， f，而read ' l llLt 
而r

Fß(f.l) fll<<_1 f,Thrud ' 1 然

F_K(f,l) face I f,Thread ' j 副班运动植

Fß(r,l) f.:e 1 f.n四... " 精植远动陋的外融通事

F _ Yl(r,l, i) f.:e I f.Tbrud' l.int i 蜻厦的质量分量

F]LUX(r,l) fac:e I f,Threa,j' 1 1 刷地问面的翩翩

(2) 访阅用户自定义的丽标量和存储糟的章， 如表 11-7 所市·

襄 11 -7 在 mem.h 宜件中访问用户自定且的面标量和存储画的营

各院 '.8 > ."费型 返回也

F ß DSI(f,l,i) face_1 r，川uud' t" inl i 用户躏富的囊面掠量
正

F_UDMI(f,t,i) fll<<_1 f，川vnd't..int i 附户庭义的囊面存幢嚣

(3) 访问混合面变量的章，如表 11.8 所"' .
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囊 1 1 - 8 在 mem.h 立件中访问混合面噩噩的密

~栋 【'黯 } "现集型 退回值

F_CO(f,t) fac:e \ r，Th且"" ， 情闽囊团、。跑上的单兀量最

飞回'_THREA叫r" fac:c_1 f ,Thrnd' 1 访间理面W边上的单元蛐章

F_CI(r,t) rac:c t f ,ThmId ' 1 访问现面M 边上的单元变量

F_CIJHREA叫r.l) r.田\ f，Thr誓'ad ' \ 恼间蟹面U 边上的单元筒'

二、 几何图形量

几何图形宏是为了在 FLUENT 中重新得到几何变量， 包括节点和面的数量、童心、在

面积且悻积等.

(1 ) 节点和面的数量， 玻 11-9 给出了返回节点与面个数的宏.

亵 11-9 在 mcm.h 文件中的节点和亵面的宏

在林 < ..直〉 '鼓提型

CßNODES{c.t) cclU c.Thrcad ' \ -个单元幡巾的节点.. 

C_NFACES(c,\) celL \ c.n、四.d ' ， -个单元幡巾的理面.. 
? + T 

CßNODES(r.t) fac:c I f，n町'ad'l -个现面中的节点'"

(2) f(l兀格和表面的重心， 表 11 - 1 0 给出了获得单兀格或表面童心的宏.

囊 11 - 1 0 在 mcm.h 文件中的茸量重心宏

在鼻 【'回 〉 '撞费盟 退回笛

w析仿真分及, C_CENTROI叫. ，C，I) ，回I.[NDN时， celUc、-"'"''''叫 ."幅.'"的z 值
4 

C伊CENTROID(..r，t) ，国I x(ND ND).fac:c_t f;啊lrcad ' \ 理面中心的 x 值

。}农面积， 表 11-11 给出了我得面积向量的宏.

襄 11 . 1 1 在 mem.h 文件中的面积向量宏

各韩 (9ft ) ...提型 温团也

C_AREA(A.f,t) Ax[ND NDj.f .. 四'_1 f,Thrcad ' , 面帆向量A

(4) 单冗格体积， 农 11- 1 2 给出丁获得单兀格其实体积的章.

襄 1 1. 1 2 在 mem.h 立件中的单元格体朝宏

也韩 < .跟】 '撇提型 退回僵

工幢..量三幢的单元幡体飘
C_VOLUME(c.。 ce lL_缸"ηm:ad ' l

单元幡体帆12. 是精对馨幢盟的体扭

四 、 节点牵

节点宏主要返回单元格节点的主数直角坐标和相应的节点速度分量.

( 1) 节点坐标宏 ， 表 11-13 给出了返回单元格节点的实数直角坐标的:Õ:.
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囊11. \3 在 mem.h 文件中E量的节点坐标宏

在臂、 ( .ft ) ...提型 却E圄'"

NODE X(n晴) 节点的x坐标

NODEY(~) NOIk.n咽k 节点的y坐标

NODE Z(国"'" .""，.抽出 节点的 z 坐标

。) 节点速度变量虫 ， 农 11-14 给出了返回且在兀格节点速度分量的童.

褒11 . 14 在 mem.h 文件中的节点速庄重量宏

‘ 在陈 ，.回 } '撞撞盟 返回值

NODEGX(r田"" .od陆·阳蝇e 节启迪厦的X卦量

NODE GY(node) NOIk. 1'IOC!e 节点遣踵的 Y分.

一NODEGUf回扣} NoOc . nodc 市t.i遣厦的 Z分量

五、$帽宏
国

表 11 -15 给出了返回一个与整体事相节点相连的实数变量. 吧!

褒11 .1 S 在 ss..mph皿<.h中的噩量密

各栋 ， .搬} '监费型 退回值

C~VOF{t.pt[OJ) t clU c"Thn:ad..pt 主要相的体职分量

C~VOF(t叫，" cclU c,: 第两个辅助帽的伴唱H骨'直

11 .2.2 实用工具宏

FLUENT 提供了针对其变量操作的 系列工具， 这些工具中大部分可以作为茸直撞执

行.

1宰相模型的

ι 宫包

注意:

2包吉单

注意

323) 

」



p
c
m
z
→
直
体
分
析
及
仿
真

实
用
被
覆

324 

Thread 飞由阻止

Domain .domain; 

thr四dJoopj(Uhread， domain)l. loops over all face threads in a domain.J 

} 
(3) 查询单元钱章中的单元. 可以应用 begin_ c JooP 和 end_c_lo叩来查询给，U 币

元钱童 C_，由r四d 上所有的单元，它包含 begio_ c_l∞p 和 end_c_loop 的说时J ' 

完成对单元钱章中单元所做的操作，定义包含在 ( )中 . 当查找控制区单 létX

嚣的单元时，应用的 loop 全嵌套在 thread_loop_c 中 .

cell t c; 

"盲目d-c-thmad，

begin_cJoop(c, c_thread) 户 loops ov'町 cel1 s in a cell thread 町

{ 

end_c_loop(c, c_thread) 
(4) 查询面钱章中的面 . begio_fJ∞p 和 end_Cloop 可以用来查找给定面线索

f thread 的所有的丽，它包吉 beginJ_1∞p 和 end f I∞p 的说明，完成对丽钱

章中西单元所做的操作，定义包吉在( )中 . 当查找控制区面绒童的所有面

时， 应用的 loop 圭嵌垂在 thread_loop_f 中 .

fa四:_t f; 

ηlread -f_thread; 

begin_C1∞p(f， f .血read) , - loops Qver faces in a face thread 町

{ 

end_C1∞p(f， U hread) 
(5) 查询单元中的面. 下面的函数用以查询给定单元中所有的面，包吉单独的查

询说明，后面是所做的操作包含在()中.

face t f; 

Thread -tf; 

mt n; 

c jace JooP(鸟飞 n)

{ 

,- loops over all faces 00 a ce l1 -, 

f= C FACE(c,t,n); 

tf~ CJACE_THREAD(时，叶，

这里 n 是当前面的索引号.当前面的索引号用在 C FACE 宏中以藐得所有面的数量

(如. f~ C FACE(c.t.n)) . 



另一个在 c face loop 中有用的若是 CJACE_THREAD . 这个章用于合井两个面线索

〈如 ， tf~ CJACEJHREAD(c，t.n)λ 

(6) 查询单元节点. 当想查询给定单元中所有节点时 ， 可以使用 c_nodc_loop 函

数， 它包吉单独的查询说明，后面是所做的操作，包吉在()中 .

cell t c; 

Thread 气，

mt n; 

c-node-1∞p(c. t.n) 

node = C_NODE(c， t，叶，

这里 n 是当前节点的童引号.当前节点的索引号用在 C→NODE *中以我得所有节点

的数量.

二、 事相组分董询营

事相组分查询章用于;j;相模型的 UDF 中 .

(1) 查询混合物中相的控制区.

sub _ domain _Ioop 章用于查询泪合物控制区的所有相的于区，井可在1姐告物控制区给每

个相区定义指针且相关的 phase_ domain _ index . 注意 sub domain I∞p 宏在执行中和

，ub 由ead~loop 主是相似的.

. ; index of subdomain pointers 町int phase _ domain _index; 

Domain "mixture←do ηam; 

Domain " subdomain; 

sub_domain_loop(subdomain, mixtu阳_domain， phase_domain_index) 

sub domanloop 的变量是 subdomain 、 mixture domain 和 phase_ domain _index . 

subdomain 是 ph臼e-level domain 的指针. mixture domain 是 mixture-level domain 的指

针.当想用 DEF1NE 章时 mixture domain (包含控制区变量， 如 DEFINE ADJUSTl 可通

过 FLUENT 求解器自动传递给 UDF. 混合物就和 UDF 相关了. 如果 mixture_ domain 没有

显式地传递给 UDF. 应用另外一个置来恢复它. phase_domain_index 是于区指针索引号，初

始相的索引号为 0 ， 混合物中其他相则依次加 1 . 注意 subdomain 和 phasc_ domain _ index 

是在 sub_domain_loop 茸定义中初始化的.

。)查询混古物的相线索.

sub thread lo。p 章用于查询所有混合物等值线的相等值线索， 井远回每个子区和相关

phase _ domain _ index 的指针 . 如果 subthread 指针与进口区域相共，那么这个若将提供给进

口区域每个相面线索指针.

mt phase dory3am index, 

丁nread .subthread; 
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Thread *mixture thread; 

sub_thread_1∞p(subthread， mixture _ thread, phase _ domain_ index) 

sub_thr四d_l∞P fl'J 自变量是 subthread ， mix阳re thread 和l phase- domam- mdeh 

subthread 是相线童的指针 mixtuIe thread 是 mlxture叶evel thread 的指针.当用 DEFlNE

茸〈包吉一个线索自变量)定义时 mixture_ thread 通过求解器自动传递给 UDF . 使其与棍

合物相关. 如果 mixture thread 没有显式地传递给 UDF. 则需要在调闸 sub_thread_loop 之

前，调用工具!i:来恢直它 . phase_domain_Înd目 是于区指针索引号 ， 可以用直

PHASE_OOMAIN_lNDEX 恢!l . 初始相的索引号为 O. 视古物中其他相依次加 1 . 注意

subthread 和 phase-doma1tIndex 是在 sub_thread_loop 宏定义中酷初始化.
(3) 查询混合物Ijl所有单元的线索.

mp_threadJoop_c ;f用于在询混合物控制区所有单元的线索，提供了与混合物等值钱有

关的相等值钱蜜的指针.当应用到混合物控制区时 ， 和 threadJ∞p_c 宏晶等价的. 单元钱
章第 t 相的指针Jil: pt(i] . 这里 ， 是相控制区索引号 phase_domain_index . pt[i]可以用做宏的

自变量. 相控制区索引号 phase_domain _index 可以用 PHASE_DOMAIN_INDEX 恢直 .

丁nread **pt; 

Thread .cell threads; 

Domain .mixturc_domain; 

mp _ thread _Ioop _ c(ceIUhreads, mixture _ doma叽 pt)

mp_thread_1∞p_c fl'J 自变量是 cel1 threads , mixture domain 和 pt .
cell threads 是网格线索的指针 mixture domain 是 mixture.level 控制区的指针. pt 是古

有 phase-Ievel 线索的指针敏组.

当要用包含控制区变量的宏来定义时 mixture domain 通过草解器自动传递给 UDF.

使其与混合物相关. 若 rnixture domain 没有显式地传递给 UDF. 应用另外一个工具章来恢

!l . 拉意 pt ~I cell threa血的值是由查询函数派生出来的 . mp_thread_1∞p c 一般用于

begin _ c _Ioop 中 ， begin_c_loop 9!IJ用于查询问格线索内的所有阿棉 . 当 begin_cJoop 眼辈在

mp_thread_loop_c 中，就可以查询棍合物中相单元钱嚣的所有网路7 .

(4) l'!询混合物中所有的相面线索.

mp_thread_1∞pJ 用于查询炮台物控制区内所有熄合物等值钱的ïfñ钱虫，井且提供每个

与混合物等值钱有关的相等值线索指引 . 在混合物控制区内，和 th，四dl∞pJ 几乎是等价

的 . 当 fEEZ相等值钱指剧时. pt(i]可以作为茸的自变量 . phase_domain_index 可以用宏

PHASE OOMAIN INDEX 来恢直.
刊read ..pt; 

Thread .face threads; 

Domain .mixture domain; 

mp _ thread _ Ioop_ f(face_threa由. mlxtu陀~ domain, pt) 

mp_thread_1∞pJ的自变量是 face 由陀ads. mixture domain 刷 pt .

facc_threads 是面线索的指针，是混合物等值线控制区的指针. pt 是包吉相等值线童的
指针数组.
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当'Il!用包含控制巨变量的宏来定义时 mixture domain 通过 FLUENT 的束解端自动传

递给 UOF. 使其与混合物相关. 若 rnixture domain 没有显式地传递给 UDF. 应用另外一个

工具章来恢复. 注意 : pt 和 cell threads 的值是由查询函数派生出来的 . mp_lhreadJ oop_f 

一般用于 beginJ_loop 中. beginJ_loop J!rJ 用于查询罔格而统章内的所有网路 . 当

beginJ_loop 嵌垂在 mp_1由 read 1∞pJ 中 ， 就可以查询混合物中相单元面钱嚣的所有问格

丁 .

三、 世置面噩噩的宏

F PROFI LE 宏可以世置面的变量值， 当要生成边界条件的外形或存储新的变量值时 ，

自动调用这一函数.

F _PROFILE( f. t. n) 

F PROF I LE 的自变景是 f. 面的索引号是 face t , t 为面上线索的指肘， 黯数 n 是要在

边界上世定的变量标志符. 这些变量通过 FLUENT 的求解端自动传递给 UOF . 不必给它们

赋值. 例如 a 进口地界包骨且压事l.~温 ， 工者都在 UOF 中定义 . 进口边界的变置在

FLUENT 中赋予整数 O. 其他赋予 1 . 当在 FLUENT O'J进口边界对话缸中定义地拌条件时， 【二二

这些整数值白求解锦世定 . I I 

四.访问没有赋值的自噩噩的;f I ~ 
井非所 有 的 UOF 部直接把函 数所需要的自变量传届给求解始 . 例如 . I 再

DEFINE ADJUST 和 DEFINE IN IT 传递给混合物控制区变量 ! 这里

OEFINE ON OEMANO 是没有被传边的自变量. 下面提供了通过 OEFINE 函撒访问没有被

直接传递给 UOF Jt件的工具.

{1} Get_Domain . 

着控制区指针没有显式地作为自变量传递给 UDF. 可以用 Get Domain 宏恢直控制区指

针.

Gct_ Domain(domain_id); 

domain id 是一个整撇 ， 对于混合物控制区其值为 I. 在宰相混合物模型中其值依次加

在11\相流中 domain id 为 1 ， Get Domain( 1)将返回流体控制区的指针.

DEF INE_ON_DEMAND(wode_ud盯

} 

Domain *domain; /* domain is decJared as a variablc 町

domain = Get_Domain(I); ;* retums Auid domain poinler 町

在多相流中 Get_Domain 的返回值是混合物等值线索，或单相等值线章 ， 或相等值钱

章，或相等值钱童控制区榈树 . don、 ain id ~J值在混合物控制区始终是 I. 可以lfJ FLUENT 

里的图形用户界面获仰 domain id . 

OEFINE_ON_OEMAND(my_udQ 

自第
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Domain .mixture_domain ; 

mtxtum- doryEazn z GeL DomaIn( l ), ,. retums mixture domain pointer 叮

/'四d assigns to variable 句

Domain .subdomain; 

subdomain = Get Domain(刀;;. relums phase wilh ID=2 domain pointer.; 

/. and assigns to variable 勾

(2) 通过相控制区索引号使用相控制区指针.

有两个方法可以获仰混骨物控制区具体相 (或于区〉的指针 ， 可以用去

DOMAJN_SUB_ DOMAJN 或 Get_Domain . OOMAJN _ SUB _ DOMAIN 有两个自变量

mixture_domain 和 phase_domain _index . 这个函数返回给定 phMe-dory3aItmdex 的相指价.

注意 DOMAIN SUB DOMAIN 在执行上和 THREAD SUB THREAD 章相似.

p
c
m
z
4
流
体
分
街
且
仿
真

实
用
数
程

int phase_domain_index = 0; 

Domain .mixlure_domain ; 

Domain . subdomain = DOMAIN_SUB_DOMAJN(mixl‘.lre_domain，ph出e domain inde啡，

mixture domain 是 mixlure-level domain 的指针.

当用包含控制区自变量的宏 DEFINE 时 ， mlx阳re domain 自动通过 FLUENT 的草解器

柑递给 UDF . UDF 就和混合物相关联了 . 否则 ， 如果 mixture domain 没有显式地传递给

UDF . 国 l需要在调用 sub domain I∞p之前， 用另外一个宏工具来恢复.

phase-d。ma1tIndex 是于区指制地索引号. 它是一个鼓数初始相值为 O. 以后每相伍抽:

JIII 1 . 当用包含相控制区变量 ( DEFINE EXCHANGE PROPERTY 、 DEFJNE VECTOR 

EXCHANGE_ PROPERTY ) 的 DEFINE 宏时 . ph国e_domainJndex 是自动通过 FLUENT 自由

束解错传递给 UDF. UDF 就和互相作用的相相联罩了 . 否则 ， 需要硬代码调用

DOMAIN SUB DOMAIN 章给 ph国e domain index 指针赋值. 如果宰相流模型有两相，然

后 phase_ domain _index 初始相的值是 O. 第三相的值为 I . 然而，如果il:'相流模型中有E辜

的相， 需要用 PHASE_DOMAIN_INDEX 置来恢直与给定控制区的 ph国e domain index . 

(3) 通过相控制区索引号使用相等值线索指针.

THREAD-SUB-THREAD 宏可以用来恢且给定相控制区虫引号的 phase-Ieve l thread 

(subthrcad)指针 . THREAD_SUB_THREAD 有两个自变量 mixture_thread 和 phase_domain_

index . 这 一 函数远 回 给定 ph眉飞domain index 的 phase- Ieve l 线索指针 . 注意

THREAD SUB THREAD 在执行上与 DOMAIN SUB DOMAJN 宏相 且 .

/. primary ph脑e index is 0 ., 

int phase _ domain _index ... 0; ,. primary ph国e index is 0 ., 
Thread .mixture thread; 1* mixture-Ievel thread pointer ., 
丁ñread . subthread = THREAD _ SUB _ THREAD(mixture _lhread,phase _ domain _inde:叶，

mixture thread 是 mixture-level 线索的指针. 当用包含舷制区自变量宏 DEFINE 时， 官

告自动通过 FL四川 的束解撒传递给 UDF. 这样. UDF 就和混合物相关联丁 . 否则，如果

混合物控制线索指针没有显式地传递给 UDF . 则黯要在调用 Lookup_ Thread 蜜之前 ， 用另

外一个宏工具来恢复.
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phMejoma，n」ndex 为于区指针的索引号.它是一个整数， 初始相值为 0，以后每相伍

次加 1 . 当要用包含相控制区索引号变量的 DEFINE 童时 ， ph皿c domain _ index 通过

FLUENT 的求解器自动传递给 UDF，使 UDF 与具体的相直作用相相关联.否则 ， 需要用硬

代码改变宏 THREAD_SUBJHREAD 的 ph副e domain index 值. 如果事相流模型中只有两
相 ， 那么 phase_dom创nJndex 的初始相是 0，第二个相为 1 . .t!有更辜的相，需要用

PHASE DOMA刑UND以 理来恢旦与给定区域相关的 ph四 domain_in邮.

(4) 通过混合物等值线使用相线章指针数组.

THREAD_SUB_THREADS 宏可以用以恢复指针数组 pt，宫的元童包吉相等值钱〈于线

索〉的指针. THREADS_SUBJHREADS 有一个变量 mixture_ thread . 

Thread .mixture thread; 

Thread ..pt; ,. initialize pt ., 
pt ::: THREAD_SUB_ THREADS(mixrure_thread); 

mixture thread 是 mixture.l eve l thread 代表网格线索或面线索的捕针.当用包肯钱变量的

DEFINE 宏时， 它通过 FLUENT 的求解器自动传递给 UDF ， 这个函数就相混合物关联了 .

否则，如1*混合物线索的柑针没有血式地传递给 UDF ， 则需要用另一个置来恢复.
pt[iJ数组的元章是与班 ， 相的相等值钱辈有关的值， 这里，是 ph国e domain_index . 当

蛙l恢复网路具体相的信息时，可以用 pt[iJ作为一些网路变盘茸的自变盘.例如 。 C_R(" pt[i])

可以用来返回网格点 c 第 t 相的衔应. 指针 pt[iJ可以用 THREAD_SUBJHREAD 来恢置，

用，最为自变量. phase_ domain_index 可以用茸 PHASE ∞MAIN INDEX 来恢直.

(5) 通过相控制l区指时调用混合物撞制区指针.

当 UDF 有权访问特殊的相等值线索 〈于区〉 指针时，可以用宏 DOMAIN_SUPER_

DOMA IN 来恢直混合物等值线章控制区指针 . DOMAIN_SUPER_DOMAIN 古有一个变量

subdomain . 注意 DOMAIN_SUPER_DOMAIN 在执行上和 THREAD_SUPER_THREAD 章
是非常相似的.

Domain .subdom副n ，

Dory,aIr1·mtxture doma1R Z DOMAIN SUPER-DOMAINOubdory、 ain);

Subdomain 最多相流混合物控制区相等值线索的指针.当用包含控制区变量的 DEFINE

宏时 ， 它会通过 FLUENT 的求解器自动传递给 UDF，使函敢与混合物中的第-相:1<'第二相
关联 . 注意 在 当前 的 FLUENT 版本中， DOMA.N SUPER DOMAIN 将返回 与

Get Dom剧n( l )相同的指制 . 这 样 ， 如果 UDF 可 以使用于 区 的指剧， Ellt且使用01;

DOMAIN SUPER DOMAIN 来代瞥 Get Domain 宠以避免将来的 FLUENT 版本造成的不晴
在问题.

(6) 通过相钱审指肘使用1回合物线索指针 .

当 UDF 有权访问某一条:t!.{恢复混合物等值线索捕时的于线索指制时 ， 可以使用直

THREAD _ SUPERJHREAD. THREAD _SUPER_ THREAD 有一个自变量 subthread .

Thread . subthread; 

白lread .mix阳re thread = THREAD伊SUPER_ THREAD(subthread); 

subthread 在多相iJI(混合物巾是一个特殊的相等值线索指针 . 当使用包肯钱变量的

DEFINE 宏时 ， 官通过 FLUENT 的束M据自动传递给 UDF，使函数与泪古物中的两相关

'
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联. 注意在执行上和 THREAD_SUPER_THREAD 宏是非常相似的.

(7) 通过区的 10 使用钱章指针.

当想要在 FLUENT 的边界条件对话框中恢复与给定区域 10 相关的线索指针时，可以使

用量 L∞kup_Thread 来实现. 例如 ， 假世 UDF 需要对该区域的特殊线索操作〈井非查找所

有的线索 l，可以用 DEFINE !<:定义 UDF ， 而不用将线索指针从 FL四川的草解器传递到

UDF , UDF 还可以使用 Lookup_ Thread 未获得想要的指针. 这一过程分两步 首先，从

FLUENT 的边界条件对话程中获得区域的 10 然后 ， 使用硬代码作为自变量调用!<:

L∞kup_O刊read . L∞kup_Thread 返回与给定区域 10 相关的钱靠自由指针. 可以将线索指针赋

给 thread_name . 井在 UDF 中使用 .

int zone 10; 

Thread 'thread name 军 Lookup_ Thread( domain,zone _, 0 ); 

在~相流的上下文中，通过荤Lookup_ Thread 返回的钱嚣是与控制区自变量相关的相等

值线索.

(8) 使用相的控制区指针.

当有权访问与给定相待值钱章控制区指针的 domain id 时，可以使用 OOMAIN_I口 宏来

实现 . DOMA阳I_ID 有一个自变量 subdomain . 它是相等值线直控制区的指针. 控制区〈混

合物〉 的最大等值线索的 domain id ~1默认值是 1 . 即=如果被传递给 OOMAIN 10 的控制

F l 区指针是混合物控制区的等值线章指针， 则函数的返回值为 1 .注意 当在 FLUENT 的相

事后|对话框中选择需要的相时， 宏所返回的 domain id 是和显示在图形用户界丽中的整数值 旧

Z 雪 |相同的 .
程在 Domain 'subdomain; 

ik|mt doma町d " ∞MAIN_LD(subdomain); 

垦 (9) 通过相控制区使用相控制区索引号.

.1 宏 PHASE OOMAIN INDEX 返回给定相等值线索控制区 ( 于区〉捕时的

phase_dolT、ain_index . PHASE_DOMAlN_INDEX 有个自变量 subdomain. 它是 ph田。Icvel

domain 的指针. phase_domain _index 是于区指针的索引号. 初始相的值为整数 0，以后每

相依次加 1 • 
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Domain 'subdomain; 

int phase_domainJndex " PHASE_ DOMAIN_INDEX(subdomain); 

五 、 访问邻近网格和结曹亚量的宏

FLUENT 提供了确定邻近阿棉田和线索变量的宏. 在复杂的 UDF 立件中 ， 当查询特定
网格或线童的面时，就会用到这个宏. 对给定的面 f和宫的线索 tf，两个相邻的网格点为，0

1阳1 c1 . 若是控制区附面层上的面则只有 CO ， cl 的值为 NULL . 通常 ， 当把同格导入到

FLUENT 中时， 按照右孚定则定义面上节点的顺序， 面 f 上的网格点曲、 CI 都存在.下面

的宏返回网格点 cO 和 cl 的 10 和所在的线索.

celU cO ::: F _CO(f,tf); / ' returns 10 for cO'f 

tcO "" THREAD _ TO(t町 /' retums the cell thread for cO 叫

celUcl ::: F_CI(f,If); /'re阳ms ro for cl ' / 



tcl ~ THREADJI(tf); j - re阳ms the cell thread for c l - / 

逞'整 由 F AREA 和 F FLUX 返回的信息是直接相关的!这些值从网格，0 到 d 返回正值.

大、 为网格定义内存的军

为了存储、恢复由 UDF 同格区域变量的值， 可以用 C UDMl 量来分配 500 个单元.这

些值可以用做后处理.这个在用户定义内存中存储变量的方法比用户定义标量更加有效.

C_UD阳巾， thr酬， index) 

c 是网格标志符号 ， thread 是网格线指针， index 用于识别数据内存分配.与索引号。相

关的用户定义的内存区域为 O. 在用做内存存放变置之前，首先需要在 FLUENT 的 User

Oefined Memory 对话框中分配内存.在图吊用户窗口分配的每一个用户定义的内存，都会

创建一个新的变量.例如 要指定两个内存分配区，那么两个变量 udm-Q l阳1 udm-I 就会在

数据储存错中产生.这些名字将会在后台处理对话框中显示出束.

七 、 提量工具

FLUENT 提供了可以用在 UDF 中计算有关矢量的工具， 它们在源程序中以茸的形式运

行.下面我们详细介绍在 UDF 中可以利用的矢盘工具. 在矢量工具主中有个约定俗成的惯

例 ， V 代表矢量 ， S 代表标量， D 代表一系列三维的矢量. 在矢量函数中约定的计算顺序，

括号、指数、乘除、加减 ( PEMDAS ) 不再适用.相反下划线符号" " 用来表示一组操作

数， 因此对元素的操作先于形成-个矢量.

(1) NV_MAG 计算矢量平方和的平方根.

NV MAG(x) 

2D, sqrt(x[O]'x[O] + x[ I]'x[ 1)); 

3D: sq口(x[O]吨[O]+x[ l ]气 [ 1 ]+x[2]气[2]);

(2) NV MAG2 计算矢量的平方刷.

NV MAG2(x) 

2D, (x[O]'x[O] + x[l ]'x[l)); 

3D , (x[O]'x[O] + x[I]'x[l] + x[2]'x[2)); 

(3) ND ND，在 RP_2D 和盯'_3D 中，常数 ND ND 定义为 2. 如果想在 2D 中注

立一个 2X2 矩阵，或在 3D 中建立个 3X3 的矩阵时，可以用到它.

mal APG3- NDl[ND- ND] 

for (i::0; i<ND _ND; ++i) 

for LF0, J< ND ND，忡j)

A[i][j] ~ 币，且，
(4) ND SUM 计算 ND_ND fI'J和 .

ND SUM(x, y, z) 

20: x +y; 

3D: x+y+z; 

(5) ND SETτ 产生 ND ND 的任#说明.

ND SET仙， V， W， CU巾， t), C V巾， t) ， C W(c, t)) 
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u = C U(c.t); 

v =C_V(c, t); 

if 3D: w = C W怡，以
(6) NV_V 完成对两个矢量的操作­

NVV归， =， xk

a[0] ~ x[O]; a[l] ~ x[I]; etc 

撞撞. ，面巫k方'叫01->1创中周-*-代，*-.将得翩翩吨101 .

σ) NV_VV，完成对矢盘的基本操作.在下面的茸调用中 "+"符号还可以被符

号" "、" /"、" *" 代曾 .

NV VV归 = x,+, y) 

20, a[O] ~ x[O] + y[O], a[ l] = x[l] + y[I]; 

(8) NV V VS ， 用束把两个矢量相加(后一项都乘以一常数)~ "+" 符号可以换

成" "、"*"或" / "， "*" 符号可以替换成"/飞

NV V VS怡，气 x， +, y. 气 。 匀，

2D, a[O] ~ x[O] + (y[0]'0.5), a[l] ~ x[ l ] +(y[l]'0.5); 

(9) NV _ VS_ VS ， 用来把两个矢量相加〈每一项都乘以一常数 )0 "+"符号可以换

句" I 成" "、"*"或 " 1 " ， " * "符号可以瞥换成 "/ "0
r , 

辜百 NV_VS_VS归 =， x，气 2.0 ， +，弘 气 0.5);

量王 20 ， a[O] ~ (x[0]'2.0) + (y[O]' O 匀， a[ l] ~ (x[ I]'2.0) + (y[ I]'O 匀，
程在 (10) ND_OOT 下列的工具可以计算两个矢量的点积·
在扣| 阳'0∞OT(x归x川，弘川
再 20 ， (x俨*u + y*v叶);

革 3D : (x*u + y*v + z*w); 

NV _DOT(x, u) 
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20, (x[O]'u[O] + x[ I]'u[ I]); 

3D, (x[O]'u[O] + x[ I]'u[l] + x[2]'u[2]); 

NVO OOT(x, u, v, w) 

20: (x[O]*u + x[l]*v); 

3D: (x[O]*u + x[1 ]*v + x[2]*w); 

)\ 、 与非定常搬值模拟离主的E

用 RP 变量量有权访问 UDF 中非定常的变量. 如可以利用 RP-GeLReal 宏藐得流动的

时间.

real current_ time; 
current tune = RP Get Realrlnow-tune吁，

表 11-16 是在每个时间步*处理时间信且的 RP 置列表.



襄 11.16 每个时闹步快处理时间情息的 RP 宏刑'隆

RP 素 退回惰"

即一ÛC'I_Rul ("Row吨阳问 题目当菌的计'耐阔咱》
--一一一.-

RP _ ÛC'I_Rul ("pllysical-ci脚刽叼叮 』 退回当'而例汁，刷刷"'.咿》

RP _ (leUnte, cr ( 阳。，即') 埠因当前的计算时间'"峰'配 《钞 》

11 .2.3 常用 DEFINE 宏

‘ 
DEFTNE 童 般分为通用的 DEF1NE 宏、模型指定的 DEFINE '"、多相流模型中的

DEF1NE 宏、离散相模型中的 DEF1NE 宏且动网格模型中的 DEFTNE 宏 5 类.

-、 通用的 DEF1NE 茸

通用的 DEFINE 章执行一般的访问和操作求解器数据的操作 ， 这些函数部和 FLUENT

中的物理模型无关.

( 1) DEFINE_ADJUST(name. d) , DEFINE_AD且JST 章是一个调节和修改 FLUENT

变量的通用主. 在每一步远代开始之前，利用该置函数可以悔改流场变量 ，

对流场的某个变量进行积分.或根据流场的变量对边界串件进行调整.该茸

函数包括两个哑元 symbol name 和 Domain*d . name 是所指定的 UDF 的名

字 . d 是一个指针， 指向一个 domain 数据，由 FLUENT 求解器传递给 UDF .

该宏函数没有退回值.

(2) DEF1NE_INIT(name. d) , DEFINE_1N1T 置可以定义一个初始场， 在初始化时

被执行一次 ， 井在求解暗进行了默认初始化之后调用 . 结果与使用 patch 一

样 ， 常瞌用来在某些指定区域进行流场初始值的世置. 该宏函数包括两个哑

元 symbol name 和 Domain*d . name 是所指定的 UDF ~J名字 . d 是一个指

时，指向一个 domain 披据，由 FLUENT 求解器传递给 UDF. 该宏函数设有

返回值.

。}DEFIINE-ON-DEMAND{name) DEFllNE-ON-DEMAND 宏可以定义一个披

命令执行的 UDF ， UDF 只有在接到用户指令植激活的时候才调用，井平和法

代过程联系在一起. 该宏函数只有-个哑元 symbol name . name 是所指定的

UDF 的名字 ， 该主函数没有返回值.

(4) DEFINE_RW_FILE(name, fp): DEFJNE_RW]I LE 被用于定且要写入 cas 或

dat .:x:件的信息 ， 可以保持戚存储任何 data 类型的自定义变量. 该宣函数包古

两个哑元 symbol name 事1 FILE*d. name 是所指定的 UDF 的名字 .fp 是一个

指叶， 指向所需写人的主件， 由 FLUENT 草解器传递给 UDF . 该宏函数没有

返回值.

(5) DEF1NE_DELTAT(name, d) , DEF1NE_DELTAT 宏用于控制非定常问题求解时

时间步长的控制和调整，只有在可变时间步长度选项被激活的情况下才可以

调用. 函数返回值就是时间步仕的值. 1主宏函数包括两个哑元 symbol name 

和 r Domain*d . name 是所指定的 UDF 的名字， d ~一个指针 ， 指向一个
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domain 数据，由 FLUENT求解器传递给 UDF. 该宏函数返回值是实型.

(6) DEFlNE_EXECUTE_AT_END(name), DEFINE_EXECUTE_AT_END 宏在法代
的最后-步或最后一个时间步完成后被执行. 如果想在某个特殊时刻计算流

量，则可以调用这个宏函数. 该宏函数只有一个哑元 symbol name . name 是

所指定的 UDF 的名字， 该宏函数没有返回值.

除了 DEFlNE_EXECUTE_AT_END 之外，还有 DEFINE_ EXEC盯E_AT_EXIT 、

DEFINE EXECUTE FROM GUI 和 DEFlNE EXECUTE ON LOADING 三个通用宏函数，

DEFlNE_EXECUTE_AT_EXIT 在退出 FLUENT 任#时执行 DEF阳E_EXECUTE_
FROM GUI 在所指定的某个图标或其他 GUI 控件被单击的时候执行 DEFlNE_EXECUTE_

ON LOADlNG 只能用于编译型 UDF 中，在 FLUENT加就编译完 UDF 时执行.

二、模型指定的 DEFINE 宏

FLUENT 中的模型指定宏比较常用 . 表 11-17 列串了相关模型指定宏的函数名与功能.

褒11-17 销关榄型指E宏的函'也名与功能

，.画'配备稼 功能

一

自定义边界截面上的变量分布

自定义111寻属性

用于修正壁画的焦渴.

返回所有组分的..... 摩尔反应事

在始定时间步上相分获..所有翅份的均-tl1~".反应事可用于 EDC 和
PDF.后穰型

定义用户，厚项

部分预混越健懊型中的混合，曹攘的定义
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DEF哩NE PROFILE 

DEFINE PROPERTY 

DEF哩NE HEAT FLUX 

DEFINE NET 民区ATlON RATE 

DEFINE CHEM STEP 

DEF1NE SOURCE 

DEFINE CPUI 

DEFINE TURB PREMIX SOURCE 一-一

DEFINE D1FFUSIVITY 

定义.模憾键牟利温厚项

用于定义组分.运方程戴着用户臼也义标'瞌 WDS) 方息中扩融事和扩
傲，晨'段的确定

常用于修改界面上的扩徽Ii射到院和扩徽... .. 

改变将殊反射学越明肆面的内褒丽的巢t!.院

改变关于离徽坐标辐射榄自盟中辐射.远方耀中的泣t!项初'防唰项等源项

为精射模型定义精则分'段相函'院

用于j;阳帽的愤型命定义辐射强厦簿，敛

DEFINE OOM DIFFuse REFt.ECTlVlTY 

DEFINE_OOM_SPECULAR_REFLECTIVπy 

DEFINE DOM SOURCE 

DEFINE SCAT PIIAse FUNC 

DEFINE SOLAR INT自唱SITY

DEF剧E ORAY BAND ABS COEFF 

DEFINE VR RATE 

DEFINE SR RATE 

DEF剧E NOX RATE 

DEFINE sox RATE 

DEFlNE]R..阳回

• 
自定义灰帘的吸收系，险为温度例果-+锄lI< 用于1院获懵 DO辐射损型

自定义容疆民化学反应速事表达董忠

一一定义用户寝面反应拿

用于...必 细胞料"备" NO恨的尘"'，.

.改"'"的生成率

在锥子裹面a庭模型中臼定义个帷子表面反应
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缕缕

拿画'由各.. .." 

DEFlNE_PRANOTL_(D . ιO. T、 T_WALL) 用于蛐槐计算命规定各个梢'‘.，障方疆的..峙'段

。EfI'NEJRU8ULENT_V1SC臼IIT 自E意义-"，恤'在性系'险的画画敏

DEFINE_ WALL1UNCTIONS (!定义'且画面'除

三、 宰相流模型中的 DEFINE 宏

多相流模型中的 DEFlNE 宏只能用于事相流模型中，主要宏函数如表 11-18 所示.

褒 1 1-18 ~帽流镇型中的 DEFINE i;

宏画'由各栋 功能

DEFINE CAVITAnON RAT在

τ 

对 个多相混合"111'‘动'皇立自于压为，表为葡导装产生水，庭
内的模盛

规定关于多栩罐里~栩间栩豆作用变量的\JDF.

捕定多相反应遵事

，指定多栩施动问题巾的..w.遮事

定义相同遮II滑移

DEFINE_EXCHANGE_PRQPERTY 

DEFINE HET RXN RATE 

DEFINE MASS TRANSFER 

DEFINE VECTOR. EXCHANOE PROPERTY 

四、离敝相模型中的 DEFINE æ 
离散相模型中的相关 DEFlNE 宏函数且功能如表 11 - 1 9 所示.

襄 11 - 1 9 离触徊馈型中的相关 DEFlNE !f; 

黯函'由各掠 功"
臼定义缸子到撞撞界后的状态

建义除拍子重力'"阻力外的J<锥体狈力

臼'"义顾槐加温体之闹的阻力属敏

定义瓢'宣撞击!I襄面后的禽幢庸"民‘民

臼鑫又顾槌糊连鲸徊'‘你的佬'民和".

a定义癫融入射到'‘蝠咿的钢'自备，非

自鑫义摊子的定停

修改写入取样输出的内理'

臼定义离徽拥抱子的材料属性

在每次'因艘位置更断后更新钵量的。‘

自定义'童子运动方:郭中的"项

。定义嚼"椒'目中穰"闸的111‘"黯

.，重施于拿仰之闸的钳缺标准

自定义'施..划...型中的时间多 .. 

指定平衡，眼汽压力

DEFlNE_DPM_BC 

DEFINE DPM BODY FORc e 

DEFINE DPM 0民AG

DEFINE DPM EROSION 

DEFINE ÐPM HEAT MASS 

DEFINE OPM INJECnON 刑π

DEFlNE DPM LA W 

DEFINE DPM DUTPUT 

DEFINE DPM PROPER'γy 

。EFINE DPM SCALAR UPDATE 

DEFINE_DPM_SOURCE 

DEFINE DPM SPR.AY COLLOOE 

DEFINE DPM SWlTCH 

DEFINE DPM TIMESTEP 

DEFINE_DPM_ VP J罔UILlB

'
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五 、 动网梅模型中的 口EFINE 茸

动网格模型中的相关 DEFINE 茸函数且功能如表 11 -20 所示.

褒 1 1 .20 动网幡棚里中的相关 DEFlNE 宏

UI配备穗 1 功能

DEFINE GC MOTION 定义重心移动

DERNE_G回M 定义变彤的儿何区坝。嚣'面配置节"

DEFlNE 0则o MOTlON .立撞倒每个嗜血的运鞠

DEFlNE_SOOf _PROPERTI固 定义移硝萄体的六自由Il运确规锦

11.3 UDF 的解释与编译

UDF 编写好之后宿要通过解释或编译将其加载到 FLUENT 中 . 解释和1蝙译的英文分别

为 mte叩，，' 和 compile. 下而分别介绍.

11 .3.1 UDF 的解释
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UDF 解释是最简单的加载方法，优点是不需要量装 C 编译错，适合简单的 UDF 程序.

UDF 解释的过程很简单，首先将编写好的 UDF X件直直至工作目最下 ， 然后执行

FLUENT 中的 Define- User.Defined - F山ctions-Interpreted 命令 ， 弹出如图 11-2 所示的

UDF 解释对话框， 在 Source File Name 栏中输入编写好的 UDF X件.ß(后缀名为 ".c勺，

或利用 勘_.-按钮查找 UDF X件，单击旦旦j掠钮，叩开始了 UDF 的解释 . 若勾选

Display Assembly Listing 选项，规图窗口中还会显示解释信息列表. 如果程序有铺误 ，

FLUENT舍提示错误的原因旦发生错误的程序行数 • 
• ，咽跚跚跚"1m …·电

--陆- 旦旦=.1
CPI>C__N..e 
F一一一­

Stect Sln 

同..---一丑
r m.pI.yAsu圃Iy u....
r U..C.~~dCPP 

旦旦L.:旦!.J ... I 
黯11-2 UDF 解"对话倔

解释成功后 ， UDF 就已经加就到了工程中，用户可根据需要在边界矗件、材料属性或

其他对话植中调用.

11.3.2 UDF 的编译

由于有些 UDF 函数不直持解辑运行，故需要对其进行辅译. 编译的前提是必须正确去

装 ClC++编译器 .

3描



正确安装 C/C++编译器之后，执行 FLUENT 中的 Define→ User-Defined→ Functions→

Compiled 命令，弹出如图 门 -3 所示的编译对话框.

'咱
S...rc. r:u .. 斟

|
」

时 -1 Mt_缸， m..

l J l 
二"... 1旦旦J .-... ! ..2空空」
山...， ...... 1""" ..;."" ---一一一一」巳」

且旦J It..e旦 旦旦」

回 11-3 <JI)F äh李对话枢

对话框左侧的 Source Files 列程用于增加和显示 UDF 程序， 右侧的 Header Files 列表用

于增加和显示需要的头文件.单击左但IJ Source Files 列表下的旦旦按钮，在弹出的 Select

File 对话框中查找需要加班的 UDF )J:件，单击~按钮关闭 Select F i l e 时话框.

回到编译对话框中 ， 即可发现 Source Fil es 列章中已经出现了加载进来的 UDF 文件名，

此时需要用户在 Library Name 中输入共享库的名字 ， 井单击 Library Name 在侧的一旦旦一l按

钮，建立 个共享库，同时编译 UDF 文件， 井把编译好的 UDF 立件放λ该共享库中.若编

译正确 ， 则可单击且旦旦」按钮把编译好的 UDF )J:件装栽到当前工程中来应用.

【实例 II-Il 槽道内箱体运动的 UDF 应用

在输液管道中经常遇到阻盛情况，如下水道杂物的堆积、输汕营内蜻和l沥青的沉积等.

遇到这种情况时，我们可以采取多种精tf措施， 其中组简单的方法就是加大流速将障碍物冲

出管道， 下面我们结合 UDF 介绍一下槽道内箱体在气流忡击作用下的运动情况.

-、 实例概述

固 11 -4 所示为槽道， 在距入口 2.5m 处有一个 lmx lm 的箱体，箱体在入口气流 lm/s 的

作用下向在运动.

气

-+ 
--+ 
--+ 

'm 
同一--1叫

2m 

'm 'mJ. 
问 "m 叫

因l! -4 帽道衡?体运动几何iII型筒刨

思路分析

作用在箱体上的压力是推动其运动的主要力 ， 在压力的作用下箱体向右做加速运动，加

速度的大小由压力决定 ， 而压力沿流程卫是逐渐改变的 ， 因此本例需要使用 UDF 程序来E

新不同位置箱体的运功速度. 由于本例箱体是在不断运动的 ， 因此还需要运用动阿格模型.

通过本实例的演示过程，读者将学习到

• UDF 的描写，
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• DEFfNE_CG_MOT10N 章，

• UDF 的 IP辑，

• 动网格模型，
• UDF 曲调用 -

~(uu)一#见附带先盘"刷刷卜l.msh ..、"削\s111- l.d旷、"川15111-
I.jou ..、 "Chll、11 l- l.tm ..、 U ChJ I、111- 1.cas "、 u Ch l1、1I 1 - 1.dat " 、

"Ch l1 \d.c飞 "Chll飞dong.mpeg n . 

'‘... " Chll飞AVT\sIII-I.avj"o

二、模型建立

1. iF/i GAMBIT，首克建立代在制的拒形面 . u ['i" -~ -f霄，在
Create Real Rectangular Face 面极的 Width 和 Height 担分别输入 10 和 2 . 单击

. 然后在 Create Real Rectangular Face 面艳的 Width 和 Height 拉

都输入 1 ，单去E豆画::1接扭，得到如固 11 -5 所示的几何图形.

" 
h 

图1]-5 矩形面的始.，

2 下面;j'iJll~_将代在制的面 2 移动王正确饵，即在 M叫C响 Faces
面扭中选中画 2 . 悻持 Move 为红色选中，在 X 担输入-2.5. Y 拦输入-0.5 . 单

去宣豆画主1按钮:t.且移动雄作.

3 阳来就是址行峭的布尔操作，特 Face Ó1"- '1' élJ l !L棚，在刷刷的
草一行 Face 中i&取 facc. I (大扭形面)，在革二行 Faces 中i&取 race.2 (小矩

形ó1 ) ， 单击ι..... I柱扭，克成布尔减操作，最后的儿何模型如图 11-6 所

示.

E 
回11~ 建立好的几饵"型

三 、 网格划分

本例可以直接对面域进行面同格划分.

1. .\'-..而-['1iï-W， 打开 M国h Faces tf1~ . 在 F.国叶选取几何翩翩
( face 川， 设置网格划分方式为 Tri 羊ι和 Pave 法划分，选择 Spacing 下面的

lnterval size ， 并在左侧输入 0.1 ，单去E豆豆二l接扭，生成如围 11 -7 所示的ó1

同格.

2. .\'-..[-.→南，在 Speci市 Bound町 Typ白阳中选择左侧入吨，制定义



为 VELOCITY INLET 边界，%，称为 10; 选择右恻出口边，将其定义为

OUTFLOW 边界，名称为 out; 选择箱体的左 右 上 3 司马边，特它们定义为

WALL. 名称为 x-bian . 如圈 11-8 所示.

'" 脑-

1,.- 1 ... 胆

图 11 -7 面网格 图 11-8 边界樊型的定义

3 执行 File- Export -> Mesh 命令，将同格崎出为 slll- l.msh .

四 、 UDF 程序的编写

由于简体主要沿 x 方向运动，故得定义 x 方向上的力 ， 加速度由力/质量得到. 本例的

程序如下:

#include "udf.h" 

static real v..J)rev = 0.0; 

DEFrNE_CG_MOTlON(movinLbody, dt, vel, omega, time, dtime) 

{ 

Thread 气，

face t f; 

real NV VEC (A); 

real force, dv; 

NV S (vel , =, 0.0); 

NV _S (omega, =, 0.0); 

if(!Data_ Valid_P ü) 

第
门
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retum; 

t = DT_THREAD (dt); 

force = 0.0; 

beginJ_loop (f, t) 

F AREA (A, f, t); 

force = force + F] (f, t) • A[O]; 

} 

endJ_loop 伍。

dv :: dtime • force 1 100.0; 

v yrev = y yrev + dv; 

vel[O] = v""prev; 

} 

程序编写好后，保存立件名为 d.c . 井放至工作目录下.

五、 求解计算

启动 FLUENT 二飨单柑&计算器，执行 Fi le→Read→Cru;e 命令，读入划分

339 



p
c
m
z
4
流
体
分
析
及
仿
真

实
网
被
程

340 

好的网格立件 "slJ J -l.msh" • 

2 执行 Grid→Check 命令， 时间格进行桂割. 成功栓嗣后窗口鼻函中最后一行出

现 "Done" 语句 . 执行 Grid→Scale 命令， 弹tI:! Scale Grid 对话枢.本制模

型在 GAMBIT 中是按 m 生成的 ， 放保持默认世直即可，单击主旦旦接扭是间

Scale Grid 时话框.

3 启用非是常计算， 即执行 Oefinc-Models→Sol ver 命今，在伴出的 Solver 时

话柜中选中 Time 下方的 Unsteady，其余保持耻认，单击-巳J接扭. 执行

Deflne→Materia l s 命令，事照前面介绍的方法调用材料一一-水.

4 主选定义克后设置操作环境，执行 Define→Operat ing Conditions 命令，打开

Operating ConditÎons 时话桩，如圄 11-9 所示，保持耻认设置，单击~接

4豆.
" 11112:21' ZAU2Ú2… 咱

如PMMmM叫

--阳._c叫
)( .... [ï一一一­

... ....r一一一

~巨型」四
四川， 11作野雄设置

5 撼着走义过耳牵件，执行 Define→Boundary Conditions 命今，妹出 Boundary

Condit ions 对话框.左边的Zone 为持走义的边界名~.右边则为时血的边-If­

是型，本制定义如于.

. 选择 fluid . 其盎型 Type 为 fluid ，单击 set.... 按钮，在 Fluid 对话框中的

Material Name 下拉列囊中选择 water-liquid . 单击 OK .

• 选择 10，其提型 Type 为 veloc町-inlet，单击」呈-按钮，在回 11-1 0 所示的

Velocity I nlet 对话框中的 Vclocity Specification Meth叫 中选择 "Com阳nen旷，

Reference Frame 选为 Absol ute，在 Vel田ity Magnitude (mls) 中输入!.最幸

进口速度为 1时S. 最后单击」巳」按钮完成速度进口 m 的设置.

EI 

…「…h崎加描向_øjC呻自庸 3 
陆叩，，-陆面

H自由同l'

V怕曲同F

• 

问一问
可
d
可
d

一旦.J 1!:!l 2旦J
图11-10 蕴11温口设置

• 选择。川，其提型 Type 为。utf1ow ， 单击 8-'-.. J查钮，在 Outf1ow 对话框的

Flow Rate Weighting 中输入 1 .表示进入的水均从班出口班出 .



上述步骤世置完后，到了本例的关键一步，即加载 UDF 程序.

6 执行 Define"'" User-Defined 司 Functions..... Compîled 命令，妹出如圄 11-11 所命

的蝠译对话框，单击对话植左侧 Source Files 列在下的」旦二』安钮，在伴出的

Sel回 File 对话柜中量找 UDF 文件"缸"单击一旦」按钮是闲 SeleCl File 时话
担. 回到摘译时话植中，即可在现 Source Files 则在中巳挂出现了加就追求的

"d.c飞默认Library Name 中共事碎的名字 "libud俨 ， 单击 Libra叩 Name 右侧

的-制旦， 建立-个共事库，同时属译 UDF 主件，此时 FLUENT制

窗口中会出现蝇译仿息，如圄 11-12 所示. 编译正确后，单击 '"" 1接扭扭酶

译奸的 "d.c. 加拿且到当前工程中来.‘ 

|~- ., r :=J 副叫陆睛'由

- l ~空空」 主"，，_ 1 _ 1

出~.-阳.. M 

回1I. 1l 偏涛对话黯

叫，
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因川口编海铺息

7. ，.-一步进行动网格模型的走义 ， 执行Define..... Dynamic Mesh -0 Parameters 命

令，在蝉出的Dynamic Mesh Parameters 对话柜中句边的namic Mesh 埠项，对

话柜自动展开， 如圄 11-13 所示. 在 Sm∞thing 迫项卡输入国示#数.句边

Mesh Methods 栏中的 Remeshing 这项 ， 单击 Remeshing 迫项卡，勾追 Size

Function 迫项 . 并输入圄 11-14 所示的各事歇，单去'"如缸.
'1"... ,. ...J. 1 "'. "'" /x 

叩-

W 阳-嗣.. 
C ""，，"旬，

C '" 

』呻坷 I~惆阳. 1 Rc_.嗣 1-睛<1阳001' ....... 1

S",,", C_II'" f_f1一一一

8叫町阳嗣四-1'一-

c…喃自恤.....~面一一

甲， 011110.叫r一丑

「 抽阳_.

;医主旨

~王 1 I ....!旦J

fØ 1 1 . 1) 即nam i<; M甜".田回国对话惬
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E 
… 
阁 。1"'-......c_ 
「
「蜘阳时

h翩翩咱l叩咽险-1同_1"00f"白. 1

句伽-

川u"叫"--… 「叶~

叫…0_ 
r叫
W 幌..刷刷

阳帽U晴-"'"I '~，'-­
M呻跚跚

..._ c.._四"F一一

1'" 

h』'A声j_.-…- 1' .:3 ... 回_.蛐-I' .'~

.. '由--('-1一-

胁， ' 

坐E里l

-旦」 王-1 旦旦J

阻 L 1.14 Re耐$hing ..数目.11

遣. ， ...例还可以iA JJI 边界型品矗交代替 UDF . 周边界型品很时 ， 可以划分为结构简格 并采则动."岳

(Layering ) 技水

8 执行 Define→Dynamic Mesh - Zones 命令，设置边界型晶晶的使用时卑，选择

Zone Names 下拉列在中的 x-bi血，设直其是型 Type 为 民igid Body (刚体运

动) ， 选择 Motion UDFlProfile 下拉 f'l在中的 xt: :libudf (上步已经将其导人

FLUENT)，保持 Motion Attributes 选项卡命的其他默认设直. 选择 Meshing

Options 选项卡 ， i1 .1. Cell Hei酬为 0.1 (部近网格的尺寸).单击'"立如钮

克成实体的运动性置，如圄 11-15 所示 . 选择Zone Names 于拉萨l在中的

wall . 过直其桌型乃阳 为 Deforming (史形).选择 Meshing Options 迫项卡，

输入圄 11-16 所示的事It. 最后单去主旦旦接扭是闭Dynamìc Mesh Zone币对话

桂.

I 
叫

_. 
r 副--.

e 民栩.h御
俨 。"叫

c "~叫"

时叫… 1--问叫句阳l

前嚣主a
"由.~呻.­

• "'"1'---
Y"' lil'--一

3 
C叫"叫…

T1rIcIoo-.z... f'一一

阁11-15 集体运动设置



ZeH N_. 
同一-

'''' 俨 2…"、，
俨 民句"…v
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俨 υ·…

‘ 

--蝇. 1 Gc.-try 0CtWIMI0 ( 
.......缸-咱.......

- -句 r. ... 旬，P 阴阳"刷.. r ，鸣曲"

_ .... …钳制Ie_.w.， ....... 
... 饵-"翻'如嗣同r.丁.陆... 

r l . ,. 
叫甲恼...响叫了一一

M翩翩帽.-….

叩础楠mji

阁 11-16 底边变形位置

9 动网格模型设直克后，执行 Solve -- Control ..... Solution 命今，保持耻认#截住

直，单击-立J接缸
10 接下来对埠场进行相始也 . 执行 Solve..... lnitialize -- lnitialize 命令，在

Solution lnitial四tlon 时话柜中选择 tn . 蝠序单击」旦J 旦旦j. ~旦乙按钮.
1 1 初始化后，执行 Solve -- Monitors → 民由idual 命令，在弹出的 Residual

Monitors 时话据中选中 Plot，打开虫草曲线圄. 时话框下方的 Crileria 中可"

输入各在挂的收敛柑庄要卓. FLUENT 默认为 o∞1.本制悻持默认，单击

一旦J按钮.
12 下面设置本制的动画画.执行 Solve -- An imate..... Define 命令，弹出 Sol ution

Animation 对话桩，通过右侧的箭头将数字从 0 调成1.如围 11 - 1 7 所示， 在

Name 栏输入 dong ， 将 wh剧性直为 Time Step , Every 谊直为 10 . 即每一楠

的最啤时间为 10 个时间步.

M ",.ø," S e阳出「封

I ADtW. N.me E,,",IY WM晴 4

「 阿γ一- [11封面"W::J 旦旦::J '
r !~，，，，， .n{. r--丑F可「丁."' .. ) 
「同.....c. p丑 1 " . ，.，，， n 丁二ι」

「同""0.. r丑 I ' ， r ， '"τ丁ι」
r t~."".古?厂丑r一丁ι.::..J二

一旦J 旦旦旦旦J
四川口 动画个"设置
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13 往母对动画进行详阳设置，单击靠一行最右侧的E至哥拉扭，弹出如圄 11 - 1 8

所示的Animation Sequencc 咛话梧.

……m 
s......rJ阴阳 "翩翩

F 幅幅....，. 阿可

: zt咱陆-1'一封国
......。缸'町

ω.，，~Twoe 

""" 
F 问刷刷.. 

三 I

r .. 嗣. ..咄

俨 嗣阳

俨告丁
~--I 

~旦旦丘U
回] 1-18 A刷m..咽 S饲筐~对话幌

14 选择对话柜中的 Storage Type 为 Metafile，在 Window 中输入\，通过单击右

倒 '. 1按钮使时庄的 ;d 窗口生效，此时会出现一个空白的圆形窗口 . 选择

Display Type 下方的 Grid，单击-已如扭.

16 

克咸丰边设直后，执行 File → Write- C吕e 命令，将工程丈伶保存为 sll l­

I.cas 

执行 Solve→Iterate 命令，设直时间步长 0.055，时间步为 2∞，单金主....按

钮开始解耳.

选代克后，执行 Solve→ Animate ..... Playback 命令，打开如困 11-19 所示的动品

回放时话框( Playback 对话枢).选择 Playback Mode 下拉列在中的 Play

Once，即回社一次. 选中 dong，保持 Start Frame 为 1 ， lncrement 为 1 ， End 

Frame 为 20 . 即从第 1 蛐开始回社直至第 20 蛐. 拖动 Replay Speed 革动串可

d控制动画回挂的追庄. 最后在 Write/Record Format (悻存格式)中选择

MPEG . 单击卫生腋钮. 此时可H看到窗口 1 中的迫在动画开始重嘶描址，

格放的同时， 动画在工作目录下保存为 mpeg 的格式文件.

阴句禽... 

时...-阿瓦m ::J 

俨且1俨哈萨... 量

丰 一- -"
-=J斗二F二L:J到
二j 一且j_ IWfoi-v Spu' f_ 

H陆时._.阿苟言二了丁

…...阴阳

.... 帽~句_.

旦旦旦坠J I CJ.n J -.!:!!.旦」
圄 1 1.19 凹町讪，k对话据

I 

18 执行 Display - Contours 命今，选择 Contours of T拉萨i在中的 Velocity 和



Velocity Magnitude . 得到$"迫云图，如圄 11 -20 所示.

19 执行 Display - Vectors 命令，选择 Vectors of 下拉到在中的 Veloc坷，得到迫

庄矢量圃，如圄 11 -2 1 所示

20 执行 File- Write- Data 命令，将计算结果悻冉为 sl ll - l 削主件. 最后执行

File- Exit 命令，安全退出 FLUENT.
U川盯 Im..，，"_.1 队 131 
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1 1.4 本章小结

阳 1 1 -21 法度矢'蓝图

本意主要介绍了 UDF 的基础知识. UDF 宏且 UDF 的解释与编译，重点介绍了 UDF 宏

且常用宏的功能，使读者了解了 UDF 的基本理论及量函数的使用. 在此基础上，通过一个

实例讲解了 UDF 的基本使用方法， 帮助读者掌握 UDF 的基本用法且相关操作过程， 为实际

工程运用奠定基础.
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第 12 章

典型工程实例

前面已经介绍了 FLUENT 相关模型的基本理论与使用方法， 所草草例均置扣模型的实

际运用与操作而展开. 读者在积露了前期模拟经验之后 ， 需要结合实际问题进行有针对性的

仿真计算 ， 以期有放指导实际生产设计. FLUENT 的丰富物理模型及数也算法可以帮助用

户分析航空航天、土木工程、石油工程、机械设计等方面的相提问题， 如石油工程中的钻井

完井、井下分析、泄漏扩散、$相管流、 燃烧爆炸等均可以利用 FLUENT 从仿真的角度去

进行流动分析.

FLUENT 包含糊流模型、事相流模型、传热模型、动间棉模型、组分输运与化学反应

模型等多个模型，针对具体问题，究竞选择哪个模型，定义何种边界矗件， 是否要借助

UDF 函数等都是我们面临的实际难题. 本意将结合石油天然气、环撞、机械等工程领域的

典型问题进行 FLUENT 流体骨析且仿真的介绍， 通过 T 型管内气液分离流动模拟、 空气钻

井环空气固两相流动模拟、 气井井下节流流场模拟等实例的演示，帮助读者掌握解决工程实

侧的思路 ， 井学舍利用 FLUENT 去分析实际问题. 由于自然界和工程问题中遇到的绝大部

卦流动都是事相流动，且常常需要调用 UDF 函数且动网格模型， 所以下面我们针对宰相流

模型、动网棉模型且 UDF 的使用 ， 讲述 4 个实际工程中遇到的典型例于， 帮助读者掌握解

决实际工程问题的，也路相方法.

主室里
• 工程实例的分析思路. • 可压缩气体流动分析.
• 模型的选择. • UDF 的工程应用 .
• jC相撞幢型的使用 . • 动网格模型的使用 .

主主主组
• T 型管内气班分离班动模报.

• 空气钻井耳空气回两相班动模拟.

• 气井井下节撞撞墙模拟.

• 齿轮章内革体班勒模拟.
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12.1 T 型管内气液分离流动模拟

在石油工程且环榄工程领域， 经常涉及到气液分离的问题， 目前用于气液升高的方法有

很多，包括重力沉降、折流分离、离心力分离、丝网分离、超遮卦离且填料分离等， 其中 ，

最方便的一种方法就是重力沉降法，利用 T 型管来实现分离效果. 下面我们针对此类问

题， 介绍 FLUENT 的工程应用 .

一、 在倒概述

图 12.1 所示为一个 T 型营，横管、垂管直径均为 O.03m ， 水和空气的混合物从下端流

入， 其中水的进口流速为 1. 5m1s 空气的进口流速为 1 .6m/s，空气的体积分数为 0.02 ， 气泡

直径为 Immo 混合流在 T 型交叉点处分流， T端入口段长 O. 1 5m ， 上端垂管和横管长都为

O.3m ， 其中上端出口质量流率为 62%. 右侧出 口质量流率为 38% 0

思路分析

本例涉及到气液分离 ， 故需要调用事相流模型 ， 卫由于给出的是气泡直径 lmm ， 所以

应将水定义为基本相，而将空气定义为第二相.

通过本实例的演示过程，读者将学习到2

• 1-相撞模型的使用，

• 相间相互作用的设定，
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• 施量守恒的判里，

• 现合模型与欧拉模型的对比，
• 体积分散云图的查看，

• 矢量图与等值蝇围的叠加.

哑....)一#见附带先盘"气咱4飞咄Cωh口川》
l .jou"飞、 " Chl2飞\s1l 2- 1 缸Yη， "飞、 "Ch l口2飞、5 1川12-斗l-mi川x阳r陌e.c圄 "飞、 "Ch l山2飞怡511 2- 1

m，眩xt阳"'阳e.da创t"飞、 "ChI2'飞怡回s剖l川1 2-1-噜e剧u旧le衍r.ca副s飞 "Chl口2飞Is ll口2-I-eul眈 da刽t "飞• 

(uu) 参见附带光盘咄12\AVl\s11 2- I.avÎ n . 

二、模型建立

1 双去 GAMBIT 的桌面快绽万式， 启动 GA如田IT.

本例模型需要建立两个面域，然后进行布草加操作

生成回 1 2-1 所示的几何模型.

2 单击陌-~ -~， 在 圈 12-2 附的
。eate Real Rectangular Face 1iJ扭的 Width 和

Height 中分别输入 0.03 和 0.45 ， 并选择

Direction 为 +X+Y ， ...去芷豆画工1按钮.
3 在 Create Real Rectangular Face tfJ扭曲 Width

和 Height 栏分 !'I 输入 0.3 和 0.03 ， 单击

E豆豆工j按钮. 此时的视围窗口如圄 1 2-3 所示，

战.

下面需要将第二个代表横主臂的矩形面域移动至正确位置， 井与第一个面域合井成一个

面.

4 单击 Face 1iJ.+.i.中的F按钮， 在 Move/Copy 阳回阳中选择面 2 ， 保持
Move 桂选中 ， 在 Global 下的 x 中输入 0.0 1 5 ， Y 中输入 0. 1 5，单击E豆画二l
接扭完成域面的移动掉你.

5 单击 Face 面板中的I盲棋钮， 在 Unite Faces 面板的 Face 中选取画 I "'00 2 , 

保持提型 Type 为 Real，单去E豆画二l接扭， 克成布尔加操作. 此时的视固窗

口中的几何模型女，固 12-4 所示 ， 00 I 与 002 合并且了面1.

- Ii百一
帽.. ~

主l一栩i

… -p
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z
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流
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回12-2 cr四 Real Roctang l,llar F阳面拯

已显示有两个推立的把市面

1,li 

6功 、J‘

回 12-3 两个独立的矩形茵场 因 124 儿何，.型
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三、网幡划分

下面对计算区域进行罔幡划分.

l 由于本制的计算ßl&.较简单，故单击「百→I百-- f否， 打开 Mesh Faces 面
板，选中本倒计算E峰的i! 1 ， 且 "Elements: Quad" 和"Type ， Map" 的罔

#划分方式，并革用 Interval size 为 0.005 划分.，网格，保持其他默认设置 ，

单击-.!I岳二」按钮， 生A如圄 12-5 所示的画同格.

2 同制l分奸后定义迫冉典型，单击fWï -f莓，这中下~进口边，以为追庄
入口边~ ( VELOCITY _lNLET), -1;非为 m; 选中i;倒出口边，定义为自由此

埠边界( OUTFLOW ), -1; '*为 out-y; 同样将土部出口边也是:t..:h OUTFLOW 

迫冉，-1;非为。ut-s . 如圄 12.{; 所示.
_00'矿山

言'‘"…凶'"刷

-" 一LDC !lY.1 "",-[1 

回lH 烛"集型的忠义

将网格输出为 sl12-I .msh .

四川， 攘盟网格

3 执行 File- Export司M目h 命令，

四、 求解计算

1 启动 FLUENT 二维单柑庄计算器. 执行 File_Read_Case 命令，读入划分

峙的网格文件 "sIl 2- l.msh" . 同掉该人之后，执行 Grid→Ch田k 命令，措圭罔

格的悻息，峙矗后一行出现"Done" 语句 .

2 执行 Grid-Scale 命令，摊出 S国le Grid 时话桩，本倒不需要重伤定义同格

的尺寸，从如圄 12-1 所示的对话柜中可看出计算E峨的尺寸范围.

3 执行Definc-Models-So1ver 命令，弹出 Solver 时话桩，~相，且模型只能选

m压力晶卓解嚣，这里保持默认设直.直接单击一旦J接缸.

4 执行 Oefinc_Models→Multiphase 命令，在弹出的 Multiphase Model 对话框

中克i&4t Mixture , Multiphase Modcl 对话握自动展开， 句地 Slip Velocity 和

Implicit Body Force 这项 ， 如圄 12-8 所示，单去一旦如恒，是闻斌对话植.

C ~ 

r….阻

"-俨 E由

俨阳 •• 

X厂一 GOIiII_ er.... .. F丁
'1'一 ~坦旦旦到

-"'[ï一-一』町r一

田""" 1' - .... "I.c.~.，---
....叫

'国.... 歪'""

" 
阁 12-1 S饵"。而对"帽 因12-8 多相.\l1I!设置

「
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5 启用鸡流模型 . 执行 Define-→Models→Vis∞us 命今， 弹出Viscous Model 时

话岖， 在 Mode1 i&项中选择 k.epsilon[2 eqn] ，在 k-叩silon Model 埠项下选择

Standard ， 保留其他默认设置， 单击一旦」接扭.

6. ~队照前面介姐的方法定义宝气和水两种材料.

7 定义基本相和事二相. 执行 Define→Ph酣S 命令， 在 Phases 对话框的 Phase

刑在中选择 ph国时，在 Type 选项中选择 pnm町-ph副e. 拙后单去」注二峙
钮. 在国 1 2-9 所示对话框的 Phase Material 列在中选择 wat町'.liquid ， 并在

Name 主本柜中输入 water 代替原幸的 phase- l ， j事击一旦且会扭. 剧后在 Phase

列在中选择 ph陋。2 . 在乃F 这项中选择 secondary.phase . 单去1主μ按钮，

在围 1 2- 1 0 所示对话柜的 Phase Material 列在中选择町，并在 Name 且本柜中

输入 a"代替原束的 ph剧。2 . 同时在 Properties 下的 Diameter[m] (直径)中输

入气地直径。∞1. 单击-巴」接扭.

回国幽幽幽………E画

3主主过
。，叫

3卫ι」-嗣同I阳回

严百

F= 
向…m制I..... .~ ，" :::J ult....1 

一旦」匾豆L.'旦J
",12-9 A5本相"宽 阔12- 1 0 第二相像E

8 回到 Ph国目时话柜中，单去E豆豆哥拉钮， 如圄 12- 11 所示. 此时会打开

Phase lntercation 时话框， 如困 12-12 所示 ， 我们可旧在斌对话柜中走义不同

相间的相互作用 . 这里选择 Drag Coefficient 中 的 schiller-naumann ， 即是义气

地与水之间使用 schiller-naumann 来吨x.相间阻力 . 单击 Slip i阜项卡，此时相

间的滑移追庄公式革用的是默认的 m皿ninen--et.al，保持其设直，单击-丘且安

钮，是闭 Phase lntercation 对话桓.

。叫 |恤 I c"_ I _ 1..... 1 M… 1 阳_. I .......T...... I

回国国·皿………·匾'
~~，… 

3.!旦」 AFlr r.IM~'~W，--一 忡幅幅-

f1FJJ 
」

一旦J I2亘!L!旦J
回 12 . 12 .. 曾向作用的设重因12. 11 phases对"帽



9. j/时于Define→句erating Conditions 命令，打开Operating Conditions 对话植，如圄

12-13 所示，选中Gravity. 指定重力方向为 y 轴，在 Y[mls2]主本桓输入-9.8 1.

同时选择 Specified Operating阳明项，并在文本柜中输入 O. 单击-巳」接扭.

悖旦出'叫

-阳--回翩翩 貌"罚庐-…一…­

K网「一一一 ，-匈fi:i1一-

YÞOOI f'一一一一?"世如响阳--

' .……叫严血盟主

-坐」 旦旦 ""' 1
回归 13 镰作环填~置

10 定义边界串件 . 执行 Define→Bound町 Cond阳ns 命今，伴出 Bound町

Conditions 对话桩，定义如下.

• 在左边的Zone 栏选中 m . 保持 Phase 为 rnlxture，单击 8...... ~查钮，在回 12-
14 所幸的 Veloc町 Inlet 对话框中选择 Specification Method 下拉列囊中的
lntensity 阳d Hydraulic Diameter . 在 Turbulent Intensi可[%J 中输入 10. 在

Hydraulic Diameter[m]中输入 0.03.

白白阳叫-1每-. 1 - 1蛐呻叫睛

一句-陶"阳-国-位~I ..:J 
，-抽剑』曲町「一一一-

w…"…，同[õ.百 一

翻12-14 耀食物温度进口设置

· 回到 Boundary Conditions 对话框，仍选择 m . 改变 Ph酣 为阴阳，单击

」旦CJ按钮，在固 12-15 所 示的 Y，1田町 lnlet 对话框中选择 Ye1田町
Specifi咀lion Method 下拉列囊中的 "Magnitude，Nonnal to Boun由ry" .井保持

Reference Frame 为 Absolute，在 Ye1田ity Magnitude[mls] 中输入1.5.单击

o. 且安钮.

-- -1'" 1"""'" 
悔，由 1-1-1-.1- 1咱翩翩1幽 l

掬--蜘--严-国..……町 且
陆-协-1-… 1

W呻嗣回晦'-r:o一一- 1- 丁

-"-.l旦旦到 - 1

回 12.]5 水的海 JJ:入口世置

• 再决回到 Bound町 Conditions 时话框，仍选择 in，改变 Phase 为 町，单击
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二丘~~费钮，在 Velocity InJet 对话框中选择 Veloc町 Specification Me曲。d 下拉

列章中的 Magnitude， Norma l to Bound町 ，并保持 Reference Frame 为

Absolute . 在 Veloc町 Magni阳de[mlsJ中输入 1.6; 另外， 由于速度λ口气体的
体租分融为 0.02 ，所剧这里曹要单击对话框中的 Multiphase 造项卡，在

Volume Fraction 中输入 0.02，单击 0< 且安钮.

· 在左边的Zone 栏选中 out-y. 保持

Ph8!雪e 为 mlxture . 单击 8.t....校钮，在

回 1 2-16 所示 Qutf10w 对话框中的 Flow

Ratc Weighting 栏输入 0.38，单击一旦」

按钮.

一坐」 旦旦」旦j
因12.16 幽口设置

• 同理，在左边的Zone 栏选中 out-s. 保持 Phase 为 mlxture，单击」主L按钮，

在 Outflow 对话框中的 Flow Rate We帧ting 中输入 0.62，单击」ιJ按钮.
1 1 执行 Solve - Control -. Solution 命今，弹出 Solution Contro l s 对话抠，选#

Pressure 的计算格式为 PRESTO! ，保持其他默认设置，单击~接但.
1 2 对，且场进行相曲也. 执行 Solve → Initia lize → Initialize 命令，在 Solution

Initialization 对话握中选择肌时进口相始化，蝠序单击~、旦旦l 卫旦乙
接扭.相始化后，挑行 Solve - Monitors -. Residual 命令， 在弹出的 Residua!
Monitors 时话柜中选中 Plot，打开战革曲线圄_ FLUENT 默认各事量的收佳柑

庄要卓为 o∞)，本剖保持II.i人，单击~接扭

13 克成土述步骤的设置后，执行 File - Write→ Case 命令，将工程主件保存为

slI 2-I-mixture 四s_

14 执行 Solve -. herate 命令，设直选代步为 1仪lO步 ， 单去旦旦旦接扭开始衅

算.这代收最后，执行 Display→ Contour.; 命令，选择 Contours of 下拉J'J在中

的P<essun: 和 Static Press隅，保持 Ph町 J'J在中的 mlxture . 勾选 Options 栏

中的 Filled 迫项， j再去E豆到接恒，得到如圄 1 2- 1 7 所示的剧辈分布云田 .
改!t Conto四 川拉到在中的 Vel叫 和 Veloc ity M咿阳de ， 单击且国
按钮，可得追庄分布云固，如圄 12-18 所示.

回，，-口压·纱布舌帽《匍舍'腿'但》

15 改吏Contours of 下拉J'J在中的选项为 Phases.. 和 Volume fraction，并选择

回 12-.1 越a分布云副《槌舍JIIII ) 



12-Phase 111在中的 wat臂，单击E豆豆1接恒，可得水的体租分扯云田，如圄
19 所示.

政直 Phase 为 81r. 可得气体的体和分数云圄，如圄 12-20 所示.
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空气的体积分'且 〈栅舍榄踵】
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欧锺''''谜量

-旦」 正-1 2旦」

5112. )-

回12-2地

在换用且#模型计算前，先将混合模型的计算结果保存下来 ， 执行 Fi le­

Write -Case 命令，将结果主件保4年为 sI1 2- I.m阴阳re.dat .

下面选用欧4主模型进行~相施计算，不需要退出混

合相计耳的工程主件 . 执行 Define→Models

→Multiph曲e... ， 在弹出的 Multiphase Model 对话握

中选择 Euleri酬 ， 如圄 12.21 所示，单去~接缸.

重嘶时 ，血 场初始化 . 执行 Solve - ln山alize →

Initialize 命令， 在 Solution InitÎalization 时话柜中选

择'" . 对进口扭曲化 ， 蝠序孚击」旦J . 旦旦j
王1.. 巳按钮 . 执行 File - Write - Case 命令，将工程主件保存为
euler.c目.

也行 Solve - lterate 命令， 说直追代步为山∞步， 单去生.... 柱也开始解耳.
追代收敛后，执行 Display - Contours 命令，得到现合物的压岳和气水两相的

体和分耻云圄，如圄 12-22 王圄 12-24 所示.

水的体职分11((精合槐凰》回 12 - 1 9

17 

19 

20 

21 

18 

*的体极分'民 ，11:怯帽'睡〉
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四

阁 12.24 空气的体狈分.((欧拉罐型〉

从图中可以看出两种不同的多相流模型计算出来的结果之间存有一定的差距，尤其体现

在体积分数云图上.

在混合流体刚进入横管时，欧拉模型的体积分数图中可以看到明显的水的体积分数极小

值区域 〈或空气的体积分数极大值区域)，而海告模型中的变化相对平缓.

22 改变 Contours of 下拉列在中的选项为 Vclocity 和 Velocity Magn阳巾， 并选

E| 排 Ph回到在中的 W阳，取消t);t. 0阴阳栏中的 Filled酬， 特应国
南~I 按钮，得到如圈 1 2-25 所示的水的速度等值线圄.
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因 12.2~ 水的鸡皮镰值键因

23 执行 Display.... Scene 命令，弹出如固 12-26 所示的 Scene Description 时话抠，

勾迫 Scene Composition 栏中的 Overlays 迫项，单击旦旦除钮后单击旦旦!fl安
钮，是闭坡时话框. 这样就可以在原来的视圄窗口中进行圄甜的叠加.

24 执行 Disp lay → Vectors 命令，保持 Vectors of 为 Velocity ，选择 Phase 为

Water，其余保持耻认，单击主堕tcl接扭，就可旧看到等值线与速度失量困的叠
加，如固 12-27 所示.

25 执行 File- Write- Case 命令，将结果文件保存为 sI 1 2- I -euler.dat .
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回 ]2-26 Scene ~ri酬。但对话悟

26 执行 File→ Exit 命令，安全退出 FLUENT .

回 1 2-27 等等值钱与失量圆的叠加
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12.2 空气钻井环空气固两相流动模拟

空气钻井是以空气作循环介质携带岩屑的钻井技术， 作为欠平衡钻井技术的一个耸立，

因其钻速快、成本低和对储层伤害小的显著特点岳呈人们关注. 上世纪 90 年代， 美国、加

拿大以及欧洲 些国革开始了气体钻井技术的应用，并不断发展完善.我国在上世纪 60 年

代对四川盆地进行丁气体钻井的早期探索，近年来，很多袖田的部分汹气井己推广气体钻井

技术，井取得了良好的效果. 但气体钻井的整体技术还有待进一步完善，尤其环空气固两相

流场分布的控制还需进一步研究， 以求菁效衡量空气的携岩能力和冲蚀效应，为工艺垂数的

世计提供依据.

一、 实例概遗

如图 12.28 所示，取井斜 5。的 10m 环空井段进行模拟

卦析，井眼 6月 16.5mm (环空外径).钻杆 Ø l 27mm (耳空

内径).王军管与钻杆的绝对粗糙度 O.04678mm (环空内外壁

的粗糙程度) .岩屑的密度为 2600kg/mJ ， 比热为
Il00J/(kg 町，导热系数为 O.3W/(m.K) . 气固两相混合物从

下部入口进入，空气流速为 25m/5 . 岩屑流速为 15m/s. 岩

O.127m 

回 12-28 环空攥型示塞图
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屑的体积分数为 0.02. 颗拉直径为 0∞ 1m .

思路分析

本例为三维的气回两相流动模拟，首先要建立三维模型 ， 然后在 FLUENT 中调用事相

流模型，可以是欧拉模型 ， 也可以是混合模型. 这里我们选择欧拉模型，读者有具趣可以用

视台模型试验一下，其具体操作见上例，这里不再详述.

通过本主例的演示过程， 读者将学习到

• 井斜耳空模型的建立，
• j.相欧拉模型的使用，

• 量属材料的定义，
• 壁面扭槌度的定义，
• 轴向剖面固的明割，

• 遇视轮廓且图形后处理~化.

(u".. )一#且附带光盘 "Ch12\s112-2.msh ，.、气hI2\s112-2.d旷、"吨Chl川川12山2\s川、
2.jou "飞、 'Ch1 2飞、.11口2-2 缸n"气、 'Ch12飞、sI1 2-2.ca础s"气、 "Chl口2飞、s l口1口2-2.da副， "飞• 

E一番见附带她 'ChI21AVI\s1l山'"·
p
c
m
z
→

流
体
分
析
且
仿
真

实
用
微
程

二、 模型建立

1 启动 GAMBIT . 特陌-~-[霄，在围 12却阳的Create Real Circolar 
Face liJ植的 Radius 中崎入 0.15825. 保持 Plane 为 XY (即建立在 xOY 00 
土).单击E豆豆::.J按钮. 然后在 Radìus 中输入 0.0635. 单击 ，里L.J按钮，

碍到如圄 12-30 所示的几何面战.

-阿 ，③

-曲".. 1>写了一旦l

h 立4

‘国 E
「丁画i:J ?r-1iiiM __ 

回 1 2 .)0 几何面.. 阻 12.29 C 回c Real C~ular F.，c 面'民

2 单击 Face 帧命的F按钮，在固 12-3 1 晰的 Subtract Real Faces 峭的革
一行 Face 中选取00 1 (fa由 1 ).在草二行的 Faces 中选取函 2 ( face .21.单击

-!I亘:::J按钮，即可用 002 去'" 00 1.得到耳宜的横截00 .
3. ....t.[百司~ -r;:'". >>.认 X. Y 、 z 都为 O. ... .t.r .... 豆口按钮，蜡制出席

点，然后在 x 中输入 0.87 ， z 中输入 9.9币.>>.认 y 为 O. 单击""' .画豆2按钮，

生咸阳上的另一，我 - ....f["j""-[百吨F. 在 Create Straight 臼ge 面时将
刚生成的两个精点相连.生成耳宜体的轴蝇，如圄 12-32 所示.
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幽画画... ‘·‘矗…-
- ~Il;~;' ;-' - 一-.!l

..,-
，由J)Kd 工工2主J..-
-且也J":豆豆L旦旦」
闸 1 2-31 Subt国‘ R.副 Fω~ 而'民 陶 12-32 始创输线

、

4 接下来由妓横截面生成整个环宜儿何体. Hf8-~司日军，弹出如国 12.
33 所示的 Sweep Faces Iil'品，在 F，e目中选取ó1 \， 选择 Pa山为 Edge，在

Edge 中遇刺惜制的抽血( edge 川，保持 Type 为 Rigid. 单去」盟二}按

钮，得到如围 12-34 所示的几何悼.

5 几何体生成后就不需要轴线了 ， 畔击 Edge Ó1'" 'f ~~棚，在国 1日5 所
示的面扭中选中轴蝇，单击 "'" 按钮，将抽蝇删除-

6 为 T 间格划分万佳，需要将体进行划分. 单击1百- r百吨用\在 Create
Real Rectangular Fa四面品的 Width 和 Height 中分别输入 20 和 1 0，并选择

Direction 为 ZX Centered . 单舍r.画E工}按钮，生成一个用于"1分体的面 .

r_ fjõ剧 t 主1
同蝠属 ,4·,HF, e V圃"

1.!I 
'" M..! "--阳. ...

.一-， . ，曲晴 、， ，嗣世

呻『一一

,,,., . 险勒蛐.. .-
，由

四 l

""-' --"'" 』

( 

ι "幽'1" 15 …·

_ .. 巳JI]t; .1 主l
J 叫

• _0 ' • 

....!!且J_豆豆L旦旦」
阳 12.B S ..... 饵pF~面扳 倒 12 .)4 儿何损婴体 帽 1 2-35 Deleu: Ed&e 面'民

7 . -1'- .,j; r百-r古- 1言， 在圄 1 2-36 所示的 Split Volume i1.4&.中衅 volume. l ，
埠取 Split Wi山为 faces ( Real )，然后选择 Faces 为刷生成的ó1 5 . 单去

-旦旦---1按钮，得到如圄 1 2-37 所示的几何体.

…...' ....."" - 声-， .!J 
幢幢」旦，.... ...1 

- IE!三::::J.!I
"-
J一
'一

...旦旦~-

阳 1 2.36 Spli! VoI\l四 面饭 阁 1 2-37 份制成的体
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二、 网格划卦

1. ...，t，r百-fF-[歹，在剧8田输入柜中选择径向的回牵线段，制 Interval
Count 的划分方法将其划分为 5 段. 利用同样的分段划分方式将内外圄由民都分

为 20 段，将轴向战段分iJ 50 段，得到如圄 1 2.38 所示的战同格.

2 单击「百叫fF-[亩，选择划分有刷刷刷帆轴向 !'I函，制 Quad 和
Map 的划分方式，得到如圄 12.39 所示的面网品.

r',;.? 
阁 12-38 貌肉" 随12-39 面网捕

3 轴[百4陌吗面，选中分割的两个体( volume. 1 和叫ume.2 )，制 Hex
和 Map 的划分方式进行体罔格划分，得到如圄 1 2-40 所示的体同格.

P| 4 网制l分奸后走义边界~"!I' . 单纠葛咱南，选中7邮址口画( face . 1 和
量自 fa目的，定义为追庄入口边耳 ( VELOCITY lNLET), .t非为叫选中上部出
岳王| 口面( face.4和 face . lO ).走义为自由出流主耳 (OUTFLOW )，名称为 out ;
覆在 | 选择内壁画(阳 3 和"四7)，将其走义为 WALL 边界，且非为 n酬.同样
在| 将外壁面( 也因 2 和 face.9 )也定义为 WALL 边界，名林为 waibi，如圄 12-4 1

~I "斤示 .
真

S皿

回 12-40 if肉馅 捆 12.<4 1 ib界樊堕定又

i 执行 File- Export- M田h 命今，将网格输出为 slI 2-2.msh.

四、束解计算

1. 启动 FLUENT 三罐单蜻庄计耳器，执行 File→Read→Case 命令，该人划分

峙的网格主伶 "sI t2-2 .msh" 网格读人之后，执行 Grid→Check 命今，检查同

格的信息，持最后一行出现 "Done" 语句 .

2. 执行 Grid→Scale 命令，弹出 Scale Grid 时话桩，本倒不需要重新足1网格



的尺寸，从国 12-42 所示的对话框中可H看到计算区峰的尺寸跑回 .

安 1
叫 F..... U....C............ 
"['一一 刷w.. Crc时 b'F丁

vr一一 旦旦旦旦旦j
zr一一

h曲h嗣

时间内有去一问ÞOOI I1 . mus 

VMill ÞOOI fi芳百一 "'"顾问 11.1SHS

h曲同F一一一- Z- "' I'"H 一

二.... 1 旦旦旦J ! êì .. e I tkl, 

回 归:-42 Scak Grid 对话舷

3. "-5(.本制所用别的模型 . 执行 Define→Models-Solver 命今，弹出 Solvcr 时

话框，保持耻认设直，单击-巳陆扭. 战行 Define→Models→Multiphase 命

令，在伴出的 Multiphase Model 时话握中选择 Eulerian . 单去」巳且安钮， 是闭

谅时话括.最后还需启用消流模型，执行 Define→Models →VÎs∞us 命令，
伴出 Viscous Model 对话框，在 Model 选项中选择 k-epsilon[2 eqn] ， 在 k­

epsilon Model 迫项7选择 Standa时，保留其他黠认设直，尊去-巴J接扭.

4 由于气体在井下的密度要高于标准密度，这里定义其为 1 Okg/m3 ， 故雷执行

Define叶Matcrials 命令，在 Ma‘crials 对话柜中选中 町， 民直其密度为

1 Okg/m' , t!\后单&旦旦旦旦主协扭.ZA空气密度改茸的是;/..，
5. i皇矗走 ;/，，11: I青材料.单击 Materials 对话植右侧的旦旦旦旦旦旦旦旦旦斗接扭，

在困 12-43 所录的Open Oatabase 时话握的 Database Name 中输入 new
materials ，陆后单企 盼_.按钮 ， 佯出如圄 1 2-44 所示的 User-Defined

Database Materials 对话框.

-」三民
s 

h呻阔...." i-田 3 
" 

"阳需二二:J'.'
_.-叫叫声百一iI

陶叫申创I

T王富忘昌E • 主.;;J

旦旦j ..... l -J e哩J Q回响吐

罔 12-43 open o.w.se对情报 圆 1 2-44 绪...性"配

6 在 User-Defined Database Matcrials 时话柜中走义去屑的美型 :IJ fluid ( J相iL
模型中的圄相需要定义为流体是型)，名非为 yanxue . 物性事敬如圄中所示
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3回

{具体的物性事数走且可查看前面章节，这里不再详述)， 单击主旦J和王opy ! 

按钮，将足且好的幸屑悻存在自在义材骨数据库中 ， 并导人到当前工程中进

行计算. 单击旦旦三品扭，关间 User-Defined Datab田e Materials 时话植.
7 回到 Materials 对话柜中，即合皮且在 Flu阳t Fluid Materials "'-.f.主列在中存在了

宝气和居屑两种材料. 单击 Materia ls 对话握中的王旦旦按钮，克成材料物性的

定义.

8. ;t5l..~本相和革二相. 执行 Define→Ph皑白命今，在 Ph届四对话柜的 Phase

列在中选择 ph届时，在 Type 选项中选择 pnm町-ph眉e，然后单击」兰L按
钮， 在打开对话梧的 Phase MaterÎal 列在中选择町，并在 Name 主本植中输λ

'"代替原来的 phase-I . 单去一旦J按钮-
9 在 Phase 则在中选择 ph出e-2 ， 在 Type 迫项中选择 se鸣。nd，可 ph嗣e，单击

」主二:...，，~安扭， 在圄 12-45 所示时话柜的 Phase Matcria l 列在中选择凹，并且
Name 丈本柜中输入 y四川e 代替原来的 ph掘。2 ，同时在 Pr叩ertlcs 下的

Diameter[m] (直挂)中输入量屑颗拉直径 0.001，单击-丘』安扭.
10 回到 Ph自由时话植中，单去医豆垂司按钮，弹出 Phase Intercatìon 对话桩，如

圄 1 2-46 所示. 与主制相同，选择 Drag Coefficient 中的 schiller-naumann，是

义!If属和主气之间俊用 schi11 er-naumann 来计算相间阻力 J在去 Slip 边项卡，

此时相间的清移速度品式革用的是耻认的 mannÎnen-et-al ， 保持其性置，单击

-巴J按钮，是闭 Phase Intercatìon 对话柜.
-吨 -.幽……国回国………-圃'

h 

~-­
-'-1. 
刊，白

..... l~ 1明白1_ 1.... 1-- "-_ 1_刷，-叫

3王~I .---一-~一一 晴蜘悼- 一一三I一」

' 
恤-"'1 • 

1'.... 
'3 ..，二J iÎ

』

-巳l 旦到」旦j
院12-46 侧向作用的提义回 12-4 S 柑.11..蚀栩姐:义

川 执A于 Define→Operating Conditions 命令，打开 Operating Conditions 时话担.

如圄 12-47 所示，边中 Grav坤，指定量为方向为 z 轴，在 Z(m1s2)右侧输入-

9.81，同时选择 Specified Operating Density 项，并在1本柜中输入 1.225 ， 单

击-巳妹也-
12 克A上述操作后，定义边界串件. 执行 Define→Boundary Condilions 命令.

佯出 Bωndary Conditions 时话桩，定义如下边11-.

• 在左边的Zone .t呈选中肌保持 Phase 为 mox阳阻，单击J型二J按钮，在回 12-
48 所幸的 Velocity lnle 对话中E中选择 Sp回ification Me由叫 下挂列章中的
lntensity and Hydraulic Dîameter . 在 Turbulent lntensity[%}中输入 10 ，在

Hydraulic Diameter(四'1中输入 0.1895 (耳空外挂威去内在)，单击-巴」按钮.
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因 12-4 8 Vl::kx: ity Inld 对话棍

• 回到 Boundary Cond巾。ns 对话握，仍选择 tn . 改变 Ph由e 为 alr，单击」主­
挂钮，在圄 1 2-49 所示的 Velocity lnlet 对话框中选择 Ve1胆町 Speαfication

Method 下拉列是中的 Magnitude， Nonnal to Bound町， 并保持 Reference Frame 

为 Ab皿lute. 在 Ve1国时 Magnitude[mls]中输入 25 . 单啬-巳J按钮.

~- - x 

,-- 盹...

____ ! Tk..... I R翩翩- 1 ... 阳|阳 !国崎…. 1晒 l

" .. 曲'"喇睛"恤....rw.同曲. NenII.t .. s-耐向 J才
阳帽-"呵!抽.- 4 

，，'呻..酬由叫 1" 4 

」巳」 王旦J --.!!!U
四 12-49 空气的速度入口定义

· 再回到 Bounda叩 Conditions M话框，仍选择肌改变 Phase 为 yanxue . 单击

」旦斗桔钮，在回 12-50 所幸的 Velocity lnlet 时话框中选择 Veloc町

Specifi四tion Method 下拉列囊中的 Magnitude. Nonnal to Bounda可 ， 井保持
Rererence Frame 1.J Absolutc，在 Velocity Magnitude[mls]中输入 15 ; 另外，由
于速度入口岩屑的体积分虽为 0.02. 所且这里需要单击 Multiph国e 选咂卡，在

Volumc FractÎon 中输入 0.02. 单击-巳J按钮.
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回归.SO 指属的速度入口定又

· 在左边的Zone 栏选中 。ut ， 保持 Phase 为 mixture，单击」主二J按钮，在回

1 2-5 1 所幸的 Outf1ow 对话框中的 Flow Rate Weighting 中输入 1 ，即表示进入

的施体均从谊出口拖出，单击」巳J按钮.

民 |

I.htu~c 

...._w啕~.呻

一旦J l!!豆!I ~旦U
回归" 出口定义

F| • 在左边的Zone 栏选中 neibi ， í革持 Pha:归 为 m>x阳，"，单击」坐ι按钮， 弹出如

!~I 回 12-52 所幸的 Wall 时话框，在对话框的 Wall Roughness 下方的 Roughness

巨 | 嗣酬[mJ中输入 o∞刷678 ， 保持 Roughness Constant 为 0.5. 单击i放
程草| 钮.
份
额

在
真

恤'由 1""*- 1 -白|阳由 I DI'W 1............ luos 
明白白

'由町旧 ""…
俨叫时

-- ，吨
' 陶酶
F 阳曲._-
俨中，I.，"Y u. 门'
r ",. I Stn w..-...... 
阳阳..陶幅"间严丽亘古一问:高厂一~

h归..C-F一一-1- ::J 

" 
• 同理.足点 waibi (外壁面)的粗槌度也为 o 以刷4678，

13 地再走且好后 ， 执行 Solve - Control- Solution 命令，弹:f:: Solutioo Controls 

时话框，保持其耻认设置， 单击-旦J接扭.
14 接下来时iA.场进行初始化 . 执行 Solve -0 In itia lize 叫 lnitialize 命令，在



Solution ln i t ia l四tlQn 对话括中选择 m . 时进口初始化，顺序单击」旦j.
旦旦旦出扭.

1 5 朝姑化后，执行 Sol....e 司 Monìtors → Resid皿l 命令，在蝉出的 Residual

Monitors 对话柜中选中 Plot. 打开残呈曲线固 . FLUENT 耻认各事数的收最蜻

庄要卓为 0.001，本倒保持耻认， 单击~接扭.

16 执行 File- Write→ Case 命令，将工程又件保存为 5112-2 瞄.

17 执行 Sol....e - Iterate 命今，设直途代步为 1 0∞ 步， 单去生旦旦按钮开始衅

11'. 
1 8 迭代结阜后 ， 为显示由下而土过程中流场的直化， 需要足义抽向剖面 . 执行

S旧face → Plane 命令， 摊!I:如圄 12-53 所示的 Plane Surface 对话枢. 在 Points

下的三也坐标中分别输入 xO[m) 、 yO[m) 、zO[m)为 0‘ O . O . 川 [m) . y1[m) 、

z l lm)为 O. O. 9.96 . x2 [m) . y2[m). z2[m)为 \. O. 9.96. 并在 New Surface 

Name 中输入础， 单击-空空」接扭生成轴向剖面 .

t 

--
F且-P且-F且- i tL­
F且-p且- r.-ι-H注一
严一带一带一俨-' --

19 因'*'趣的长挂比很大 ， 显示出的圆形过于狭长， 所队执行 Grid→Scale 命

今，在弹出的 Scale Grid 时话柜的 Z 中输入 O. \. 如圄 12-54 所示 ， 单击

E豆丑剧也使得轴向长庄缩小到原来的 10% .

二二.. 
只「一 GriOI w.. CreMH '" F丁

'1'一一一 旦旦旦旦旦旦l
2F一一

h由国酬

- ""' 1-' . tsns - "'" 11...n 
呻恻I-'.tsns -"'I' .151n 
-"'''1''--- 血"'" I'.M 

二旦J旦旦l 旦旦J_'生」
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20 执行 Display司 Contours 命令，在 Contours 对话柜的 Suriaces 中选择己走且的

轴向剖面 z-h ，然后选择 Contours of 下拉萨l 在中的Pressure 和 Static

Pressure . 保持 Ph"-，，，列在中的 m.lxture，并勾这 Options 栏中的 Filled i阜项，

单去E豆豆1制翠，碍圭忡圄 1 2-55 所示的压强分布云圄. 武宣 c。阳urs of 下
拉ftJ，在中的 Velocity 和 Velocity Magn阳出，并选择 Ph醋 f'l-*- <f的 町，单击
E豆到按钮，可得宝气的这庄分布云国，如圄 12-56 所示. 改选 Ph"-，，，列在
中的选项为 yanxue，单击 ! 01'''2 '制丘，可碍A告屑的迫庄分布云圃，如圄 12-
57 所示.
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21 改直 Contours of T拉列在中的选项为 Phas田和 Yolume frac lion，并选择

Phase 列在中的 凹，单去 I DI. pl-y 1按钮，可得凹的体和分散云圃，如圄 12-58

所示. 改~ Phase 为 y皿xue . 可碍幸屑的体租分数云困 ， 如困 12-59 所示.

22 执行 File - Write - C四命令，将结果主件保存为 sI 1 2-2 .dal.

23 执行 File- Exit 命令，安全退出 FLUENT.

3刷
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我国天然气拗探、开发、储运且利用技术的相时落后制约了国民经济的发展 ， 大力监展

清洁能源已成为本世纪重要的战略任务. 虽然我国天然气直源较丰富，但分布广、气藏类型
直杂、产出层系事、产启压力商曙特点给实际开来、生产带来了困难， 因此起样科学地开来

一直是困扰油气回技术人员的难题. 由于井下节流工艺具有降低井口压力、避免水告物生

成、提高气流擒液能力等优点而受到丁人们的关注. 目前， 该技术已在我国$个气旧的事口

气井中应用，取得了较好的姓提.

-、 实例慨述

#考川渝地区井下节流工艺的实际#数，选用适于Ø73mm (27/.") 汕臂的固定型井下
节流器，节流嘴孔径为 3. lmm ， 高度为 20cm，在 4890m 生产井中 ， 节流嘴的圭装深度为

2∞Om 井底产层压力为 55.77MPa . 井口压力为 8MPa 井口耳境温度为 22 .397 'C ，地温霄，

度为 1.936 'c 1 1∞m ， 天然气相对曹 I!l 为 0.6679 ，比热容为 2222JI{kg' K) ，导热革敢为

0.0332W/{m'K) ， 动力粘度为 1.087叫 O'SPa-s . 几何模型简图如圈 12-60 所示.

l .2mm E 
" 。

E" 

••• 

" 

因12-60 Jt:于1府施几何领攫示意回



思路分析

本主涉且到天然气在高压环填下的流动问题，因此需要将其槐为可压缩流体处理. 由于

地温梯度的存在，故还需用到 UDF 函数来定义地温梯度.

通过本实例的演示过程， 读者将学习到

• 对称模型的建立，

• 可压缩气体温动，
• UDF 画 11;);:且，

• 天然气材料定义，

• 沿井理分布幽蝇的绘制 .

哑王...1}一'见附带先盘 ""Chl川山叫川1口山阳川2缸阳川、M剧112-3.msh"飞、 "句咱叩cα阳ωh1川l山2川W
3刊J。刷u "飞、 'Cωh1口2、、M咄sl副11口2-3 田 "飞、 'Cαh1山2缸剧飞、回凶s剖副l川1口2-3.c耻 " 、 u ChI2\s11 2-3.dat" 、

"Ch1 2飞udf.c"• 

罐，哑u)一'见附带光盘咄1川1\s11山「·
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二、 模型建立

由于 GAMBIT 中仕直比太大的情况下生成的面网格合出现很大的歪斜度，且带虑到节

流嘴处网格的细化，故将模型划分成 8 个面域， 其位置且长度如圄 12-6 1 所示.
H9010 1400m 99m 99皿 '900w

L 1- - I+-→1卜
、

, 
, . 

0.8m 0.210 1回

回 12-6 1 分区尺寸

1 双击 GAMBIT 的桌面快拢方式，启动 GAMBIT.

2. ~们只建立右倒-丰模型，叶林轴建立在 y 轴上，首克#照国 12-61 ，将模型

中所有棉点的坐标计算出来 . I!.i Æ; -'t'-.t.r--陌-í;C.在 Create Real Vertcx 
面极中直且模型点的蜡制，共 20 个点，如圄 12-62 所示.

3. .Ur百-f1f-F. 在 Create Straight Edge 面刷刷迫在时蝇，再-'t'-.t.r百
-r百-[0.在 Create Face from Wire lTame if1t.i.中刷刷函，形成几何模
型的 s 个面址，如圄 12-63 所示.

三、 网捕划分

1. -'t'- .t. r百司f1f-币，在Edg国输入柜中选择需要划分的蝇段 I .*.JfJ Interval 
Count 的划分方法进行战同格划分.1>蝇耻的同#划分段..如圄 12-64所示.

3由
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2. ....I;r百→自-~，选择所有的函，相 Quad 和 Map 的划分方式，得到 | 饵章
如围 12-65 所示的面网掉，节埠嘴址同格局部放大国女，圄 12-66 所示.

图 12-6S 面网格 囱"品节'‘嘴处面网稿的局部放大

3 同格划分奸后以边冉典型，单击r.-→I莓，选中下部进口边( edge.28 ), 

定义为压力入口边耳 (PREESURE_INLET )，名称为 inlet ; 选中上都出口边

( edge 川，定义为压力出口边界 (PREESURE_OUTLET )，名称为 outl锐，选

择 y 轴上的对林边( edge.2. edge .6 ‘ edge. I O 、 edge.14 、 edge. 1 7 、 edge.23

edge.26 、 edge.2肘，将其走义为叶林边界( SYMMETRY)，且称为 symm; 将

367 
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右侧井壁边( edge.4. edge.7. edge.9. edge.ll. edge.13. edge. 1 8 、 edge.24 、

edge.27 、 edge.30) 走义为壁画边冉 (WALL)，名非为 wall ; 将节啤嘴右侧边

(edge. 15 )也定义为壁.fJ边界( WALL)，名#为 choke wall，如围 12-67 所

示.

W峭

翻 12-67 边界樊型定义

4 执行 File - Export→ Mesh 命令，将网格输出为 sI1 2-3.msh.

四、束解计算

2 

3 

5 

启动 FLUENT 二级单柑庄计算器，执行 File→Read-Case 命令，读入划分

好的网格主件 "sI 1 2-3.msh" 网持该人之后，执行 Grid_Check 命令，检查网

格的仿息 ， 持最后一行出现 "Done" 语句 .

执行 Grid-…Sca le 命令，悼出 Scale Grid 对话桩，本倒不需要重新走且同格

的尺寸，从对话框中可，~琦出计算E峰的尺寸范围 .

执行 Define_Models→Solver 命今，弹出 Solver 对话掘，保持最认诅置，单

击-巳如钮.
执行Define- Models- Energy 命令， 句选 Energy 时话据上的 Energy Equation 

选项 ， ~;.t世，舌传I!<计算

启用瑞埠棋型.执行 Define→M叫els→明scous . . ，命令，弹出 Vis∞us Model 对
话桩，在 Model i&项中选择 k-epsilon[2 呵时，在 k-epsilon Modcl 选项宁选择
Realizab le ，勾.i&. Oplions 栏中的Viscous Healing 边项(启用帖热lt且 L 如圄

1 2-68 所示 ，
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6 固立然气中的主要成分为甲坑，址从 FLUENT 自带数据库中持甲炕调用出

来 . 执行 Defi白ine→Ma刽terial s 命今'单击 Materials 对话框右侧的

Auent DIIt,b.. e 接扭，在弹出的 Fluent Database Materials 对话握中，利用

选动串选择 Fluent Fluid Materials 列在中的 methane[ch4}，见围 12-69，单击

王E旦接扭，即将数据库中的材华←一一甲炕拷贝到当前工程中 . 单击旦旦旦按钮
关闭该对话框. 回到 Materials 时话桩，即会且现在 Fluenl Fluid Materials 下拉

到在中存在了甲坑和主气两种材料.

』

俨……

"咱阳再忡m, .... 丙
句阳崎 1-­

, .... 
~_.阳缸叫陆刨问"

1"..在

U
-
u
-
u
-
U

一
刷刷由陆刽阳明

F面再

圄 12-69 用筑材料的调用

7 由于王熙气在高压环境下是可压捕的，因此本制将其施动当作可压缩乱动来

#虑，选中 Material s 对话柜中的 methane，改变其密度( Dens町)为 id国l

8町，女，圄 12-70 所示.
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因 1 2-7V 改变咿妈的密度

8 单去 Materials 对话框右侧的~旦旦旦坦坦e.. ， 一按钮，在弹出的 F!uent
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Oatabase Materials 时话框中，将 Material Type 改为 solid . 利用琅动串选择
Fluent Solid Materials 111~中的 steel ，如圄 1 2-7 1 所示，单合二'PY 按钮，即将

-.-
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回12-1 1 钢材'斗的调用

9 单击 Material s 对话柜中的王旦旦柱扭，克成本制材料物性的走义.

1 0 执行Define_Units 命令 ， 弹出 Set Units 对话框 ， 选择Quant i ti目中的
pressure. 在 Units 可时看到目前二程中关于压强的单位.单击阳-JjH萃，在

蝉出的 Oefjne Unil 对话柜中的 Unit 中输入.t.f;1: mpa . 在 Factor 中输入

刚刚刚， 单击『坐」按钮，定义压强的~j牌位 MPa . 选#< Qu皿t1tles 中的

temperature , FL四川默认的，孟庄单位为 K. 这里在们选择'C.单击-巳且安

钮.

11 执行 Define→Operating Cond山ons 命令，打开Operating Conditions 对话植.
如圄 1 2.72 所示，保持默认设直，单去」巳J按钮.

'幽幽幽幽圃翩翩翩…-田'
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四12-n 镰作环键设置

口 本倒要用到 UDF 来定义井壁的地温梯庄函敛，因此打开 VC+-唯序峰得器，



输入7面的 UDF 程序，悻存为 "udf.c" 文件，并址直在工作目录下.

#include "ud f.h" 

DEFINE _ PROFlLE(W ALL _ inlet,thread,index) 

{ 

face t f; 

real x[ND_ND]; 

real y; 

beginj_1回p{f，tlu-ead)

{ 

F CENTROID(x,f,thread); 

,-.[1); 

F PROFILE矶山ead，index)=273.1 5+22 .397+0.01936.(价，

endJ_loop(f，由r曲曲

1 3 执行 Define→ User-Deflned - Functions - lnterpreted 命令，得出 UDF 解非对话
桩，在 Source Fi1e Name 担中输入蝇写好的 udf.c . 单击旦旦j按钮，将地温梯

庄品批调入.

14 克A上述操作后，走义本制的边界串件. 执行Define→Boundary Conditions 

命令，体:l: Boun也叩 Condìtìons 时话植，定义如下边Jf-，

. 在左边的Zone 栏选中 f1uid，单击」主-按钮，在围 1 2-73 所示的 fluid 对话框

中选择 Material Name 下拉列囊中的 methane，单击-坐」按钮.
「 ‘) 1,,, .1 叮.

主生J
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~12η 罐体介'定义

• 回到 Bounda叩 Conditions 时话框，在左边的Zone 拉选中 m恼，单击二丘-坡
钮，在圄 12-74 所幸的 Pressure Inlet 对话框中捕入 Gauge Total Pr目sure(mpa]为

55.77. Supersonic/lnitial Gauge Pressure[mpa] 为 55.76 ，选择 Direction

-
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Specìfication Me由od 为 Nonnal to Boun也可· 选择 Turbulence 的 Specl自由tlOO

Method 为 lntensi()' and Hydraulic Diameter (董动强度与水力直径)，输入

Turbulent lntens町[%]为 1 ， Hydraulic D陆meter[m)为 0.062 . 最后选择 Thennal
选咂卡，在 Total Temperature[c]中输入 11 7，如固 1 2冉所示，单击~按
钮

~.俨且酬'‘·咽 ,- 巧运--IIIIlet 
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一旦J~到~
刚12-75 入口温度的足义

• 回到 Boundary Conditions 对话框，在左边的 Zone 框中选中 outlet . 单击 8... .. 1

按钮，在国 12.76 所示的 Pressure Out1et 时话框中输入 Gauge Pressure[mpa]为

8 ， 选择 B，e才Idlow Direction Specificatìon Meth叫 为 Normal to Boundary . 然后

选择 Backf10w Turbulence 的 Spee而cation Method 为 Intensity and Hydraulic 

Diamet町，输入 Backflow Turbulent lntensity[%]为 1 ， Hy命-aulic Diameter[叫为

0.062 . 最后选择 Thenn创 造项卡，在其中的 Backflow Tota\ Tem阳阳叫eJ中输

入 22.397，如图 12.77 所示，单击一旦』安钮.
• 回到 Boundary Conditions 对话框，在左边的 Zone 栏选中 symm，单击」旦斗
按钮，弹出如固 12.78 所幸的对称边界定义对话框，直接单击~按钮.
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阁 12-n 出口温度的lVl.

• 回到 Boundary Condilions 对话框，在左边的 Zone 框中选中 wall，单击-旦ι
按钮，弹出如固 1 2，79 所幸的 Wall 对话框，选中 Therm创 造项卡，选择

Thermal Conditions 为 Temperature . 然后选择 Tempera阳叫c]右侧下拉列囊中的

udf WALL inlet . 即调用 T地温梯度面世， Jl外，选择左下角 Material Name 

下拉列章中的 steel .

h …... noo..- I__ I勘响~ I- I -份…l刷 l
~叫一

俨 ~.-
• .'甲白

'一俨-' -' 
τ甲阳"广一一- 1"'百:;::;;;;;--丁

W蝠'怕四..同l '

M归自』问r一一一阿E一一丁

?…………·四事

?二四皿 |
回12.78 对称咄界定义 阳12平"摩洒地界伎重

再找回到 Boundary Condi tions 坤话框， 在左边的 Zone 栏选中 choke '咽11 . 单
击 "L 按钮，与上面井壁边界定义一样，选中 Thennal 遣嘀卡，调入地温梯

--1- →一--.:1 ，旦

3 73 
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度函数 udfWALL inlet，选择壁面材料为铜管，单击一旦」按钮.
15 边界定义奸后，此行 Solve-噜 Contro l - Solution 命令.排出 Solution Controls 

对话框，改主 Momentun 为 Second Order Upwind 格式，保持其他默认设直 ，

单击"且安~A.
16 接下来时流场进行相始化 . 执行 Solve • lnitialize • lnitialize 命令 1 在

Solution Initialization 对话柜中选择 m，对进口初始化，顺序单击」丘」 、
旦旦j、卫旦三接扭.

17 相始化后，执行 Solve → Monitors -0 Residual 命令，在弹出的 Residual

Monitors 时话桓中选中 P10l，打开战革曲或固 . FLUENT 默认除 ene电y 为 10<
外，其他各事数的收姓柑度要求为 0.001 ，本制保持默认，单去」巳」按扭.

18 克成上述步骤的设直后，执行 Fi1e -噜 WrÎte → Case 命令，将工程主件保再为

sI 12-3.c田.

19 执行 Solve → Iterate 命令，设置追代步为 14∞步，单击旦旦旦按钮开始解

耳.

20 迭代结束后，执行 Display -0 Contours 命令，输出本制节，且嘴处的速度 ，且

庄、马赫数云圄女。圄 12.80 王国 12-82 所示. 可以清楚地，看到节流后速度的增

大和温庄的降低.

m 

•• 
四... 
" •• -" " •• mummm 

囱 12.80 速度分布罔 因 12.81 温度分布

阳 ]2.82 马份量分布



21 执行 Plot.... XY Plot 命令，在圄 12-83 所示的 Solution XY Plot 时话柜的 Y

Axis Function 下拉列在中选择 Pressure 和 Static Prcssure，并选择 Surfaces "1在

中的 symm . 选择 Plot Direction 的 Y 为1， 句这Options 栏中 的 Position On Y 

Axis .i&项，保持其他为默认设置，单击 P\oII J接缸.弹出如圈 12-84 所示的轴

向压强分布做点圄 .

| ‘_.....，絮' • 
筒- -…_v_r.回圈·1õ1 __. 气Fr「-一- 阳·由白 二i

1 r 
. -…v战睛. • 
r w州幢幢- , 
r 

• 
' -
' 

时，~ -
帆。 ---

唰-•• ...瞄............... ........... .. 
抽阳.....(I!'Ø8)

倒 12-83 So IYlion XY Plot别的阳 剧12-84 fIII ~;J压组分苟

22 同理， 政:t. Y Ax is Function 下拉萨l在中的选项，可且得到时且的轴向速度和

温庄的分布曲蝇，如圄 1 2-85 和圄 1 2-86 所示. 这些曲鸪圄可以锵助^in分析

节，且嘴处是否在晶在生水合物猪草，为井下节茸的节流嘴安革及设计提棋一 笛
'
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刚 12-8~ 输向u纱布

23 分析直后 ， 执行 File叫 Write-Case 命令，

24 执行 File ..... Ex it 命今，安全退出 FLUENT.

剧 1 2-86 输向温度分布

将结果又件保存为 sI1 2-3.dat .

12.4齿轮泵内流体流动模拟

齿轮泵是容积泵的一种，由两个齿轮、泵体与前后盖组成两个封闭空间 ， 当齿枪转动

时，齿轮脱开侧的空间的体jgh\小变大， 形成真空，将液体吸λ ， 齿轮咄古侧的空间的体积

从大变小，而将液体挤入管路中去，其吸人腔与排出腔是篇两个齿轮的啃古钱辈隔开的. 齿

375 
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轮泵适用于输送不吉固体颗粒和1纤维，无腐蚀性的润滑油或性质类似润滑油的其他液体， 以

且用于液压传动系统.大流量齿轮袖泵现主要用于汕田、袖库、港口、码头、船舶等大流量

输汕、卸袖，起到了很大功效.

、实例概述

如I图 12.87 所示，齿轮泵模数为 3，齿轮数为

10 ， 变位罩数为 0.5 ， 压力角 20 ，齿轮转速为

420r/m ìn . 油流从上万进入 ， 下方流出 . 汹的密度

为 960kg/mJ，粘性系数为 O.048Pa's .

思路分析

本例可以借助 CAXA 电于阁版来绘制齿轮京

的几何模型，通过边界型函数来定义齿轮的转动 ，

另外需要启用动同格模型.

通过本主例的泌示过程，读者将学习到 :

• CAXA 电于围板量制齿轮，

• 边界型函数的定义，

• 动网格模型设置，

• 动画记录，
• 班蝇的显示 .

圈 12.87 齿役被几何确型示意自由〈单位 mm )

哑<.11)一鲁凯见附附带光蛐盘"吧咄C由h 121s川、

恒<.11 )一参见附带先盘 ‘"川、回咄川肌叩I川山卧川l口匹山2二2-4川 "、 "吨咄咄叩Chl2川1山2川、
4.jou "飞、 "ChI 2'飞、s l川12.4.trn "气、 "Ch1 2飞Is I川1 2.4.ca田s飞 "Chl口2飞、，11口2A.0200.ca描s"飞、

" Ch I口2\、回s剑11口2-4牛.0200.da划t "、" Chl2、1 12A.0400.cas "、" Ch l 2、1 12.4.

0400.dat ..、 "Ch1 2、1 1 2-4-06∞ c田"、" Ch 1 2、1 12A.0600.dat " 、 "ChI 2\s 1

12A.0800.cas "、" Ch 12\s112.4.0800.dat "、" Chl 2、1 1 2.4. 1 000.cas "、

" ChI 2\s 1 1 2 .4. JO∞ dat " 、 " Ch l 2、11 2 -4-1 200.c田 " 、 " Ch 1 2飞到 1 2-4-

1200.dat"、 "Ch12、 11 2-4.1 400.c描"、 u Ch 12\s112-4. 1400.dat "、 "Ch1 2、1

12.4. 1 600.c苗" 、" Chl2、11 2-4 - 1 600.dat" 、" ChI 21s1 1 2-4- 1 8∞ cas "、

" Ch l2、11 2-4- 1 8∞ dat "、" ChI 21s11 2 -4-2000 .c蹈 " 、" Ch l 2、112-4-

2000.dat" 、 "Ch1 2、112-4.2200.cas "、" Chl2、112-4.2200.dat'气 "Ch1 2、1

1 2.4.2400.c田" 、" Ch 1口2飞、回s剑l川1 2.4.2400.da剖t

" Ch l2飞、s I 12-4 -2600.da创t " 、" Chl2、112.4.2800.cas" 、 u ChI2\s112.4. 

2800.dat "、" Chl2、I 12-4.3000.c画"、" Ch1 2、11 2-4-3∞O.dat "、

" Chl2飞left.txt " 、 " Ch 1 2飞right.txt "、 " Ch12\.pressure.mpeg " 

"Ch1 2飞press ure gIf FJ. 

每u)一害见附带光盘咄l川\s1 12.4.av ì " 0 



二、模型建立

l 启动 CAXA 也于圄拉机楠版 2∞9 杜仲 1 可以看到其工具按钮位于工作界面的

土方 ， 从中找到高且蜡圄接扭扭 ， 如圄 12-88 所示

俨) .c o ð ，Q，

!Ò ~非 /回民

回口... 菌.绘图工具骸钮

2. j院去其中画齿轮的接扭， 弹出如困 12.89 所示的南开战齿轮齿市事敢对话植.

在时话柜中 ， 输入本倒齿轮的基本喜数，输入奸后单击Z二E且且按钮，摊出如

圄 1 2-90 所示的预且对话桩，在有效齿数中输入 10. 单击 .. 接扭. i且时

就在视围窗口中出现7 一个画峙的浮动齿轮 (住直尚永确定).将其抱动主原

点处，使中点与原点重合， 单击鼠标丘键，即克成了一个齿轮的蜡制 .

们>t~II... J + U 吱 E

叫

•• -阳一 蝠 .. ~ rõ外酣

u … ;õ3 .四.. .. ..- 俨 内盹

..-
IIl111lU : -- r-3 

叫E

11.....:... Ji"宫古

r- ­
r- 蝇

E王豆卫 一旦旦」

百豆豆豆.ι王 震l

e圃…..& : ~ 

....嗣咱 们「

P 霄'且111. : ~ …_, ID一..: ~ 
r .(AlQl悦 ， .-

-旦旦」

(..t.-..~ [三!:J _旦ι」

则 1 2-19 .1自~霞 圄 1 2-90 笛.te .fî徽笛'虚设置

3 接同样的方法再蜡制一个一样的齿轮. 蛙制克后将工程主仲保存为 dwg 格式

主件

4 启动 AutoCAD 2∞7 . 读λsI1 2-4 .dwg，按照圄 1 2-87 所示的模型示意困，克
成齿轮最轮廓的其他蜡制. 具体的 CAD 操作，这里不再详述， 读者可以查阅

相关 CAD 书描.

5 蜡制在成后 ， 在命今00板中单击E画按钮， 选择围彤的所有轮廓蝇， 单去鼠标

右键且按~蝇， 执行 File - Export 命今，选择保存提型为 AClS ( .. 四川，
输入川 4酬， 再次选梓圄彤的轮廓蝇，单击凰柑键辅臣吕键. 将模型
以面城形式输出 ， 棋 GAMBIT调用 .

6 旦去 GAMBIT 的桌面快彼万式，启动 GAMBIT. 执行 Fi le - lmport - ACI S 命

今， 输入立件名 511 2-4.5at ， 即可将 CAD 中蜡制的圄形导人到 GAMBIT 中 .

7 此时的几何回形为 3 个 00域 ， 我们的计算区域为外圄 00域且会两个齿轮 00

埠 ， 故".;t， F ace 00 #.命的F按钮，在 Subtract Real Faces 峭的第一行 Fa目
中选取外国 00域， 在第二行的 Faces 中选取两个齿轮00域， 单击 .".， I按

扭， 得到本制的计算区域， 如圄 12-91 所示.
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回 12-9 1 绘制."，儿俩"想

三 、 网格划分

1 榈树奸后进行网格的划分. 轴r.--[F斗百， 打开 Mesh Faces i1 
板， 选中本制的计算E城，以 Elements: Tri 和 Type: Pave 的同格划分方式，

并革用 Interval size 为 0.2 划分面网格，保持其他默认设直，单击 .".，. 按

钮，生成如圄 12-92 所示的面罔格.

2 网格划分好后定义边界奥型 . 单击I画\- r莓，选中上都进口边，走义为压力
人口边J1- ( PRESSURE_lNLET )，名#为 m; 选中下4JI出口边，定义为压力出

口地界 ( PRESSURE OUTLET)， 名非为。时，将左侧齿轮的壁画走义为壁画

边界 (WALL ) ，名林为 w 1 ; 同样也将右侧的壁画走义为壁画边J1-

( WALL)， 名非为 w" 如图 12-93 所示.

3 执行 fi1e -Mesh 命令，将网格输出为 sI 1 2-4 .msh .

"… 
lZ严 j

"JJ h
"
民
抽

四"

阁 1 2-92 面向精 四 12-93 iå界樊型设置

四、束解计算

l 启动 FLUENT 二维单柑庄计算器，执行 File_Read_Case 命令， 讲入划分

好的网掉1件 "s1l 2-4.msh" . 网格读人之后，执行 Grid_Check 命令，桂查网

格的信息，桂剖且功后会出现"Done" 语句 .

2 本倒需要改主模型的尺寸，执行 Grid→Scale 命令，然也 Scale Grid 时话

框，如固 1 2-94 所示，选择 Grid Was Created In 下拉到在中的 mm，单击

E豆曰挂扭，即将模型捕，J、为原来的川翩，此时的计算E域尺寸范围可A
Domain Extents 中看出 .
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四口" 尺寸定义

3 宁一步走义卓衅的基本模型 . 执行 Define→M叫els-Solv町命令，伴也

Solver 时话柜，选择 Time 为 Unsteady，保持其他默认设直，单击-巳如扭-

4 执行 Define_Models→Viscous 命今，弹出 Viscous Model 时话桩，在 Model

;&嚼中选择 k-epsilon[2 eqnJ ， 在 k-epsilon Model .i!项于选择 Standard，保留其

他默认设置 ， 单击-坐」按钮.

5 基本模型是巳义革后，在义材料的物性事数. 执行 Define→MateriaJs 命令，单

击 Materia l s 对话植右侧的 R旦旦Ott.b..巳二ι接扭，在伴出的 Fluent Dalabase 

Material s 对话柜中 ， 利用革动条选4t Fluent Fluid Mater回l s 列在中的 fuel-oil­

liquid , j醉金二~接钮， 即将扯据库中的材料一-;<，都持且到当前工程中 . 单

击王旦旦接但朵闭式事对话植. 回到 Materials 对话桩，即合且现在 Fluent Fluid 

Materials 下拉 f'J 在中存在了宝气和油两种材料，如圄 12-95 所示 . 单击

圆圈M ' -
俨一…

-崎陆如M

严百
3千主」

因 12-95 材'电泊的建叉

6 执行 Define-Operating Conditions 命令，打开Operating Conditions 对话担.

如圄 12-96 所示， 在事考i王强4主直 ( Reference Pressure L饵ation) X[m]中输入

0.0205. Y[叫中输入 0.025. 单击-旦j柱扭.
7 接量定义迫.jf-帝仲. 执行 Define→Boundary Conditions 命令，得出 Boundary

罐
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• 

Condilions 时话桩，走且如下.

• 在左边的 Zone 栏选中 fluid，单击」丘』按钮，在固 12-91 所示的 Fluid 对话罹

中选择 Matenal Name 下拉列表中的 fuel-oil-liquid . 单击-坐」按钮.

"-…………………唱
M阳
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阳12-97 流体介鹏也义附 12.96 11作环魄被置

• 在左边的 Zone 栏选中 m. 单击」旦L按钮，在圄 12-98 所示的 Pressure lnlel 

对话框中的 Gauge Total Press田.e[p缸四 1J中输入 O. 在 SupersonicJlntital Gauge 

Pressure[pascal] 中输入 O. 选择 Specification Method 下拉列最中的 Intensity 四d

Hydraulic Diameter ，在 Tu，也ulent lntensity[%] 中输 入 5 .在 Hydraulic

Diameter[m]中输入 0.004. 保持其他默认设置，单击-旦-1按钮.
~~ 

_m_ 
专k--护"
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，，-嗣楠'嗣同 |E

制，..1k0l_幅. "'" 1','" 

~旦旦旦旦j
园口" 压力入口应叉

· 在左边的 Zone 栏选中 Qut，单击 8-'-._ 按钮，在固 12-99 所示的 Pressure

Outlet 对话握中的 Gauge Pressure[pascal] 中输入 O . 同样选择 Rαfication
Me由国 下拉到最中的 lntensity and Hydraulic Diamet町， 在 Turbulent

Intensity[%]中楠λ S . 在 Hydraulic Diameter [m]中输入 0.004 . 保持其他耻认

世置，单击-丘J按钮.
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回12-99 压力出口定义

8 在启用动同格模型之前，首且需要走义齿轮i运动的边.Jl-型函数，打开两个主

白记事本主件，分别输入如下两组函缸，悻冉为 left.tx t 和 right.txt 两个主件，

并址直工作目录下 .

在侧齿轮的边界型函数为

((left 3 point) 

(time 0 I 60) 

(omega_z 43.98 43.98 43.98日

右侧齿轮的边界型函数为

((';gh日 point)

(time 0 1 60) 

(omega_z -43.98 -43.98 -43 .98日

9 拉行 Define→Profiles 命今，弹出如围 1 2-100 所示的 Boundary Profiles 对话

框， 单去 RUL f按钮， 找到书写好的 left.tx t 和 right.tx t 又件， 读入后对话框会

自动显示相关信息，

• 

因12-100 j&).地界型国内数

10 执行 Define - Oynamic Mesh → Parameters 命令 ， 在弹出的 Dynamic Mesh 

Parameters 对话柜中勾迫 Dynamic Mesh 迫项，对话框自动展开，如圄 1 2-101

所示选中 Mesh Methods 栏 中 的 Smoothing 和 Remeshing 迫项，默认

Smoothing 追项卡的事缸设直. 在 Remeshing 迫项卡的 Options 栏中选择 S ize

Function 和 Must Improve Skewness ， 其事业设直如圄 1 2-101 所示 ， 单击-坐J

按钮.
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因12- 1 01 功网恪帧型.ltilt置

1 1 执行 Define -- Oynamic M田h→ Zon田命令，世直边界型品盘的使用时卑，选择

Zone Names 中的 w_l . 设直其是型 Type 为 Rigid Body (刚体运动).选择
Motion UDF/Profile 于拉到在中的 left (上步已经将其导人 FLUENT>.保持

Motion Attributes 选项卡中的其他默认设直 . i!捺 Meshing Options 埠项卡，诅

.1. Cell Height 为 0 仪)02 (部近同格的尺寸). 单去一旦旦」按钮克成左侧齿轮的

运动世置，如圄 12. 102 所示. 同理，选择 Zone Names 中的 w r . 设置其真型

Type 也为 Rigid Body (刷体运动).选择 Motion UDFlProfile 下且1'1在中的

right . 在 Cenler of Gravity Location 的 .[m}中输入 0.033 . 并设置 Cell Height 

也为 0.0002. 单击 c.旦J按钮克成右侧齿轮的运动设直 最后单击王旦旦按钮

关闭口;归18mic Mesh Zones 时话挂.

俨 阳町
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俨…
俨刷一-

F旦旦一~
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回 12-102 移动边"说置

12 动网格棋型设置克后 ， 执行 Solve → Control -+ Solution ...命令， 在 Solution

Controls 对话枢将 Pr国sure.Vel田町 Coupling 设直为 SIMPLE 格式，然后将



Discretization 项的 Pressure 议直为 PRESTO! .将 Momentum ， Turbulence 

Kinetic Energy、 Turbulence Dissipation Rate 吐直为 First Order Upwind ， 保持其

他耻认性直，如圄 1 2-103 所示， j院去

二5E j
胸--F 丘

…由
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。‘

阁 12-103 求"控制.lh9.1r:

1 3 接下来时流场进行初始他 . 执行 Solve 司 Initia lize → lnitia lize 命令，在

Solution I nitializat ion 时话柜中选择 all-zones . 对全区战朝她化， 蝠序单击

~. 旦旦l‘旦旦三桂扭.
1 4 剧始也后，执行 Solve 司 Monîtors -0 R阻idual 命令，在妹出的 Residua l

Monitors 时话柜中选中 Plot . 打开蝇革曲线圄.对话植下方的 Criteria 中可以

输入品事般的收盘柑庄要卓， FLUENT ~认为 0.001 ，本制保持默认 ， 单去

一坐监钮.
15 下面设置本例的动画 . 执行 Solve -0 Animate 唱 Define 命令，弹出 Solution

Animation 时话框，通过右侧的箭头将业丰从 0 调成1.如国 12-104 所示，在

Name 中输入 pressure，将 When 选为 Time Step，设置 Every 为 50，即每一袖

的章悻时间为 50 个时间步.

16 接着时动画进行详细设置. 单去阳明ure 行最右侧的丘巳斗按钮，弹出如圄
12-105 所示的 Animation Sequence 时话挂.
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因 12- 1 05 动画详细设置倒 12-10咱动画个徽设置
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-旦出

17 选择对话柜中的 Storage Type 为 Metafile，在 Window 中输入 1 ，通过单击右

侧的，..除扭使时血的 ;d 窗口生效，此时会出现一个宜白的圆形窗口 . 然后边
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择 Display Type 下万的 Conto山"这时自动弹出 Contours 时话框，选择对话框

中 Conlours of下万的 Pressure 和 Static Pressure ， 并将 Options 栏中的 Filled

句边， 单击~到接扭后，刚才的宝白窗口 1 中即出现了初始时割的压强云

圃 ， 如围 12-106 所示. 单击王，.，巳桂扭关闭 Contours 时话柜 ， 回到 Animation

s呵uence 时话括中单去」巳J按钮
完成上述步糠的设置后 ， 执行 File - Write - Case 命令， 排工程主件保存为

s112-4.cas. 

执行 File- Write- Autosave 命令， 打开如国 12-107 所示的 Autosave Cas/Data 

对话框， 在 Autosave Case File Frequency 和 Autosave Data File Frequency 栏中

输入 200，即每 2∞个时间步自动保存一次 case 和 data 文件， 单击」巳J制且

是闭该对话框.

18 

19 
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~旦旦~
臼动保存设置

执行 Solve -0 Iterate 命令， 谁直时间步长为 0.0∞ 1 ， ， 时间步为 3000，并输入

Max Iterations per TimeStep 为 60 ， 单去旦旦旦按钮开始解耳. 计耳结束后 ， 执

行 Solve - Animate -噜 Playback 命今， 打开如圄 12-108 所示的动画回就对话挂

( Playback 时话框)，选择 Playback Mode 下拉列在中的 Play Once ， 即回址一

次. 选中 Animation Sequence 中的 pressure，保持 Start Frame 为 1 ， lncrement 

为 1 ， End Frame 为 60 ， 即J，i，. J在 1 帧开始回放直五第 60 帧 . 拖动 Replay Speed 

革动条可H控制动画回址的迫皮. 在 Write/Record Fonnat (保存格式)中选择

MPEG，单击」生j接.... . 此时可以看到窗口 1 中 的速度动画开始重新jf，址，

播址的同时， 动画将~~ mpeg 的形式保存其罪像又件在工作目录下. 最后改吏

WritelRecord F ormat (保存格式)为 Hardcopy Frames，单击』空业安钮，将动
画以 lP8 的形式保存每蛐固片在工作目录下 . 将生成的压强的每蛐圄片保存在

新建立件夹下 ， 然后旧文件臭的形式导入 Adobe ImageReady 中进行动画处

理，生且动画主件 P'田S旧'.8汀， 并保葬在当前工作目录下 .
执行 Disp l町→ Contours 命今，在 Contours 时话柜中选择 Contours of 下拉列

在中的 Veloc町和 Velocity Magnitu巾，并选中Options 栏中的 Filled，单去

l DlsplV接扭， 碍到 O.3 s 后的速度分布云田 ， 如国 12- 109 所示.

因 12- 107应强"J*自时刻云图阳 1 2- 1 06
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阁 12-108 劫. ~IAtJ.t说幌 111[2.[09 0.3. 后的遮!l份布云阁

22 武t. Contours of 下拉别在中的选项为 Pressure 和 Static Pressure，再次单击

国国棚，刷 0.3s 后的压强分布云围，如圄 1 2- 110阳.
23 执行 Disp1ay-VI剧。"命令， 弹出 Vectors 对话框，选取精对话拒 Vectors of 

下方J'I在中的 VeJocity 和 Color by 列在中的 veJocity 且 Veloc町 Magnitude .

持在制的 Scale 改为 2 . 单击E豆豆1接扭，得到如圄 12-111 所示的速度矢量
图 .
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图12- 111 OJ.后的速度，哇n回 1 2- 1 10 0.31 后的血'显分布云图

24 盖想显示此时流蝇，执行。isp1町→ Path LÎnes 命今，弹出如困 12. 11 2 所示的

Path Lines 时话桩， 选择 Re1ease from Surfaces 中的 tn . w_1 和 w_r . 设置 Step

Size(m]为 0.0 1 ， Steps 为 5∞0 ， Path Skip 为 2. 单去E豆困制血可旧事到如
图 12-113 所示的i血线圈 .
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因 12-1 \3 0. ).)目的流线显示

25 均分析不同时刻;，t场的变化，可以执行 File - Read吨 Case & Data 命今，读入

"sl12.4. 1 OOO.cas" 和 "sI1 2-4- I OOO.dat " ，同样利用 Display -- Contours 命

令，显示 O. l s 后的速度与压强云固， 如国 1 2-1 14 和圈 12-115 所示.

幽幽幽圄翩翩翩 亘监
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26 

因 ]2-11 4 0.15 厉的速度去圆 圆 12-115 O. 1s后的原缉云图

还可读入 "sI 12-4-1600.cas" 和 "sI12-4-1600.da俨，显示 0.16s 后的速度与压强

云圄， 如围 12-116 和困 1 2- lI7所示.
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团12_116 0.16， 后的法度云图
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27 迫#- Contours of 下拉到4中的选项为 V.I国坷...和Velocily .~咱由圃10. 并取

消选中 Options 肿的 Fillcd i& 'ii .单去E豆国接但.搏"怪圈 12'118 晰
的 0. 16s 后边庄的.1f值蝇国 .

" '1m;二J二巳
• 
唰

皿

•• 
" 
•• 
~ 

•• 
H I '. 

•• 
嘟

咀

•• 
国

" 
" ‘· 
" .. 
" 

嗣12-118 0. 165 后的速度等值俄陶

28 执行 Display → Scene 命今，弹 出 Scene Description 时话桩，勾i! Sccne 

Composi tion 下方的 Over1 ays，单击丘ply ~安钮后单击卫巴二按钮，关闭键时话
担. 迫样此可以在昂来的祖国窗口中进行圄彩的叠加.

29 执行 Display - Vectors 命令， 保持 Vectors of 为 Vel田町，民主 Scalc 改为 5.

其余保持默认，单击旦旦除扭， 且可，~看到等值且与迫庄矢量固的叠加. 利
用虱标中幢握取需要放大显示的 E峰，并利用且标左键#动困1Jí.合过4主

直 ， 圈 1 2.11 9 所示为局部放大的速度矢量与等值线追加围.

30 鼠标右键单击圆形窗口的标题栏 ， 会伴也知圄 12.1 20 所示的革单，选择 Copy

10 Clipboard 可队俊圄形窗口中的视圄悻存在剪贴板伞，用户可队将其1制 !'J

合适的主相中 .

安全退出 FLUENT.
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圃 12 川 9 0. 16雹后扇"放大的温度~.与每锁线"'细回 圈 12.120 锦贝四川院文件
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12.5 本章小结

本章结合石汕天然气、环境、机械等工程领域的典型问题进行了 FLUENT 流体分析且

仿真的介绍， 主要针对事相流模型、动网格模型且 UDF 的使用 ， 讲述了 T 型营内气液付高

流动模拟、空气钻井耳空气固两相流动模拟、气井井下节流流场模拟等 4 个实例，帮助读者

掌握解决实际工程问煌的思路和方法，井学会如何利用 FLUENT 去分析与解决实际问题，

做到学有所用.

/2 
v最

> 实际问题的思路分析.

> 模型的选择与调用 .
> 利用 FLUENT解决实际工程问题的操作过程.
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